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CINDEX Update Notes

Cindex 3.4 Update

These notes describes capabilities and features of Cindex™ added since the publication of the Cindex 3.0 User’s Guide. The changes were introduced in various
versions through Cindex 3.4.
You should read these notes in conjunction with the User’s Guide.
Language Support

Cindex 3.4 provides more support for indexing in languages other than English.
Cindex can work with entries that contain multiple scripts, for example Cyrillic,
Hebrew, Chinese. When an index uses more than one script, Cindex normally
follows a Unicode standard to determine the sorting precedence of letters and
other characters (Latin letters have the highest precedence, followed by Greek
letters, then letters and characters from other scripts).
When you choose a language for sorting, you can specify that characters from
the script for that language have precedence over characters from other scripts,
so that entries in that script will be placed ahead of entries in all other scripts. To
set this check Language Script has Precedence (this is always checked if the sort
language uses the Latin alphabet).When Language Script has Precedence is
unchecked, Cindex uses the default script ordering.
If you are working in a right-to-left reading language such as Arabic or Hebrew,
Cindex will lay out entries correctly as long as it knows the language you are
using. Specify the language via Sort settings in the Tools menu. You can override
the natural layout by choosing from the Text Alignment submenu in the Character menu (Windows) or the Format menu (Mac).
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Labeling Records

When you label or unlabel a record Cindex no longer automatically marks the
record as 'modified' (i.e., it does not update the date stamp and user identifier). If
you prefer to have the record marked as modified you can set a new preference
(Preferences->Editing->Label Sets Change Flag).

Keyboard Shortcut

There is a new keyboard shortcut for adding or removing small caps: Ctrl+Q
(Windows) or Command+Shift+C (Mac).
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CHAPTER 1

Overview

Cindex™ is a uniquely capable program for preparing indexes to books, newspapers and other periodical publications. It offers the professional indexer
unmatched features and ease of use. You can also use it to prepare glossaries, or to
create subject authority lists based on existing indexes. Cindex does not replace
you as the indexer, but supports you through a host of features that greatly simplify index preparation and enable you to produce the finest indexes in virtually
any format.
In many respects Cindex behaves like a word-processing program—it displays
the index in a document window, formatted like a printed index, and you can
explore and move through this document as you would any other word-processor document. In other fundamental respects Cindex is unlike a word-processor.
For example, when you make a new index entry, you do not type into the document directly, but into a record—analogous to an index card—and Cindex, following alphabetizing rules you have specified, determines where this entry will
appear in the index.

MAJOR FEATURES OF CINDEX
Instant, Automatic
Alphabetizing

As you make or change entries, Cindex instantly alphabetizes them, and you see
your index in alphabetical order as you work with it. You may sort entries using
letter-by-letter or word-by-word alphabetizing (following language-specific conventions), or by order of page references or by date. If you wish, Cindex will
alphabetize main headings and place subheadings in ascending or descending
order of page number. Numbers and symbols appearing in entries are ignored or
evaluated at your option. Cindex automatically ignores any of a selected set of
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Major Features of Cindex

words (usually leading prepositions), or any phrases that you mark for special
handling. You can override the standard sorting rules when you need to.
Automatic Formatting

You do not format or punctuate entries as you enter them, or merge duplicate
entries or arrange cross-references; Cindex does all these things automatically,
providing you with a fully up-to-date index at all times. You have full control
over the appearance of the finished index, which you can see on the screen
exactly as it will appear on paper. You can choose from several formats in addition to the standard indented and run-in (paragraph) styles. Special formatting
options make Cindex ideal for the production of magazine or newspaper
indexes.

Documents for
Typesetting

Cindex can provide finished indexes as documents designed for word-processing
programs, and document layout programs. Cindex will also make fully markedup XML and SGML documents. You can define your own markup tags for particular publishers.

Embedding Index
Entries

Cindex can embed index entries directly in word-processing documents (for
example, those used by Microsoft Word), so that page numbers and index formatting can be provided by the word-processor.

Instant Recall of Words
and Phrases

If you use a certain phrase often in an index—such as a standard subheading for a
magazine index, or a clinical condition in a medical index—you can create an
abbreviation to represent it. When you type the abbreviation, Cindex will
instantly recall the full word or phrase that it represents. You can keep different
sets of abbreviations for different kinds of indexes.

Search and Replace

You can find any entry instantly by specifying the letters it starts with, or you can
find any word or phrase in the index regardless of its position in the entry. You
can make a conditional search for words and phrases—for example the presence
of “friends” and “foes” in the same entry. In addition to searching for and replacing specific words or phrases, Cindex allows you to search for patterns of characters. For example, you might want to find “any word beginning with an
uppercase letter and ending in ‘ing’,” or “any four-digit number beginning with
19 and enclosed in parentheses.” A global search and replace function allows you
to modify entries quickly and easily throughout the index.
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Major Features of Cindex

Powerful Spelling Check

Cindex includes a powerful spell-checker that quickly finds and helps you correct misspelled words. Dictionaries for many languages are freely available.

Working with Groups of
Records

If you want to work with only a subset of the entries in the index (for example,
those for a particular chapter), Cindex can act as though these are the only
records in the index.

Cross-References

Cindex will place cross-references (e.g., See and See also) immediately following
main headings or as the first or last subheadings, as you prefer. Cindex will automatically apply designated typographical effects (e.g., italics) to text forming the
lead to a cross-reference or the body of it, and will punctuate the cross-references
automatically in any way you require. It will also check your cross-references and
will provide a list of questionable ones and ones that are of the wrong type or
refer to missing entries. Cindex will also tell you which entries have references
made to them, , it can generate cross-references automatically when it encounters
terms you specify, and it can convert cross-references to fully-qualified entries.

Page References

Cindex handles page references in virtually any form, including mixed Roman
and Arabic numerals, dates (including names of months) and multi-part references of the kind often found in periodicals. Cindex can sort dates and complex
references in virtually any way you might want, no matter how they are entered
in records. When Cindex displays or prints the formatted index it will arrange
references in ascending or descending order, and will abbreviate them (for example, printing 321–325 as 321–25), conflate them (for example, printing 23, 24,
25–26 as 23–26) and suppress component parts as you require. If a publisher
adds or removes pages in a book that you have already indexed, Cindex can
adjust page references automatically. Cindex can also check whether entries contain too many unqualified references.

Managing Subheadings

Cindex can identify entries that contain orphaned subheadings, or unnecessary
levels of subheading. If you wish Cindex will automatically convert redundant
subheadings to modifiers of the heading at the level above. Cindex will also identify modified headings that should properly be organized as heading and subheading, and if you wish will make that conversion too.
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How to Use This Guide

Work on Indexes
Concurrently

Cindex allows you to work on several indexes concurrently, so that, for example,
you can prepare author and subject indexes together as you work through a
book. You can instantly move from one index to the other as you make or modify entries.

Cumulations and Spinoff Indexes

Should the need arise, you can combine (cumulate) separate indexes into one
large one, and Cindex will automatically merge the entries. You can just as easily
split a large index into parts.

Importing and Exporting
Entries

Cindex can import index records from, and export records to, XML documents
and plain text documents of the kind produced by database programs. Cindex
can also import records stored in the formats exported by the indexing programs
Sky Index and Macrex.

HOW TO USE THIS GUIDE
This Guide to Cindex is organized in two parts. Chapters 1 through 13 take you
through the steps required to make an index, explaining features at each stage.
Chapter 14 provides a reference to all the Cindex commands, organized by the
menus in which they appear. Use the first part to familiarize yourself with Cindex and what it can do for you; use the reference to find explanations of menu
commands and pointers to tutorial discussions (these pointers appear in square
brackets beside each item in the reference).
The Guide assumes you are familiar with Windows, with the mouse, and with
menus and dialog boxes. It also assumes that you understand folders and that you
know how to start an application program. These features of Windows are
explained in help provided with your computer.
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On-Screen Help

Notational Conventions
This Guide uses the following conventions:
Tempo Font

Identifies a menu item or an item in a panel.

SMALL CAPS

Identifies a keystroke or keystroke combination that you
type.

[NN]

Reference (Chapter 14). Identifies the page on which a
topic is discussed fully.

ON-SCREEN HELP
Cindex provides comprehensive on-screen help. Choose Help Topics from the
Help menu (or hit F1).
Most of the dialog boxes that Cindex displays have a ? in the title bar. To learn
about the function of any item in the dialog box click the ? then click the item.

UPDATES
From time-to-time Indexing Research releases updates to improve the performance of Cindex. When Cindex is installed it is set to check automatically for
updates. If an update is available Cindex will notify you and ask if it should
download the update.You can turn off the automatic check if you prefer not to
be notified (see “Checking for Updates” on page 13).

CINDEX DOCUMENTS
Cindex makes and uses several different kinds of files on your computer. Each
type of file has a distinctive icon associated with it. The following paragraphs
introduce these documents. Later sections of this Guide describe fully the various kinds of documents that they represent.
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Cindex Documents

Indexes

Index files hold index entries, from which you produce the finished index. Index
files, which carry the filename extension .ucdx, work with both Cindex for Mac
and Cindex for Windows.

XML Records

XML Record files hold index entries in a open format suitable for interchange
with any software that parses XML. XML Record files carry the filename extension .ixml.

Archives

Archive files hold index records in a compressed form. Archives cannot represent
the full range of accented letters and symbols accommodated by Cindex 3, and
are recommended only for interchange with earlier versions of Cindex (both
Mac and Windows). Archive files carry the filename extension .arc.

Templates

Template files hold models of indexes. They contain all the information about
how entries should be formatted and sorted, etc., but contain no entries. Template files, which carry the filename extension .utpl, work with both Cindex for
Mac and Cindex for Windows.

Style Sheets

Style sheets contain information about the style of an index and how index
entries are formatted and laid out on a page. You can keep different style sheets
for different layouts. Style sheets files, which carry the filename extension .ustl
work with both Cindex for Mac and Cindex for Windows.

Abbreviations

Abbreviation files hold abbreviations you have defined to represent long words
or phrases. You can insert the word or phrase in an index entry merely by typing
its abbreviation. You can maintain different sets of abbreviations for different
purposes. Abbreviation files work only with Cindex for Windows, and carry the
filename extension .ucbr.
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CHAPTER 2

Starting an Index

THE ELEMENTS OF AN INDEX
A Cindex index is a collection of entries that you can view and print in any form
you wish and in any order you wish. Each entry is a complete reference to some
material in the work being indexed. Cindex maintains each index entry as a distinct entity in the document, so that it can display entries in the style and order
that you prefer.
An index entry consists of a heading and one or more locators (usually page numbers, sometimes cross-references to other entries) that show where the indexed
material can be found. An entry may contain subheadings as well as headings.
Subheadings are used to avoid making headings that would otherwise contain
too many locators.
Cindex can display and print entries in any order and in a wide variety of formats, as long as you prepare entries in a standard way. To help you do this, Cindex uses records to hold the text of index entries. A record always contains a
heading and a page reference or a cross-reference; it may also contain one or
more subheadings.
A record is usually, but not always, equivalent to an index entry. When Cindex
displays or prints a formatted index it may combine several records (identical
except perhaps for page references or cross-references) to form a single entry.
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Creating and Saving Indexes

CREATING AND SAVING INDEXES
Creating the Index
To start a new index choose New… from the File menu, or click
in the toolbar. Cindex will display a dialog box that asks you to name the index. (Unlike a
word-processor, Cindex cannot work with a new “untitled” document—you
must create and name a new document before you make entries). It is often useful to give the index a name that identifies the material being indexed.
NOTE: You can set Cindex so that it will initially use a standard folder when saving and
opening indexes. See “Default Folder” on page 13. for more information.

When you click Save, Cindex will open a new document window in which the
index entries are displayed as you make them. Most of your commerce with the
index will be through this window. When you close this window, Cindex closes
and saves the index document.
Standard Settings

To make a properly organized index out of a collection of records, Cindex needs
to know how the entries held in records should be sorted (for example, alphabetically, or in order of page number) and how they should be formatted for display
(for example, in indented style, or in run-in style). Cindex also needs to know
what restrictions (if any) you want to place on the contents of entries (for example, it can require that locators conform to some specification, or that entries
may not have sub-subheadings).
When you create a new index, Cindex endows it with standard settings. These
settings are initially taken from a special set built into Cindex. You can change
both the standard settings and the settings for individual indexes:
To review or change the way in which entries are sorted, see Chapter 9 “Sorting
Entries” on page 149.
To review or change the way in which entries are formatted, see Chapter 10 “Formatting the Index” on page 169.
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To review or change the properties of index records, see Chapter 12 “Managing
Index Documents” on page 213.
Using Templates

Cindex can create a new index from a template—an existing index that serves as
a model for the new one. The new index inherits all its settings from the template. “Using Templates” on page 219 explains how to set up and use templates.

Setting an Index Aside
To close an index at any time click the close box in its main window, or choose
Close from the File menu. Cindex automatically saves changes to the index, and
remembers the size and position of its window. To close all open indexes, choose
Close All from the Window menu. To close all open indexes and quit Cindex,
choose Exit from the File menu.
Backing-up Your Work

When you finish a session of work on an index always make a copy of it (preferably on some other disk). You can copy an index using Windows Explorer, or you
can use Cindex to save a copy of any index you have open for work.
To save an exact copy of the active index, choose Save Backup Copy… from the File
menu.
You can make a plain text document that contains all the information about the
content of entries (though not information about the document format, or
about how the index entries are alphabetized) by choosing Save As… from the
File menu, then selecting XML Records format. For more information see “XML
Records” on page 204.

Saving Changes

As you add or modify index entries, Cindex automatically saves them. To allow
you to work quickly, however, Cindex does not do this immediately for every
small change you make. Cindex is initially set to save changes automatically every
ten minutes; you can change that interval, or you can disable automatic saving.
See “Automatically Saving Changes” on page 13.
NOTE: When an index contains unsaved changes Cindex indicates this by displaying
an asterisk (*) beside its name in the title bar.

CHAPTER 2 Starting an Index
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Opening an Existing Index
To open an existing index, choose Open… from the File menu or click
. Cindex displays a list showing the names of indexes it can open. Click the index
name to select it in the displayed list, then click Open. To open an index from
Windows Explorer (and start Cindex if necessary), double click its icon.
You can open an index as a read-only document that cannot be modified. To do
this check Read Only; this item is dimmed if the selected document cannot be
opened as a read-only document.
To open a recently-used index choose it by name from the File menu. To set how
many names will appear in the menu, choose Preferences… from the Edit menu.
Cindex will display the dialog box shown in Figure 1 on page 12. Choose from
Maximum Number of Recent Indexes.
You can configure Cindex so that when you start it up it will automatically open
the last index you worked on. See “Opening an Index on Startup” on page 11.
Checking Index
Integrity

Cindex checks the integrity of each index it opens. If Cindex finds errors or damage it will ask if should attempt repairs. It is generally advisable to allow this. If
records have been damaged Cindex will report the number of repairs made and
will “mark” the repaired records so that you can later find and examine them. For
more information on marked records see “Marked Records” on page 86

Preserving and
Discarding Changes

For each open index Cindex keeps a private copy that it updates each time it
saves the index automatically, or you save the index with Save. If you make
changes to an index and then wish to discard them, you can restore the index to
its last-saved state by choosing Revert to Saved from the File menu.
To save a exact copy of the active index at any time, choose Save Backup Copy…
from the File menu.
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Working with Several Indexes
Cindex allows you to work on several indexes concurrently (for example, subject
and author indexes to the same volume), while keeping each index completely
separate from the others. Choose New… or Open… from the File menu to create
or open each index you want to work on.
If you have more than one index open, Cindex operates only on the index whose
window is active; to make an inactive index active, click its window, or choose it
by name from the Window menu.

SETTING PREFERENCES
You can customize Cindex to suit your preferences. Some settings govern how
Cindex deals with all index documents; others pertain to individual indexes.

Setting General Preferences
Opening an Index on
Startup

You can set Cindex so that when you start it by double-clicking its icon (rather
than by opening one of its documents with the Windows Explorer), it will automatically open the last index you worked on or will display a panel through
which you can open a document. To specify how Cindex should behave when it
starts, choose Preferences… from the Cindex menu (Figure 1) and click Open Last
Index or Show Open Panel.

CHAPTER 2 Starting an Index
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FIGURE 1.

Identifying the Indexer

Setting General Preferences

Cindex can include in a record information to identify the person who made or
modified the record. To include such information in records, choose Preferences… from the Edit menu (Figure 1 on page 12) and enter up to four identifying characters at User ID. Cindex will attach the identifier to each record you
make or modify (this information is not part of the record text).
If you want to use a different identifier in different sessions with Cindex, check
Prompt for User ID. Each time you start Cindex it will display a dialog box
(Figure 2) through which you can enter your identifying initials.
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FIGURE 2.

Setting the User Identifier

Automatically Saving
Changes

Set Save Open Indexes Every… to the interval at which you want Cindex to save
changes. If you set the interval to 0, Cindex will not save changes automatically.
Regardless of your setting, Cindex always saves changes when you close an index
or end your session. To save changes to the document at any time choose Save
from the File menu or click
.

Default Folder

You can specify a folder in which Cindex will initially browse when you choose
Save… or Open… from the File menu. To specify this default folder choose Preferences… from the Edit menu (Figure 1) then click Default Folder. Cindex will
open a file dialog box through which you can find or create the folder you want
to use.

Default Window Sizes

You can set Cindex so that it automatically uses the full screen when you start it
(otherwise it sets its main window to the size last used). You can also set Cindex
to display indexes in the largest possible window (otherwise it sets the index window to the size last-used). To make these settings, choose Preferences… from the
Edit menu (Figure 1).
• Check Maximize Cindex to make Cindex use the full screen.
• Check Maximize on Opening to make Cindex display indexes in the largest possible
window.

Checking for Updates

Check Automatically check for updates to let Cindex check automatically and notify
you when an update is available from Indexing Research. If you turn off the automatic check you can at any time check for an update by choosing Check for
Updates… from the Help menu.
CHAPTER 2 Starting an Index
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Default Font and Size

When you start a new index Cindex establishes a default font and size in which
all entries are displayed, except for parts explicitly marked for display in some
other font. The default font is initially set to Arial, 12 point, though you can
change it at any time. For more information See “Fonts and Styles” on page 33.

Editing Records

Cindex provides several features for simplifying the editing of records, and
checking for mistakes you might make while entering them. These settings,
made through the Preferences dialog box, are described in “Working Efficiently
with Records” on page 36.

Setting Preferences for Individual Indexes
Three broad classes of settings govern the way Cindex works with individual
indexes.
Views

Cindex provides several settings that allow you to specify what parts of an index
it should display, and how it should display them. You make these settings
through the View menu. Chapter 4 “Viewing, Finding and Printing Entries” on
page 55 provides information on views.

Style and Layout

Cindex can display formatted index entries in several styles (for example,
indented or run-in) laid out on pages in different ways. Chapter 10 “Formatting
the Index” on page 169 describes the formatting options.

Sorting

Cindex can sort entries in whichever way you prefer (for example, alphabetically,
or by order of page reference). Chapter 9 “Sorting Entries” on page 149 explains
how to set up the sort order you prefer.

Toolbars
Cindex provides toolbars with buttons that execute some of the most often-used
commands. The main toolbar is displayed just under the menu bar. A second
toolbar appears when you add or edit entries (Figure 5 on page 21). You can customize both toolbars.
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To rearrange or remove or restore buttons, double-click anywhere on the toolbar
except on a button. Cindex will display the following dialog box.

FIGURE 3.

Customize Toolbar

• To move a button already in the toolbar, drag it to a new position in the right-hand
panel.
• To remove a button from the toolbar, drag it from the right- to the left-hand panel.
• To restore a button you have removed, drag it from the left- to the right-hand panel.
• To restore the toolbar to its state when Cindex was first installed, click Reset.

Cindex remembers your settings until you change them.
Cindex offers shortcuts for rearranging and removing buttons without your having to open the dialog box:
• To move a button to a new position, hold down the ALT key and drag the button to
its new position, then release it.
• To remove a button from a toolbar, hold down the ALT key while you drag the button off the bar, then release it.

CHAPTER 2 Starting an Index
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Adding and Editing Entries

This chapter describes how to make and edit index entries. As you work on your
index, you might need more information than is provided here. The following
chapters provide full discussions of topics mentioned here:
• For information on cross-references, see Chapter 7 “Cross-References” on page 109.
• For information on page references, see Chapter 8 “Page References” on page 127.
• For information on sorting entries, see Chapter 9 “Sorting Entries” on page 149.

INDEX RECORDS
The Need for Records
Consider the following fragment from an index to a book on neurology:
Homonymous hemianopsias, 215
pituitary tumors and, 222, 225-227f

This contains two entries (there are references to two distinct topics) and were
you preparing entries on index cards you would make them initially on two separate cards. One card would contain the entry
Homonymous hemianopsias, 215
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and the other would contain the entry
Homonymous hemianopsias
pituitary tumors and, 222, 225-227f

If you did not use two cards, but prepared both entries on a single card, as in the
first illustration, any entry you made later, such as
Homonymous hemianopsias
optic tract damage causing, 312

could not easily be fitted between the other two. So that Cindex can re-arrange
headings as you add and remove entries, each distinct entry (a heading with one
or more subheadings and a locator such as a page reference, or cross-reference)
must occupy its own record.
Record Structure

You can think of a record as a computerized index card on which you type the
entry, just as you would type an entry on an ordinary card. Cindex assigns a number to each record you make. This number serves merely to identify the record—
it is not part of the content of the record—and reflects the order of the record's
addition to the index. You can (but need not) use record numbers in locating
and managing index entries. Records generally retain their numbers permanently.
The entry you make in a record must have a heading and will usually (though
need not) have a locator. The entry may have a subheading and sub-subheadings.
Each distinct element of an entry (heading, subheading, etc.) occupies a separate
field of a record. Each field has a name that indicates the kind of element it contains.
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Main Heading
Subheading
Sub-subheading
Locator
FIGURE 4.

The record window, showing a record with four fields

Figure 4 shows a record with four fields (three heading fields and a locator field),
each labeled to identify its contents. Cindex provides default names for the fields
of records. You can provide your own names if you prefer. For more information
on this see “Specifying Field Names, Sizes and Contents” on page 216.
By keeping elements of entries segregated in fields, Cindex can arrange and
manipulate entries in exactly the way you want. For example, Cindex can sort
page references in a wide variety of formats, and can alter or remove page references selectively. It can also combine, conflate and abbreviate references to identical headings. To accomplish these things Cindex has to know what part of the
record contains the page reference. To ensure that Cindex can always identify
references, these are placed in a separate locator field (often called the Page
field).
Every record must have a field for a main heading and a field for a locator. The
locator field (called the Page field in the window shown in Figure 4) is always the
last field in a record. Between the main heading and the locator there can be
other fields for a subheading, sub-subheading, sub-sub-subheading, etc. When
Cindex is installed it is set up to accept records with up to four levels of heading
(i.e., records that might contain sub-sub-subheadings) plus a locator. If you want
your index to accommodate more levels of heading, you can increase the number, up to fifteen. See “Specifying the Structure of Records” on page 213.
Cindex normally allows records to contain a variable number of fields. Every
record contains at least two (for the main heading and the locator), but Cindex
CHAPTER 3 Adding and Editing Entries
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normally adds fields for subheadings only when you need them. Some kinds of
indexes require every entry to be organized with a fixed number of headings. If
you are preparing an index of this sort you can set Cindex so that records in the
index will always have a fixed number of fields. See “Specifying the Structure of
Records” on page 213.
Some publishers require that headings conform to certain specifications—for
example, they must not contain more than a specified number of characters, or
may not contain particular characters. You can, if you wish, place constraints on
the characters Cindex will accept in particular fields of records. See “Specifying
Field Names, Sizes and Contents” on page 216.
An index record can hold only a certain number of characters. When Cindex is
installed, this number is set to 100, which is adequate for many indexing purposes. You can increase this number whenever you need to. See “Specifying the
Structure of Records” on page 213.

MAKING NEW ENTRIES
This section illustrates the steps in making a record, using as an example an entry
that when formatted would appear as:
Homonymous hemianopsias
parietal lobe lesions and, 222, 225-227f

To begin a new entry, choose New Record from the Edit menu, or click
in the
toolbar. Cindex will open at the foot of the main index window a record entry
window in which you type the text of the entry. You can set the window to any
convenient height by dragging the dashed bar at its top margin
NOTE: If you prefer to work with a record window that is completely separate from the
main index window, you can configure Cindex to provide this. Choose Preferences…
from the Edit menu, then click the Editing tab. Cindex will display the window shown in
Figure 9 on page 27. Check Use Separate Window.
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Main heading field
Toolbar

Locator field
Status line

Characters used Characters free Date modified User ID Delete status
FIGURE 5.

Label status

Ins/Ovr

Elements of the record entry window

The record entry window is divided into three parts: at the top, a row of buttons,
in the middle, an area where you type the entry; at the bottom, a status line. The
status line shows, at left, the number of characters already in the record, followed
by the number of characters you can add to it. After you have added the record to
the index the status line will also show the date and time at which the record was
last modified. Sometimes Cindex displays additional status information.
Follow these steps to make the record:
1.

Type the heading Homonymous hemianopsias beside the ‘Main’ prompt.
Cindex provides all the standard Windows editing capabilities for you to select and
correct text as you type it. You can clear, cut, copy, or paste text by choosing the
appropriate item from the Edit menu or using a toolbar button. You can undo or
redo changes to the text. Use the BACKSPACE key to delete characters backward; use
the DEL key to delete characters forward. Cindex provides additional shortcuts for
working with words or fields as units of text. Table 1 on page 22 summarizes these.
As you enter characters in the record (or remove them), the display in the status line
changes to show how much space you have used and how much is available in the
record (Figure 5 on page 21). If you use all the space Cindex will warn you with a
beep, and will not allow you to enter further characters. The section “Changing
Record Size” on page 214 describes what to do if you find that a record cannot hold
the text that you want to enter.
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Key(s)

CONTROL
CONTROL

CONTROL
CONTROL
END
HOME
TAB
SHIFT TAB
CONTROL BACKSPACE
CONTROL DELETE
CONTROL SHIFT

Action
Move insertion point to next line [plus SHIFT to select]
Move insertion point to previous line [plus SHIFT to select]
Move insertion point to last line
Move insertion point to first line
Move insertion point back one character [plus SHIFT to select]
Move insertion point forward one character [plus SHIFT to select]
Move insertion point back one word [plus SHIFT to select]
Move insertion point forward one word [plus SHIFT to select]
Move insertion point to end of field (or next field if at end) [plus SHIFT to select]
Move insertion point to start of field (or previous field if at start) [plus SHIFT to select]
Move insertion point to start of next field
Move insertion point to start of previous field
Delete text to start of word
Delete text to end of word
Delete text to start of field

BACKSPACE

Delete text to end of field

CONTROL SHIFT
DELETE
CONTROL +
CONTROL CONTROL ]
CONTROL [
CONTROL SHIFT S
CONTROL N
CONTROL 0
CONTROL RETURN
ENTER (keypad)
PAGE DOWN
SHIFT PAGE DOWN

Exchange heading at insertion point and the one below it (Full flip) [wit h SHIFT reverses
the Smart Flip preference setting]
Replace heading at insertion point with the one below it (Half flip)
Increase by 1 the last page reference in the locator field
Decrease by 1 the last page reference in the locator field
Exchange the leading text in a field with parenthesized text that follows
(N is a number key). Inserts text of heading level N from the last-edited record
Insert text of locator field from the last-edited record
Enter new/changed record in index, close window
Enter new/changed record in index, close window
Enter new/changed record, move to next
Enter new/changed record, leave a copy as a new record

TABLE 1.
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Key(s)
PAGE UP
ESC
CONTROL SHIFT O

Mouse

Action
Enter new/changed record, move to previous
Discard changes to record, close window
Restore record to its initial state
To select a word, double-click it. To select a whole field, triple-click it. To extend the current selection in a unit of the size last selected, SHIFT-click.

TABLE 1.

Shortcuts for managing text in the record entry window
2.

To complete the heading and create a field for a subheading, hit the RETURN key.
Beside the ‘Sub1’ prompt type the subheading pituitary tumors and. Do
not type leading spaces to indent it. This is unnecessary because Cindex produces the
indentations automatically when it displays or prints the formatted entry. If you leave
leading or trailing spaces in any part of a record, Cindex will remove them when it
saves the record.
Each time you hit RETURN Cindex opens a field for a new level of heading. You can
break any field (except the very last field) into two new fields by hitting RETURN; you
can combine two fields by placing the entry point at the beginning of the second and
hitting BACKSPACE. If you leave any fields empty, Cindex will remove unnecessary
ones when it saves the record in the index.

3.

When you have completed the subheading, click to the right of the ‘Page’ prompt (or
hit TAB) to move the text entry point to the locator field. Insert as many references as
you want (up to the limit of the available space in the record), separating each from
the next by a comma. You need not insert spaces between adjacent references and can
save space by not doing so; Cindex will generate the spaces between the references
automatically when it displays the formatted index. When you have finished with the
record, it should resemble the one shown in Figure 6.

A record with a heading, subheading, and page
references
FIGURE 6.
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A similar entry with a cross-reference might look like this:

A record with a heading, subheading, and a crossreference
FIGURE 7.

Characters
Accented Letters and
Symbols

Cindex uses Unicode to represent characters. A record may contain any character you can type on the keyboard (including characters you form when you hit a
key while holding down the CONTROL key, using shortcuts for Microsoft Word;
Cindex Help provides a table of shortcuts for accented characters). You can also
choose characters from the Character Map. Choose Character Map… from the
Character menu. Cindex will display the window shown in Figure 8. To view the
characters available in a symbol font or other special font, choose the font from
the Font drop-down list in the map.
To insert a character from the Character Map into a record, click the character in
the map to enlarge it, then drag it to the place in the record where you want to
insert it. Alternatively (or if you want to insert a series of characters), click them
in turn in the Character Map, then copy the set from the map to the record.
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FIGURE 8.

Reserved Characters

Character Map

The characters < > { } ~ and \ have special significance in the sorting of entries.
“Overriding Sorting Rules for Individual Entries” on page 162 explains their
functions. To include one of these characters as a literal character in a record,
place \ immediately before it. Thus, to use \ as a literal character you would type
\\ in a record; to use ~ as a literal character you would type \~. When Cindex
displays the index entry it shows only a single \ or ~.
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Formatting and Punctuating Entries
Headings and subheadings will sometimes be too long to fit on a single line in
the record window, or too wide fit on a line in the main index window. You
should not try to organize headings into lines of the proper length, nor should
you worry about indenting runover lines or providing punctuation at the end of
field (for example a comma that would appear before page references. Cindex
automatically breaks long lines, indents runover lines and inserts appropriate
punctuation when it displays or prints the formatted index, following a document layout specified for the index. Cindex will not be able to format an entry
properly if you provide leading or trailing punctuation in record fields. For information on how to specify the document layout see “Formatting the Index” on
page 169.
There is generally no limit to the length of text in a single field (providing it is
less than the total record size) and if you type beyond the edge of the record window Cindex will wrap the heading around to the next line (you can set the size of
the window to display the text in the way you prefer). How Cindex breaks lines
of text in the record window has no bearing on the appearance of the entry in the
formatted index. Use the RETURN key only to indicate the end of a heading or
subheading; do not use it to break a long line of text at the edge of the window.

Saving a New Entry
When you have completed your entry, hit CONTROL RETURN (or ENTER on the
keypad). Cindex will close the window and display the new record in the main
document window, formatted in the manner dictated by current settings. If your
record is empty Cindex will discard it automatically.
NOTE: To close the window and discard the entry hit ESC.

If you are using a free-standing window for record entry, you can also save the
entry by clicking the close box, or by choosing Close from the File menu. If you
use either of these methods, Cindex normally asks if you want to save (or discard) the record. You can set Cindex so that it will not query you, but instead
always discards changes to the record, or always saves changes to the record. To
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specify how Cindex should behave when you close the record window, choose
Preferences… from the Edit menu, then click the Editing tab. Cindex will display
the window shown in Figure 9. Choose the behavior you want by clicking the
appropriate item in the box labeled On Closing Window.

FIGURE 9.

Preferences for adding and editing records

• If you click Always Save, Cindex will always save a record, no matter how you close the
window (it always discards changes if you hit ESC).
• If you click Ask, (the default setting) Cindex will prompt you to decide what it
should do if you close the window by clicking the close box or choose Close from the
File menu.
• If you click Always Discard, Cindex will always discard changes if you close the window
by clicking the close box or choose Close from the File menu (it always saves changes if
you hit CONTROL RETURN, or ENTER on the keypad).
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Cindex remembers your setting.
Displaying New Entries

As you add each record to the index, Cindex displays it in the main window. If
that is set to display index entries in draft view, Cindex will display a bullet
beside the lowest level of heading in the new entry to indicate that the record has
been changed during your current session with Cindex.
While you are adding new records, Cindex normally displays them in recordnumber order so that you can see the most recently-added records in their order
of entry. If you prefer, Cindex will display each new record in its sorted position
in the index.
To make Cindex display new entries in their sorted positions, choose Preferences… from the Edit menu, then click the Editing tab. Cindex will display the
window shown in Figure 9 on page 27. Check Track New Entries.

Checking Entries

As you store each record Cindex checks for certain typographical errors. It automatically removes leading or trailing spaces in any field, and removes excess
blank fields. If you have used parentheses, square brackets or quotation marks to
enclose any part of a heading or any part of a page reference, Cindex checks for
matching pairs. If it finds a mismatch, it will warn you with a beep and will highlight the field that contains the mismatched elements. If you really do want to
leave the mismatched characters in a field, Cindex will accept the record when
you make a second attempt to store it.
If you have enclosed text in < > or { } —special characters that Cindex uses to
control the sorting of entries—Cindex checks that these occur in matched pairs
in a field. If Cindex detects a mismatch, it will beep and highlight the field that
contains the mismatched elements. If you make a another attempt to enter the
record without having first corrected the error, Cindex will display an explicit
warning message.
Cindex allows you to impose your own restrictions on the contents of individual
fields of records—for example, you can stipulate that the locator field must contain only numerals. For information on how to do this see “Specifying Field
Names, Sizes and Contents” on page 216. If you have imposed some restriction
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on the contents of a field, Cindex will warn you with a beep (and will highlight
the offending field) if you try to save a record that contains forbidden characters
or character sequences.
Stamping Records with
Date and User Identifier

When you add a new record to the index, or modify an existing record, Cindex
stamps it with the date and time at which the record was added or changed, and
the user identifier (if any) you provided. This information is held separately from
the record text. When you view a record in the record window Cindex displays
the date and time of modification and the user identifier in the status line at the
foot of the window. You can find records by their date of modification or by the
user identifier. “Controlling the Scope of the Search” on page 72 explains how to
do this.

Making a Series of Entries
To make several new records in succession, can save each new one by hitting
PAGE DOWN (or clicking
) rather than CONTROL RETURN. Cindex will save
the record and clear the record window for a new one.
To save a new record and leave a copy of it as the foundation of another one, hit
SHIFT PAGE DOWN or click
.

Moving Through Entries
When the record entry window is open you can use the PAGE DOWN and PAGE
UP keys, or the
and
buttons, to move forward or backward through the
records displayed in the main index window, bringing each in turn into the
record window. You can change the text of any record in the window; the
changed record will be saved automatically when you move to another one.
When you move beyond the last record in the index, Cindex will leave the
record window empty for a new entry.
To edit any entry visible in the main document window, double click it, or click
to select it and hit RETURN or choose Edit Record from the Edit menu. Cindex
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will place the record in the record entry window for you to make changes. When
you are finished, hit CONTROL RETURN to save changes and close the window, or
or
(or hit PAGE UP or PAGE DOWN) to save the record and move to
click
the previous or next one, or click SHIFT PAGE DOWN to save the record and leave
a copy as the foundation of a new one. To discard changes and close the window
hit ESC.

Page References and Cross-References
Cindex has powerful capabilities for searching among and modifying locators,
for sorting multiple locators that follow a single entry, and for formatting them
in different ways. (“Page References” on page 127, and “Cross-References” on
page 109, describe what Cindex can do with page references and cross-references.) Cindex can employ its capabilities only if knows where to find locators,
and how to recognize multiple locators when an entry contains them. The following paragraphs introduce some basic principles you should follow when making and editing entries.
To ensure that Cindex knows where to find locators (both page references and
cross-references), always put them in the locator field of the record. The locator
field is always the last field in a record.
To ensure that Cindex can display cross-references and page references in their
correct positions in the formatted index (these positions can vary with the index
style you choose), do not mix cross-references and page references in the same
record. If an entry has both page references and cross-references, you should make
two records that contain identical headings, one with page references in the locator field, the other with cross-references in the locator field. Cindex provides
simple ways to duplicate a record so that you need not type it twice.
To ensure that Cindex can recognize multiple locators when you place more
than one in the locator field, you should use a standard character to separate one
reference from the next. This character should not be one that would ever appear
within a locator. When parsing locator fields Cindex assumes that page references are separated from each other by a comma, and that cross-references are
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separated from each other by a semicolon. If you want to use other characters as
separators, you must designate them explicitly. “Specifying the Structure of Page
References” on page 128 explains how to do this for page references; “Specifying
the Structure of Cross-References” on page 110 explains how to do this for crossreferences.
Page References

To find or adjust page references, Cindex needs to know what character denotes
an inclusive range (e.g., 55-57). Cindex normally recognizes a reference to an
inclusive range of page references by the appearance of a hyphen between the
numbers, but you can use another character if you wish. “Specifying the Structure of Page References” on page 128 explains how to change that character.
When Cindex displays entries in the fully formatted view it can translate this
separating character to some other character or sequence of characters. For example, Cindex can display as ‘55 to 57’ a reference that exists in a record as ‘55-57’.
“Formatting Page References” on page 140 explains how to arrange this.
When you need to specify a range of page numbers (e.g., 237-239), always enter
the range in full, even if your publisher wants it abbreviated (e.g., 237-9). Cindex
can abbreviate references automatically when it formats entries; if you abbreviate
references when you place them in records, Cindex might not always be able to
find locators when you search for them.
Cindex will work fluently with compound locators that consist of multiple components, including dates, roman numerals and letters. If you use compound locators do ensure that the character you use to separate distinct references (the
default character is a comma) does not appear within a reference.
When you put several page references in one locator field, you need not place
them in ascending order. Cindex will sort them when it displays the formatted
entries.

Cross-References

Cindex recognizes a cross-reference by identifying its introductory phrase as one
of the following: See, See also, See under, or See also under. If your index uses
cross-references that begin with some other kind of introductory word or phrase,
you must designate that explicitly. Chapter 7 “Cross-References” on page 109
explains how.
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When you type a cross-reference, you need not apply a style to the introductory
phrase. When Cindex displays formatted entries it can apply different designated styles automatically to the introductory phrase and to the body of a crossreference.
When you put several cross-references in one locator field, you need not place
them in alphabetical order. Cindex will sort them when it displays the formatted
entries.

Comments, Web Addresses and Other Special Text
You may want to attach to your index entries comments that should not appear
in the finished index, or special text such as web addresses (URLs) that augment
normal locators in the last fields of records. This is most easily achieved by
reserving a record field for the purpose.
When you want records to contain special text that is not part of the normal
entry you can assign a special attribute to the last subheading fields (those that
immediately precede the locator fields), and can place the special text in these
fields. When you assign the special attribute Cindex ensures that the last text
field is always attached to the locator field, and cannot be joined to any other, or
split into multiple fields. Subheadings you add to the record are always inserted
above the special field.
Text in the special field can be hidden when you view the formatted index, and
can be ignored in sorting entries.
To configure your index records to have a special last text field preceding the
locator field see “Special Last Text Field” on page 215.
To suppress the display of this field in the formatted index see “Typography and
Punctuation of Headings” on page 184.
To ignore the contents of this field when sorting entries see “Field Evaluation
Order” on page 149.
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Fonts and Styles
Fonts

Except for parts of entries explicitly marked for display in a particular font, all
entries are displayed in a standard font. When the main window for an index is
active, you can change the standard font and type size by choosing from the
appropriate drop down list in the main toolbar
NOTE: When you start a new index Cindex establishes a standard font and size in
which all entries are displayed. By default, Cindex also uses this font and size when it
displays records for editing in the record window. The standard font is initially set to
Arial, 12 point.
To change default fonts and sizes, choose Preferences… from the Cindex menu and click
the View tab (Figure 10). Under Default Font use the menu to set the font that Cindex
will assign initially when it creates a new index. At Main View set the size of text to be
used initially for displaying entries in the main index window; at Entry View set the type
size to be used when you work in the record window (you cannot change the type size
locally within a record). If you set this to 0, Cindex will always set the text in the record
window at the size used for display in the main window.
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FIGURE 10.

View Preferences

When you are working in the record window, you can set any part of an entry in
a font of your choosing. Select the text you want to change, then choose from the
font drop-down list in the main toolbar.
To restore to the standard font any segment of text set in some other font, select
the text, then choose Default Font from the Character menu, or click
in the
record window toolbar, or right-click and choose from the contextual menu.
Styles
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The default style for an index is plain text. You cannot apply another style to a
complete index, but you can apply a style automatically to particular elements of
entries. For example, Cindex can display all main headings in boldface capitals,
regardless of how you entered the headings in records. Similarly, Cindex can display and print the introductory See or See also phrases of cross-references in a
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specified style (e.g., italics) and the body of a cross-reference in some other style,
such as small caps. For more information about applying styles automatically to
headings, see “Typography and Punctuation of Headings” on page 184; for
information about applying styles to page references see “Formatting Page References” on page 140; for information about applying styles to cross-references, see
“Placing and Formatting Cross-References” on page 119.
To apply a style to text in the record window, select the text, then choose the
style from the Character menu or the contextual menu displayed when you right
click in the record window. The most often-used styles, boldface, italics and
underline are available through the
,
and
buttons on the record window toolbar. You can apply multiple styles to the selection. If you choose a style
when no text is selected, that style will be applied to the next characters you type.
NOTES: If you apply the SMALL CAPS style, Cindex will display the text in the record
window as small letters, but will not change the case.In the main index window lowercase letters will appear as small uppercase letters.

To remove all styles from a selection choose Plain from the Format menu or the
contextual menu. To remove a single style from a selection that contains several
styles, choose that style from the menu.
Case Conversion

To convert the case of selected text, choose the appropriate conversion option
(Uppercase, Lowercase, Initial Caps) from the Character menu.

EDITING EXISTING ENTRIES
From the main view of the index you can edit any record by double-clicking it or
by selecting it then hitting RETURN or choosing Edit Record from the Edit menu.
Cindex will display the record in the record window. You can modify it using the
techniques described in the preceding section. To discard any changes you have
or hit CONTROL
made, and restore the record to its original state, click
SHIFT O ; to discard changes and close the window, hit ESC. When you have completed your changes, hit CONTROL RETURN to save the record and close the win-
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dow, or click or
(or hit PAGE UP or PAGE DOWN) to save and move to the
previous or next record.
To leave behind a copy of the edited record as the foundation of a new record, hit
SHIFT PAGE DOWN or click
.
Restoring the View

When you finish editing a series of records, Cindex normally leaves the main
view window showing the last-edited record. If you prefer, You can make Cindex
restore the display to its state before you started editing. To do that, choose Preferences… from the Edit menu, click the Editing tab and check Return to Entry Point.

WORKING EFFICIENTLY WITH RECORDS
Cindex provides several features that help minimize errors and keystrokes when
you make and edit entries. This section provides information about a range of
techniques for working with individual records. “Advanced Editing” on page 83
introduces some methods for making changes to many records concurrently.
Cindex provides powerful features to help you find the records you want to edit.
For information on how to use these, see “Finding Entries” on page 67.

Contextual Menus
Some of the most often-used menu items are available in a pop-up menu that
Cindex will display when you click the right mouse button in the main index
window or in the record-entry window. The set of items in the menu depends on
the window in which you click.

Auto-Completion of Entries
As you begin typing the text of a new entry, Cindex can automatically complete
each record field if what you have typed matches text in the corresponding field
of an existing record. To enable auto-completion of entries, choose Preferences…
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from in the Edit menu (Figure 9 on page 27), and click the Editing tab. In the box
Adding check Auto-Complete Entries.
When you enable auto-completion, and you begin typing the text of a heading in
a new record, Cindex will look for any existing record whose heading begins
with the text you have typed. If Cindex finds a match, it will append and highlight the text to complete the heading you are typing
NOTE: Auto-completion works only when the index is sorted alphabetically. It does
not work if your index is sorted by page number. If your index is sorted using letter-byletter or word-by-word alphabetizing, Cindex will not attempt to complete an entry
until you have typed enough of it to specify where the entry would appear in the index.
For example, if you begin an entry with a quotation mark (which is ignored in letter-byletter and word-by-word alphabetizing), Cindex will wait until you have typed further
characters before looking for a matching entry. For this reason you may find it most convenient to use Simple alphabetizing while adding entries to the index. For more information on sorting entries see Chapter 9 “Sorting Entries” on page 149.

If the appended text is what you would have typed, you can accept it and open a
new field by hitting RETURN, or you can accept it and move to the next field by
hitting TAB. If you want to append text hit . If the supplied text is not what
you want, continue typing. As you type, Cindex will automatically search for a
record that has a matching heading, and will continually supply you with the
first heading (if any) that matches exactly what you have typed. As soon as you
type a character that would make the current record no longer match an existing
one, Cindex will remove any highlighted text it has automatically appended.
Cindex can automatically complete subheadings at any level, as long as the main
heading and any preceding levels of subheadings match an existing record in the
index.
When you have checked Auto-Complete Entries, Cindex makes two other options
available (Figure 9 on page 27). To make Cindex complete entries that match
existing ones, regardless of letter case and type style, check Ignore Style & Case.
NOTE: If you have checked Ignore Style & Case, and Cindex completes an entry from
a source that does not match in style and case, it automatically adjusts the style and case
of the text you have typed.
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If you wish, Cindex will display in the main view (behind the record-entry window) the entry it is using as the source of text to complete the heading you are
typing. To enable this display, check Track Source.
NOTE: If you have checked Track Source, Cindex will display the source entry only if it
would normally be visible in the current view of the index.

Manipulating Fields in Records
Cutting, Copying and
Pasting Text

When you cut or copy text that spans more then one field, Cindex preserves the
field divisions in the text; when you paste text into a record, the field boundaries
are also pasted. If pasting text would cause a record to contain more than the
maximum number of fields allowed in the index, Cindex will not paste the text,
and will warn you with a beep. If cutting text from a record would cause it to
have fewer than the minimum number of fields required by an index, Cindex
will replace the cut text with empty fields.
NOTE: When you paste text Cindex normally also includes style and font information
if it is available. To discard style and font information hold down the SHIFT key as you
paste.

Removing Superfluous
Spaces

When two or more successive spaces are entered in a record, these are automatically reduced to a single space. To change this behavior, choose Preferences…
from the Edit menu, and click the Editing tab (Figure 9 on page 27). In the box
labeled General uncheck Remove Extra Spaces.

Dragging and Dropping
Text

When the record window is active, you can drag text between fields, or between
the record window and the record window of another index. You can also drag
text between a record window and another application program, such as a wordprocessor. To drag text, select it, release the mouse button briefly, then press the
mouse button and begin the drag. If dragging text into a record would cause the
record to contain more than the maximum number of fields allowed in the
index, or more characters than the record can hold, Cindex will not complete
the drag, and will warn you with a beep.
When you drag text between index records Cindex always copies the text. When
you drag text within a record, Cindex moves the text unless you hold down the
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CONTROL key while completing the drag, in which case the text is copied. When

you drag text out of a record, Cindex always copies the text; it does not remove
text from the record.
NOTES: Cindex normally also drags and drops style and font information if it is available. To discard style and font information hold down the SHIFT key as you drop the
text. Cindex always sets the text at the size specified for the record window.
Retrieving a Field from
the Last-Edited Record

While working on any record, you can retrieve headings individually from the
last record you edited. To retrieve the text of a main heading from the last-edited
record and place it at the insertion point, hit CONTROL 1; for other heading levels hit CONTROL N, where N is the level of heading to be retrieved (2 for subheading, 3 for sub-subheading, etc.). To retrieve text from the locator field of the
last-edited record hit CONTROL 0.

Managing Page
Numbers

Cindex provides several ways to simplify the entry of page numbers.
• When you add a series of new records, the entries in successive records will often
refer to the same page of text. You can set Cindex so that as it creates each new record
it fills the locator field with the contents of the one you last made. To do this, choose
Preferences… from the Edit menu (Figure 9 on page 27) and click the Editing tab.
Check Carry Locators Forward.
When Carry Locators Forward is checked, each new record you create starts with its
locator field holding the same references as the record you last added. When you
alter the references in the locator field in a new record, the altered ones become the
ones Cindex will load into subsequent new records.
• You can configure Cindex to generate the second part of a page range automatically
when you type the character that connects the two parts of the range. For example, if
a dash is the connecting character, and you enter 55- Cindex will complete the reference as 55-56. Cindex does this only if the last recognized component of the last
page reference in the locator field is a number in Arabic numerals. To enable autocompletion of page ranges, choose Preferences… from the Edit menu (Figure 9 on
page 27) and click the Editing tab. Check Complete Page Ranges.
• With a single keystroke you can increment or decrement the last page number in the
locator field (the text cursor can be anywhere in the record). To increment the page
number, hit CONTROL ]. To decrement the page number hit CONTROL [. This opera-
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tion affects only the last component of the last page reference in the locator field. If
the last recognized component is not a number in Arabic numerals (e.g., it consists of
Roman numerals or is an alphabetic suffix), the operation does nothing.
Managing Acronyms

When a record field contains a phrase followed by text in parentheses (for example, an acronym followed by its expansion, or vice-versa) you can exchange the
toolcontents of the leading text with the text in parentheses by clicking the
bar button or hitting CONTROL SHIFT S.

Inserting Fields

To insert a subheading in a record that has only a main heading and a locator,
place the insertion point at the end of the main heading and hit RETURN. Cindex
will make a new field between the main heading and the locator. Use the same
method to insert a sub-subheading. To demote a heading to a subheading, so
that you can insert a new main heading above it, place the insertion point at the
beginning of the main heading, and hit RETURN.
If you inadvertently add too many blank fields, do not worry about removing
them. Cindex automatically removes excess blank fields and any fields that contain only spaces when you save the record. Cindex also removes leading and trailing spaces in any field.

Breaking Fields

To convert a heading with a modifying phrase into a heading with a subheading,
place the insertion point to the right of the comma before the modifying phrase,
hit BACKSPACE to delete the comma, then hit RETURN. Cindex will move the
modifying phrase into a new subheading field. You can break any field (except
the locator field) by placing the insertion point where you want the break then
hitting RETURN.
NOTE: In the course of preparing an index you might create many records with modified headings that would be better arranged as headings with subheadings. To relieve
you of the tedious task of finding and editing such entries individually, Cindex will do
the job for you automatically. For information on how organize this, see “Reconciling
Heading Levels” on page 95.

Joining Fields
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While you are making records, you will often produce them with subheadings
(or even sub-subheadings) in the expectation of adding further entries for the
same heading. If you do not in fact add other records, you will end up with iso-
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lated records that contain a single entry organized as heading and subheading, as
in:
analgesia, 6.16
anesthesia
general, 6.37
anuria, 5.19

In such cases, you will normally want the isolated subheading to be brought up as
a modifier to the main heading.
To change a subheading to a modifier, place the insertion point the beginning of
the subheading then hit BACKSPACE. Now type a comma, or another character
you want to separate the heading from the modifier. You can use the same
method to bring up a sub-subheading as a modifier to a subheading.
NOTE: You do not need to edit such records individually. Cindex will automatically
convert redundant subheadings to modified headings. For more information on this,
see “Reconciling Heading Levels” on page 95.
Flipping (Exchanging)
Fields

To exchange (flip) the contents of any two fields, place the insertion point anywhere in the upper field and click
, or hit CONTROL +. To discard the contents of the upper field and pull up the contents of the lower field (half flip)
or hit CONTROL –.
click
Cindex is initially set to make flips and half-flips that are ‘smart’. In a smart flip:
• A flipped heading inherits the case of the initial letter of the heading it replaces.
• If the subheading field that becomes the main heading begins with words from a set
you specify, these words are moved to the end of the main heading that will become
the subheading. If the lower field is the locator field and contains a see reference, the
cross-reference prefix is removed as the field is promoted; if the locator field contains
a see also reference, the prefix is transferred to what will become the new locator.
• (Full flip only) If the subheading field that becomes the main heading ends with
words from the specified list, these words are moved to the beginning of the main
heading that will become the subheading.
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To disable smart flipping choose Preferences… from the Edit menu, click the Editing tab (Figure 9 on page 27), then uncheck Smart Flip.
When you make a full flip (CONTROL +) or a half flip (CONTROL –) you can
override the current mode (smart or not) by holding down the SHIFT key while
you give the command.
To edit the set of prefix and suffix words that can be moved during a smart flip,
choose Flip Words… from the Document menu. Place a ~ immediately before
any word (such as and or versus) that should maintain its prefix or suffix position
as it is moved from one field to the other.
NOTE: If you set Flip Words when no index is open for work, your settings become the
defaults applied to new indexes.

Propagating Changes to Subordinate Records
When you work in the record window and change the contents of an index
heading, you will normally want all succeeding records that shared that heading
to be changed in the same way. When Cindex is installed it is set to ensure that
when you change the text of one or more headings, and save a record, the
changes are automatically propagated to all succeeding records that shared the
original heading(s).
You can disable propagation generally, and reinstate it on a record-by-record
basis, or you can enable propagation generally, and disable it on a record-byrecord basis (this is how Cindex is initially set). To set the general behavior,
choose Preferences… from the Edit menu, click the Editing tab (Figure 9 on
page 27) then check (or uncheck) Propagate Changes.
If propagation is enabled generally,
is initially depressed when Cindex opens
the record window for editing. You can disable it and enable it as required for
each record. If propagation is disabled globally,
is initially raised when Cindex opens the record window for adding or editing.
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NOTE: Automatic propagation of editing changes can save an enormous amount of
work, but to use it to best effect you need to watch that you edit the right record. For
example, to change a main heading, you should edit the first record in a series. Cindex
does not propagate changes backward, so any records above the one you change will be
untouched.

Checking Locators
You can set Cindex to check locators and warn you about (or forbid) the entry of
a record that has an empty locator field or a malformed range of page numbers
(e.g., 95-93). Choose Preferences… from the Edit menu, click the Editing tab
(Figure 9 on page 27) then click the appropriate button under Bad Locator.
• If you click Accept, Cindex will accept an empty locator field or a malformed locator.
• If you click Warn, Cindex will beep on your first attempt to enter a record with an
empty locator field or malformed reference, but will accept a subsequent attempt.
• If you click Forbid, Cindex will never allow the entry of a record with an empty field
or malformed reference.

Cindex remembers your setting.
NOTE: Cindex can also check that no entry contains too main unqualified page references. See “Checking Page References” on page 132.
Identifying Acceptable
References

Cindex can check that each reference you enter falls within limits that you specify. You can specify a value that no reference may exceed, and you can specify the
greatest permitted span in a range of references. To specify limits choose Reference Syntax... from the Document menu. The relevant settings are under Page
References.
To specify the largest permissible value for a locator (typically the number of the
last page in the work being indexed), enter it at Maximum Value. This may be a
compound (multi-part) locator if your index uses these. Do not enter a range of
locators. To set no limit, leave Maximum Value blank.
To set the largest span acceptable in a range of references, enter the number of
pages at Greatest Range. For example, to permit a span of 10 pages or less, such as
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23-33, or 102-112, but not a span of eleven pages, you would enter 10. To place
no restriction on the allowable span, set 0.
NOTE: Cindex uses any limits you specify for Maximum Value or Greatest Range only
when reference checking is enabled (see “Checking Locators” on page 43).

For more information on the types of locators Cindex can work with, see Chapter 8 “Page References” on page 127.

Checking Cross-References
Cindex can check that cross-references you enter in records have targets elsewhere in the index.
Choose Preferences… from the Edit menu, click the Editing tab (Figure 9) then
click the appropriate button under Bad Cross-Ref.
• If you click Accept, Cindex will accept a cross-reference that has no target.
• If you click Warn, Cindex will beep on your first attempt to enter a record with an
cross-reference that has no target, but will accept a subsequent attempt.
• If you click Forbid, Cindex will never allow the entry of a record with cross-reference
that has no target.
NOTE: Cindex checks that a target heading begins with the text of each cross-reference
in the locator field of a record. It does not check that the cross-reference is a full match
to the target heading. For more rigorous verification of cross-references see “Verifying
Cross-References” on page 112.

USING HOT KEYS
You can designate a set of keys or key-combinations (hot keys) that you can use
to simplify editing. A hot key can have attached to it frequently-used words or
phrases that you can insert in a record simply by hitting the appropriate key. The
text you attach to a key can contain style attributes such as boldface and italics.
When Cindex is first installed two hot keys have text attached: the word ‘See’ is
attached to SHIFT F1, and the phrase ‘See also’ is attached to SHIFT F2.
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Setting-up Hot Keys

To review or change the text assigned to hot keys, choose Hot Keys from the Tools
menu. Cindex will display a dialog box through which you can change settings.
To define or change a key, click in a left panel under Key, and type the keystroke
combination you want to use, e.g., CONTROL F1. Do not type the words as you
see them in the panel; simply enter the keystrokes.
NOTE: Choose your keys or key combinations carefully, so as not to conflict with normal usage by Cindex or other programs. Once you have defined a hot key or key combination, that definition prevents Cindex (or any other active application program) using
the key for any other purpose while Cindex is active

To specify or change the text attached to a key, click in a right hand panel under
Attached Text, and type the text you want to use. You cannot apply attributes to
text you type, but you can drag or paste text that contains styles. The most convenient source of such text will probably be a selection in the record entry window.
NOTE: If you attach text that contains font attributes, Cindex remembers only the
Symbol font. All other hot-key text is rendered in the default font for the index.
Using Hot Keys

To insert text in a record, click where you want the text to appear (or select any
text you want to replace), then hit the appropriate key or key combination. If the
inserted text would cause the record to contain too many fields, or too many
characters, Cindex will warn you with a beep.

ABBREVIATIONS
Cindex lets you use abbreviations to represent long words or phrases; when you
type the abbreviations in records Cindex automatically expands them to the
phrases they represent. For example, you might define ards to represent Adult
respiratory distress syndrome.
Cindex can maintain multiple sets of abbreviations that you can use in different
kinds of indexes, but it can use only a single set at one time.
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Defining Abbreviations
Cindex initially has no abbreviations defined. You can define abbreviations and
their expanded phrases as you work on an index, or independently of it. You can
define abbreviations in two ways: by entering them through the Abbreviations
window, or by extracting a word or phrase from a record as you work on it in the
record-entry window.
Working through the
Record-Entry Window

While you are adding or editing a record, you can define an abbreviation for any
word or phrase that you have typed. Select the text for which you want to define
an abbreviation, then choose New Abbreviation from the Edit menu or right-click
and choose from the contextual menu. Cindex will display a small window in
which you can type the name of the abbreviation. Click OK to complete the definition.

Working in the
Abbreviation Window

To view or edit abbreviations, choose Edit… from the Abbreviations submenu in
the Tools menu. Cindex will open a window that shows all its abbreviations and
the phrases they represent.

Expanded phrase

Abbreviation

FIGURE 11.

The Abbreviation entry window

To add an abbreviation, choose New Abbreviation from the Edit menu. Cindex will
display and highlight the word NEW in the left column. Replace this by typing
the abbreviation you will enter in a record to recover the long phrase (‘ards’ in the
example above), then hit TAB, and type the full phrase you want the abbreviation
to represent (‘Adult Respiratory Distress Syndrome,’ above).
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The abbreviation may contain any sequence of up to eight characters except a
space and certain punctuation marks discussed on page 48. If the expanded
phrase or parts of it should appear in a particular style, select the text and choose
the style from the Character menu. (You cannot specify a font—abbreviations
are always expanded in the font in use at the insertion point in a record.)
Use the normal text-editing functions to edit any abbreviation or its expanded
phrase. If you create or change an abbreviation so that it matches another one,
Cindex will warn you when you close or deactivate the Abbreviations window.
You must change the duplicate; Cindex will not allow the same abbreviation to
represent two different phrases.
To remove an abbreviation, select it together with its expanded phrase (as a
shortcut you can triple-click it), then choose Clear from the Edit menu, or hit
DELETE.
The number of abbreviations you can have in a single set is limited only by the
available memory on your computer.
You can view abbreviations sorted alphabetically by abbreviation or by expanded
phrase. Click the appropriate column header (Abbreviation, or Expansion) to
sort by that key.
To save the current set of abbreviations when the Abbreviation window is active
choose Save or Save As… from the File menu.
NOTE: If you have changed but not saved abbreviations during a session, Cindex will
always ask you, before quitting, if you want to save the changes.

To print the current set of abbreviations and their expanded phrases, ensure that
the abbreviation window is active, then choose Print… from the File menu.

Saving and Loading Abbreviations
Cindex works with one active set of abbreviations (its name is displayed as the
title of the window in which you edit abbreviations), and when you define a new
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abbreviation Cindex always adds it to the active set. You can maintain multiple
sets of abbreviations for use on different occasions.
To start a completely new set of abbreviations, choose New… from the Abbreviations submenu in the Tools menu.
To deactivate the current set of abbreviations, leaving none active, choose Close
from the Abbreviations submenu in the Tools menu.
To open an existing set of abbreviations, choose Load… from the Abbreviations
submenu in the Tools menu.
Cindex keeps track of the set of abbreviations you last used, and automatically
uses it when you start a new session.

Using Abbreviations
To insert expanded form of an abbreviation anywhere in a record, simply type
the abbreviation. If there is enough room in the record Cindex will expand an
abbreviation that is preceded by a space or any of these characters:
(["“'‘

and succeeded by a space or any of these characters:
)],.;:"”'’

Cindex will not accept any of the above characters in an abbreviation, though
they may appear in the expanded phrase. If there is not enough room to accommodate the expanded phrase, Cindex will beep.
If you type the abbreviation at the end of a field, Cindex will expand it if you use
or TAB or RETURN to move to the next field.
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If you find that you must use an abbreviation literally, you can insert it in a
record with the following procedure: append some spurious character to it, followed by the character that would normally trigger its expansion, then move the
entry point back to the spurious character and delete it. Because Cindex checks
abbreviations only when you type one of the special terminating characters that
triggers expansion, it will not expand the abbreviation that results from deleting
the spurious character.
To prevent conflict between acronyms you want to use literally and acronyms
you want to use as abbreviations, begin your abbreviations with a character or
symbol that you are unlikely to use in the index. For example, if you want to use
CME both as an abbreviation for “Continuing Medical Education” and as an
acronym, you could name the abbreviation !CME, @CME or #CME.

DUPLICATING RECORDS
When you double-post entries you produce two very similar sets of entries, perhaps differing only in the organization of the main heading. For example you
might have a series of entries under the heading “Dogs and cats” that you want
also to appear under the heading “Cats and dogs.” Cindex makes it easy to produce one set of records based on another.
When the Record Entry
Window is Active

To make a new record based on the one currently open in the record window,
.
choose Duplicate from the Edit menu, or hit SHIFT PAGE DOWN, or click
Cindex will make a new record from the one currently displayed (after saving any
changes to the current record). The window's title shows you that it contains a
new record. You can modify this new record as required. At any time before you
save it you can click
(or hit CONTROL SHIFT O) to restore it to its original
form. Cindex will save the record when you click
,
or
, or use a corresponding shortcut. If you do not modify the new record—that is, the record
remains an exact duplicate of the one on which it was based—Cindex simply discards it.
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When the Main
Document Window is
Active

When the main document window is active, you can duplicate any records on
display. Select those you want to duplicate, then choose Duplicate from the Edit
menu. Cindex will duplicate the selected records and place the new one(s) properly in the index. For more information on finding and selecting records to
duplicate, see “Selecting Entries” on page 63 and “Finding Entries” on page 67.

Working with Duplicated
Records

Because you normally duplicate records as a prelude to modifying them, Cindex
displays the new record(s) so as to facilitate editing:
• If you duplicate a single record, Cindex immediately opens it for editing in recordentry window. Regardless of whether or not you subsequently modify it, the record
remains a part of the index.
• If you duplicate several records, Cindex forms a temporary “group” from them, and
displays just this group in the main document window. You can edit these records in
the normal way. “Groups of Records” on page 65 explains what groups are and how
to use them while preparing an index. To restore the display of all index records in the
main document window, choose All Records from the View menu or click

.

NOTE: You can also duplicate selected entries by choosing Copy from the Edit menu,
then Paste from the Edit menu. If you use this method, Cindex does not open the record
window (for a single record) or form a temporary group (for multiple records).

Copying Entries from One Index to Another
To copy entries from one index to another, select them in the main index window, then drag them into the main window of the destination index. (For more
information on selecting records, see“Selecting Entries” on page 63.) Alternatively, you can copy and paste the records: select the records you want, then
. Activate the main window of the
choose Copy from the Edit menu or click
index into which you want to paste the entries, then choose Paste from the Edit
.
menu, or click
NOTES: You cannot undo this drag or paste, but you can restore the index to its lastsaved form by choosing Revert to Saved from the File menu. See “Preserving and Discarding Changes” on page 10.
Cindex always inserts pasted records—it never replaces any records currently selected.
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You can copy and paste, but cannot drag and drop, records within the same index.
You cannot paste or drag records into an index when its record window is open.

If the records in the destination index cannot accommodate as many fields as are
in the records being dragged or pasted, Cindex will ask you if you want to
increase the permitted number of fields.
If the record size in the destination index is too small to accommodate the
records being dragged or pasted, Cindex will ask if you want to enlarge the
record size.

DELETING AND RESTORING RECORDS
To remove a record (or records) from the index, select them in the main document window then check Deleted in the Edit menu, or click
in the main toolbar. A deleted record is not physically removed from the index—it merely
becomes hidden when you view a fully formatted index. In a draft or unformatted view, a deleted record is shown with the symbol (in blue) in the left margin
beside it. Deleted records are never displayed in a formatted view.
To restore deleted records select them in the main document window and
in the toolbar.
uncheck Deleted in the Edit menu, or click
In the record window you can delete the current record by checking Deleted in
the Edit menu (or clicking
). You can restore a deleted record by unchecking
Deleted (or clicking
). The status line at the bottom of the record window displays “Deleted” if the current record is deleted.
To remove deleted records permanently choose Compress… from the Tools
menu. “Compressing Index Entries” on page 225 explains how to use Compress.
Deleted records cannot be restored after you have compressed the index.
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LABELING RECORDS
Cindex lets you label records that it will display in conspicuous colors. A label
serves as a marker you can use for any purpose you choose (for example to identify records that contain incomplete entries). The label has no other function
than to provide a tag that you can use to identify a class of records and make it
conspicuous. Cindex can use a label as a search criterion in find and replace operations. A record may carry one of seven different labels.
To label a record or records, select them in the main document window then
choose the label you want from the Labeled submenu in the Edit menu, or rightin the toolbar and
click and choose from the contextual menu, or click
choose from the drop-down menu.
A labeled record is displayed in a distinctive color. If you are working in a draft
view of the index the whole record is displayed in that color; if you are working
in a fully formatted view of the index, you can control whether the text is colored
(see “Labeling Options” on page 52). You can also control whether labeled
records are visible. See “Displaying Labeled Records” on page 57.
To change or remove the labels on records, select those you want to change:
• To remove all labels, choose No Label from the submenu or drop-down list.
• To remove only the label that matches the first record in the selection, choose that
label from the submenu or the

drop-down list.

NOTE: If the first record in the selection carries no label, choosing a label from the submenu will apply that label to all selected records.

To label or unlabel the record in the record-editing window, choose from the
Labeled submenu in the Edit menu, or from the contextual menu, or from the
toolbar drop-down list.
Labeling Options
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To change the colors Cindex uses to labeled records, choose Preferences… from
the Edit menu, click the View tab, then under Label Colors double-click the colored
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cell for the label you want to change. Cindex will display a panel through which
you can set the color.
Cindex normally applies the label color to records only when displaying index
entries in a draft view (for information about different views of the index, see
“Views” on page 55). To make Cindex use the label color in the fully formatted
view, choose Preferences… from the Edit menu, click the View tab, then under
Label Colors click Display in Formatted View.
In the formatted view the label color is applied only to the page references or
cross-references from a record (or the lowest-level subheading if there are no
page references or cross-references).
When you print index entries, whether or not labeled records appear distinctive
depends on the capabilities of your printer.
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Viewing, Finding and
Printing Entries
VIEWS
Cindex provides several ways for you to view the index as you work on it. These
range from a fully formatted view that lays out the index exactly as you would see
it printed in a book to an unformatted view that makes explicit the structure of
the records from which the index is formed. Cindex also allows you to display
and work with only parts of the index.
The title of a main document window is always the name of the index. The status
bar at the bottom of the window (Figure 12) displays:
• Which records are accessible in the view.
• How many records are accessible in the view.
• How many new records have been added in your current session.
• How entries are sorted.

Fully Formatted View
To display the fully formatted index, choose Full Format from the View menu, or
click
in the toolbar.
In this view (Figure 12) index entries are displayed in fully finished form, in
whatever index style (indented, run-in, etc.) you have specified. Cindex suppresses the display of duplicate headings, gathers together and sorts page references from the same heading, and gathers and sorts cross-references from the
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Views

same heading. For full information on setting the style and layout see “Formatting the Index” on page 169.
Indented

Run-in subheadings

Which records are accessible

Total in view
FIGURE 12.

Total new

Sorted type

Search text

Fragments of an index in different fully-formatted views

You can switch between indented and run-in views of the index by clicking
or
in the toolbar. In the fully formatted view Cindex will hide deleted
records and records that contain no text, and it will hide certain text in
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records—for example, phrases that you have inserted specially to control alphabetizing of entries.
You should always use a fully formatted view when printing the finished index or
saving it for typesetting, but because this view obscures the structure of individual records you will probably find that during development of the index it is less
useful than a draft formatted view (Figure 14).
Displaying Labeled
Records

In the fully formatted view Cindex normally displays labeled records, though
they will appear in their distinctive colors only if you have enabled that
(see“Labeling Options” on page 52).
NOTE: In the formatted view only page references or cross-references from a labeled
record will be colored. If a record has no page references or cross-references, the lowestlevel subheading is colored.

You can use labels to control which records Cindex will display. To hide records
that carry a particular label or labels (or no label at all) choose Hide by Attribute…
from the View menu. Cindex will show the box in Figure 13.

FIGURE 13.

Hiding Records by Attributes

For each class of record that you want to hide, check the corresponding box, then
check Enable Hiding. Records that are hidden are generally treated as though they
did not exist: for example, you cannot find them by searching through the index.
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Draft Formatted View
To display the draft formatted index, choose Draft Format from the View menu,
in the toolbar.
or click

Indented format

Record Attributes

FIGURE 14.

Fragment of an index in draft formatted view

In draft view Cindex displays all records, without hiding any content that it
might make invisible in the fully formatted view. In draft view Cindex shows the
entries in a standard indented format. Cindex permits you some control over the
layout of entries (for example, margins and columns, line spacing, and placement
of cross-references), but most of the more advanced style and layout options are
unavailable in draft view. “Formatting the Index” on page 169 describes the format settings, and which of them apply to the draft view.
Automatic Switching to
Draft View
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When Cindex opens the record window for you to add new records, it normally
changes the display to show entries in draft view if the main window was displaying entries in a fully-formatted view. This makes it easier to see how complete
entries are formed from records. If you prefer to add and edit entries with the
main window showing fully formatted entries, you can prevent Cindex changing
the display.
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To specify how Cindex should display entries in the main view while you are
adding or editing records, choose Preferences from the Edit menu. In the dialog
box that Cindex displays (Figure 9 on page 27) click the Editing tab, then check
or uncheck Switch to Draft View.
Customizing the Draft
View

You can customize the draft view in two ways:
1.

Showing Record Numbers. As you add each record to the index, Cindex assigns it a
unique number. You can use this number (although you never have to) in working
with records. To see record numbers (Figure 15) check Show Numbers in the View
menu. To hide record numbers, uncheck Show Numbers. The initial setting is to hide
numbers. Cindex remembers your setting and uses it until you change it again.

FIGURE 15.

2.

Draft view with record numbers displayed

Depth of Headings to Display. Cindex normally displays all fields in records. You
can set it to display only main headings, or only main headings and subheadings, etc.
(Figure 16). To display headings to a specified depth, choose a heading level from the
View Depth submenu in the View menu. The initial setting is to show all levels of
headings. Cindex remembers your setting and uses it until you change it again.
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Draft view showing only main headings and
subheadings
FIGURE 16.

Summary View
The summary view shows only the main headings of entries, together with crossreferences made both to and from these entries. Records that are the sources of
cross-references are displayed to the heading level from which the cross-references originate; records that are the targets of cross-references are displayed to
the depth of heading level referred to. To display the index in summary format
(Figure 17) choose Summary from the View menu.
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FIGURE 17.

Fragment of an index in summary view

When Cindex shows the text of a cross-reference made to a heading, it displays
the cross-reference in square brackets […] appended to the heading. Each crossreference is contained in a separate set of brackets. If the cross-reference was from
a subheading, the contents of the brackets show the heading and the subheading,
after a semicolon.
Customizing the
Summary View

When Cindex displays records in summary view, you can show or hide record
numbers, as outlined under “Customizing the Draft View” on page 59.

Unformatted View
In the unformatted view, all the fields of all records are displayed in full, with
fields laid out sequentially. To display the index as unformatted entries
(Figure 18) choose Unformatted from the View menu.
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FIGURE 18.

Customizing the
Unformatted View

Fragment of an index in unformatted view

When Cindex displays records in this view, you can show or hide record numbers, and can control the depth to which headings are displayed, as outlined in
“Customizing the Draft View” on page 59. You can also specify whether Cindex
should wrap long entries on to continuation lines, or clip them at the edge of the
window. By default Cindex wraps long entries; to display clipped entries,
uncheck Wrap Lines in the View menu. To wrap lines, check Wrap Lines.

Sorted and Unsorted Views
Cindex is set initially to display entries in alphabetical order, following rules
described in “Alphabetical Sorting” on page 153. You can quickly switch
between an alphabetical sort and a page order sort by clicking
or
in the
toolbar. “Sorting Entries” on page 149 describes how to change the sort rules to
suit your requirements.
Cindex can also display index entries in record number order. This can be useful
if you want to see the order in which you added records to the index. To display
records in record number order, uncheck Sorted in the View menu. To display
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entries in whatever order is dictated by the sort rules in effect, check Sorted in the
View menu.

SELECTING ENTRIES
Many Cindex operations are undertaken on entries that are selected (highlighted) in the main document window.
You can select any index entry by clicking it; you can extend the selection by
dragging (forward or backward) through the displayed entries, or by SHIFTclicking the entry at the other end of the range. You can also extend the selection
by using the keyboard shortcuts shown in Table 2 on page 67. To clear any selection, hit ESC.
Cindex provides a shortcut for selecting blocks of entries under a heading. To
select all the records under a particular main heading, move the mouse to the left
margin of the screen. The pointer will change from a left-arrow to a right-arrow
(Figure 19) signifying that Cindex can select blocks of records. Click beside the
main heading of the set of records you want to select. Cindex will select all the
records under that heading. To select all the records under a particular subheading, place the mouse to the left of the subheading, then click. You can use the
same method to select blocks of records under any lower level of heading.
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FIGURE 19.

Selection of a block of entries under a heading

To select the record displayed at the top of the window, hit SHIFT TAB.
To select all records, choose Select All from the Edit menu.

WORKING WITH SUBSETS OF RECORDS
When you open an index you have access to all its entries through the main document window. Often you will want to work with only a subset of entries, which
can be more conveniently done if these are isolated. Cindex provides several ways
to isolate entries for work.

New Records
To see only new records (that is, those added to the index since you began work
in the current session) choose New Records from the View menu. If you have
added no records in the current session, this item is dimmed.
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Cindex will display (in order of entry in the index) only the new records. When
you set the view to show new records, Cindex generally behaves as though these
were the only records in the index. Suppose, for example, that your index contained 900 records, 100 of which were new. When the view is set to show new
records, Cindex will behave as though the first 800 records do not exist, and
operations such as searching the index (discussed later in this chapter), examine
only new records. The status bar at the bottom of the main document window
will indicate that you are viewing New Records, and that there are 100 of them.
To restore the view of the complete index, choose All Records from the View
menu, or click
in the toolbar.
NOTE: When viewing new records, you cannot use the tools Expand (described in
“Expanding Index Entries” on page 224) Compress (described in “Compressing Index
Entries” on page 225) or Reconcile Headings (described in “Reconciling Heading Levels”
on page 95). These items in the Tools menu are dimmed.

Groups of Records
Cindex can form defined subsets (“groups”) of records in the index, treating each
group as though it contained the only records in the index.
Making a Group

You can make a group from any records in the main index window. To do this,
select the records you want to work with, then choose New Group from the File
menu (also available through the pop-up menu Cindex displays when you click
the right mouse button). Cindex will display just this set of records in the main
document window, giving it the title Temporary Group. The number of records
that a group can contain is limited only by the amount of memory in your computer. To restore the view of all records, choose All Records from the View menu.
To view the group choose Temporary Group from the View menu.
The temporary group survives only until you create another group, finish your
current session with Cindex, or explicitly make the group permanent (see
below).
NOTE: Although the group is temporary, the records in it are permanent. That is,
when Cindex discards a group it discards only the information about which records
belong to a group; it does not discard the records.
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Working with Groups

When Cindex displays a group, it generally behaves as though the records in that
group were the only ones in the index. For example, when Cindex searches for
text in entries, it searches only among records in the group.
There are a few restrictions on what you can do with groups:
• You cannot switch between sorted and unsorted views of a group: Cindex displays
records in the order in which they appeared when the group was formed. You can,
however, change the sorted order of a group by choosing Sort… from the Tools menu
to resort the group. This sort need not use the sort rules employed in the main index.
• When you modify records that belong to a group (for example, by editing a record),
Cindex will display the changes but will not rearrange the order of the records in the
group, which might no longer be correctly sorted. You can re-sort the group explicitly, if you wish. Records are always correctly sorted when you restore the view to
show All Records.
• If you add a record to the index while you are viewing a group, the record does not
become a member of the group, and Cindex therefore does not display it until you
change the view to show All Records.
• Some Cindex tools cannot be used on groups. You cannot use the tools Expand
(described in “Expanding Index Entries” on page 224) Compress (described in “Compressing Index Entries” on page 225) or Reconcile Headings (described in “Reconciling
Heading Levels” on page 95). These items in the Tools menu are dimmed when a
group is displayed in the main document window.

Making a Permanent
Group

You can preserve any temporary group permanently. To save the group, first
make sure it is on view (if necessary, choose Temporary Group from the View
menu), then choose Save Group… from the File menu. Cindex will display a dialog box through which you should provide the name you want to give the group.
When you click OK, Cindex will remember the group. Cindex automatically
saves information about groups that belong to the index.
Each group you save becomes an item in the Group submenu in the View menu (it
is no longer accessible through the Temporary Group item in the View menu). To
view a group at any time, simply select it by name from the menu. To restore the
view of all records, choose All Records.
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Managing Groups

Cindex provides several tools to help you manage groups. For information on
these see “Managing Groups” on page 227.

FINDING ENTRIES
Cindex provides several ways for you quickly to find records you want to work
on. You can display a particular entry instantly by typing the beginning text of its
heading, or by entering its record number. You can search the index to find
entries that contain specified text or references.

Navigation Shortcuts
When the main index window is active, you can use the keys and keystroke combinations shown in Table 2 as navigation shortcuts.
TABLE 2.

Navigation shortcuts in the main document window

Key(s)

Action
Moves selection (if any) down one record or entry.
Moves selection (if any) up one record or entry.

SHIFT

Extends selection (if any) down one record or entry.

SHIFT

Extends selection (if any) up one record or entry.

TAB

Brings selection (if any) into view.

SHIFT TAB

Selects record at top of window.

ESC

Removes highlighting from selected records.

PAGE DOWN

Moves display down one page (does not affect selection).

PAGE UP

Moves display up one page (does not affect selection).

HOME

Moves display to head of index (does not affect selection).

END

Moves display to foot of index (does not affect selection).

RETURN

Opens the selected record for editing.

Other characters

Treated as the leading text in a record (or a record number, if
digits). Cindex brings the matching record into view. Text you
type appears in the status bar at the foot of the index window.
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Finding by Beginning
Text in Headings

When the main index window is active, you can instantly bring into view and
highlight any record by typing the character (or characters) that begin its heading. Cindex tracks the characters you type, and as you define more precisely the
beginning text of the heading, it will narrow the range of displayed records. You
need type only as much of the heading as you need to identify it unambiguously.
Cindex displays the text you type in the right-most panel of the status bar at the
bottom of the window (Figure 12 on page 56). If you type text that matches no
heading, Cindex will beep.
To locate a subheading under a heading, type enough of the heading to locate it,
then type a semicolon, then the leading text of the subheading. For example, to
find the subheading ‘international’ under the heading ‘Trade’ you might type
tr;in

if that were enough to identify the heading and subheading unambiguously.
NOTE: If the heading of the record you want begins with a numeral, you should type
the character \ immediately before you start typing the beginning of the heading. If you
do not use \ Cindex will assume you are looking for a record by its number.

Cindex knows that successively typed characters are part of the same heading as
long as you type them at reasonable speed; if a long interval separates keystrokes,
Cindex assumes you are starting to specify a new heading. The interval Cindex
attends to is determined by standard Windows keyboard settings. To change the
interval, use the Control Panel, and under keyboard settings adjust the “Repeat
Delay.”
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If you need to enter a long sequence of characters to specify the target heading
and any subheadings, choose Go To… from the View menu. Cindex will display
the panel in Figure 20. This allows you to enter text at your leisure.
Main heading fragment
Subheading fragment
Sub-subheading fragment
FIGURE 20.

Go To a specified entry

Type as much leading text as you need from the heading and any subheadings,
separating levels of heading with a semicolon, click Record to tell Cindex that you
are searching for a record, then click OK.
Cindex remembers up to 16 of your previous Go To… search requests. To recall
and reuse a previous search specification, click the arrow beside the text box to
display and select the specification you want.
Finding by Record
Number

When the main document window is active, you can bring a record into view by
typing its number. Cindex will track the digits as you type them, and will highlight the record whose number matches what you type.
If you prefer, you can specify the record number by choosing Go To… from the
View menu (Figure 20). Type the record number, click Record to tell Cindex that
you are searching for a record, then click OK.

Finding by Printed Page Number
To bring into view the entries that will appear on a particular page of the printed
index, choose Go To… from the View menu. Cindex will display the panel shown
in Figure 20. Click Formatted Page to indicate that you want to see entries that
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fall on a particular page, then click OK. Cindex will display the entries that would
appear on that page.
To find records that contain references to specified pages in the work being
indexed, see “Searching for Locators” on page 75.

Finding Records that Contain Specified Text
Cindex can find records that contain particular words or phrases anywhere
within the record. To search for a word or phrase, choose Find… from the Edit
in the toolbar. Cindex will display the window shown in
menu, or click
Figure 21.

Enter
search text
here

FIGURE 21.

Find window

To make a simple search for a word or phrase, type the word or phrase where the
indicator is blinking. Click Find (or hit RETURN) to begin the search for the first
occurrence of the word or phrase.
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NOTE: Cindex generally dims the Find button unless you have specified some text to
search for.

When Cindex finds the first record that contains the target word or phrase, it
displays that record in the main document window. If you are working with a
draft view of the index, Cindex highlights the target word or phrase; if you are
working with a fully formatted view, Cindex highlights the whole entry that contains the target word or phrase.
To continue the search after Cindex has found a target, click Find Again, or choose
Find Again from the Edit menu. Cindex will find the next record that contains the
target text.
To work on the highlighted record, click the main document window to activate
it, then double-click the record to open it for editing.
To resume the search after interrupting it, click the Find window, then click Find
Again to continue.
To cancel a search, and restore Find settings to their default values, click Reset.
To close the Find window, hit ESC, or click the close button in the title bar.
You need not keep the Find window open after you have specified what you
want Cindex to search for. To find the next record that matches a search specification you have previously provided, choose Find Again from the Edit menu.
When Cindex finds a record it will highlight it (or the relevant part of it). To
open any highlighted record for editing, double-click it, or hit RETURN.
NOTE: Cindex maintains a list of the words and phrases used in previous searches. To
search for a word or phrase you have sought in the recent past, click the arrow button at
the right-hand edge of the box that contains the search text, then choose from the list
displayed.
Finding All Matching
Records

To find all records that contain the text you want click Find All. When you do this
Cindex examines all the records that could be displayed in the current view and
collects in a group all those that contain matching text. When it has completed
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the search, Cindex displays these records in the main window as a temporary
group.
To switch the view to show all records, choose All Records from the View menu,
button in the toolbar. To switch the view back to the records
or click the
found in the last search, choose Temporary Group from the View menu. You can
switch the view to this group at any time until you form another group, or save
the group as a permanent group. (“Making a Permanent Group” on page 66
explains how to make a group permanent.)
When you make a permanent group from the results of a search, Cindex saves
with the group information about the search criteria used to find the records that
belong to the group. As you add or modify records, some might become eligible
for inclusion in the group, or some already in the group might no longer meet
the criteria for inclusion. To cope with such situations, you can rebuild the group
by applying the original search criteria to the modified index. For information
on this see “Managing Groups” on page 227.
Searching for Styles and
Fonts

To search for text formatted in a particular style or font, click Attributes… Cindex will display a dialog box through which you can specify the attributes of the
text you are looking for. Click OK to set the style(s) or font. To indicate that it
will search for styled text, Cindex displays the appropriate letter (B for boldface,
etc.) to the right of the Attributes… button. If Cindex will search for a font, it displays § beside the button.
Cindex can search for style and font attributes applied to any text. To find any
text set in a particular style or font, click Attributes… to specify the style and font
you want, but do not specify any search text. Then click OK.

Controlling the Scope of
the Search

Normally Cindex searches among all records that are accessible in the current
view. Cindex can confine the search to certain parts of the index, or to records
modified at specified times or by a particular user.
• To search among all records click All Records in View.
• To confine the search to records you have selected, click Selected Records (this is
dimmed if no records are selected).
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• To confine the search to a range of records in the view, specify the starting and ending records in From and to. You can specify a range of headings by entering leading
text, e.g., Abr through Doc. You can also specify a range of record numbers (e.g., 55
through 79) within which Cindex should confine the search. To search among specified headings, you need only provide as much of the beginning text as will identify a
record uniquely. Your specification can include leading text from a subheading:
append a semicolon to the heading text then add subheading text (see the example
under “Navigation Shortcuts” on page 67). To specify a heading that begins with digits, place a \ before the first digit; Cindex will otherwise interpret leading digits as a
record number.
If you omit the first part of the range Cindex will search from the head of the index
until it finds a record that matches the end of the range. If you omit the second part
of the range, Cindex will search from the starting record until it reaches the foot of
the index.
NOTE: When Cindex searches among a range of records, it proceeds in whatever order
the records are displayed on the screen. Before beginning the search it checks that the
last-specified record appears after the first. If the last record appears before the first,
Cindex will display a warning message.

• To search among records last modified between specified dates and/or times, type
the starting and ending dates in the date boxes labeled From and to. Cindex interprets
dates in whatever form is standard in the country you are working in (e.g., month,
day, year or day, month, year) and can accept dates in a wide variety of forms (e.g.,
Jan 1 96, 1/1/96, 1 January 96, January 1 1996). If you omit the year Cindex assumes
the current year. If you omit the month, Cindex assumes the current month. If you
omit a starting date, Cindex assumes January 1, 1970; if you omit an ending date,
Cindex assumes a date far in the future.
• To search among records made or edited by a particular user, enter the user’s identifying initials in the User ID box.
NOTE: When you specify a range of records, or dates, or the User ID, and you do not
specify text that Cindex should find, Cindex will find any record that meets your search
criteria.
Using Record Attributes

You can confine the search to records that possess specified attributes or lack
specified attributes. In the Only Among box, click Records that are to confine the
search to records that carry all the attributes you will check; click Records that are
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not to confine the search to records that carry none of the attributes you will
check.
• To include or exclude new records (those created during your current session with
Cindex) check New Records.
• To include or exclude records you have changed in the current session with Cindex,
check Modified Records.
• To include or exclude deleted records (those that will not appear in the fully formatted index), check Deleted Records. For more information on deleted records see
“Deleting and Restoring Records” on page 51.
• To include or exclude marked records (those on which Cindex was unable to undertake some global editing operation you had specified, or which Cindex has repaired),
check Marked Records. For more information on marked records, see “Marked
Records” on page 86.
• To include or exclude records that Cindex has created automatically, check
Generated Records. For more information on generated records, see “Converting
Cross-References to Fully-Qualified Entries” on page 116 and “Generating CrossReferences Automatically” on page 117.
• To include or exclude labeled records, check Labeled Records. Use the drop-down list
to specify a particular label, or any label. For more information on labeled records,
see“Labeling Records” on page 52.
NOTES: When you are working with a fully formatted index, Cindex ignores deleted
records and records that you have designated as hidden (see “Displaying Labeled
Records” on page 57).
You need not specify target text (although you can) when deploying attributes (New,
Modified, etc.) in a search. If you do not specify target text, Cindex finds any record
that has all (or none) of the attributes you checked.
Searching within
Specified Headings

Cindex normally looks for the target text in all fields of a record. To confine the
search to a specified field or fields use the drop-down list at the bottom left of
the window.
• To search among all fields choose All Fields.
• To search among all text fields (excluding the locator field) choose All Text.
• To search only within the lowest-level text field, choose Last Text.
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• To search only within a specified text field (main heading, subheading, etc.) choose
the field by name from the lower part of the list. You need not specify target text
(although you can) when you confine the search to any single subheading field. If you
do not specify target text, Cindex finds records in which that field contains no text.
(You must always specify target text when you choose the main heading field, or
All Fields, or All Text).
Searching for Locators

To confine the search to the locator field choose Page from the drop-down list at
the bottom left of the window (this item—always the one immediately after Last
Text—will have a different name if you have assigned a name to your locator
field).
When you confine a search to the locator field, Cindex normally treats the text
to be matched as a locator specification, rather than plain text (the item Evaluate
References is automatically checked). For example, if your search text is 57-66,
Cindex will find any record that refers to a page within the range 57-66, rather
than looking for the character sequence “57-66.” Cindex makes intelligent decisions about references. For example, if you ask it to find records that refer to any
page in the range 22–35, it will also find a record in which the locator field contains a sequence such as 20–40. When you specify a range of pages, the second
should be greater than the first. Cindex will warn you if you enter a badly-formed
range.
Cindex can evaluate and search for complex locators (for example
1996: May 393) or ranges of them. “Evaluating and Sorting Page References” on
page 132 provides more information on how Cindex evaluates these.
To find records that contain no page references, or contain badly-formed ranges
of references, provide no page reference (leave the text field empty).
NOTE: Cindex understands that it should search for locators that fall within a range
when it sees two locators separated by a hyphen, for example: 57-66. You may use
another character as a connector that denotes an inclusive range, but only if you have
told Cindex what this character is. “Specifying the Structure of Page References” on
page 128 explains how to change the standard connecting character.
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To prevent Cindex evaluating locators (and make it treat your search characters
as plain text) when searching in the locator field, uncheck Evaluate References.
Additional Options

Cindex normally accepts a match to the target text regardless of whether or not
it forms a whole word or part of a word. To make Cindex accept matches to
whole words only, check Whole Word. For this purpose a whole word is a continuous sequence of letters and digits. If your search text contains punctuation or
spaces, the check box is dimmed.
Cindex normally ignores the case of letters when finding a match to the target
text. To require matches of the same case, check Case.
In addition to searching for words or phrases, Cindex can look for more complicated sequences of characters that match a pattern, such as “any three digit number,” or “any occurrence of the word ‘and’ at the beginning of a line.” See
“Patterns” on page 233 for a description of patterns and how to use them. To
make Cindex treat the search target as a pattern rather than literal text, check
Pattern. When Cindex searches for text that matches a pattern it dims the search
options to evaluate locators, to find whole words, and to make case-insensitive
matches.
Cindex normally begins a search at the head of the index and progresses forward.
To search backwards from the end, click Up; to search forward, click Down.

Conditional Searches
Cindex lets you look for combinations of words or phrases, e.g., the occurrence
of the word “university” and the word “finance” in the same record; it can also
find an occurrence of a particular word or phrase without some other word or
phrase, e.g., a reference to “Warsaw Pact” and no reference to “Soviet Union.”
The first step in finding such records is to form a simple statement of the conditions, e.g., Find university and finance, or Find Warsaw Pact and not Soviet
Union, or Find cars or automobiles. When you do this it becomes clear that to
make a conditional search you need to be able to represent the entities and, or
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and not. Cindex provides these entities (known as conditional or Boolean operators) for you to use in specifying conditions that a record must meet before it can
be displayed.
To find records that do not contain the text or the specified text attributes, check
Not (positioned immediately before the box where you specify the search text).
For example, to find records that did not contain the word ‘See’, you would set
up the search as shown in Figure 22.

FIGURE 22.

Finding records that lack specified text

To find records that contain the specified text and/or some other text, select and
or or from the drop-down list to the far right of the text. Cindex will extend the
window so that you can specify a second word or phrase to search for (and other
attributes to be associated with it, such as a style or a whole word, etc.) By choosing and or or you can extend the window repeatedly for up to four search
sequences. For example, to find any record that contained Smith or Smythe or
Schmitt, you would provide three search phrases, connecting the first to the second with or and the second to the third with or, as shown in Figure 23.

FIGURE 23.

Finding records that contain one of several sequences
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To find any record that contained theater and not New York, you would enter
the search phrases as shown in Figure 24.

FIGURE 24.

Finding records that contain two different sequences

For each component of a conditional search you can specify the field (if any) to
which Cindex should confine the search, whether or not Cindex should seek a
whole word, whether or not the search is to be case-sensitive, and whether or not
the search sequence specifies a pattern.
Grouping elements of a
Search

A search expression that contains several components might be interpreted in a
number of ways. For example, a search for
NATO and not Warsaw Pact or China or Japan

could mean “find a record that refers to Nato and not to the Warsaw pact, or a
record that refers to China or a record that refers to Japan,” or it could mean
“find a record that refers to Nato and does not refer to the Warsaw Pact or to
China or to Japan.”
Cindex interprets the expression in the first way, as a result of following these
simple rules: not applies only to the component immediately following, because
it takes precedence over the other operators. Cindex then groups the components connected by and because and has a higher precedence than or. If we could
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use parentheses to indicate how Cindex groups the components for evaluation,
we would write the previous search sequence as
(NATO and (not Warsaw Pact)) or China or Japan

Bear these issues in mind if you need to construct a complex search sequence.
For example, to look for records that contained NATO and bombs or missiles,
where you intended
NATO and (bombs or missiles)

you would specify a search for
NATO and bombs or NATO and missiles
Evaluation Order

Cindex evaluates search components from first to last, and stops evaluation as
soon as a test is conclusive. Thus, were you searching for
Smith or Smythe or Schmitt

and a record contained ‘Smith’, Cindex would not look for ‘Smythe’ or ‘Schmitt’.
Were you searching for
theater and not new york

and a record did not contain ‘theater,’ Cindex would not look for ‘new york’.
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PRINTING ENTRIES
Before you print the index you should ensure that you have selected a printer,
and that you have specified the page setup you prefer.

Page Setup
To specify how Cindex should print documents, choose Page Setup from the File
menu. Cindex will display a dialog box through which you can set the paper size,
page orientation, and margins (You can also set margins, with additional flexibility, by choosing Margins & Columns… from the Document menu). The available
page setup options are explained in the documents provided with your printer or
with Windows.

Printing
Cindex prints entries as you see them on the screen. If you are viewing a fully formatted index, the printed pages contain fully formatted entries; if you are viewing a draft format, the entries are printed in draft format. The index style and the
layout of entries on the screen or page are determined by settings you make
through choices from the Document menu. These are described fully in Chapter
10 “Formatting the Index” on page 169. When Cindex is installed it takes standard settings that will be suitable for many purposes.
To print entries, choose Print from the File menu. Cindex will display the standard Print dialog box. Except for the options noted below, all the settings you
can make are determined by the software the controls your printer, not by Cindex, and are explained in the documents provided with your printer or with
Windows.
Choosing which Entries
to Print

You can specify which entries should be printed from among those available in
the current view of the index. Choose from among the options available in the
Print range box.
• To print all the entries click All in View.
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• To print a range of pages click Page, and enter the starting page number at from. To
stop printing at a particular page, enter the page number at to. If you provide a starting page number but no ending number, Cindex will print all pages from the starting
page through the end of the index. If you provide an ending page number but no
starting one, Cindex will print all pages from the first through the ending number.
• To print selected entries, click Selection (this item is dimmed if no entries are
selected).
• To print a range of entries, click Records. Specify the starting entry at from and the
ending entry at to. You may specify the entries by the leading text from their headings
(for example, Gov through Man), or by their record numbers. If you need to print a
range of subentries under a single heading, you can specify these by entering enough
of the heading to specify it uniquely, then entering a semicolon, followed immediately by the beginning text of the subheading at which you want to start (or stop)
printing. If you specify a starting entry but no ending one, Cindex will print entries
from the starting one through the end of the index. If you specify an ending entry but
no starting one, Cindex will print entries from the beginning of the index through
the ending entry. To specify a heading that begins with a number, place a \ (backslash) immediately before the first digit, otherwise Cindex will interpret the number
as a record number. Because the \ has this special function, to specify any entry whose
heading begins with \ you must place a \ before it (i.e., the specification must begin
with \\).
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Advanced Editing

Cindex provides several powerful capabilities that gather and execute sequences
of commands (macros), search for and replace text in records, adjust page references automatically (for example when pagination is changed after an index has
been prepared), and consolidate or separate multiple references to the same
heading. Cindex can also reconcile headings so that the index contains no
unnecessary levels of heading.

MACROS
Macros provide a way to encapsulate a long or complex series of operations in a
single command. Cindex can create a macro by recording a sequence of keystrokes that complete some operation on an index. You can then invoke this
recorded sequence at any time by choosing the command to replay the macro.
A macro is most useful when you want to undertake the same sequence of steps
repeatedly, perhaps on several index records. For example, you might want to set
the subheading in italics in a series of records. This involves opening each record,
selecting the text in the subheading, choosing Italics from the Character menu,
then saving changes and moving to the next record. By defining a macro that
records the steps you undertake to make changes to the first record, you can
make changes to all subsequent records by choosing a single command.
You can record or replay a macro whenever a main index window or a recordentry window is active.
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Using Macros
To start recording keystroke events, choose Record Events from the Tools menu,
then from the submenu choose the macro (1 to 10) you want to record. Until
you stop recording, Cindex will remember every keystroke. While Cindex is
recording a macro, it displays “Recording” blinking in the status window.
To stop recording, hit CONTROL BREAK (the break key is next to the keyboard
status lights). Cindex remembers any recorded macro until you record a new one
with the same number. Cindex can remember up to 10 different macros at any
one time
To define a macro to set a series of subheadings in italics, you would do the following:
1.

Open the first record for editing.

2.

Start recording the macro.

3.

Hit

4.

Hit SHIFT END to select all text in the field.

5.

Hit CONTROL I or click

6.

Hit SHIFT PAGE DOWN or click

7.

Hit CONTROL BREAK to stop recording the macro.

to move to the subheading field.
or choose Italic from the Character menu.
to save changes and advance to the next record.

Having defined the macro, you can execute it on any open record.
To execute a recorded macro, choose Play Events from the Tools menu, then from
the submenu choose the macro you want to execute. Cindex will deliver the
series of keystrokes you had previously recorded. While Cindex is playing a
macro, it displays “Playing” blinking in the status window.
NOTE: Your use of macros is not confined to the record-entry window; you can record
and use a macro when a main index window is active.
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SEARCHING FOR AND REPLACING TEXT
To search for and replace text anywhere in the index, choose Replace… from the
. Cindex will display the window shown in Figure 25.
Edit menu, or click
Through this you specify the text to be sought and the text to replace it.
NOTE: Although you can use Replace to make global changes to page references, Cindex provides a more flexible tool specially designed for adjusting page references. See the
section “Adjusting References” on page 90.

To make a simple replacement of a word or phrase, type that word or phrase
where the indicator is blinking in the Find field, and the text to replace it in the
Change to field. Click Find (or hit RETURN) to begin the search.

FIGURE 25.

Replace window

Cindex looks for matching text that falls entirely within a single field of a record;
it will not find a phrase that straddles two or more fields of a record. When Cindex finds the first record that contains the target word or phrase, it displays the
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record in the main index window, and highlights the target (in draft view) or the
whole entry (in fully formatted view). Click Replace to replace it, or Find Again to
move to the next instance.
To resume the search after interrupting it, click the Replace window, then click
Resume to continue.
To stop a search, and restore Replace settings to their default values, click Reset.
NOTE: Cindex maintains a list of the words and phrases used in recent searches. To
search for a word or phrase you have sought in the recent past, click the arrow button at
the right-hand edge of the Find box, then choose from the list displayed.

To replace all instances of matching text click Replace All. When you choose to
replace all occurrences, Cindex continues its search from the current record and
replaces all further occurrences of the matching text. It does not replace text in
records you have already passed over.
NOTES: When using Replace All take care not to make unintended replacements. A
common error is the substitution of embedded words. For example, if you changed all
occurrences of “disc” to “disk,” you could produce words such as “diskussion” or “diskard.” You can avoid this hazard by checking Whole Word.
You cannot undo replacements, but you can restore the index to its last-saved form by
choosing Revert to Saved from the File menu. See “Preserving and Discarding Changes”
on page 10.

To remove specified text from records, leave the Change to field blank. If you
delete text that occupies a complete field in a record, Cindex will remove the
empty field from the record (providing the record will still contain at least the
required minimum number of fields).
To close the Replace window, hit ESC, or click the close button in the title bar.
Marked Records
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If the replacement of one word or phrase by another would cause a record to
exceed the space allowed for it, Cindex will not make the change. When this
happens, Cindex puts a special internal mark on the record, and after it has completed its scan of the index, displays a warning message. When you view records
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in draft view, Cindex displays # beside any record that has been marked. The
mark has no function other than to indicate that Cindex could not complete
some operation on the record. The mark is never displayed when you view or
print a fully formatted index. The record remains marked until you change it
with Edit Record, from the Edit menu. You can search the index with Find (Edit
menu) to find records that have been marked.
NOTE: A record will also be marked if Cindex ever has to repair it (see “Checking
Index Integrity” on page 10).

Finding and Replacing Styles and Fonts
To search for text formatted in a particular style or font, click Attributes… (next
to the Find text). Cindex will display a dialog box through which you can specify
the attributes of the text you are looking for. Click OK to set the style(s) or font.
To indicate that it will search for styled text, Cindex displays the appropriate letter (B for boldface, etc.) to the right of the Attributes… button. If Cindex will
search for a font, it displays § beside the button.
To change attributes or add attributes to text that previously lacked them, click
Attributes…, next to the Change to text. Cindex will display a dialog box through
which you can specify changes you want to make.
• To leave a style unchanged (either present or absent) click the appropriate button
under Ignore.
• To add a style click the appropriate button under Apply.
• To remove a style click the appropriate button under Remove. (Buttons in this column
are dimmed if you have not specified that you are searching for the style.)
• To leave the font unchanged, click Ignore in the Font box.
• To change the font click the button beside the drop-down font list. Choose
<Default> to restore the font to the default, or choose a font by name to apply a particular font.
Searching for and
Replacing Text
Attributes Only

To search for and replace styles or fonts regardless of the text they are attached to
do the following:
• Specify search attributes without specifying search text.
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• Specify replacement attributes without specifying replacement text.
NOTE: The Find button is dimmed if you specify neither a font change nor a style
change.

Controlling the Scope of the Search
Cindex normally searches for and replaces text among all records accessible in
the current view.
• To confine the search to records you have selected, click Selected Records.
• To confine the search to a range of records within the view, specify the starting and
ending records in From and To. You can enter the beginning text of the headings that
define the range (e.g., Abr and Doc) or a range of record numbers (e.g., 55 and 79).
To confine the range to some subheadings under a heading, enter in each box as
much text from the heading as you need to specify it uniquely, then type a semicolon
followed immediately by the leading text of the relevant subheading. If you are specifying a heading that begins with a numeral, place a \ (backslash) immediately before
the number. Otherwise, Cindex will interpret leading numerals as a record number.
Because the \ has this special function in a record specification, to find any record
that begins with this character you must place a \ before it; that is, \\ must appear at
the beginning of the specification. If you omit the first part of the range Cindex will
search from the head of the index until it finds a record that matches the end of the
range. If you omit the second part of the range, Cindex will search from the starting
record until it reaches the foot of the index.
• To search among records last modified on a particular date or between specified
dates, type the starting and ending dates in the boxes labeled From and To. Cindex
interprets dates in whatever form is standard in the country you are working in (e.g.,
month, day, year or day, month, year) and can accept dates in a wide variety of forms
(e.g, Jan 1 96, 1/1/96, 1 January 96, January 1 1996). If you omit the year Cindex
assumes the current year. If you omit the month, Cindex assumes the current month.
If you leave the starting date blank, Cindex assumes January 1, 1970; if you omit an
ending date, Cindex assumes a date far in the future.

Searching and Replacing among Records with Particular Attributes
You can confine the search to records that possess specified attributes or lack
specified attributes. In the Only Among box, click Records that are to confine the
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search to records that carry all the attributes you will check; click Records that are
not to confine the search to records that carry none of the attributes you will
check.
• To include or exclude new records (those created during your current session with
Cindex) check New Records.
• To include or exclude records you have changed in the current session with Cindex,
check Modified Records.
• To include or exclude deleted records (those that will not appear in the fully formatted index), check Deleted Records. For more information on deleted records see
“Deleting and Restoring Records” on page 51.
• To include or exclude marked records (those on which Cindex was unable to undertake some global editing operation you had specified, usually because there was too
little room in the record), check Marked Records. For more information on marked
records, see “Marked Records” on page 86.
• To include or exclude records that contain automatically-generated cross-references,
check Generated Records. For more information on generated records, see “Generating
Cross-References Automatically” on page 117.
• To include or exclude labeled records, check Labeled Records. Use the drop-down list
to specify a particular label, or any label. For more information on labeled records,
see “Labeling Records” on page 52.
NOTE: When you are working with a fully formatted view, Cindex ignores deleted
records and records that you have designated as hidden (see “Displaying Labeled
Records” on page 57).

Searching and Replacing in Particular Fields
Cindex normally looks for the target text in all fields of a record. To confine the
search to a specified field or fields choose from the Field drop-down list under the
Find field.
• To search among all fields choose All Fields.
• To search among all text fields (excluding the locator field) choose All Text.
• To search within the lowest-level text field, choose Last Text.
• To search only within a specified text field (main heading, subheading, etc.) choose
the field by name from the lower part of the list.
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• To confine the search to the locator field choose Page (this item—always the one
immediately after Last Text—will have a different name if you have assigned a name
to your locator field).

Additional Options
Cindex normally finds and replaces the specified text regardless of whether it
matches a whole word or part of a word. To make Cindex accept matches to
whole words only, check Whole Word.
When Cindex searches for text to replace, it normally requires a case-sensitive
match. To make Cindex ignore letter case, uncheck Case.
Cindex can search for and replace text that matches a pattern (sometimes known
as a regular expression). “Patterns” on page 233 describes the syntax of patterns,
and how to exploit them in making complex replacements. To make Cindex treat
the search target as a pattern rather than literal text, check Pattern.

ADJUSTING REFERENCES
Indexes often are prepared when final pagination is uncertain, requiring you to
change page references when the correct numbers become known. Page numbers
might also need revision if a previously indexed volume is split into parts, or several separate volumes are combined into a single one. Cindex provides special
tools for adjusting page references. These tools allow you to add offsets to page
numbers or subtract offsets from them. For example, you can add 2 to every reference to pages between 550 and 634.
To make adjustments to page numbers, choose Alter References… from the Tools
menu. Cindex will display the dialog box shown in Figure 26
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FIGURE 26.

Altering References

NOTE: Before using any of the procedures described in this section you should ensure
that Cindex knows what character you use to denote an inclusive range of references,
and what character you use to separate successive references when more than one
appears in a page field. “Specifying the Structure of Page References” on page 128
explains how to specify these.

Adding an Offset to All Page Numbers
To add an offset to all page references given in Arabic numerals, in all records
accessible in the current view:
1.

Under Scope click All References.

2.

Under Action click Adjust Only.

3.

Enter in Adjustment the number you want to add to (or subtract from) every page reference in the index.

4.

Click OK to adjust all page references.

Cindex ignores references in Roman numerals, cross-references, and any references that contain no Arabic numerals (e.g., Frontispiece, or February). Cindex
adjusts references in all records that are accessible in the current view, coping
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properly with ranges such as 78-82. If you are viewing all records, Cindex will act
on all records; if you are viewing a group of records, it will act only on records in
the group.
NOTES: You cannot undo adjustments to references, but you can restore the index to
its last-saved form by choosing Revert to Saved from the File menu. See “Preserving and
Discarding Changes” on page 10.
An adjustment to page references may require Cindex to add characters to a record. If
there is insufficient space for the alteration, no adjustment is made and Cindex marks
the record. If Cindex has marked any records it will display a warning message after it
has completed the adjustments. If a record is marked, a # appears beside it when it is displayed in draft view. You can find marked records with Find (Edit menu). Cindex
removes the mark when you edit the record.
Adjusting Parts of
Compound Locators

If your locators are compound references, (e.g., 23:14:2 or 34[2]:25–27), Cindex
will normally adjust only the first component. To make adjustments to other
parts of compound references, you can provide a pattern to specify leading parts
of references that Cindex should skip to find the single element it should adjust.
“Using Patterns when Altering References” on page 249 explains how to use patterns to specify which element of compound references Cindex should adjust.

Adding an Offset to a Range of Page Numbers
Sometimes you will need to adjust page references to a restricted set of pages. To
add an offset to references falling within a specified range:
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1.

Under Scope click Range, and enter the lowest and highest page numbers that should
be adjusted. Be sure to enter the numbers as they exist before adjustment. If you specify only an upper limit Cindex assumes the lower limit to be 1. If you specify only a
lower limit, Cindex assumes the upper limit to be all higher references.

2.

Under Action click Adjust Only.

3.

Specify in Adjustment the offset to be added to (or subtracted from) every reference
that falls within the range.

4.

Click OK to adjust references that fall within the required range.
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References needing adjustment may be intermixed in a record with others that
do not need adjustment; Cindex disregards references that fall outside the range
you have specified.

Removing References to Page Numbers
To remove references to a range of pages from an index (you might need to do
this when a chapter is removed from a book after you have prepared the index):
1.

Under Scope click Range, and enter the lowest and highest page numbers that should
be removed. You must specify at least one limit (high or low) of the range of references to be removed. If you specify only an upper limit Cindex assumes the lower
limit to be 1. If you specify only a lower limit, Cindex assumes the upper limit to be
all higher references.

2.

Under Action click Remove References. When Cindex removes page references, it normally adjusts all references to higher-numbered pages. You can inhibit this adjustment (if you want to leave room for new material), by checking Hold Higher Values.

3.

If you want to add an additional offset to (or subtract one from) the automatic
adjustment of references to higher numbered pages, specify it in Adjustment.

4.

Click OK to remove all the required references.

Cindex removes only references in Arabic numerals. It copes intelligently with
references that specify a range of page numbers (e.g., 45–60). If either the high
or the low limit falls within the range defined by such a reference, it is adjusted
appropriately.

Adjusting References after Movement of Chapters or Sections
All too often chapters or sections of a book are moved to different places after
the text has been indexed. As long as you know the old and new page numbers,
Cindex can correct all the entries automatically. By forming a group for the
records that are associated with each chapter or section that needs to be moved,
you can quickly and easily adjust the entries in the index.
Suppose that a book of 550 pages contains a chapter beginning on page 325 and
ending on page 337 (thirteen pages). After you have indexed the book, the pubCHAPTER 5 Advanced Editing
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lisher moves the chapter to start at page 430 and end at page 442. You have to
add 105 to all references to pages in the chapter being moved, and you have to
subtract 13 from all references to pages in the block that is displaced. In planning
the alterations it helps to visualize the layout in blocks of pages, like this:

Initial positions:

1–324

325–337

338–442

443–550

Final positions:

1–324

325-429

430–442

443–550

To make the adjustments, follow these steps:
1.

Ensure that each record contains only a single page reference (or that all references in
any one record refer to the same chapter or section). To ensure that each record contains only a single locator, choose Expand from the Tools menu (see “Expanding Index
Entries” on page 224). Cindex will create as many new records as it needs to accommodate a single reference in each one.

2.

Ensure that the view is set to show all records. If necessary choose All Records from the
View menu.

3.

Form a group of records that refer to the each block of pages to be changed:
Use Find (Edit menu) to find records that contain references to the pages in the
required range (for the first group this would be 325-337).

Enter the range of page numbers as the text to be found, being careful to separate the
range with a hyphen (see figure).
Choose the locator field from the Field drop-down list to confine the search to the
page references, and be sure to check Evaluate References (see figure).
Click Find All. Cindex will make a temporary group that contains all the records with
references in the specified range.
Choose Save Group from the Edit menu and save the group with an appropriate name.
4.
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Repeat steps 2 and 3 to form a group of records for each additional block of page
numbers the need adjustment (in this example, 338-342).
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5.

Add the appropriate offset to all references to the each block of pages:
Set the view to show the appropriate group (choose it by name from the Group submenu in the View menu).
Choose Alter References from the Tools menu.
Click Adjust Only and set Adjustment to the offset required for that group (in this
example the first group would require an adjustment of 105).
Click OK to make the adjustment.

6.

Repeat step 5 for each additional group that requires adjustment (in this example the
second group would require an adjustment of -13).

You can use this technique even when many segments of a book have been rearranged.

RECONCILING HEADING LEVELS
When forming entries you will often create records that have more levels of
headings than are necessary, and in which orphaned subheadings would be better organized as modifiers of the heading above (or perhaps removed). Conversely, you might create several records, each of which has a different modifier
following the same heading, but which would be better arranged as a series of
subheadings under a single main heading. Cindex can find orphaned subheadings, and can reconcile headings automatically by making conversions of either
kind.
To find orphaned subheadings, or to reconcile headings, choose Reconcile Headings… from the Tools menu. Cindex will display the dialog box shown in
Figure 27.
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FIGURE 27.

Reconciling Headings

Choose from the Check Headings Below drop-down list the level below which you
want Cindex to examine subheadings. For example, to seek orphans or redundant subheadings only at the sub-subheading level or below, choose the name of
the subheading field.
Finding Orphaned
Subheadings

To obtain a list of orphaned subheadings click Find Orphaned Subheadings then
click OK. If Cindex finds any records with orphaned subheadings it will display a
window that contains a list of them. On each line Cindex displays the number of
the record and information about the orphan. Click any item in the list (or use
the and keys) to bring its record into view in the main document window;
double-click a selected item (or hit RETURN) to open a window in which to edit
its record.

Adjusting Headings

To adjust records so that the index contains no redundant heading levels, or
orphaned subheadings, click Reconcile Headings.
When Cindex reconciles headings it first scans the whole index looking for
modified headings (i.e., those in which the heading is followed by some qualifying phrase that might otherwise be a subheading). Cindex normally assumes that
text appearing in the heading after a comma (and not part of some larger seg-
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ment of text in quotation marks or parentheses) is a modifier; you can specify
another character if you use a different one to introduce modifiers. Wherever
Cindex finds a modified heading, it breaks that provisionally into a heading and
subheading (it will also apply the same procedure to subheadings and sub-subheadings). You can inhibit this step if you wish.
Cindex than re-scans the index, converting any redundant subheading to a modifier of the heading at the level above. The result is an index in which no modified headings exist that should be heading and subheading, and in which no
levels of subheading are redundant.
Before you click OK, review the following options.
Options

If your headings contain some character other than a comma to introduce a
modifying phrase (for example, a semicolon), set the appropriate character at
Modifying Phrases Follow. You should enter only a single character.
If you want Cindex merely to convert redundant levels of subheading to modified headings (without previously examining and possibly breaking any modified
headings that currently exist) check Preserve Modified Headings.
If your index contains words or phrases that might follow a comma (or other
introductory character you have specified with Modifying Phrases Follow) and
which do not represent modified headings (for example, in a name index, where
a forename or initials might follow a surname), you should check Protect Names.
This prevents Cindex breaking any heading if the text that follows the introductory character begins with an uppercase letter. Protect Names is automatically
checked if you check Preserve Modified Headings.
When Cindex encounters an orphaned subheading (i.e., the only subheading at
a particular level) it can convert the subheading to a phrase modifying the heading above or it can remove the subheading altogether. Click Convert Orphans to
Modifying Phrases to convert the subheading to a modifier of the heading above;
click Remove Orphans to delete the orphaned subheading (leaving the rest of the
record intact).
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NOTES: You can reconcile headings only when you are viewing All Records and only
when you are viewing them in alphabetical order.
Cindex adds characters to a record when reconciling headings. On occasion Cindex
may be unable to reconcile headings in a record because the record cannot accommodate the additional characters, or would contain too many fields. If this happens Cindex
will mark the record and will display a warning message.
You cannot undo changes made during reconciliation, but you can restore the index to
its last-saved form by choosing Revert to Saved from the File menu. See “Preserving and
Discarding Changes” on page 10.
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CHAPTER 6

Checking Spelling

Cindex can check your index entries to find misspellings and typographical mistakes. The spell-checker is organized to cope with the special demands of checking index entries (for example, it ignores parenthetical endings to words, and it
will ignore page references if you wish).

CHECKING WORDS IN ENTRIES
To check the spellings of words in entries, choose Check Spelling from the Edit
menu. Cindex will display the panel shown in Figure 28.
Cindex is provided with one standard dictionary, for US English. Dictionaries
for other dialects and languages are available via internet download. For indexers
with specialized needs, a dictionary containing medical terms is available. You
can also create your own dictionaries for terms that are not in any standard dictionary.
Cindex checks spelling in whatever language is shown in the Language dropdown list in the lower left part of the panel. If this is not already set to the language you want, choose the appropriate one from the list. Cindex will remember
your choice for future sessions.
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FIGURE 28.

Spelling window

To begin checking the spelling of entries click Start. Cindex will examine entries
from the first accessible in the current view.
To restore the spelling checker to its initial state, check Reset.
To close the window, hit ESC, or click the close button.
If Cindex finds a word it does not know, a questionably punctuated word, or a
duplicated word, it will display the word in the Unknown box:
Misspelled Words
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If Cindex does not know the word, or the word is badly punctuated, Cindex will
try to suggest alternatives. If Cindex makes suggestions it puts the most probable
word (which will be at the top of the list) in the Change To box; if Cindex can find
no probable alternative spelling, it places a copy of the unknown word in the
Change To box. In either case Cindex highlights the word, and you can edit it as
required.
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NOTE: If you prefer Cindex to offer suggestions only when you ask for them, you can
disable the automatic suggestion. “Suggesting Alternative Spellings” on page 106
explains how to do this.

If the unknown word is misspelled, and Cindex has placed the correctly spelled
version in the Change To box, click Change to accept the suggestion and continue.
If the correctly spelled word is somewhere in the list of suggestions, click it to
place a copy in the Change To box, then click Change to change the misspelled
word.
If Cindex has not suggested the correct word, type the correct one directly into
the Change To box then click Change; Cindex will check the word you have typed.
To delete a misspelled word simply remove it from the Change To box.
NOTE: You can at any time place a copy of the original (unknown) word in the Change
To box: simply click the unknown word.
Unknown but Correctly
Spelled Words

If Cindex objects to a word that is correctly spelled, you can ignore the single
occurrence by clicking Ignore; you can ignore all future occurrences within the
current session by clicking Ignore All. If you want Cindex to remember a new
word permanently, click Add to add it to a personal dictionary.

Duplicate Words

If a word is duplicated, Cindex indicates this. To delete the word click Delete; to
ignore the duplicated word click Ignore.

Using Personal Dictionaries
You can maintain personal dictionaries for specialized terms. When Cindex
encounters a word that is not in its main language dictionary it looks for it in a
personal dictionary (if you have designated one). You can keep as many personal
dictionaries as you wish, but you can use only one at a time. You add words to
your active personal dictionary as you encounter them while checking spelling.
To add a word to a personal dictionary click Add. Cindex will add the word to
whichever dictionary is named in the Dictionary drop-down list. When Cindex is
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first installed it has no personal dictionaries, and the drop-down list will show
<None Selected>.
If no dictionary has been selected, Cindex will ask if you want to create a new
dictionary. Click OK to create a dictionary (Cindex will then ask you to provide a
name for the dictionary, before adding the word to it); otherwise click Cancel.
When you create a new personal dictionary, or choose one from the Dictionary
drop-down list, Cindex remembers your choice.
Managing Personal
Dictionaries

To examine or edit the words in a personal dictionary, click Options… Cindex
will display the dialog box shown in Figure 29.

FIGURE 29.

Spelling Options

Choose the dictionary you want from the list under Personal Dictionary, then click
Edit. Cindex will display a list of the words in the dictionary. You can add, change
or delete words freely, and you can paste text from other documents. Words may
be in any order, but each must be on a separate line, or be separated from the next
by some space.
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To create a new, empty, personal dictionary, click New. Cindex will display a box
in which you can type the name of the new dictionary.

Interrupting and Resuming Spell Checking
While Cindex is checking the spelling of entries, you can interrupt it (for example to edit a record) by clicking the main index window, then double-clicking the
record you want to edit.
To resume checking spelling at the point where you interrupted it, choose Check
Spelling from the Edit menu (or click the Spelling window), then click Resume.
To stop checking and reset the spelling checker so that it can begin again at the
head of the index, click Reset.
NOTE: If, during the course of checking entries you change the scope of the examination—for example, you change from checking all fields of records to checking only the
main headings—Cindex will reset the spelling checker so that it restarts at the beginning of the index.

CHECKING ONLY PART OF THE INDEX
Cindex normally checks the spelling of all records accessible in the current view
of the index, and normally checks words in all the text fields of records. It ignores
anything but cross-references in the locator field. You can confine the examination to a subset of the records in the current view, and you can control which
fields of records are checked.

Specified Range of Records
To check all records accessible in the current view, click All Records in View.
To confine the check to records you have selected, click Selected Records (this is
dimmed if no records are selected).
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To confine the check to a range of records in the view, specify the starting and
ending records in From and to. You can specify a range of headings by entering
leading text, e.g., Abr through Doc. You can also specify a range of record numbers (e.g., 55 through 79) within which Cindex should confine the search. If you
want to check among specified headings, you need only provide as much of the
beginning text as will identify a record uniquely. You can specify leading text
from a subheading by appending a semicolon to the heading text then adding
subheading text. To specify a heading that begins with digits, place a \ before the
first numeral; Cindex will otherwise interpret leading digits as a record number.
If you omit the first part of the range Cindex will examine entries from the head
of the index until it finds a record that matches the end of the range. If you omit
the second part of the range, Cindex will examine entries from the starting
record until it reaches the foot of the index. If you omit both ends of the range,
Cindex examines all records in the current view.
NOTE: When Cindex examines a range of records, it proceeds in whatever order the
records are displayed on the screen. Before beginning the examination it checks that the
last record in the range appears after the first. If the last record appears before the first,
Cindex will display a warning message.
Checking only Records
with Particular Attributes

You can further restrict spell-checking to records with particular attributes:
• To examine only records created during your current session with Cindex, check
New Records (this option is dimmed if there are no new records)
• To examine only records changed in the current session with Cindex, check
Modified Records.

Specified Fields in Records
Cindex normally checks all text fields of a record; in the locator field it normally
examines only cross-references. To confine the search to a specified field or fields
choose from the Field drop-down list.
• To check all fields choose All Fields.
• To check all text fields (excluding the locator field) choose All Text.
• To check only the lowest-level text fields choose Last Text.
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• To check only within a specified text field (main heading, subheading, etc.) choose
the field by name from the lower part of the list.
• To confine the check to the locator field choose Page (this item—always the one
immediately after Last Text—will have a different name if you have assigned a name
to your locator field). Cindex normally checks only cross-references in this field. If
you want Cindex to examine the spelling of locators other than cross-references,
check Check Page References.
NOTE: If you have used the Field drop-down list to exclude the locator field, Cindex
will dim the item Check Page References.

SPELLING OPTIONS
Languages
To specify the language in which Cindex will check spelling, choose from the
Language pop-up menu. If supplementary dictionaries are available for that language, they will be displayed in the Use Additional Dictionaries list, visible when you
click Options. Check any you want to use.
If the language you want is not displayed, you can download a dictionary. Cindex employs the open-source spell-checking technology that is used in software
such as the web browser Firefox and the email client Thunderbird. Dictionaries
for many languages, and some dictionaries containing specialized terms, are
available at no cost.
Installing Dictionaries

To enable Cindex to use additional dictionaries, you must install them in the correct place. Follow these steps to find and install a dictionary:
• Browse available language dictionaries at https://addons.mozilla.org/en-US/thunderbird/language-tools/. Choose and download your dictionary package. A medical
dictionary package is also available for download from https://addons.mozilla.org/
en-US/thunderbird/downloads/latest/6526/addon-6526-latest.xpi.
• Append the filename extension ".zip" to the name of the downloaded file, then unzip
it.
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• Inside the unzipped folder will be another folder named dictionaries. The dictionaries folder contains two files, one whose filename has the extension .aff, and another
(with the same name) and extension .dic. The files are named using a standard convention for representing languages and country variants. For example: en_US.aff and
en_US.dic (US English); en_AU.aff and en_AU.dic (Australian English); nl_NL.aff
and nl_NL.dic (Dutch).
• If you are using Windows XP, copy or drag the .aff file and the .dic file to this folder:
C:\Documents and Settings\All Users\Documents\Indexing Research\Cindex3.0.
• If you are using Windows Vista or Windows 7, copy or drag the .aff file and the .dic
file to this folder:
C:\Users\Public\Public Documents\Indexing Research\Cindex3.0
NOTE: If your disk is not named C, substitute the appropriate drive letter in the
instructions above.

General Options
You can control several aspects of spelling by setting options. Click Options in the
Spelling window to display the dialog box shown in Figure 29.
Suggesting Alternative
Spellings

Cindex can suggest alternative spellings of words it does not recognize. It can do
this whenever it encounters an unknown word, or only when you request it.
When Cindex is first installed it is set to suggest spellings automatically.
To make Cindex seek alternative spellings whenever it finds an unknown word,
click Always Suggest Alternatives. To make Cindex suggest spellings only when you
want them, uncheck Always Suggest Alternatives. Cindex will then suggest alternatives only when you click Suggest in the main spelling window. Cindex remembers your setting until you change it again.

Ignoring Words in
Capital Letters

To make Cindex ignore words in capitals (often abbreviations or acronyms)
check Ignore Words in CAPITALS. Cindex remembers your setting from session to
session.

Ignoring Alphanumeric
Sequences

To make Cindex ignore alphanumeric character sequences such as aa99 or 9b32,
check Ignore Alphanumeric Strings; if you leave this item unchecked, Cindex will
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treat all such sequences as misspelled words. Cindex remembers your setting
from session to session.
Clearing Words to be
Ignored

Each time you click Ignore All when checking a document, Cindex adds the word
to be ignored to a private list that it maintains for the duration of your current
session. Cindex discards this list when you quit. If you want to clear that list
without quitting, so that Cindex forgets the words you had told it to ignore,
click Clear Ignore List.
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Cross-References

Cindex does much of the work required to manage cross-references: it will place
cross-references in the position of your choice (immediately following the heading, or before or after subheadings); it will automatically format the introductory phrase (See and See also) and the body of the cross-reference in whatever
style you choose; it will sort and combine multiple references to the same heading or subheading; it will check cross-references and warn you if you have made
circular references or references to non-existent entries. Cindex will also tell you
if you have made cross-references to headings under which there are fewer than a
specified minimum number of entries. Cindex can generate cross-references
automatically, so that, for example, if a particular heading appears in your index,
there will always be a correctly-formed cross-reference to it.

HOW CINDEX IDENTIFIES CROSSREFERENCES
To identify cross-references and organize them correctly, Cindex has to know
not only what word will begin a cross-reference (e.g., See), but also what words
might make up the remainder of the introductory phrase (e.g., also or under).
Cindex normally assumes that a cross-reference can begin with see (in any mixture of upper- and lowercase letters) followed by any combination of also and
under. Thus, See, See also, See under and See also under are all acceptable introductions to cross-references. If your cross-references begin with a word other
than see and continue with words other than also or under, you must change the
settings Cindex uses, otherwise it will be unable to check or format cross-references.
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To manage cross-references properly Cindex also has to know how they are
punctuated. If you place several cross-references in a single record, Cindex needs
to know how to distinguish them, so that it can check them and format them
properly. Cindex normally assumes that one cross-reference is separated from the
next by a semicolon (;) and looks for this character when examining entries. Cindex also uses this character when it combines and sorts multiple cross-references
from several records under the same heading. If Cindex does not know how to
separate multiple cross-references it will not be able to check them or format
them.
Regardless of where you want cross-references to appear in formatted entries,
you should enter them in the locator fields of records. If you do this, Cindex will
place and punctuate them correctly, and combine and sort multiple references
from otherwise identical records. Cindex does not prevent you entering crossreferences in other fields, but most of its capabilities for managing cross-references will not be available if you do.

Specifying the Structure of Cross-References
To specify the structure of a cross-reference, choose Reference Syntax… from the
Document menu. Cindex will display the box shown in Figure 30.
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Settings for
cross-references

FIGURE 30.

Specifying Cross-Reference Syntax

Items that affect how Cindex recognizes cross-references are in the box labeled
Cross-References.
To specify the words that can begin the introductory phrase, type them at Lead.
You may enter text in upper- or lowercase letters—Cindex ignores letter case
when searching for these words. The first word in the list must be the word that
begins any cross-reference, but subsequent words in the list may appear in any
order. The list Cindex uses initially lets it recognize cross-references that begin
with see and continue with also or under, or also under.
To specify the character that will separate one cross-reference from the next,
when more than one cross-reference is made from a heading, enter a single
ASCII character at Separator.
To specify words that introduce general cross-references of the form “See individual drugs” or “See also specific treaties,” enter the appropriate words at General.
When Cindex is installed this list contains the words ‘individual’ and ‘specific’.
Cindex uses these words when:
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• sorting multiple cross-references to the same heading; those that begin with a general
term are normally placed at the end of the series.
• verifying cross-references; Cindex does not look for a target entry for any cross-reference that begins with a general term.

To permit Cindex to recognize cross-references entered as subheadings, uncheck
Recognize Cross-References in Locator Field Only. This is generally not recommended
because some of the tools for managing cross-reference work only with cross-references entered in the locator field. Moreover, if you enter a cross-reference a
subheading, Cindex may be unable to distinguish it from normal text that begins
with the words used to identify a cross-reference.
NOTE: To use the word that introduces a cross-reference (usually ‘see’) in some other
context, place a ~ (tilde) immediately in front of it to prevent Cindex treating it as the
start of a cross-reference.

VERIFYING CROSS-REFERENCES
As you enter a cross-reference in a record, Cindex can check and warn you if
there is no target entry (see “Checking Cross-References” on page 44). Cindex
can also undertake more comprehensive verification of cross-references, checking
that they refer correctly to record(s), that they are not circular, that they are of
the right type (e.g., see or see also), and that they match in letter accent and case.
To help you decide when double-posting would be preferable to making a crossreference, Cindex can also identify cross-references made to a heading under
which there are fewer than a specified number of entries.
To verify cross-references among entries accessible in the current view, choose
Check References… from the Tools menu. Cindex will display the dialog box
shown in Figure 31. Check Verify Cross-References, and click OK.
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FIGURE 31.

Checking References

If a record contains several cross-references, Cindex will check all of them, as
long as each reference is separated from the next by a semicolon (;) or some other
punctuation mark you have designated (see “Specifying the Structure of CrossReferences” on page 110).
NOTES: Cindex looks only among records accessible in the current view when seeking
target entries.
Cindex ignores deleted records, both as the sources and the targets of cross-references.
Cindex also ignores as sources any labeled records that you have designated as hidden
(see “Displaying Labeled Records” on page 57).

Cindex maintains a list of words that introduce general cross-references that it
will not attempt to verify (Cindex will, however, alert you if you make a general
cross-reference of the wrong type). When Cindex is installed this list contains
the words ‘individual’ and ‘specific’. (“Specifying the Structure of Cross-References” on page 110 describes this list and how to modify it).
After Cindex has checked the index it will display a window that contains a list
of incorrect or suspect cross-references, each followed (in square brackets) by the
main heading of the record from which it was made. Before each item Cindex
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displays the number of the record and a note about what was wrong with the
unverified reference:
• Missing identifies a cross-reference to a heading that was not in the index, or to a
heading that lacked a locator.
• Circular identifies a cross-reference that refers to another cross-reference.
• Too Few identifies a cross-reference that refers to a heading with fewer than a stipulated minimum number of subentries (see “Finding References to Too Few Target
Entries” on page 115).
• X/XA identifies a See cross-reference that should have been a See also, cross-reference
(or vice-versa). This can accompany other warnings.

Click any item in the list (or use the and keys) to bring its record into view in
the main document window; double-click an item (or hit RETURN) to open a
window in which to edit its record.
Enforcing Strict
Verification

Cindex normally accepts as a legitimate cross-reference a shortened form of the
main entry, or one that differs in letter accent or case, so it will not object to
cross-references of the kind shown below, where the See also reference is a short
form of the complete entry.
Austin, Emily Margaret Brown (daughter of MA)…
…
…
…
Bryan, Emily Austin. See also Austin, Emily Margaret

Cindex will also accept a cross-reference to a subentry made by referring to the
entry as if the subentry were a modifier. The reference
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Bone
tuberculosis of. See Tuberculosis, skeletal
tumors, 1878
…
…
Tuberculosis
skeletal, 2306

might be directing the reader to the subentry “skeletal” under the entry “Tuberculosis,” or it might refer to the modified heading “Tuberculosis, skeletal.” When
Cindex encounters a cross-reference that has some qualifying phrase after a
comma it first tries to find the modified heading (i.e., “Tuberculosis, skeletal”). If
it fails to find that heading, it will try to find the heading “Tuberculosis” with the
subheading “skeletal.” If the cross-reference contains multiple phrases separated
by commas, Cindex assumes that the candidate subheading follows the last
comma.
To insist that Cindex find an exact match (including letter accent and case)
between a cross-reference and its target entry (and therefore flag references of the
forms shown in the examples above) check Require Exact Matches. When you
insist on exact matches, Cindex requires only that the text of the cross-reference
matches that of the target; styles and fonts are ignored.
Finding References to
Too Few Target Entries

A cross-reference can often be dispensed with altogether, and replaced with a full
entry, when the heading to which it refers carries one or few entries. Indeed,
many publishers require that no cross-references be made to fewer than some
specified minimum number of entries.
Cindex can flag cross-references made to fewer than a certain number of entries.
(Cindex must always find at least one target of a cross-reference, otherwise it
flags a reference as missing.) Set Minimum Number of Entries to Match to the minimum number of target entries Cindex must find for each cross-reference. If you
have stipulated that there should be more than one entry under the target heading, Cindex will display “Too few” if a cross-reference points to too few targets.
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NOTE: Cindex can automatically convert cross-references to fully-qualified entries. See
the following section.

CONVERTING CROSS-REFERENCES TO
FULLY-QUALIFIED ENTRIES
Cindex can automatically convert entries that make see references into fully qualified entries that contain all the information from target entries, giving rise to
fully double-posted entries. You may wish to convert cross-references when they
point to fewer than a specified number of targets.
To convert see references, choose Manage Cross-References from the Tools menu.
Cindex will display the box shown in Figure 32.

FIGURE 32.

Managing Cross-References

Set For Fewer Targets Than to the number of target entries below which you want
Cindex to convert a cross-reference into a set of full entries. For example, to convert into a fully qualified entry any cross-reference that points to one or two target entries, set For Fewer Targets Than to 3. Cindex examines all the records in the
current view, and where it finds a cross-reference to fewer than the minimum
number of target entries generates new records that contain full entries.
NOTES: Cindex deals only with records that contain cross-references in the locator
field. It ignores records that contain cross-references as subheadings.
Cindex ignores deleted records, both as the sources and the targets of cross-references.
Cindex also ignores as sources any labeled records that you have designated as hidden
(see “Displaying Labeled Records” on page 57).
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Cindex marks as deleted, but does not otherwise alter, the record making the original
cross-reference.
If for some reason Cindex cannot create new records, it leaves the original one intact.
To view the new records that Cindex creates, use Find (Edit menu) and search for Generated records.

GENERATING CROSS-REFERENCES
AUTOMATICALLY
If you regularly prepare indexes on a particular topic, you might use a relatively
standard set of terms, and some standard cross-references. To ease the burden of
providing the correct cross-references, you can create a source of standard ones
that Cindex will automatically place in an index whenever the index contains the
appropriate target entries.

Preparing a Source Index
Use New… to create a new index in the standard way. This index will be the
source of generated cross-references, and should be sorted alphabetically, using a
letter-by-letter or word-by-word sort. For information on how to choose the
alphabetizing method, see “Alphabetical Sorting” on page 153.
The special index should contain one cross-reference in each record, organized
as follows:
• In the main heading field, enter the text that will be the main heading of the crossreference.
• In the first subheading field enter any subheading that accompanies the main heading. You can continue this to whatever depth of sub-subheading you wish.
• In the locator field enter the text of the target entry, without any leading See or See
also. Cindex will decide what form of introductory phrase is required when it
includes the cross-reference in another index. If you want to refer to a subheading
under a main heading, enter the main heading with the text of the subheading as a
modifier, after a comma.
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Suppose you wanted to generate a cross-reference from “Leningrad” whenever
your index contained an entry for “St. Petersburg.” The record in your special
cross-reference index would look like Figure 33:

FIGURE 33.

The form of an entry in a special cross-reference index

When you generate cross-references for your working index, any entry for St.
Petersburg will trigger the formation of a new record that contains:

FIGURE 34.

reference

A record with an automatically-generated cross-

To insert special cross-references in your working index, choose Manage Cross–
References from the Tools menu. Cindex will display the dialog box shown in
Figure 32. Choose Generate from File… to open the special index that will be the
source of the cross-references. As soon as you open this index, Cindex will
extract the appropriate cross-references from it. If your working index already
contains a cross-reference that would be generated, Cindex will not add another
one.
Cindex normally generates both See and See also references, as appropriate, but if
you want to create only See references (omitting any See also references) check
the “See” References Only box before opening the index.
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Cindex knows which records contains automatically generated cross-references,
and can find these at any time. To find generated records, choose Find… from the
Edit menu, and check Generated. When you click the Find button, Cindex will
display the first automatically-generated record it finds.
You can remove automatically generated records from the index by choosing
Compress… from the Tools menu. “Compressing Index Entries” on page 225
explains how to do this.
NOTE: If you edit and change a generated record, Cindex no longer considers it to
have been generated automatically.

PLACING AND FORMATTING CROSSREFERENCES
Different styles of indexes require different arrangements of cross-references,
varying both in the placement and the punctuation of the references.
To specify the punctuation, placement, and ordering of cross-references, choose
Cross-References… from the Document menu. Cindex will display the dialog box
shown in Figure 35.
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FIGURE 35.

Placing and Punctuating Cross-References

NOTE: The settings you make take full effect only when you view the fully-formatted
index. In a draft view of the index, Cindex will show cross-references in the correct position in the index, but will not punctuate them automatically, nor will it necessarily
arrange them alphabetically if several references are made from the same heading.

Cross-References from the Main Heading
To specify the arrangement of references made from the main heading, click the
From Main Heading tab.
Punctuation

Cindex can punctuate See and See also references differently. Enter at Prefix the
punctuation (including any spaces) you want to separate each kind of cross-reference from its heading or preceding page references. Enter at Suffix any trailing
punctuation (e.g., a period, or a closing parenthesis) that should follow the last
cross-reference made from an entry.

Position

See references, which direct a reader to other entries in the index, generally
appear immediately following the headings from which they are made. Cindex
can place a See reference either run on from the heading, or as a subheading.
Choose the arrangement from the Position drop-down list.
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See also references are made from entries that also carry page references, and their
positions depend upon the style of the index and the preference of the publisher.
In indented (set-out) style a See also reference from a heading generally appears
in one of three places:
• Immediately following the heading (this is often the preferred form):
Parking, 325
Parks, 465.See also National Parks; State Parks
management, 473
noise, 460
Pelicans, 267
• As the first subheading:
Parking, 325
Parks, 465
See also National Parks; State Parks
management, 473
noise, 460
Pelicans, 267
• As the last subheading:
Parking, 325
Parks, 465
management, 473
noise, 460
See also National Parks; State Parks
Pelicans, 267

In run-in (paragraph) style the cross-reference may appear in one of two places:
• Immediately after the heading (this form is often preferred):
Parking, 325
Parks, 465 (See also National Parks; State
Parks);
management, 473; noise, 460
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• After all the subentries:
Parking, 325
Parks, 465; management, 473; noise, 460. See
also
National Parks; State Parks

To specify where Cindex should place “See also” cross-references from a main
heading, choose from the Position drop-down list. This provides the following
options:
• Heading (always). “See also” references from a heading follow the heading (or any
preceding page reference) directly, without a line break. Cindex is initially set use this
placement of “See also” references.
• Heading (no page). “See also” references from a heading follow the heading directly,
without a line break, but only if there are no preceding page references. If there are
preceding page references, the See also references are formatted as a subheading.
• First Subheading. “See also” references from a heading are gathered together and displayed as the first subheading, above any regular subheadings that carry page references.
• Last Subheading.“See also” references from a heading are gathered together and displayed as the last subheading, below any regular subheadings that carry page references.
• Last Subheading (conditional). “See also” references are displayed as the last subheading; if there are no subheadings the cross-reference directly follows the page references from the heading.
NOTES: When See also references may be placed run-on from the main heading or as
subheadings, depending on context (the second and last options, above) Cindex provides Prefix and Suffix punctuation only when the cross-references are run on from the
main heading. Cindex suppresses punctuation if the cross-references are formatted as
subheadings.
Depending on the position you choose for “See also” references, Cindex may re-sort the
index.
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Cross-References from Subheadings
To specify the punctuation of cross-references made from subheadings, click the
From Subheading tab. Enter at Prefix the punctuation (including any spaces) you
want to separate the cross-reference from its subheading or preceding page references. Enter at Suffix any trailing punctuation (e.g., a period, or a closing parenthesis) that should follow the last cross-reference made from a subheading.
When placing cross-references from subheadings Cindex provides the same
options as are available for cross-references from main headings (Figure 35 on
page 120). Choose from the Position drop-down lists how See and See also references should be placed.

Sorting Cross-References
When Cindex displays the fully formatted index it draws together all the crossreferences from a single heading, even if you have entered these in different
records, then normally sorts them in a single alphabetical sequence.
Cindex maintains a list of words that introduce general cross-references that
should be placed at the end of any sorted set. “Specifying the Structure of CrossReferences” on page 110 describes this list and how to modify it. If in some
instance you want Cindex to place a general cross-reference in its alphabetical
position in a series, put a ~ immediately in front of the leading word, as in “~specific.”
If you do not want Cindex to arrange multiple cross-references alphabetically
(but instead display them in the order in which you entered them in records),
uncheck Alphabetize Multiple References (Figure 35 on page 120).
NOTES: Cindex alphabetizes a series of cross-references only when you view the index
as a fully-formatted document.
Cindex cannot arrange cross-references alphabetically unless they appear in the locator
fields of records.
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Suppressing Cross-References
You might on occasion want to display or print index entries without cross-references. To do this, check Suppress All References (Figure 35 on page 120).
NOTE: Cindex suppresses cross-references only when you view the index as fully formatted document. Cross-references are always visible in draft or unformatted views.

Text Style and Capitalization
Cindex will automatically apply a style you designate to the introductory phrase
of a cross-reference, and will apply the same or a different style to the body of the
cross-reference. When Cindex is first installed it is set to display the introductory
phrase in italics, and the body in plain text. To specify a style for the introductory phrase click Prefix Style… (Figure 35 on page 120).To specify a style for the
body of the cross-reference, click Body Style… For either setting, Cindex will display the dialog box shown in Figure 36.

FIGURE 36.

Style settings for cross-reference prefixes

Choose the styles and form of capitalization you want. When setting the prefix
style (but not the body style) you can choose Automatic capitalization to make
Cindex capitalize the phrase according to preceding punctuation: Cindex will
automatically capitalize the first word of the prefatory phrase if the cross-reference is formatted as a subheading, or the preceding punctuation mark (with any
intervening space) is a period; Cindex will set the initial letter to lowercase if the
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preceding punctuation is a comma (with any intervening space) or an opening
parenthesis.
Cindex does not apply styles or capitalization to the body of any cross-reference
that begins with a word you have identified as introducing a general cross-reference. See “Specifying the Structure of Cross-References” on page 110.
NOTE: Cindex applies styles automatically to cross-references only when you view the
index as a fully-formatted document.
Suppressing Automatic
Styles

When the body of a particular cross-reference already has some style applied, you
would not normally wish the prefix to carry the same style. If you check Don’t
Apply Prefix Style if It Matches Existing Body Style in the main Cross-References
panel, Cindex will not apply an automatic style to the prefix if that style is
already applied to the body of the cross-reference.
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Cindex manages both ordinary page references and unusual locators such as
dates or multi-part references. Even if you have spread references to the same
entry across several records, Cindex will combine and order them properly when
it formats the index; it can sort entries by date, no matter what the format of the
date in a record; it can conflate and abbreviate references and can suppress
repeated components of multi-part references. To take advantage of these capabilities you need to follow a few general principles when putting your references
in records. The first part of this chapter therefore provides general guidance on
entering locators.

HOW CINDEX IDENTIFIES LOCATORS
Any text in the locator field of a record, not specifically identified as a cross-reference, Cindex treats as a locator (generally a page reference). Figure 37 shows
examples that Cindex can recognize and evaluate.
Frontispiece, 89, 106–108n., 202f
vi, xiv, 9-15, illus. 45
13:10:19-21, 20:46:5, 21:3:15
mcmlxv, mcmlxx
53(vii)A, 53(vii)B, 53(ix)A

FIGURE 37.

Examples of references that Cindex can evaluate
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You can place as many references as you want in the locator field of a single
record. Cindex therefore needs to know how to recognize distinct references.

Specifying the Structure of Page References
To specify the structure of a page reference, choose Reference Syntax… from the
Document menu. Cindex will display the dialog box shown in Figure 38.
Settings for
page references

FIGURE 38.

Reference Syntax settings

Settings that affect how Cindex recognizes page references are made in the Page
References box.
Separating Individual
References
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Cindex normally assumes that if several page references are in a single record,
each will be separated from the next by a comma. Cindex also uses the comma
when it concatenates references from several otherwise identical records. You can
use a different separating character, but you must tell Cindex what that character
is. If Cindex does not know the correct separator it might treat a single reference
that contains a comma as two separate references, and might rearrange the components of the reference when it formats the index. For example, some references
shown in Figure 37 contain commas (e.g., May 2, 1977) and would not be corCHAPTER 8 Page References
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rectly understood unless Cindex knew that the separator was a semicolon. Set
the separator you want (a single ASCII character) at Separator.
NOTE: If a complex locator must contain within it the character that you have designated as separating one locator from the next, you can prevent Cindex recognizing it as
a separator by enclosing it in <…> or placing \ immediately before it.
Identifying an Inclusive
Range

You will often indicate an inclusive range of pages (e.g., 155–158) by joining the
references with a hyphen. Cindex needs to know how you denote an inclusive
range, so that it can conflate or abbreviate references properly when it formats
the index, and can adjust them properly when required. If you use the hyphen in
chapter-page notation, so that for example, 5–7 means chapter 5, page 7, you
must specify some character other than the hyphen to indicate an inclusive
range. Specify the separating character at Connector. You can use any single ASCII
character such as $ or @ that has no special meaning for Cindex. This character
need not be the one you wish to see in the fully formatted document: when Cindex produces the formatted index it will translate the connecting character into
whatever character or sequence of characters you wish to have displayed and
printed. For example, if you specified $ as your connecting character, you could
enter 6–8$6–10 in the locator field of a record and have Cindex display and
print it as 6–8 to 6–10.

Recognizing and Classifying Components of References
After identifying an individual reference, Cindex parses it into segments. There
are two kinds of segments, those comprised of Arabic numerals, and those comprised of letters.
A simple locator consists of a single segment; a compound (multi-part) reference
of the kind shown in Figure 37 can contain several. A digit or series of digits followed immediately by a letter or series of letters (e.g., 55f ) is considered to be
two segments; a reference of the form 67a2 would be treated as having three segments. Segments can also be separated by one or more spaces, symbols or punctuation marks. These separators are all treated as equivalent. A reference such as
10:xix 67 therefore has three segments.
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After Cindex has identified segments of a reference it classifies them. A segment
consisting of digits (e.g., 345) is always evaluated as a number. A segment comprised of letters can be evaluated as a number in Roman numerals (e.g., xiv), as
the spelled-out name of a month (e.g., May) or as plain text (e.g., Plate), depending on settings you make.
When Cindex is first installed, it is set to recognize Arabic numerals, and to treat
any letter sequence as a plain text segment (it does not recognize Roman numerals or names of months). When Cindex compares reference segments of different
types, it assigns higher precedence to Arabic numerals, and lower precedence to
segments made of letters. “Evaluating and Sorting Page References” on page 132
describes how to change the kinds of segments Cindex recognizes, and how it
evaluates them.
Roman Numerals

Cindex can recognize Roman numbers comprised of these characters: IVXLCDM or ivxlcdm. Do not mix upper- and lowercase characters in the same
number; if you do, Cindex will treat it as plain text. Be sure that the number is
neither preceded nor succeeded by another letter. This restriction is designed to
ensure that Cindex will not mistake normal text for a Roman number. For example, Cindex recognizes the number 6 in vi, [vi], and vi:a, but not in avid, vision,
or province.

Names of Months

Cindex can recognize names of months spelled out in English, in any mixture of
upper- or lowercase letters, as long as the name of the month is not preceded or
succeeded by a letter. Cindex therefore recognizes “may” and “May” but not
“maybe” or “dismay” as a month. The name of any month may be abbreviated to
as few as three letters.

Plain Text

Any sequence of letters not recognized as Roman numerals or the name of a
month is treated as plain text. When evaluating letters as plain text, Cindex distinguishes upper- and lowercase versions of a letter, and assigns them the following precedence:
AaBbCc… …Zz
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WORKING EFFICIENTLY WITH PAGE
REFERENCES
If you follow these guidelines, you will be best able to take advantage of Cindex
in organizing page references as you want them.
Use the locator field

Always put page references in the locator field of a record (usually called the Page
field). Cindex depends on references being in that field when it organizes or
transforms them.

Provide Complete
References

When you make an entry, you should as a general rule provide a complete reference, even though you may not wish the whole reference to appear in the formatted copy of the index. For example, if your publisher requires references to an
inclusive range of pages to be abbreviated (e.g., 307–10 instead of 307–310) you
should enter the full range (307-310) and allow Cindex to abbreviate the reference when it formats the index. It is a good idea to do this even when the inclusive range includes volume or part numbers (e.g., 22:55-22:58 rather than 22:5558). You should also enter full references if your entries refer to volume numbers
or dates (e.g., June: 23, June: 27, August: 15) even if you want repeated numbers
or dates to be suppressed in the formatted output (e.g., June: 23, 27; August: 15).
When Cindex produces the formatted copy of the index it will suppress as much
as you require of repeated volume numbers or dates.
The benefit of entering full references is that Cindex can always find entries that
refer to a particular page or date, no matter how complex the locator, and can
make automatic adjustments of the kind you might need if your publisher adds,
removes or rearranges pages after you have finished the index. If you have
entered some shortened form of a reference Cindex might not always be able to
deduce its full form and might not be able to find it or modify it properly.

Apply Type Styles to
Individual References

You can use text styles and fonts freely in references, even in complex ones that
contain several parts (e.g., 1987: May 15). However, you might not need to
apply styles explicitly to references or parts of them. When Cindex displays or
prints a fully formatted copy of the index, it can automatically apply specified
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type styles to all or selected parts of page references. For more information see
“Applying Type Styles to References” on page 146.

CHECKING PAGE REFERENCES
While you are entering records in the index Cindex makes a variety of checks to
ensure that the references are properly formed and fall within acceptable ranges
(see “Checking Locators” on page 43).
Cindex can also find entries that make too many undifferentiated references
from a particular heading, even if these occur across multiple records. To find
such entries, choose Check References… from the Tools menu. Cindex will display
the dialog box shown in Figure 31 on page 113. Check Page References and at
Maximum locators in single entry set the maximum acceptable number of undifferentiated references.
If Cindex finds any entries that contain too many references it will display a window that contains a list of records, each followed (in square brackets) by the
number of undifferentiated references associated with it. (If you are also verifying cross-references, the list of undifferentiated references will follow the list of
unverified cross-references).
NOTE: Cindex counts references as they would be displayed in the formatted index.

Click any item in the list (or use the and keys) to bring its record into view in
the main document window; double-click an item (or hit RETURN) to open a
window in which to edit its record.

EVALUATING AND SORTING PAGE
REFERENCES
Cindex evaluates page references under the following conditions:
• When a single entry has multiple references, and these have to be ordered when the
formatted index is displayed or printed.
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• When entries are ordered alphabetically, but are identical at all levels of heading that
are being evaluated.
• When you want entries ordered by page reference.

Before Cindex can arrange references in the order you want, it has to know what
precedence to assign to different kinds of segments (for example, whether a reference to a name of a month should precede a page reference in Arabic numerals), and it has to know how you want it to evaluate multi-part references (for
example whether a three-part reference of the form month:day:year should be
evaluated in the order year:month:day). Cindex is initially set up to:
• recognize letters as plain text (ignoring their possible interpretation as Roman
numerals or names of months).
• assume that a reference consisting entirely of letters (e.g., Plate) should succeed one
that is in Arabic numerals.

Cindex evaluates multi-part references from left to right.

Setting the Precedence of Reference Segments
You can specify how Cindex should recognize segments comprised of letters (as
Roman numerals, spelled out months, or plain text), what precedence it should
assign to different classes of components, and in what order it should evaluate
components.
To change how Cindex recognizes components of a reference—for example, to
enable the recognition of Roman numerals and names of months—or to change
the precedence of different classes of components, choose Sort… from the Tools
menu, then click the Locators tab.
Cindex will display the items shown in Figure 39.
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FIGURE 39.

Sorting locators

Through the Type Precedence list you specify whether or not Cindex will recognize a segment of a particular class, and (if it does recognize it) what precedence
Cindex should assign to it.
Cindex recognizes only segments corresponding to the classes that are checked
with + marks. If a member of the list is unchecked, Cindex never recognizes a
segment of the corresponding class. To check or uncheck a member of the list,
double-click it.
NOTE: If you uncheck all the classes of segments comprised of letters (Roman Numerals, Letters, Months), Cindex will treat letters as punctuation.
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When Cindex examines references and compares two components of different
classes (e.g., a component interpreted as a spelled out month and one in Arabic
numerals), it uses the order in which recognized classes appear in the Type Precedence list to determine the precedence of the components they represent. The
checked item at the top of the list has the highest precedence; unchecked items
always appear at the bottom of the list. To change the order of components that
are checked, drag them to the positions you require. When Cindex is first
installed it recognizes Arabic Numerals, and Letters, with Arabic Numerals having the greater precedence. Cindex is set not to recognize Roman Numerals or
names of Months.
When Cindex is set to recognize two or more classes of segments that can be
comprised of letters, it assigns a particular set of letters to the highest-precedence
class whose requirements the set satisfies.

Attending to the Style of a Reference
Sometimes text styles—bold, italic, underline—are used to distinguish different
types of page references. When Cindex finds two locators (or the least significant parts of multi-part references) that have identical values it uses their text
styles to order them according to a precedence that you can specify. When Cindex is first installed it sorts otherwise identical references in this order: plain,
bold, italic, underline.
To change the precedence of text styles, drag items in the Style Precedence list.
The style represented by the top item has the highest precedence.

Setting the Evaluation Order of Multi-Part References
Cindex is initially set to evaluate multi-part references from left to right. For
some kinds of multi-part references, particularly dates, the normal evaluation
order may not be satisfactory. For example, if your references had the form
month:day:year you would probably want them to be evaluated in the order year,
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month, day. Cindex will evaluate components of a multi-part reference in any
order you choose.
Through the Segment Order list you specify whether or not Cindex will evaluate a
segment, and (if a segment is to be evaluated) the order in which it will be evaluated. A name in the list identifies a recognized segment by its position in a reference. For example, First refers to the first recognized segment of a reference. Your
settings of Type Precedence, discussed in the previous section, determine what
Cindex will recognize as a segment.
Cindex evaluates only reference segments associated with checked items in the
list. Double-click an item to make Cindex evaluate (or ignore) the corresponding segment of a reference. For example, were you to check First, Second, Third,
and no other segments, Cindex would ignore any segments of references in positions four or higher. If you checked only Second, Third, Fourth, Cindex would
ignore the first segment and the fifth and any higher segments.
The order in which the checked items appear in the list is the order in which
Cindex evaluates their corresponding segments. When Cindex is first installed it
is set to evaluate up to ten components of a compound reference in the order
(from left to right) first, second, third … tenth. To make Cindex evaluate segments in some other order, for example third, first, second, simply drag the item
corresponding to a component to the appropriate position in the list. (The order
Third, First, Second would ensure that a reference of the form month:day:year
was evaluated chronologically.)
If Cindex is set to evaluate a segment that does not appear in a reference (for
example you specified the evaluation order Third, Second, First and a reference
contains only two segments), it will treat the missing segment as if it had zero
value.
NOTE: If you are working with multi-part locators that contain more than ten recognized segments Cindex ignores the Segment Order setting and evaluates all the segments
from left to right.
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Locating Records that
Contain Multi-Part
References

“Searching for Locators” on page 75 described how to use Find (Edit menu) to
find records that contain references to particular pages or ranges of pages. You
can use the same methods to find entries that contain multi-part locators, but
there are additional points to bear in mind.
To search for a connected range of references, you must separate the low and
high references in your specification with whatever character you have designated as the page reference connector (usually –). Cindex will understand an
abbreviated form of the higher reference. To find all references to volume 20,
pages 10-15 you could specify either
20:10–20:15

or
20:10–15

Cindex also makes allowance for suppressed components in records. For example, if the locator field contained 20:10-15 (meaning 20:10-20:15), Cindex
would implicitly expand the suppressed segment before checking whether it fell
within the range sought.
Cindex will interpret a truncated reference sensibly. For example, if references in
records had the form “year:month day” (1988: Jan 10) and you wanted to find
any references to January 1988, regardless of day, you could look for
1988:JAN

When you seek compound references, and specify fewer components of references than are contained in records, Cindex will find all references that satisfy
the components specified in the search string; it will ignore less significant components. Thus if you specified
1988

Cindex would find any record with a reference whose first component was 1988.
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NOTE: When evaluating references while searching with Find, Cindex uses the evaluation order you have specified through your settings or Segment Order (see “Setting the
Precedence of Reference Segments” on page 133). If some component that Cindex is set
to evaluate is omitted from the specification you provide with Find, Cindex will behave
as if you had specified that component with zero value.

When Cindex parses a multi-part reference, it does not care what characters separate the components. In specifying the reference for which Cindex should look,
you therefore need not use exactly the form that appears in records. For example,
specifying
20:10:a

would find a record that referred to 20_10_a or 20.10.a or 20#10a.

Placing References in Descending Order
Settings of Type Precedence, Segment Order and Style Precedence that you make
through the Sort… dialog box (Figure 39) tell Cindex how to decide whether
one page reference is larger or smaller than another one. These settings do not
tell Cindex whether a smaller reference should precede a larger one, or vice-versa.
Normally, Cindex arranges references in ascending order (smaller to larger), but
you might occasionally need to produce an index (possibly a chronological one)
in which references must be arranged in descending order (i.e., most recent first).
To select descending order, uncheck Ascending Order under the Locator tab in the
Sort… dialog box (Figure 39).

Ordering References by the First in a Record
If Cindex needs to use the value of a locator when positioning a record in the
index (it generally does this only when positioning otherwise identical records),
and the locator field contains more than one page reference, Cindex normally
uses the lowest-valued reference (or highest-valued one if Ascending Order is
unchecked). To make Cindex order entries by the value of the first reference in
the locator field, uncheck Examine All under the Locator tab in the Sort… dialog
box (Figure 39).
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Forcing the Order of Individual References
Suppose you want a series of references from a heading to appear in this order:
18, 45–47, Plate XIV, A–2

With its standard settings of Type Precedence, Cindex would normally rearrange
the references, and display them in this order:
18, 45–47, A-2, Plate XIV

You can interfere selectively with the automatic ordering of page references by
adding components that will influence the sorted order but will not be visible in
the fully-formatted display. The components will be visible in a draft display. To
force a particular reference to the right place you can place a number enclosed in
{ } (braces) immediately before it, as in Figure 40.

FIGURE 40.

Using braces to force correct sorting of references

NOTE: You can enclose selected text in braces by clicking
dow.

in the record-entry win-

Cindex uses the {47} and {1000} in ordering the page references, but suppresses
them when displaying the formatted entry. (In the example shown, the {1000} is
used as an arbitrarily large number to ensure that the A–2 reference appears last).
You may use braces to enclose any component of a reference in the locator field.
The braces will not appear in the fully formatted display.
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You can hide whole references or parts of references from the page ordering
mechanisms by placing them within angle brackets (< >).
For example, you might have references containing Roman numerals that Cindex will evaluate. If an occasional reference also contains a letter that might be
interpreted as a Roman number, you can hide it from the ordering mechanism by
placing it inside angle brackets, as shown in Figure 41
NOTE: You can enclose selected text in angle brackets by clicking
entry window.

FIGURE 41.

in the record-

Hiding parts of individual references from sorting

The angle brackets will not appear in the fully-formatted display.
NOTE: You must always match opening and closing braces or angle brackets in a
record. If you neglect to provide a closing brace or bracket, Cindex will warn you, and
will not let you store the record until you have corrected the error.

FORMATTING PAGE REFERENCES
When Cindex displays a fully-formatted index, it sorts, formats and punctuates
page references. Cindex first gathers all the references from identical records. It
then discards any duplicates, and any redundant references to single pages that
match either the beginning or the end of an inclusive range of pages. After doing
this it can conflate a series of separate references to consecutive pages, it can
abbreviate page ranges, and it can suppress repeated volume numbers in multipart references. Cindex never alters records when it displays references in different formats.
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To specify how Cindex should format page references, choose Page References…
from the Document menu. Cindex will display the dialog box shown in
Figure 42.

FIGURE 42.

Page Reference format settings

NOTE: The settings discussed below take effect only when you use a fully formatted
view of the index.

Formatting Inclusive Ranges
Cindex provides several features for formatting inclusive ranges of page references.
Translating the
Connecting Character

When you enter references in records you must use a single ASCII character
(typically a hyphen, or minus sign) to denote a connected range of pages such as
55–67. “Specifying the Structure of Page References” on page 128 explains how
to specify this character.
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When Cindex displays formatted entries, it translates the connecting character
to another character or sequence of characters you specify. References that
appear in records as 55-67 can therefore be displayed as 55–67, or 55 to 67, or
55 through 57. When Cindex is first installed it is set to translate the hyphen to a
single en-dash. To use some other character or sequence of characters to denote
an inclusive range, set Connecting Text to the character or sequence of characters
you want.
When formatting entries, Cindex will if necessary break a line at any space, or
after a hyphen. To prevent Cindex breaking a line in the middle of an inclusive
range of references, use an en dash (ALT 0150 on the keypad) or a non-breaking
space (ALT 0160 on the keypad) where you might otherwise use a conventional
hyphen or space in Connecting Text.
Conflating References

When an entry contains a series of separate references to consecutive pages, Cindex normally arranges them in order, but does not conflate them into a single
range. Cindex can conflate references to consecutive pages, so that a series of references entered in records as
34, 33, 35, 37, 39, 40-42, 41-43

can appear as
33-35, 37, 39-43

You can set Cindex so that it will conflate aggressively, whenever two references
refer to consecutive pages, or more conservatively, when there is some larger
number of references to successive pages. To enable conflation, use the Conflate
Beyond drop-down list to specify the critical number of references to consecutive
pages. For example, to conflate references whenever two refer to consecutive
pages, choose First; to conflate when there are references to three or more successive pages, choose Second, etc. To disable conflation, choose None.
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When conflating multi-part references Cindex attends only to the last component in Arabic numerals (or the last two components if they form an inclusive
range). A non-digit may appear after the last number. Thus references normally
appearing as:
1988 (Jan) 3f, 1988 (Jan) 4f, 1988 (Jan) 5f

would be conflated as:
1988 (Jan) 3f-1988 (Jan) 5f
NOTE: Cindex will conflate references correctly only if they are ordered properly. To
guarantee that references are ordered properly in the formatted entry, regardless of their
positions in the locator field, you should let Cindex rearrange them if necessary. To
ensure this, check Arrange in Sorted Order.
Abbreviating
References

Cindex can abbreviate the upper part of an inclusive range of page numbers, so
that a range entered in a record as 920-923 might be displayed as 920-23. Two
established conventions dictate how page numbers should be abbreviated. One is
recommended by the Chicago Manual of Style (Chicago, University of Chicago
Press, 1993), the other by Hart's Rules (Oxford, Oxford University Press, 1983).
A third convention permits very aggressive abbreviation of references. For a
series of complete references that look like this
3-10, 16-18, 100-104, 107-108, 210-213, 321-325, 1496-1504, 1536-1538

the Chicago convention would format them as
3-10, 16-18, 100-104, 107-8, 210-13, 321-25, 1496-1504, 1536-38

Hart’s convention would format them as
3-10, 16-18, 100-4, 107-8, 210-13, 321-5, 1496-504, 1536-8
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and the aggressive convention would format them as
3-10, 16-8, 100-4, 107-8, 210-3, 321-5, 1496-504, 1536-8

To abbreviate the upper part of a range of page numbers, choose from the Abbreviation Rule popup menu: Chicago (for University of Chicago Press rules), or
Hart (for Hart’s rules) for Full (for aggressive abbreviation).
If your index contains multi-part page references, and you specify references
fully in records when you provide an inclusive range (e.g., 20:ix:552–20:ix:555
rather than 20:ix:552–555), Cindex will abbreviate the second reference only if
you have told it to suppress the leading parts (see “Formatting Multi-Part References”, below). When you suppress leading parts the inclusive range 20:ix:552–
20:ix:555 will appear as 20:ix:552–555, and after abbreviation it will be transformed (using Chicago Rules) to 20:ix:552–55.
If Cindex is set to both conflate and abbreviate references, it will conflate them
before abbreviating them.

Formatting Multi-Part References
When formatting compound locators such as 1986 a(ii):55, Cindex can suppress
the display of repeated leading parts that are common to successive references, so
that in the second and subsequent reference only the least significant, and changing, part of a locator is actually displayed. For example, if your record contained
the following set of references to a heading (with a semicolon being the designated page reference separator)
XIV 55:10; XIV 55:62; XIV 55:79; XV 56:108-9; XVI 57:232; XVI 57:240

Cindex could display them as
XIV 55:10, 62, 79; XV 56:108-9; XVI 57:232, 240
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To enable this kind of suppression, check Suppress Repeated Parts. You must also
provide Cindex with information about how much of the leading part of a complex reference it should suppress, and you must tell Cindex what characters it
should insert in the formatted display to denote a concatenated reference (a
comma in the example above).
To stipulate how much of the leading text should be suppressed, enter at Suppress
to a marking character or set of marking characters that Cindex must encounter
in the parts of references it will suppress. The point in the reference at which
Cindex finds the last marking character is the point up to which it will suppress
repeated leading components. Thus for references like those shown above, your
template might be a space followed by a colon. Cindex will search through each
reference until it finds the first space, after which it continues to search for a
colon. If successive references match as far as the colon, Cindex replaces the leading components of the second and any subsequent matching references with a
separating sequence of characters that you enter at Concatenate with (in the above
example a comma followed by a space). The concatenating sequence should not
contain the character that you use to separate successive complete references.
NOTES: When comparing characters in a reference against the marking characters in a
suppression template, Cindex ignores leading spaces at the beginning of any reference.
You should therefore not count these when forming a template.
Cindex will suppress repeated leading components of a reference only when the references are correctly ordered. To ensure proper ordering of page references, you should
check Arrange in Sorted Order.
If Cindex is set to conflate references, it will conflate them before it suppresses any
repeated leading components.

Punctuating Page References
Cindex always displays page references immediately after the text of the entry to
which they belong. Cindex inserts punctuation of your choice before and after a
set of page references. If you wish, Cindex will provide different leading punctuation depending on whether a single page reference follows a heading or multiple
references follow a heading.
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To specify leading punctuation (including any spaces) that Cindex should use to
separate a single reference from the text of an entry, enter it at Before Single.
To specify leading punctuation (including any spaces) that Cindex should use
when two or more references follow the text of an entry, enter it at Before Multiple.
Cindex is initially set to provide a comma followed by a space as the leading
punctuation before both single and multiple references.
To specify text that Cindex should insert after the last page reference of an entry,
enter the text at After.
When working with an index formatted in indented style, Cindex can format
page reference so that they appear flush against the right margin of the page. To
make Cindex display references in this format, check Right Justify. To make Cindex display right-justified references with a dot leader, check Dot Leader (this is
dimmed unless right-justification is checked).

Applying Type Styles to References
Cindex can automatically apply type styles to page references when it displays or
prints them. This can save you the effort of entering styled text in records. If your
index contains multi-part locators, you can set Cindex to apply a different style
to each part. Cindex is initially set to display all parts of page references in plain
text.
To specify the style in which Cindex should display and print references, click
Style… in the Page References dialog box. Cindex will display the dialog box
shown in Figure 43.
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FIGURE 43.

Page Reference style

Cindex can apply styles to up to ten segments of multi-part locators. You can
specify a different style for each segment. For the purpose of applying styles, Cindex treats each segment of a reference as consisting of possibly two components:
a part that can be evaluated (Arabic numerals, Roman numerals, text, etc.), and
any filling or punctuating characters that might precede it. Cindex treats as
punctuation any characters that it does not recognize as part of a reference element. For each segment you can specify styles separately for the reference element and its preceding punctuation (if any).
1.

Click the tab corresponding to the position of the segment to which you want to
apply a style (for a simple reference, use the First segment).

2.

Under Locator Element check the style(s) for the reference element.

3.

Under Lead Punctuation check the style(s) for any preceding punctuation.

Ordering References
When Cindex displays the fully formatted index it draws together all the page
references from a single heading, even if these are contained in several records,
then normally sorts them in an ascending sequence. (The earlier section “Evaluating and Sorting Page References” on page 132 explains how to set the rules
Cindex uses for sorting references). If you want Cindex to display multiple page
CHAPTER 8 Page References

147

Formatting Page References

references in the order in which you entered them in records, uncheck
Arrange in Sorted Order (Figure 42 on page 141).
NOTE: Several of the advanced options Cindex provides for formatting page references (for example, conflating them) depend upon references being displayed in sorted
order. If you want to use any of the advanced options you should ensure that
Arrange in Sorted Order is checked.

Suppressing Page References
You might on occasion want to display or print index entries without page references. To do this, check Suppress All References (Figure 42 on page 141).
NOTE: Cindex suppresses locators only when you view the index as fully formatted
document. In draft or unformatted views, locators are always displayed.
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Sorting Entries

This chapter describes the principles that Cindex follows when sorting entries,
and explains how you can modify them when you need to.

LANGUAGE
Different languages have different alphabetizing conventions. For example, in a
Swedish index, entries beginning with Å are placed after entries beginning with
Z. Cindex can alphabetize entries by the rules appropriate for many languages.
Cindex uses English by default. To specify another language, choose Sort… from
the Tools menu, then choose the language from the Language pop-up menu.

FIELD EVALUATION ORDER
When Cindex sorts records, it evaluates text fields alphabetically, and evaluates
the locator field numerically (if it contains page references) or alphabetically (if
it contains cross-references). Cindex can evaluate fields in any order that you
specify. When first installed it is set to alphabetize first on the main heading,
then on successive levels of subheading, down to the lowest level present; if
records are identical at all levels, their positions are determined by values of page
references; if page references are identical the positions are determined by record
number. By changing the order in which Cindex evaluates fields, you can change
the way that entries are sorted. For example, if you set Cindex to evaluate the
locator field first, your entries will be sorted by order of page reference.
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To specify which fields Cindex will attend to, and the order in which it will evaluate them, choose Sort… from the Tools menu, then click Fields. Cindex will display the panel shown in Figure 44.

FIGURE 44.

Fields settings in Sort dialog box

The order in which Cindex evaluates fields is determined by the list displayed
under Order. The items in this list show, from top to bottom, the order in which
Cindex will evaluate fields when sorting records. Cindex attends to fields that
have a + beside them, and ignores fields without a +. To change the order of a
field, drag its item to the position you want it to occupy. To make Cindex ignore
a field, double-click it to remove the +; to make Cindex attend to a field that is
currently ignored, double-click it to restore the +.
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To make Cindex sort entries by main heading only, ignoring other fields, set:

To make Cindex sort on the main heading, then by page references, then (if
entries are identical in the main heading and page references) successively lower
levels of subheading, set:

NOTE: When Cindex is set to ignore subheadings, records that have the same main
heading and subheading, but different page references, may become separated in the
index. To avoid this potential problem you should ensure that your index contains no
duplicate records with different page references. Cindex can combine references from
duplicate records into a single record. “Consolidating References from Multiple
Records” on page 226 describes how to do this.
Sorting by Page
Reference Order

To make Cindex sort entries by page reference, then by heading level, set:

When you sort entries by order of page references, Cindex places all records that
contain empty locator fields at the beginning of the index, and places records
that contain cross-references at the end of the index (in alphabetical order of reference). Cindex normally sorts the records in ascending order of page reference.
If a locator field contains multiple references, Cindex uses the lowest-valued reference by default. You can change these ordering principles if you wish. “Placing
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References in Descending Order” on page 138 explains how to sort references in
descending order. “Ordering References by the First in a Record” on page 138
explains how to sort references by the first that appears in the locator field.
Locating Records in a
Page Order Sort

When an index is sorted by order of page reference, Cindex expects that if you
want to find a record quickly you will specify it by a page reference. When you
use navigation shortcuts to find entries in the main document window (page 67)
Cindex interprets what you type as a locator, and looks up the first record that
contains that locator. If the locator begins with a numeral (as it usually will) you
must type a \ immediately before it to prevent Cindex treating the number as a
record number. The same principles apply if you use Go To… to find an entry.
When an index is sorted by page reference, you cannot bring an entry into view
in the main window by typing the beginning characters of its heading.
NOTE: You cannot use the tools Reconcile Headings or Check References when the index is
sorted by order of page reference.

Ignoring the Lowest-Level Subheading
Certain kinds of indexes require entries alphabetized on all levels of heading
except the lowest (at whatever level this happens to be), which is ordered by page
reference. For example, in the following fragment the entries directly under the
heading are ordered by page reference; entries under subheadings are also
ordered by page reference, but the subheadings are ordered alphabetically:
FOOTBALL
viewing statistics, 57
televising, 78
College
new rules take effect, 14
NCAA approves drug tests, 827
Professional
Super Bowl interviews, 31
NFL tryout results, 126
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To make Cindex sort entries in this way, specify a conventional Order, and check
Ignore Lowest Subhead. Cindex will sort the index in the order determined
by Order, but will order the lowest-level heading by page number. If two headings
at the lowest-level have identical page numbers they will be ordered alphabetically.

Sorting Shortcuts
Cindex provides a quick method for sorting the index either alphabetically or by
order of page number, without your having to choose Sort… from the Tools
to sort entries alphabetically; click
to
menu. On the main toolbar click
sort entries in locator (page number) order.
Clicking either of these buttons causes Cindex to use its current sort settings
(made by choosing Sort… from the Tools menu), except that the order in which
fields are evaluated is (for alphabetical sorting) from the main heading through
the last subheading to the locator field, or (for sorting by page reference) the
locator field, then the main heading through all the subheadings. If you want levels of heading to be evaluated in any but these two simple sequences (for example
you want this order: main heading, locator, then subheading) you should specify
that order by using the full range of sorting options available by choosing Sort…
from the Tools menu.

ALPHABETICAL SORTING
When first installed, Cindex uses a simple alphabetical sort, but does not ignore
numerals and punctuation in records. This is often the best way to keep the
index organized while you work on it, but because the simple sort attends to all
characters that appear in records, it is generally inadequate for production of the
final index. Before producing your final copy you will usually sort the index by
letter-by-letter or word-by-word alphabetizing rules.
In a letter-by-letter sort, spaces between words are ignored, and records are compared one letter at a time up to the first mark of punctuation. If the records
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match up to this point, the comparison continues to the next punctuation mark,
and so on. In a word-by-word sort, letters are compared up to the end of the first
word. If records match up to that point, the comparison starts again at the second word, and so on. In most instances the two alphabetizing rules produce
identical results; however, there are exceptions:

Letter-By-Letter

Word-by-word

endings
endogenous
end piece
end zone

end piece
end zone
endings
endogenous

In both types of alphabetizing, Cindex ignores all characters but letters, except
where noted in the following section.

Principles of Alphabetizing
When Cindex sorts records in letter-by-letter or word-by-word order it follows
these rules:
Letters

Cindex ignores letter case unless that is all that distinguishes entries. When Cindex does distinguish upper- and lowercase letters, it follows language-specific
conventions. For example, in English, lowercase sorts before uppercase; in Latvian, uppercase sorts before lowercase.
Accented letters are sorted according to language-specific collation rules. When
sorting in English, Cindex treats any accented letter as its (unaccented) English
counterpart, unless the accent is the only thing that distinguishes two entries. In
this case the entry containing the unaccented letter comes first. If the same letter
with different accents is all that distinguishes two entries, then the entries are
ordered by the letter's Unicode value.

Punctuation
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When Cindex alphabetizes entries it assigns the punctuation marks . , : and ; a
higher precedence than any other characters. These punctuation marks (especially the period) are often used in contexts, such as in abbreviations, where they
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should be ignored altogether. Cindex cannot infallibly identify special uses of
punctuation marks, but it tries to detect them by ignoring any mark that is not
followed by a space or a hyphen. Thus U.S.A. is alphabetized as USA. If you
wish, Cindex will always ignore punctuation marks when alphabetizing. “Treatment of Punctuation” on page 160 explains how to do this.
Hyphen (-) and
Slash (/)

Cindex ignores the hyphen and slash (solidus) in letter-by-letter alphabetizing,
but in word-by-word alphabetizing it normally treats these characters as spaces,
unless they are the only characters that distinguish entries. In such cases, the solidus has a higher value than the hyphen, and the hyphen has a higher value than a
space. Thus the following entries are alphabetized in the order shown:
sodium potassium
sodium-potassium
sodium/potassium

If you wish, Cindex will ignore the hyphen and slash in word-by-word alphabetizing. “Treatment of Punctuation” on page 160 explains how to arrange this.
Symbols

In making a letter-by-letter or word-by-word sort, Cindex normally ignores symbols, but if two otherwise identical entries contain different symbols, the order
of entries is determined by the character values of the symbols they contain.
You can sort entries on symbols if you wish. “Filing Entries under Symbols and
Numbers” on page 166 explains how to do this.

Numbers

Cindex normally ignores numerals when alphabetizing, unless these are the only
characters that distinguish entries. In this case Cindex evaluates a series of
numerals as a number, and orders the entries by the values of these numbers. Cindex will therefore automatically place the following entries in the order shown,
regardless of the order in which they were added to the index:
AAAS, 7th Annual Meeting
AAAS, 49th Annual Meeting
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If you wish, Cindex will always evaluate numbers. For a full discussion of this, see
the section“Evaluating Numbers” on page 161.
Identical Entries

Records that are alphabetically identical are ordered by page reference. If the
records also contain identical references they appear in the index ordered by
record number.

Choosing the Alphabetizing Method
Cindex provides three different rules for alphabetizing entries, and for each of
them offers variations on the basic methods. All the settings that govern alphabetizing are made under the Text tab in the Sort… dialog box (Figure 45).
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FIGURE 45.

Settings for alphabetizing

Choose the alphabetizing method from the Alphabetizing Rule popup menu. In
addition to the standard letter-by-letter and word-by word alphabetizing
options, Cindex offers three variant forms of each: one recommended by the
Chicago Manual of Style (15th Edition), another other recommended by the
International Standards Organization (ISO), and a third recommended by the
Society of Biblical Literature (SBL). If you choose a variant form Cindex configures for you most of the other settings available through the panel.
Depending on the alphabetizing method you select, Cindex will disable various
other options in the box. The section “Modifying the Basic Alphabetizing
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Rules” on page 159 describes these options. Choose any options you want, then
click OK to sort the index.
While Cindex is re-sorting the index it displays an indication of progress. Nothing in the index is permanently changed by any type of sort. You can re-sort the
index at any time by any sort rule.
Working with Letter-byLetter and Word-byWord Alphabetizing

When an index is sorted by the letter-by-letter or word-by-word alphabetizing
rules, you can work with records in the usual way. When you add a record, or
change a record's alphabetical position by editing, Cindex places or replaces it
properly according to the sort rule in effect. You can undertake all your work
with the index sorted by the word-by-word or letter-by-letter alphabetizing rules,
but for the reasons discussed below you may prefer to use the simple alphabetical
sort.
If the index has been sorted by word-by-word or letter-by-letter rules, when you
seek records by typing leading text from the main heading Cindex applies the
sorting rules to the text you type before looking-up the record. It may therefore
not find records in quite the way you expect. Suppose you were using a letter-byletter sort and wanted to display a record beginning with
32–bit processors

If you typed\32 to show the entry in the main index window (you use the \
because Cindex otherwise interprets 32 as a record number) Cindex would not
find the record because the standard letter-by-letter sort rule ignores numerals,
spaces and hyphens. To find the record you could type bit.
In dealing with records that contain leading text that will be ignored by the sort
rule Cindex is using, always type enough of the heading to get past characters
that will be ignored.
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Modifying the Basic Alphabetizing Rules
The following paragraphs describe how you can modify the basic alphabetizing
rules that apply to all records. Not all options are available with each method of
alphabetizing.
Setting Precedence of
Letters, Numerals and
Symbols

For sorting purposes Cindex recognizes three classes of characters: letters, Arabic
numerals and symbols. Numerals and symbols are normally ignored, but if Cindex attends to them it normally treats all symbols as having higher precedence
than all numbers, and all numbers as having higher precedence than all letters.
You can specify a different precedence through the list labeled Character Priority.
Drag the item corresponding to a character class to the position you want it to
occupy in the list. The order in which these items appear in the list determines
the precedence of the classes they represent—the item at the top of the list has
the highest precedence.
When Cindex uses symbols in sorting entries, the standard ASCII symbols proceed in the following order:
!"#$%'()*+,-./:;<<=>>?@[\]^_`{|}~

Other symbols proceed in the order of their Unicode values.
Ignoring Leading Words
in Subheadings

You will usually want to ignore leading prepositions and articles when you alphabetize subheadings. Cindex maintains a list of words (mostly prepositions, conjunctions, and articles) that it will ignore when they begin subheadings. Cindex
ignores all words at the start of a subheading until it finds one that is not in its
list. For example, Cindex would alphabetize the subheadings in the following
entries under ‘depression’ and ‘television’.
Political campaigns
during the depression
before television
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To modify the set of leading words to be ignored, edit them in the box Ignore Subheading Prefixes. The words to be ignored can appear in any order. Leave a space
between adjacent words. Cindex disregards the case of the words to be ignored,
which may contain any mixture of upper- and lowercase characters.
NOTE: Cindex does not ignore leading words in subheadings when you use a simple
sort.

To alphabetize an exceptional subheading on a leading word that would normally be ignored, place a ~ (tilde) immediately before the first word of the subheading.
Treatment of
Punctuation

In standard letter-by-letter alphabetizing, punctuation marks following a word
or phrase have a higher precedence than any letter, so the following entries would
be alphabetized as shown:
Adolescent, physical examination
Adolescent parents

An increasingly common practice is to ignore punctuation entirely in letter-byletter alphabetizing. To do this, check Ignore .,:; under Exceptions.
In word-by-word alphabetizing Cindex normally treats the hyphen and slash as
spaces (they are always ignored in letter-by-letter alphabetizing) unless these are
the only characters that distinguish entries. You can make Cindex ignore the
hyphen and slash in word-by-word alphabetizing. To do this check Ignore -/.
NOTE: This option is available only when you use standard word-by-word alphabetizing.
Ignoring Parenthetical
Phrases

Cindex can ignore phrases in parentheses. To enable this, check Ignore Parenthetical Phrases. When this is checked, Cindex will attend to the text in parentheses if
that is all that distinguishes two entries.
If you want Cindex to ignore parenthetical endings only in particular entries, do
not check this box. Instead, enclose the parenthesized ending in angle brackets:
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< >. “Ignoring Specified Characters or Words” on page 162 provides more
information about the use of angle brackets to hide text for sorting purposes.
NOTE: This option is not available when you use a simple sort. It is always checked
when you use a variant form of letter-by-letter or word-by-word alphabetizing
Ignoring Parenthetical
Endings

You can set Cindex to ignore parenthetical endings to words. To do this, check
Ignore Parenthetical Endings.
NOTE: This option is not available when you use a simple sort.

Evaluating Numbers

Because Cindex normally ignores numerals in standard letter-by-letter and
word-by-word alphabetizing, it will usually arrange the following entries in this
order:
Regulation 2725–1(a)(6) cited in special report, 1082
Regulation 2725–1(a)(5) revised in supplement A2, 1082
Regulation 2725–2(a) examined in special report, 902
Regulation 2725–1(b), draft of, 1152

In cases like these you will probably want to evaluate numbers embedded in
entries, so that the entries are sorted by their leading letters, then (if the letters
are the same) by the values of any numbers they contain:
Regulation 2725–1(a)(5) revised in supplement A2, 1082
Regulation 2725–1(a)(6) cited in special report, 1082
Regulation 2725–1(b), draft of, 1152
Regulation 2725–2(a) examined in special report, 902

To make Cindex evaluate numbers that it would normally ignore check
Evaluate Numbers, under Exceptions. Cindex will then compare entries in the specified order (letter-by-letter or word-by-word) until it finds an Arabic numeral or
series of numerals, which it will evaluate as a number. If the entries being compared contain the same numbers, the comparison continues; if the numbers differ, Cindex will place the records in numerical order. If only one of the entries
contains a number it will normally be placed before the one without, although
you can make Cindex place it differently by changing the precedence of charac-
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ters, as described in “Setting Precedence of Letters, Numerals and Symbols” on
page 159.
NOTE: This option is not available when you use a simple sort. It is always checked
when you use a variant form of letter-by-letter or word-by-word alphabetizing.

OVERRIDING SORTING RULES FOR
INDIVIDUAL ENTRIES
You will sometimes want to make exceptions to the normal rules for alphabetizing. For example, you might want to ignore a Greek letter at the beginning of a
heading, or you might want an abbreviation to be treated as if it were spelled out.
This section describes how to make such exceptions for individual entries.
NOTE: The options described here apply only when you choose letter-by-letter or
word-by-word alphabetizing. Sorting rules cannot be overridden when you work with a
simple alphabetical sort.

Ignoring Specified Characters or Words
The following examples show how you can place entries correctly in the index by
making Cindex ignore words or parts of words in records.
Entries sometimes will contain words you want Cindex to ignore during alphabetizing. For example, you would probably want the following entries alphabetized by last name then first name, with the title ignored:
Hunter, Gregory, 59
Hunter, Stewart, 43
Hunter, Thomas, 22
Hunter, Major William, 83

To ensure that the title “Major” is ignored during alphabetizing, enclose it in
angle brackets:
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FIGURE 46.

Using < > to hide a word

NOTE: You can enclose selected text in angle brackets by clicking
entry window.

in the record-

Cindex ignores characters in angle brackets during sorting, unless these are the
only ones that distinguish entries. In that case the order of entries is determined
by the characters in the brackets. The angle brackets themselves do not appear in
the fully formatted display, though they do appear in the draft display.
NOTES: In word-by-word alphabetizing, Cindex attends to spaces and hyphens
between words. When you mark a word or passage of text to be ignored, you should
always include within the angle brackets any trailing space or hyphen, as in the example
in Figure 46. If you leave a trailing space outside the brackets you may find that your
entry is misplaced.
You may use angle brackets as often as you like in any field of a record.
Ignoring the Beginning
of an Entry

If you are working on a scientific index you might make an entry like this:
-Aminobutyric acid, 453

Such an entry would normally be alphabetized under “Aminobutyric acid”
rather than under the Greek letter . To make Cindex ignore the leading letter
and the following dash (which would normally be treated as a space in word-byword alphabetizing), place them in angle brackets, as in Figure 47.
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FIGURE 47.

Ignoring Page
References

Using < > to hide leading characters

If you enclose the whole of a locator field within angle brackets (< >) Cindex
will ignore all the references contained in it. This can be useful if you are preparing an index that is to be organized alphabetically by heading with subheadings
ordered by reference or date, except for certain classes of headings (e.g., Births,
Deaths) under which subheadings are to be ordered alphabetically. Use this
order of fields to specify the overall arrangement:

For the exceptional cases you can obtain the alphabetical order of subheadings by
hiding the complete contents of the locator field in < >.

Spelling-out Numbers, Symbols and Abbreviations
Entries that begin with numbers or symbols might need to be placed in the index
as if the numbers or names of symbols were spelled out. Similarly, entries that
contain abbreviations might need to be placed as if the abbreviations were
spelled-out.
Arabic numerals in headings and subheadings are normally ignored in both letter-by-letter and word-by-word alphabetizing. To place an entry that begins with
a number as if the number were spelled out, put the spelled-out form in braces
immediately before the heading, as shown in Figure 48.

164

CHAPTER 9 Sorting Entries

Overriding Sorting Rules for Individual Entries

FIGURE 48.

Using { } to force the sorting of an entry

NOTE: You can enclose selected text in braces by clicking
dow.

in the record-entry win-

Notice that there is no space between the closing brace and 1066. Cindex uses
the characters enclosed in braces to determine the alphabetical position of the
record, but hides them and the braces when it displays the fully-formatted index
(the braces and enclosed characters are visible in the draft view). You may use
text braces as often as you like in an entry.
You can use the same technique to alphabetize any symbol. For example, to
alphabetize the Greek letter (beta) at the beginning of an entry for –Thalassemia, you would place {beta} immediately before
Cindex attends to braces only when using letter-by-letter or word-by-word
alphabetizing. Cindex treats braces as ordinary characters when using a simple
sort.

Expanding Abbreviations and Unusual Spellings
To sort names beginning with Mc as Mac, or sort abbreviations as if they were
spelled out, insert the missing letter(s) in braces, for example:

CHAPTER 9 Sorting Entries

165

Overriding Sorting Rules for Individual Entries

FIGURE 49.

Using { } to expand a name for sorting

The entry would be alphabetized under MacDonald, but in the fully formatted
view would be displayed or printed as McDonald. If Cindex encounters both the
expanded abbreviation (Figure 49) and the fully spelled version in otherwise
identical entries, the full version will precede the abbreviated version.

Filing Entries under Symbols and Numbers
In letter-by-letter and word-by-word sorting Cindex normally ignores Arabic
numerals and symbols, so entries are filed under the first letter that appears in a
heading. Certain indexes may require entries beginning with symbols or numbers to be filed under the appropriate symbol or numeral. For example, in the
index to a book on computer programming entries might be filed under symbols
such as ^ and !. To make Cindex sort an entry on a character that would normally
be ignored place a ~ (tilde) immediately in front of the character, as shown in
Figure 50.

FIGURE 50.

ignored

Using ~ to force sorting on a character normally

You may use the ~ as often as you like anywhere in a record.
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When you place ~ before a digit (0-9), Cindex treats the digit as a character; it
does not evaluate a number comprised of a series of digits. If you wish, Cindex
will evaluate and sort numbers comprised of a series of digits. The section“Evaluating Numbers” on page 161 explains how to arrange this.
When Cindex attends to symbols or numerals in sorting entries, it normally files
symbols before numerals, which are filed before letters. You can change this
order if you prefer. The section “Setting Precedence of Letters, Numerals and
Symbols” on page 159 explains how.

Reserved Characters
Because the characters \ { } < > and ~ have special meanings for Cindex, they are
normally neither displayed in a fully formatted view nor evaluated in sorting a
record.
Even if a reserved character is preceded by \ to disable its special function (for
example \\) and allow Cindex to display it as a normal character, Cindex will not
attend to it in letter-by-letter or word-by-word alphabetizing entries (because the
special character is a punctuation mark). If you want Cindex not only to display
a reserved character but also to evaluate it during sorting, place a ~ before it. If
you enter ~\ in a record, Cindex treats \ as a literal character and sorts it by its
value. The same applies to ~< ~> ~{ ~} and ~~.
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A strength of Cindex is that you can form entries in records without being concerned with how they will look in the fully formatted copy—Cindex deals quite
separately with the content of an index and its appearance. As a result, you can at
any time change the way in which entries are arranged and displayed or printed.
This chapter describes how to control the overall layout of a document, and how
to control the style and format of individual index entries.
For detailed information on arranging and formatting cross-references, see “Placing and Formatting Cross-References” on page 119. For detailed information on
arranging and formatting page references, see “Formatting Page References” on
page 140.

MARGINS AND COLUMNS
To set the page margins and columns, choose Margins & Columns… from the Document menu. Cindex will display the dialog box shown in Figure 51.
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FIGURE 51.

Setting Margins and Columns

You can set margin widths and column spacing in inches, millimeters, points, or
picas. Choose the unit you want to work in from the Unit drop-down list. Cindex
will display all measures in the unit you choose.
To set margins, enter the sizes you require in the boxes marked Top, Bottom, Left,
and Right. If you check Facing Pages, Cindex uses inside and outside margins
rather than left and right margins when it prints even and odd-numbered pages.
To specify the number of columns (up to six), choose from the Columns dropdown list. In Gutter, set the space you wish to appear between columns.
NOTE: When you select more than one column, Cindex displays screen text in a column of the correct width, but does not show side-by-side columns. These appear only
on the printed page.

Cindex knows the paper size your printer is set to use (you specify that through
printer settings described in “Page Setup” on page 80) and uses this information,
together with the margin and column settings, to determine how much space to
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allow for each column. Cindex does not allow you to specify column width as a
fixed number of characters, because the column width does not correspond to a
fixed number of characters in a proportionally-spaced font. If your publisher
requires lines that contain a fixed number of characters, do the following:
1.

Display your index in a monospaced font at an appropriate size (10 point Courier
provides 12 characters per inch; 12 point provides 10 characters per inch).

2.

Calculate how wide each column of text should be to accommodate the required
number of characters at the point size you are using.

3.

Decide how much space you want to leave between each column (the “gutter”).

4.

Use the following formula to set the left and right (or inside and outside) margins:

Left Margin + Right Margin =
Page Width – #Columns x Column Width + (#Columns-1) x

Continuing Headings across Column and Page Breaks
When printing an index in the fully-formatted view only, Cindex can repeat at the
top of any new column or page the heading from any entry broken at the foot of
the previous column or page. When it repeats the broken heading Cindex can
append some phrase (such as “continued”) to indicate that the entry was broken.
Page and column breaks are not visible in the screen display, so Cindex does not
show on the screen any repeated headings from entries that will straddle a column or page break.
To make Cindex repeat at the start of a page any headings from entries broken at
the bottom of the previous page, click At New Page; to make Cindex repeat at the
top of a new column any heading from an entry broken at the foot of the preceding column or page, click At New Column.
Choose from the To Level drop-down list the lowest level of heading that you
want repeated after a break. For example, to have only main headings repeated,
but not subheadings, choose the first item.
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To make Cindex print some identifier after the repeated heading or subheading,
supply the text at Append. To specify the style in which the appended text should
be displayed (italic is the default) click Style… Cindex will display a dialog box
through which you can set the style and capitalization.

HEADERS AND FOOTERS
To specify the contents of headers and footers, choose Headers & Footers… from
the Document menu. Cindex will display the dialog box shown in Figure 52.

FIGURE 52.

Setting Headers and Footers

If you have chosen to format your index on facing pages with different inside and
outside margins (see page 170) Cindex provides separate headers and footers on
left- and right-hand printed pages. Your options will be Left Header, Left Footer,
Right Header, Right Footer. If you have not selected facing pages, Cindex provides a
single set of headers and footers for all pages.
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Each header or footer can have three segments (left, centered and right) and can
be printed in any font or type style you choose.
• At Left type the text you want to appear at the left side of the header/footer.
• At Center type any text you want centered.
• At Right type the text you want to appear at the right side of the header/footer.

In any of these fields you can use the following special characters to denote entities that Cindex will provide automatically when it prints pages:
• @ denotes the current date/time.
• # denotes the current page number.
• % denotes the name of the index.

To use @, # or % as a literal character in a header or footer field, place a \ immediately before the character (as in \@).
If you are using facing pages and want identical headers and identical footers on
odd and even pages, set up the header and footer for one page (odd or even) then
click « Copy » to transfer the settings to the other page. This button is available
only when your Margins & Columns… settings specify Facing Pages.
Setting the Font and
Style

To set the font in which the header/footer will be printed, choose from the Font
drop-down list. The first item in this list (<Default>) represents the standard
font in which the index is displayed (you specify that font by choosing from the
Font drop-down list in the toolbar).
To specify the size, chose from the Size drop-down list (or type in the box) the
size of text, in points. If you set 0, Cindex will print the header or footer in the
text size used for the body of the index.
To set the style in which the header/footer will be printed, click Style… Cindex
will display a dialog box through which you can specify the text style.
You can set a different font, size and style for each header and footer.
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Setting the Initial Page
Number and Format

If you have used # in a header or footer to specify automatic page-numbering,
Cindex will give the first page the number you set in First Page Number (by
default, 1). Choose the number format (Arabic or Roman numerals) from the
Number Format drop-down list.

Printing the Date and
Time

If you have used @ to represent a date, you can choose the format in which Cindex will print the date by clicking the appropriate button in the Date Format box.
To include the time with the date, check Add Time.
The Long and Short formats are the standard ones provided by Windows, and you
can customize these through the Date tab of your computer’s Region and Language
Settings Control Panel.

GROUPING ENTRIES
Alphabetical groups of index entries are often set off by titles (e.g., the leading
letters common to headings in the groups). When displaying or printing the
fully formatted index, Cindex can provide titles to groups of entries, and can
provide extra spacing between groups. Cindex does not display titles in any draft
view.
To provide titles to groups, choose Grouping Entries… from the Document menu.
Cindex will display the dialog box shown in Figure 53.
NOTE: The section “Line Spacing” on page 183 explains how to control the spacing
between groups.

At Text, enter any text you want to appear at the head of each group of entries (if
you supply no text, Cindex displays no title). Use the character %, on its own or
as part of a longer text sequence, to stand for the leading letter of the group of
headings. When Cindex displays the title it will replace the % with the appropriate letter or symbol.
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FIGURE 53.

Grouping formatted entries

Cindex treats each letter of the alphabet as belonging to a distinct group, but it
lets you choose how it groups entries beginning with numbers and symbols. In
the Group Numbers and Symbols box, choose from the Grouping Method drop-down
list the method you want it to use. In each item the square brackets [ … ] contain
the classes of leading characters that Cindex will include in a single group. For
example, the item [@] [#] [$] [%]… [1] [2] [3] [4]… indicates that each leading
symbol and each leading numeral forms a distinct group. The item
[@#$%1234…] indicates that all symbols and all numbers fall in a single group
(this is the setting Cindex uses when it is first installed).
Enter at All Numbers Title, All Symbols Title, and Numbers & Symbols Title any titles
Cindex should display above the generic numbers/symbols groups.
NOTE: To identify the group to which an entry belongs, Cindex uses the first character
that is not ignored in sorting. This need not be the first character in the entry (it will
usually not be the first character if the entry begins with a symbol or a numeral).
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To specify the font in which the title will be displayed or printed, choose from
the Font drop-down list. Choose <Default> to use the standard font in which
entries are displayed.
To specify a style in which the text should be displayed, click Style… Cindex will
display a dialog box through which you can specify the style in which the title is
to be displayed.

STYLE AND LAYOUT OF ENTRIES
Cindex keeps information about the contents of entries, held in records, quite
separate from information about the arrangement of entries and the index style
(indented or run-in). This makes it possible for Cindex to display the same index
entries in a variety of styles and layouts.
To specify the index style, choose Style & Layout… from the Document menu.
Cindex will display the dialog box shown in Figure 54

.
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FIGURE 54.

Setting Style and Layout

NOTE: With the exception of line spacing, the settings you make apply only when you
view the fully formatted index; other views use their own, fixed, settings.

Setting the Index Style
Cindex can display and print indexes in indented and run-in styles and in several
variants of these.
Entries formatted in run-in style look like this:
American frontier, 89-93; Oregon trail, 92
American Indians; art, 55; dance, 89
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Run-in style is not generally suitable for formatting entries that have sub-subheadings (although variants of it may be), and entries with several levels of heading are usually formatted in indented style:
American frontier, 89-93
Oregon trail, 92
American Indians
art, 55
jewelry, 57
masks, 60
dance, 89

To specify the basic index style, click Indented or Run-in. If you click Run-in, you
can also specify through the drop-down list the level of heading below which
you want headings run-in. The initial setting, which is standard, is to run-in all
levels below the main heading. The entries shown below are formatted with
headings run-in below the subheading:
American frontier, 89-93
Oregon trail, 92
American Indians
art, 55; jewelry, 57; masks, 60
dance, 89

For each major style, Cindex provides variants you can select through the Variant
drop-down list below the buttons.
Modified Run-in Style

178

If your index contains sub-subheadings as well as subheadings (which normally
precludes the use of the run-in style), you can make Cindex format entries so that
subheadings are run-in from headings, except when any subheading has a subsubheading beneath it, in which case all the subheadings under the relevant
heading are indented and sub-subheadings are run-in:
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American frontier, 89-93; Oregon trail, 92
American Indians
art, 55; jewelry, 57; masks, 60
dance, 89

To use this format, choose Indent Major Subheadings from the Variant dropdown list.
Modified Indented Style

Cindex provides two variants of the basic indented style.
1.

In the first variant, Cindex will modify the layout of any entry in which a subheading
(or sub-subheading) falls under a heading (or subheading) that contains no immediately following page reference. Cindex converts the subheading (or sub-subheading)
to a phrase that modifies the main heading (or subheading), as in this example, where
‘art’ is a subheading:
American frontier, 89-93
Oregon trail, 92
American Indians, art, 55
jewelry, 57
masks, 60
dance, 89
To set this style, choose Run-back Subheadings from the Variant drop-down list.

2.

In the second variant, Cindex prints every level of heading for each entry, (i.e., it does
not suppress repeated headings).
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American frontier, 89-93
American frontier
Oregon trail, 92
American Indians
art, 55
American Indians
art
jewelry, 57
American Indians
art
masks, 60
American Indians
dance, 89
To use this style, choose Repeat all Headings from the Variant drop-down list.
Custom Run-On
Headings

When you have chosen an indented style you can override the default layout on
an entry-by-entry basis, and force subheadings to be run-on from a particular
level. If the last character of any heading or subheading is a vertical bar (|), Cindex will format lower levels of heading run-on from that level. Cindex automatically substitutes the appropriate leading punctuation for the bar as it formats the
entry.

Collapsing Headings

If your entries contain multiple levels of heading, you can collapse heading levels
in the formatted index, so that, for example, all subheadings are hidden, and the
page references and cross-references that belong to them are merged with those
from the main heading. This can be especially useful if you have to shorten an
index by removing some low-level headings, but want to preserve their cross-references and page references.
To collapse headings choose from the Collapse Headings below drop-down list the
level of heading below which headings will be collapsed. When you collapse
entries, Cindex automatically suppresses “See” (but not “See also”) references
that originate from a heading level that is collapsed.
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NOTE: Cindex collapses headings only when displaying entries in the fully formatted
view. Collapsing headings merely alters the display of entries; it does nothing to the contents of index records.

Indentation
In an indented index each level of subentry is indented more than the level
above. In both indented and run-in styles an entry that occupies more than one
line is run over on a continuation line, suitably indented. The settings discussed
in this section allow you to organize the indentation of entries in virtually any
way you want. All these settings are made in the Indentation box.

The Type drop-down list provides four methods to control indentation:
• No indentation. Cindex provides no leading or runover indentation. Choose None to
suppress all indents.
• Incremental Indentation. Cindex indents the start of each subheading by a specified
amount that depends upon the subheading level; for any runover lines Cindex adds
an additional amount to the lead indent. You specify the runover indentation and the
lead for the first level of subheading, and Cindex calculates all other indents automatically. Choose Incremental to specify this method. This is the method Cindex
uses when it is first installed.
• Fixed Indentation. Cindex indents headings and runover lines by amounts that you
specify separately for each level of heading. This method provides the greatest control over indentation, but requires more settings than others. Choose Fixed to use
this method. If you choose fixed indentation Cindex displays a series of tabs, one for
each heading level in the index.
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• Incremental Indentation, with special indentation for the lowest level of heading in
an entry. This method is like standard incremental indentation, but the lowest level
of subheading in an entry (regardless of its actual level) has fixed lead and runover
indents. This method is designed for indexes in which the body of an entry must be
indented by a fixed amount regardless of its placement under a main heading or a
subheading:
NEOPLASMS
Data files now online from Cancer Data Center, Dec. p 12
Oncology Guidelines Report to appear in September issue, Aug p 5
Drug Therapy
Adjuvant pain treatment in cancer: a case for psychopharmacology,
Jun pp 60-65
Prevention & Control
Implications of allied health and nursing students' knowledge of
cancer prevention, Aug pp 63-65
State Cancer Plan designed to control cancer, Sep p 5

To use this method choose Special Last from the drop-down list.
Setting Indent Units and
Sizes

Cindex can form indents in absolute units (inches, centimeters, points or picas),
or in units based on the size of characters in the font in which the index is displayed. For font-based measurement, Cindex uses the em space (the width of the
capital letter M).
Choose from the Unit drop-down list the unit in which you want to specify
indents. When you change units Cindex converts the indents to the new unit.
Cindex is set initially to form automatic indents using em-space units, with the
leading indent for the first subheading set to 1 em space and the runover indent
set to 2.5 em spaces. Specify the lead and runover indents in the Lead and Runover
boxes. You can use fractional values for both the lead and runover indents.
When using Incremental indentation, you need specify only one lead indent and
one runover indent.
When using Fixed indentation, you should specify a lead and runover indent for
each level of heading that will appear in your index. Click the tab for the appropriate heading level, then set the lead and runover indents.

182

CHAPTER 10 Formatting the Index

Style and Layout of Entries

When using Special Last indentation, you must specify incremental indents that
will be used for all levels of heading except the last. You must also specify fixed
indents that will be used for the lowest-level headings.

Line Spacing
Cindex will display and print entries single spaced, double-spaced, or spaced one
and one-half lines apart, with the line space chosen automatically to suit the font
you are using, or fixed at some size you specify. Line spacing is controlled
through items in the Line Spacing box:

To specify the spacing of entries, choose Single, 1.5 Lines, or Double, from the
drop-down list.
To make Cindex space lines automatically at an interval appropriate for the font
you are using, check Auto (this is checked when Cindex is first installed). To
make Cindex space lines at a fixed interval, choose from the drop-down list the
unit in which you want to specify the space, then enter the value in the box. Cindex will uncheck Auto if the space differs from the space it would choose automatically. If you change the unit, Cindex displays the value of the line space in
the new unit.
When displaying fully formatted entries, Cindex can insert extra blank lines at
the transition from one main heading to the next, and at the transition between
alphabetical groups of entries. To insert extra lines between main headings, set
the number at Extra at Main Headings; to insert extra lines between alphabetical
groups of entries, set the number at Extra at Alphabetic Groups.
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Adjusting Punctuation
Cindex punctuates entries automatically as it formats them, for example placing
a comma or some other character between the text of an entry and a following
page reference.
Automatic punctuation might result in Cindex placing a period or a comma
immediately after text enclosed in quotation marks, or after some text printed in
italics or boldface, or in a special font. Good practice dictates that the period or
comma should fall inside any trailing quotation mark and should appear in the
same type style or font as the immediately preceding word. You can set Cindex
so that it will adjust punctuation appropriately around quotation marks or the
closing of a type style.
To make Cindex move trailing punctuation inside quotation marks (either punctuation it supplies automatically, or punctuation you have misplaced in an entry)
check Around Quotation Marks in the Style and Layout dialog box (Figure 54 on
page 177). When this is checked Cindex adjusts punctuation around a closing
quotation mark (' " ” or ’) when that is not preceded by punctuation, and when a
matching opening quotation mark is not preceded by a letter.
To make Cindex move trailing punctuation inside the closing of a type style (e.g.,
italics or boldface) or non-standard font, check Around Styled Text. When this
option is checked, Cindex will also automatically italicize parentheses or square
brackets that enclose a phrase that is fully italicized.

TYPOGRAPHY AND PUNCTUATION OF
HEADINGS
When displaying or printing a fully-formatted index, Cindex can show headings
and subheadings in any font and style you choose, and can provide custom punctuation for them. Cindex can also suppress the display of headings at specified
levels.
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To specify the font and/or style in which Cindex will display and print headings,
choose Headings… from the Document menu. Cindex will display the dialog box
shown in Figure 55.
NOTE: These settings apply only to entries displayed in the fully formatted view.
When displaying entries in other views, Cindex uses fixed, standard settings.

FIGURE 55.

Specifying heading formats

You can provide different settings for each level of heading in the index. Click
the tab for the level of heading for which you want to set a font and style.
NOTE: If the name of the field displayed in the tab has an asterisk beside it, this is a
required subheading field (see“Special Last Text Field” on page 215).

From the Font drop-down list choose the font. The first item in the list
(<Default>) stands for the standard font used in the main view. Cindex is initially set to use this font for all levels of heading.
To set the style or capitalization to be applied to the heading, click Style… Cindex will display a dialog box through which you can specify the style.
NOTE: The font and style settings you provide do not override any explicit font and
style settings in individual records (capitalization settings do override those in individual records).
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To specify a character or sequence of characters that Cindex will show as the prefix to any heading enter the text at Leading Text. The prefix appears immediately
after the first line indent, before the heading text.
To specify closing punctuation or other characters that Cindex will append to a
heading that has no immediately following page references or cross-references,
enter the text at Trailing Punctuation.
To suppress the display of the heading, check Suppress. Cindex will suppress the
heading and any below it, together any associated page references and cross-references.
NOTE: Suppressing a heading is not the same as collapsing headings (page 180). When
headings at or below a particular level are collapsed, all the page references and cross-references from these headings are displayed as if they belonged to the heading at the level
above.

Page References and Cross-References
Cindex can display page references and cross-references in a wide variety of formats. “Formatting Page References” on page 140, explains how to organize the
display of page references; “Placing and Formatting Cross-References” on
page 119, explains how to specify the display of cross-references.

Styling Text Automatically
Cindex can automatically apply designated type styles to specified words or
phrases that appear in an index. You can always apply a style explicitly to text in
individual records, but if you regularly use words or phrases that must be displayed in a particular style, you can save time and effort by entering them in
records in plain text, and allowing Cindex to apply the style automatically when
it displays or prints fully-formatted entries, in much the way it applies styles
automatically to cross-references or page references. When Cindex is first
installed it is set to italicize vs. and versus wherever they appear in formatted
entries.
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To review or modify the words and phrases to which Cindex should automatically apply a style, choose Styled Strings… from the Document menu. Cindex will
display the dialog box shown in Figure 56.

FIGURE 56.

Specifying automatically-styled character strings

The list shows words or phrases to which some style will or can be applied. To
review or change the styles to be applied to a particular word or phrase, click in
the list to highlight it. Double-click to edit it.
• To change the styles for the selected word or phrase, check or uncheck the appropriate boxes.
• To delete the selected word or phrase, click Delete.
• To add a new word or phrase to the list, click Add then type it in the text box that
Cindex opens in the list.

STYLE SHEETS
You can gather together and save in a “Style Sheet” the collection of settings that
together determine the layout of pages and index entries. You can later apply the
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style sheet to any index. You can keep different style sheets for different kinds of
indexes.
A style sheet includes these settings: Margins & Columns, Headers & Footers, Grouping Entries, Style & Layout, Headings, Cross-References, Page References and Styled
Strings. The style sheet also contains information about the standard (default)
font and size of text in which entries are displayed and printed.
To save a style sheet, choose Save Style Sheet… from the File menu, and give the
style sheet a name.
To recall a style sheet, choose Open… from the File menu, choose Style Sheets
from the Files of type drop-down list, then open the sheet you want.
NOTE: If you load a style sheet when no index is open for work, the settings in the style
sheet become the default ones that Cindex bestows on new indexes when you create
them.
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CHAPTER 11 Exchanging Documents
with Other Applications
While you work on an index Cindex keeps it in a private format, but it can save
the index in a variety of formats that other document-management systems
understand. The first part of this chapter describes the different formats in
which Cindex can export documents, and explains how to prepare them. These
documents fall into two broad classes:
• Documents that contain the index entries, plus information about the style of index
(for example, indented or run-in) and layout. Cindex includes in the documents the
information needed to produce an index that looks like the finished one you would
view on the screen. You would normally make this kind of document when sending
an index to a publisher for typesetting.
• Documents that contain the index entries, but no information about the index style
and layout. You would normally make this kind of document when preparing index
entries for a database.

Cindex can also include in an index entries prepared on other document systems.
The second part of this chapter describes the forms in which Cindex can import
entries, and explains how you can incorporate in an index records that have been
prepared elsewhere.

SAVING FORMATTED INDEXES
When Cindex prepares an index as a document for a typesetting system or a
word-processor, it always formats entries as they would appear in a fully formatted view (even if the current view is set to some draft format). Cindex includes in
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the document most of the information needed to make the index look like it did
when viewed as a fully-formatted index on the screen.
Since Cindex does not know about the page size used that will be used by the
recipient system, nor does it know about the page numbering, or running heads,
etc., it does not include information about settings related to page size, margins
and columns, or headers and footers, nor does it include line-breaks for runover
lines. Since there are no page or column breaks in the document, it contains no
repeated headings of the kind Cindex might otherwise print at the top of a new
page or column.
Entity Tags or Styles

For most publishing and word-processing programs the basic unit of text is the
“paragraph”—a block of words terminated by a special character (often a carriage-return) and occupying one or several lines. All the information about how
the paragraph is to be printed (typeface, size, indentation, line spacing, etc.) is
represented by a ‘tag,’ ‘style’ or ‘markup’ identifier that is attached to the paragraph. By changing the formatting information associated with a tag, you change
the formatting of all paragraphs that carry that tag. In the context of producing
an index with Cindex, think of each level of heading in the formatted copy as a
paragraph of a different type.
When Cindex produces a document for another system, it attaches tags to main
headings, subheadings, etc., and also includes in most documents information
about the attributes associated with each of these tagged entities (for example,
the font and size in which it is to be displayed). Some document formats such as
XML identify only the entities in the index-- headings, subheadings, page-references, cross-references, etc., leaving the appearance of these entities to be determined by the document systems that will format the index.

Document Formats
Rich Text Format (RTF)
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RTF is an interchange format widely-used for text documents on Windows and
Macintosh. RTF documents can be read by word-processors and by most document publishing systems. Each level of index heading in the RTF document has a
unique ‘style’ attached to it. Cindex sets the initial properties of the document
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and its styles to reflect the settings you have given the index (number of columns,
indentations of headings and runover lines, etc.), so that when the document is
imported into a word-processor or page-layout program it will look much like it
did when displayed by Cindex. The appearance of the index can be changed
within a word-processor or page-layout program simply by re-defining the attributes of the styles associated with different levels of heading.
QuarkXPress /
Adobe InDesign
Tagged Text

QuarkXPress and InDesign are publishing programs available for both Windows and Macintosh. Each uses its own of system of tags to identify styles that
belong to different elements of a document. Cindex can save a formatted index
as a tagged document in QuarkXPress or InDesign format. Each level of heading
has a unique ‘style’ attached to it, and carries the attributes that belong to that
heading. These attributes can be changed in QuarkXPress or InDesign.

Tagged Text Documents

Many typesetting systems work with documents in which the elements (such as
headings and subheadings) carry identifying tags. The tags contain information
about document structure, but little or no information about the attributes associated with tags, so they say little about the document's final appearance. Instead,
the final appearance depends on the attributes that the typesetter assigns to the
tags.
Cindex comes equipped to make documents that are marked up using conventions derived from the Standard Generalized Markup Language (SGML) standard for constructing markup languages. Notably, Cindex provides for marking
up using XML (Extensible Markup Language). XML is designed to handle Unicode text and is syntactically strict. Cindex also provides for markup using conventions such as HTML, and those recommended by the Association of
American Publishers (AAP) and the University of Chicago Press (UCP). You
can define your own sets of tags to suit your needs.
Cindex provides for you to define your own sets of markup tags to suit your
needs. The later section “Managing Markup Tags” on page 194 explains how to
do this.

Plain Text Documents

You may encounter rare situations in which you have to prepare an index for a
document-processing system that does not require, or cannot interpret, informaCHAPTER 11 Exchanging Documents with Other Applications
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tion about format tags and their attributes. In such cases you can save an index as
a plain text document, with entries formatted as you would view them on the
screen, but containing no information about fonts or type styles.
When you save a plain text document, Cindex does not break long entries into
multiple runover lines, instead leaving it up to the application program that reads
the document to decide where to break lines.
For maximum compatibility with other application programs, Cindex by default
writes plain text documents using Windows ANSI character encoding. This
encoding cannot represent all Unicode characters, and may lose information.
Cindex also can export plain text documents using UTF-8 (Unicode) encoding.
To specify the encoding, choose Preferences… from the Edit menu, click the Formatted Export tab, then click your choice at Encode Plain Text Documents.

Saving the Index
To save an index as formatted document, choose Save As… from the File menu.
From the Save as type drop-down list choose the type of document you want to
make. The list shows all types Cindex can make. Choose from among the following types of formatted document. Other document types at the top of the list are
discussed later.
• Plain Text
• Rich Text Format
• QuarkXPress
• InDesign
• XML Tagged Text
• SGML Tagged Text

When Cindex saves an XML or SGML document, it marks up the document
using tags from a set you have previously specified. See the later section “Managing Markup Tags” on page 194 for more information.
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Choose a document type, set the name of the document, then click OK to save
the document. Cindex automatically provides the appropriate filename extension when it saves the file. Cindex always saves a fully-formatted index, regardless
of the view (draft or formatted) you are currently using. Cindex normally saves
all of the index that is accessible in the current view (either all records, or a
group). To include only a part of the index in the document, see the next section.
Making a Document
from Part of an Index

To save only a part of the formatted index in a document, click Options before you
save the file. Cindex will display the dialog box shown in Figure 57.

FIGURE 57.

Options for saving a formatted index

• To include only records you have selected, click Selection (this is dimmed if no records
are selected).
• To include records that would fall on specified pages (for your current page setup)
click Pages, and set at From and to the range of pages you want to include. Cindex will
include only entries that would fall on the specified pages, were they being printed.
• To include a range of records, click Records, and specify the starting and ending
records in the boxes beside From and to. You can specify a range of headings by entering leading text, e.g., Abr through Doc. You can also specify a range of record numbers (e.g., 55 through 79). To include entries under specified headings, you need only
provide as much of the beginning text as will identify a record uniquely. You can
specify leading text from a subheading by appending a semicolon to the heading text
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then adding subheading text. To specify a heading that begins with digits, place a \
before the first numeral; Cindex will otherwise interpret leading digits as a record
number.
If you omit the first part of the range Cindex will include entries from the head of the
index until it finds a record that matches the end of the range. If you omit the end
part of the range, Cindex will include entries from the starting record until it reaches
the foot of the index. Cindex dims OK if you have clicked a range of records but have
specified neither a beginning nor an ending record.
NOTE: Before including a range of records, Cindex checks that the last record in the
range appears after the first. If the last record appears before the first, Cindex will display a warning message.
Defining Subheading
Indentation

When saving documents in Rich Text Format, or in the formats required by
QuarkXPress or InDesign, Cindex can define leading indents to subheadings in
one of several ways. You can choose to have indents defined as an attribute of the
style attached to the subheading, by using ‘tab’ characters (one for each level of
subheading), or by using a character of your choice (one for each level of subheading).
The method Cindex uses by default is determined by your Preferences settings.
To set the default, choose Preferences… from the Edit menu, then click the Formatted Export tab. Click the appropriate button beside Define Indent by. When
you save the formatted index, you can override the default setting via Save As…
options (Figure 57 on page 193).
NOTE: When styles are used to define the attributes of headings and subheadings,
Cindex gives the styles the names you have assigned to different levels of heading (Main,
Sub 1, etc.). For information on how to set these names see “Specifying Field Names,
Sizes and Contents” on page 216.

MANAGING MARKUP TAGS
Cindex provides ready-made sets of tags for marking-up XML documents and
SGML documents. You can also design your own sets of tags to meet needs of
particular publishers. Tag sets are available for markup when you choose Save
As… from the File menu.
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Tags identify various elements of the index, but do not describe its appearance:
• Structure tags define the overall structure of the index, and identify levels of heading
and subheading, and page references and cross-references.
• Style tags identify parts of the index that should be displayed in a particular style
(e.g., boldface).
• Font tags identify parts of the index that should be displayed in a particular font.
• Special tags identify miscellaneous entities.

To create, modify or review sets of tags choose Markup Tags… from the Tools
menu. Cindex will display a dialog box (Figure 58) through which you can
define (or edit) tags that will denote various entities in the formatted index.

FIGURE 58.

Managing tag sets

Click the XML tab to work with tag sets for XML markup; click the SGML tab
to work with tag sets for less strict SGML markup. The drop-down list on the
tab shows all the available tag sets of the type you have chosen (XML or SGML).
If the tag set is built-in to Cindex, you can view it (the right most button will be
labeled View…) but you cannot edit or delete it. If the tag set is one you have created, you can edit or delete it.
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NOTE: The tag set named in the drop-down list on the XML tab or the SGML tab is
the one that Cindex will use to mark up the formatted index when you choose Save As…
from the File menu and select XML Tagged Text or SGML Tagged Text.

To view or edit an existing tag set, choose it from the drop-down list then click
View… or Edit…. To duplicate the tag set as the foundation for another, click
Duplicate…; to start a new tag set, click New…. Cindex will ask you to name the
tag set; the name you provide is the one you will use to invoke that tag set when
you save indexes as tagged text files. The name may contain any character permissible in a filename, but may not begin with $. To delete the tag set, click
Delete…

XML Tags
XML (Extensible Markup Language) is designed to handle Unicode text and is
syntactically strict. When you export an index as an XML document, Cindex
uses Unicode (UTF-8) to encode characters.
When you open a set of XML tags, Cindex displays the panel shown in
Figure 59.
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FIGURE 59.

Structure Tags

Panel for editing XML Tags

These identify the different structural elements of an index. Cindex provides
tags to denote the start and end of the index (Index), tags to denote the start and
end of an alphabetical group of records (Group), and tags to denote the start and
end of the title to a group of records (Heading). Additional tags identify the
beginning and end of each level of heading, the beginning and end of a page reference, and the beginning and end of a cross-reference.
CHAPTER 11 Exchanging Documents with Other Applications
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NOTES: Tag names should consist of plain ASCII characters. They should not contain accented letters or non-ASCII symbols.
A tag name may not contain any of these characters: < > & ' "
You define only start tags; Cindex automatically creates counterpart end tags.

You can configure particulars of the markup:
• Check Identify Level with Attribute to make Cindex add to each Level tag an attribute
that identifies the heading level with a number (0 for Level 0, etc.).
• Check Nest Subheadings to make Cindex nest each level of subheading hierarchically
under the level above.
• Check Tag Individual References to make Cindex apply the page reference tag or the
cross-reference tag to each reference separately, rather than to the group of references
in an entry.
• Check Suppress Leading and Trailing Text in References to make Cindex suppress the
leading and trailing punctuation that it would normally place before and after page
references and cross-references.
Style Tags

Style tags identify type styles, such as italic and boldface. Cindex will embed
style tags in the document where the index contains styled text. If you define a
tag for Bold Italic, Cindex will use that whenever it encounters a part of an entry
that carries both bold and italics styles. If the tag is empty, Cindex applies tags for
the separate Boldface and Italic attributes.

Font Tags

Font tags are used to denote changes of font. The first tag in the set denotes the
standard font in which the index is displayed in the main document window. Use
this tag to identify the concept of a default font, not a particular font. Cindex
embeds a tag for this font only when the current font reverts to the default font
after having been explicitly set to some other one.
When Cindex emits a tag to identify a font, it can emit the unadorned tag, or
can add an attribute that identifies the font, either numerically, or by name. To
make Cindex add the identifying attribute click ID (for numerical identifier) or
Name (for the name of the font).
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SGML Tags
To examine or modify tags, click the SGML tab, then choose the set from the
drop-down list. If you have chosen one of the standard tag sets provided with
Cindex (identified by a name beginning with $) click View to examine it. Otherwise click Edit to examine or modify it. Cindex will display the dialog box shown
in Figure 60.

FIGURE 60.

Panel for Editing SGML Tags
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Structure Tags

These identify the different structural elements of an index. Cindex provides
tags to denote the start and end of the index (Index), tags to denote the start and
end of an alphabetical group of records (Group), and tags to denote the start and
end of the title to a group of records (Heading). Additional tags identify the
beginning and end of each level of heading, the beginning and end of a page reference, and the beginning and end of a cross-reference.
NOTES: Tag names should consist of plain ASCII characters. They should not contain accented letters or non-ASCII symbols.
A tag name may not contain any of these characters: & ' "

You can configure particulars of the markup:
• Check Nest Subheadings to make Cindex nest subheadings hierarchically under headings.
• Check Tag Individual References to make Cindex apply the page reference tag or the
cross-reference tag to each reference separately, rather than to the group of references
in an entry.
• Check Suppress Leading and Trailing Text in References to make Cindex suppress production of the leading and trailing punctuation that it would normally place before and
after page references and cross-references.
Style Tags

Style tags identify type styles, such as italic and boldface. Cindex will embed
style tags in the document where the index contains styled text. Most markup
systems require tags to define both the beginning and the end of a run of text in a
particular style, but in some cases (for example, the AAP tags for superscript and
subscript) there is no ‘off ’ tag, and the ‘on’ tag is presumed to apply only to the
immediately following character.
If you define a tag for Bold Italic, Cindex will use that whenever it encounters a
part of an entry that carries both bold and italics styles. If the tag is empty, Cindex applies tags for the separate Boldface and Italic attributes.

Font Tags
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Font tags are used to denote changes of font. The first tag in the set denotes the
standard font in which the index is displayed in the main document window. Use
this tag to identify the concept of a default font, not a particular font. Cindex
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embeds a tag for this font only when the current font reverts to the default font
after having been explicitly set to some other one.
NOTE: the font that is represented by particular tags will vary from index to index,
depending on your font usage. For more information about fonts see “Managing Fonts”
on page 217.
Special Tags

These tags represent miscellaneous entities that might need to be encoded in a
marked-up document.
Tags usually begin and/or end with special characters that cannot themselves be
used as ordinary characters (for example, < and > are used to open and close a tag
in several tagging schemes). To use < or > as a literal character you would therefore have to define a tag to represent it. You can define up to eight tags that each
represent a character that needs special treatment.
Under Special Characters enter in a left-hand cell a single ordinary character that
needs to be represented by a tag when it is used literally in the index; in the righthand cell enter the tag that will represent it. Cindex will embed this tag in the
document whenever it encounters the special character in the index.
Under Non-ASCII Characters specify how Cindex should encode non-ASCII characters such as accented letters. Cindex encodes a character’s Unicode value
numerically, in either decimal or hexadecimal notation, preceded by the text you
specify for Prefix and succeeded by the text you specify for Suffix.
When producing a tagged index, Cindex treats each index entry as a paragraph,
and terminates it with the standard character that represents the end of a paragraph. If your publisher requires a special end-of-paragraph tag to be emitted
before the standard character, provide it at End Paragraph.
Cindex does not currently use the tag for End Line.
If your chosen index format specifies right-justified page-references, Cindex normally inserts a tab character in a tagged index to separate page references from
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their entry. If your tagging scheme requires the tab character to be represented by
a tag, provide the text at Tab.
Special Tagging
Information

At File Type enter the characters (up to three) that Cindex will use as the filename
extension that identifies the type of file made when this set of tags is used in
markup. If this is blank Cindex will automatically supply the filename extension
‘tag’ when it makes the file.

DIRECT TRANSFER OF INDEX ENTRIES
Copying and Dragging Formatted Entries
When you are viewing the fully formatted index, you can select and copy (or
drag) a collection of entries into any open document window of a word-processing program.
Entries that you copy or drag carry style and format attributes, and will appear as
they do when formatted by Cindex, providing the application program that
receives the entries can display text in different fonts and styles.

Embedding Entries in Other Documents
Cindex can directly embed index entries in Microsoft Word documents or documents from any other word-processor that uses the standard Rich Text Format
(RTF) definitions of index entries. When you view an index in draft view, and
drag (or copy) entries into a word-processor document, Cindex prepares them as
RTF index entries for direct embedding in the word-processor document. The
following notes describe the entries that Cindex prepares, and assume that you
are broadly familiar with the way in which Microsoft Word and similar wordprocessing programs handle embedded index entries.
Entries embedded by Cindex have the following properties:
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1.

They carry no page references (which will be supplied by Microsoft Word, or whatever word-processor you are using), but they do carry information about how the
page references should be formatted (as boldface or italic, etc.—make these settings
by choosing Page References… from the Document menu). For your own purposes
you can place page references in the locator fields of records, but Cindex will not
transfer them during embedding.

2.

If the locator field contains the character you use to define a range of pages, either
alone or as part of a real page reference, the embedded index entry will refer to a fictitious bookmark ("$$$") that you should later replace with a real bookmark to indicate the range of text that should be represented by the page range in the index entry.

3.

The embedded index entries carry any cross-references from the locator fields of
records. These will be formatted in the style you have previously specified by choosing Cross-References… from the Document menu.

4.

Each heading in the index entry normally carries a sort key that is used by the recipient program when it arranges the entries in the formatted index. Cindex constructs
this sort key (which will not appear in the formatted index) according to the sort
rules you have specified for the index. To take maximum advantage of Cindex’s powerful alphabetizing capabilities, you should ensure that index entries are sorted as you
would wish them to appear, before you embed them.
You can omit the sort key, and let the recipient program arrange entries by its own
alphabetizing rules. To do this choose Preferences… (Edit menu) and under the Formatted Export tab uncheck Include Sorting Information when Embedding Entries.
NOTES: Cindex formats embedded entries as hidden text. If you want to see the text
that has been embedded be sure to set your word-processor to show hidden text.
Cindex formats entries for embedding only when the view is set for draft format. If the
view is set to display a fully formatted index, Cindex will format entries in exactly the
way they appear on the screen.

SAVING INDEX RECORDS
Cindex can save documents that contain just the contents of index records
(without information about the style or layout of the index). To save index
records, choose Save To… from the File menu then from the File Format pop-up
menu choose one of the document formats described in the next section.
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Document Format
XML Records

Cindex can export index records as tagged entities in XML documents—plain
text documents that can represent all Unicode characters. This is the recommended format for interchange with other software. Tags identify key elements
of records, such as required last text fields, and locator fields, and the fonts and
text styles used in records.
NOTE: Before saving XML Records, Cindex checks the index for records that contain
mismatched < > or mismatched { } within a field. If any records contain mismatched
< > or { }, Cindex will warn you and will display the records in a group. You will need to
correct the mismatches before you can export the records.

Cindex Archive

A Cindex Archive is a document in a private format that contains index records
(including information about fonts and styles used in entries) but no information about how entries are to be sorted or laid out. Archives are readable by all
versions of Cindex, but cannot represent all Unicode characters, so you should
use them only when you must export records for use by Cindex version 2 (Mac
or Windows).
NOTE: Index documents made by Cindex 3 (those with the .ucdx filename extension)
are fully interchangeable between Cindex for Mac and Cindex for Windows.

Tab-Delimited Text

Cindex can save the text of index records (the contents of the record fields,
including the locator field) in a form that is widely used by database management programs. In this form all the fields of an index record lie on a single line,
each field being separated from the next by a ‘tab’ character. When imported into
a database program, each field in the index record will occupy a different field in
the database.
The saved document contains only plain text; Cindex saves no font and style
information, nor does it save any information about the layout of entries in the
finished index. Cindex does not export text in { } used to control sorting, nor
does it export any of the characters { } < > ~ \ unless they have been used literally
in records.
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Cindex by default uses UTF-8 (Unicode) character encoding. You can change
the encoding to the Windows ANSI character set via Options… when the Save
As… panel is displayed.

Options for Saving Records
Cindex lets you control aspects of how records are saved in documents. To
review and set options, click Options… in the Save panel before you save the
records. Cindex will display the panel shown in Figure 61 (options will vary with
the particular document type you are saving).

FIGURE 61.

Saving Records from
Part of an Index

Options for saving index records

To include only records you have selected, click Selected Records (this is dimmed
if no records are selected).
To include a range of records in the view, specify the starting and ending records
in the boxes beside From and To. You can specify a range of headings by entering
leading text, e.g., Abr through Doc. You can also specify a range of record numbers (e.g., 55 through 79). To include specified headings, you need only provide
as much of the beginning text as will identify a record uniquely. You can specify
leading text from a subheading by appending a semicolon to the heading text
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then adding subheading text. To specify a heading that begins with digits, place a
\ before the first numeral; Cindex will otherwise interpret leading digits as a
record number.
If you omit the start of the range Cindex will include entries from the head of the
index until it finds a record that matches the end of the range. If you omit the
end of the range, Cindex will include entries from the starting record until it
reaches the foot of the index.
NOTE: Before including a range of records, Cindex checks that the last record in the
range appears after the first. If the last record appears before the first, Cindex will display a warning message.
Saving Deleted Records

When saving records, Cindex does not normally include deleted records. If you
want these included in the document, check Include Deleted Records.
NOTE: When you save tab-delimited text, records contain no indication that they
were deleted.

Writing Order

When Cindex exports records, it can save them in the order in which they are
displayed in the main view window, or in record number order. The default for
XML records and archives is to write in record number order; the default for
tab-delimited text is to write in sorted order. To specify the order, check or
uncheck Write in Record Number Order.

Character Encoding

When you save records as plain text Cindex can encode the characters using Unicode (UTF-8) or the Windows ANSI character set. The default is UTF-8. To
specify the encoding, choose UTF-8 Encoding or ANSI Encoding.

Saving Records with a
Minimum Number of
Fields

When you save records as plain text Cindex can format them so that each contains at least a specified minimum number of fields. To set a minimum, type it at
Minimum Number of Fields. If a record contains fewer than this number Cindex
will write extra blank fields before the locator field. To specify no minimum, set
0.
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IMPORTING RECORDS
Cindex can import records in XML format (XML Records) and in archive format (Cindex Archive). Cindex can also import records in formats used by other
programs:
• Plain text records, from a word-processing program, text editor, or database program.
• Records from the indexing programs SKY Index.
• Records from the index program Macrex.
• Records from the legacy program Cindex for DOS.

XML Records and Archives
You can add the contents of an XML record document or an archive to an existing index, or you can create a new index from it. To add the contents of the
archive to an existing index, choose Import… from the File menu, then select the
document you want to import.
To create a new index from XML records or an archive, choose Open… from the
File menu, then select the document by name from the displayed list.
NOTE: You can open an XML record document or an archive from Windows Explorer
(and start Cindex if necessary), by double-clicking the document’s icon.

If no index with the name of the XML document or archive exists in the folder
that contains it, Cindex will automatically create a new index with the name of
the document and will import the records. If an index with the name of the document already exists, Cindex will present a panel through which you should
choose a new name and location for the index to be created.
When Cindex opens an XML record document or archive, it checks to see that
the fonts used by entries are available on your computer. If any font is unavailable, Cindex will ask you to designate a substitute. For more information on font
management, see “Managing Fonts” on page 217
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Other Import Formats
Records from a
Database

Cindex can import index records from plain text documents that have the filename extension ‘.txt’.
Records must conform to a simple specification: each record must be contained
in a single paragraph terminated by a carriage-return character, or a line-feed
character, or a carriage-return/line-feed character pair. The fields of the record
must be separated from each other by a ‘tab’ character, and the locator field,
which contains page references or cross-references, must be the last field. Such a
record might look like this when displayed by a word-processor.
Main heading

subheading

sub-subheading

1-3,15-17f

Cindex assumes that the last field in any record is the locator field, so you should
ensure that any record that has no locator (page reference or cross-reference) has
a blank last field (i.e., one with nothing after the last tab character). You need not
include empty fields between headings and the locator field: if you import
records into an index in which records have a fixed number of fields, Cindex will
automatically add empty fields when necessary.
If you are preparing records in a word-processor, you should make each record a
separate paragraph. It will generally not matter that long records are wrapped on
to two or more lines. Most word-processors provide an option to save a document as “plain text without line breaks.” You should save the records in this format.
Each record can contain up to fifteen tab-separated fields that hold the text of
headings, plus a field that contains the locator.
When Cindex imports the records it checks whether the file starts with the special sequence of characters that indicate UTF-8 (Unicode) encoding. If Cindex
finds the special characters, it imports the text as UTF-8; otherwise it assumes
that text is encoded using the Windows ANSI character set.
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When Cindex imports plain text records, it places a \ before any of the characters that have special functions ({ } < > ~ \) to ensure that they are treated as literal characters (e.g., { becomes \{ in the Cindex record).
Records from SKY Index

Cindex can import records in the tab-delimited format used by Sky Index 7 (filename extension .sky7) or the comma-delimited quoted format used by Sky Index
6 (filename extension .txt—Cindex will detect this format by examining the
contents of the document).
As Cindex imports records it captures bold, italic, underline, small caps, subscript and superscript styles (for Sky Index 7 it translates any strikeout text style
to small caps). Cindex also translates the following attributes:
• Text to be ignored in sorting entries is enclosed in <…>.
• Text to be used in sorting entries but to be hidden in a formatted display is enclosed
in {…}.
• 'Note' text is enclosed in <{…}>.

Sky Index records may use up to three alternative fonts (two for Sky 6), but the
exported document contains no information about what these fonts are. If the
records use alternative fonts, Cindex assumes the Sky Index default assignments:
• Alternative Font 1: Symbol
• Alternative Font 2: Courier New
• Alternative Font 3: Times New Roman

Characters in Alternative Font 1 (Symbol) are converted to their Unicode equivalents.
Records from Macrex

Cindex can import records that have been saved by Macrex in its backup format
(filename extension .mbk). These records contain some information about text
styles, and information about how records should be sorted.
The backup format used by Macrex does not unambiguously distinguish locators
and the body of an index entry: commas can separate different levels of headings
and can separate locators from headings and from each other. When Cindex
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imports Macrex records, it resolves this ambiguity by looking for the first number after which there are no more letters, or only letters contained in braces { }.
It places this number and everything that follows it in the locator field of the
Cindex record.
When you have read your records into a Cindex index, you will be able to
remove some of the notations required by Macrex:
• Cindex automatically ignores leading numerals in a record during alphabetizing, so
you can remove any braces (which Cindex will have translated to < >) that you have
used to hide numerals from Macrex.
• Macrex requires cross-references entered as subheadings to have the sequence ~zzz~
(which Cindex translates to {zzz}) immediately in front of them to ensure their
proper placement. You should remove the {zzz}, because they will interfere with Cindex's capacity to recognize and sort cross-references.
• Cindex will automatically apply a chosen style to See and See also, so you can remove
any styles applied to these words.
Records from Cindex for
DOS

You can import index records prepared using the legacy program Cindex for
DOS and saved in its backup format (filename extension ‘.dat’). Records contain
information about text styles and other special attributes of entries that control
how they should be sorted.

Reading Records
To import records choose Import… from the File menu. Cindex will display a
panel through which you can choose the document. File types that Cindex does
not recognize are dimmed.
When importing records made by SKY Index, Macrex, or Cindex for DOS, Cindex interprets information about text styles and other special attributes of
entries. Cindex also translates characters to Unicode, where appropriate.
Checking the Records

Before importing records, Cindex examines the document to check the following:
• Will new records fit within the current record size?

210

CHAPTER 11 Exchanging Documents with Other Applications

Importing Records

• Does any record have more fields than Cindex can accommodate?
• Does any new record contain unacceptable characters?
• Is any record badly-formed (for example, does it lack a delimiter)?

If Cindex detects that some new records are longer than the current record size,
it will ask if you want to increase the record size. Click OK to let Cindex enlarge
the record size then import the records.
If Cindex detects that some new records require more levels of headings than are
permitted in the index, it will ask if you want to increase the maximum number
of heading levels. Click OK to let Cindex increase the permitted number of fields
then import the records.
If Cindex finds any other problem it will warn you that the document contains
bad records, and will provide you the option to read the document anyway,
ignoring any bad records it contains. If you click Cancel, Cindex will stop the
operation and display a window that provides information about what was
wrong with the records it was trying to import. Each line in the window identifies an error, and shows the line number in the document being read and the type
of problem.
Cindex accumulates information on up to 200 errors. If the document being
read contains more than this number of errors, the most likely cause is that the
document does not contain records, or that records are not in the format Cindex
expects.
When Cindex reads records containing characters that might require translation
it will alert you if any record contains unknown characters. When Cindex
encounters a character it cannot translate, it substitutes the unknown character
symbol ( ). Cindex marks any records that contains untranslatable characters;
you can find these by choosing Find from the Edit menu.
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CHAPTER 12 Managing Index
Documents
This chapter describes some general tools that Cindex provides to help you manage and obtain information about Cindex documents. It also describes techniques for combining indexes to multiple volumes and for breaking indexes into
parts for spinoff volumes.

SPECIFYING THE STRUCTURE OF RECORDS
You can specify several aspects of the structure and organization of index
records. For example, you can use any names you want for the different fields in
records, and you can specify limits on the number and kinds of characters that
can be contained in fields. Cindex provides default settings when you begin a
new index, but you can change these at any time.
To change the structure of index records, choose Record Structure… from the
Document menu. Cindex will display the dialog box shown in Figure 62.
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FIGURE 62.

Setting Record Structure

NOTE: When you start a new index with New… from the File menu, you can click
Options… to display and change the structure settings before the index is created.

Changing Record Size
To change the maximum number of characters that a record can contain, set
Maximum Characters in Record. You can enter any number up to 2000 (Cindex will
round the number if it is odd), as long as it is not less than the number of characters in the longest record currently in the index. If the index contains any records
Cindex displays that number in the box to the right.

Changing the Number of Fields
A record must contain at least two fields (a heading field and a locator field), and
may contain up to sixteen. By default, Cindex allows records to have variable
numbers of fields up to five, and adds or removes fields automatically as you
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enter text in records. You can set minimum and maximum numbers of fields that
records may contain.
To set the maximum number of fields, choose from the Max drop-down list.
(Cindex does not display numbers smaller than the number of fields in the
record that contains the most fields.)
To set the minimum number of fields, choose from the Min drop-down list. If
you change the minimum number for an index that contains records, Cindex
will examine all records, adjusting the number of fields if necessary.
If you set the minimum and maximum to be the same, records will contain a
fixed number of fields.
Special Last Text Field

You can arrange that each record will contain a special subheading field that
immediately precedes the locator field. Other subheadings will always be placed
above this special field, which cannot be split or separated from the locator field.
You might use this special field to store a comment or a URL, etc. To enable this
attribute of the last text field, check Subhead Preceding Locator is Required. (This is
dimmed unless you have specified that the records have at least 3 fields.) At your
option Cindex can ignore the special last field when sorting records (see “Ignoring the Lowest-Level Subheading” on page 152) and can hide it when it displays
a formatted index (see “Typography and Punctuation of Headings” on
page 184).
When you set properties of record fields (below), or specify the formatting of
headings (via Headings… in the Document menu) Cindex will identify the special subheading level by displaying an asterisk (*) beside its name.
When exporting a formatted index in a file, Cindex treats the special heading as
though it were at the deepest level permitted in the index, and applies the formatting associated with that level.
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Specifying Field Names, Sizes and Contents
You can provide a name for each field in a record. Cindex displays field names in
various drop-down lists and in the record window. You can also specify the maximum and minimum number of characters each field may contain, and a template that its contents must match before Cindex will save the record in the
index.
Click the tab corresponding to the field you want to work with (First for main
heading, Second for subheading, etc. The last tab is always reserved for locators.)
• To change the field name type a name in the Field Name box.
• To specify a minimum number of characters the field must contain, enter the number
in the Minimum Chars box. If you set 0, Cindex sets no minimum value. (You cannot
set a minimum if the index already contains entries; in that case, Cindex displays the
number of characters in the record with longest field.)
• To specify a maximum number of characters a field can contain, enter the number in
the Maximum Chars box. If you set 0, Cindex sets no maximum value.
• To specify a template that text in a field must match, enter at Match a pattern to define
the template. See “Patterns” on page 233 for information on defining and using patterns. If you leave Match empty, Cindex accepts any text in a field.
Using Field Templates

When you make or modify a record, and Cindex finds a mismatch between the
contents of a field and a template you have defined for it, Cindex can ignore the
error, warn you about it but accept it, or refuse to accept it. To specify how Cindex should behave, choose Preferences… from the Edit menu, and click the Editing tab. Make your setting in the box labeled Mismatch to Template:
• Click Accept to make Cindex accept mismatches.
• Click Warn to make Cindex will warn you on your first attempt to save a record with
a field whose contents do not match its template; Cindex will always accept the
record on your second attempt.
• Click Forbid to make Cindex refuse to save a record in which the contents of a field do
not match its template.
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MANAGING FONTS
Cindex provides tools to check which fonts are used in an index, and to make
substitutions among fonts. You might need to make a substitution when you
work on an index that has been moved from another computer, and uses fonts
not available on yours.
To cope with potentially missing fonts, Cindex maintains an alternative font for
each (preferred) font you use in your index. Cindex always uses the preferred
font when that exists on your computer. If you open an index that uses a missing
preferred font, Cindex automatically substitutes the alternate font when displaying entries. If you later move the index to a computer that provides the preferred
font, Cindex will revert to using it. If you open an index in which a preferred
font and its alternate are missing, Cindex will display a dialog through which
you must specify an alternate font from among those present on your computer.
See “Substituting Fonts” on page 218 for more information on this.
To manage fonts choose Fonts… from the Tools menu. Cindex will display the
dialog box shown in Figure 63.

FIGURE 63.

Managing Fonts
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Checking Font Use
The table shows the preferred fonts you have used, together with their alternates.
The first font in the table is always present, and is the default font used for the
standard display of entries. Additional fonts in the list are those you have used in
records, or to display formatted headings, etc.
If you cease to use a font, Cindex does not immediately forget it. To make Cindex update its list to display only fonts that are currently in use, click Check Use
(this button is hidden if no fonts other than the default are used). If Cindex finds
unused fonts, it will ask if you want to remove them from the list for the index.

Substituting Fonts
You can change the preferred and alternate fonts Cindex uses in an index. To
change a font assignment:
• Click the list to select the row for the font you want to change.
• To specify a preferred font choose from the Preferred drop-down list (or type its
name if the name is not in the list—a preferred font need not be one available on the
computer you are using). If you enter the name of a font that is not available on your
computer, Cindex will use the alternate font, and will revert to the preferred font
when that becomes available.
• To specify an alternate font choose from the Alternate drop-down list. An alternate
font must be chosen from among those available on the computer you are using.

If you move an index to a computer that lacks any preferred font, Cindex will use
the alternate font. If the alternate is not available, Cindex will display the fontsubstitution dialog box when you open the index, so that you can choose an
alternate from among those available. A missing alternate font is indicated by a
gap where its name would be displayed. To specify a new alternate font, choose
from the Alternate drop-down list in the appropriate row.
When Cindex includes font information in a formatted document, it includes
information about preferred fonts, not alternate fonts.
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SPECIFYING ATTRIBUTES OF NEW INDEXES
Modifying Cindex Default Settings
When you create a new index, Cindex provides it with standard default settings
for record structure and reference syntax, and for sorting and formatting entries.
These settings have initial values assigned when Cindex is first installed, but you
can change them so that any new index you create starts with settings you prefer.
To change the default settings Cindex will bestow on new indexes it creates, close
all open indexes (you can use Close All from the Window menu) and choose from
the appropriate menu the item whose default values you want to set. You can set
default values for all items in the Document menu, and for Sort… in the Tools
menu. (Items for which you cannot change default settings are dimmed). The
settings you make when no indexes are open become the default ones that Cindex applies to new indexes.
To restore the default settings to their original installed values, quit Cindex and
restart it while holding down the SHIFT key.
NOTE: When you restart Cindex with the SHIFT key held down, Cindex restores all its
settings to their original values (including those of items you set by choosing Preferences
from the Edit menu).

Using Templates
When Cindex creates a new index it can use the record structure and other standard settings (for sorting and formatting entries) from an existing index. To use
one index as a model for another, you must first create a template. To make a
template:
• Open and activate the index you want to use as a model.
• Choose Save As… from the File menu, then select Template from the Save as type
drop-down list. When you save an index as a template, Cindex saves information
about the structure of records, and all the other settings that belong to the active
index, but saves no records.
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To open a template choose Open… from the File menu, and from the Files of type
drop-down list choose Templates. (You can also open a template by double-clicking its icon in Windows Explorer.) Cindex will ask you to provide a name for a
new index, and will then create it with the settings contained in the template.

GETTING INFORMATION ABOUT INDEXES
Cindex can provide several analyses of indexes and the entries they contain.

Obtaining General Statistics
To obtain basic information about the index document, such as the times of its
creation and modification, and the time you have spent working on it, together
with information about the number of formatted entries and the pages they
occupy, choose Index Statistics… from the Tools menu. Cindex will display the
dialog box shown in Figure 64.

FIGURE 64.
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Click Go to start the analysis.
Initially, the panel shows:
• The date and time of index creation.
• The date and time at which the index was last modified.
• The accumulated time the document has been open for work.

To obtain further information. Click Go. Cindex will examine the index then display the following information:
• The number of printed pages, and lines occupied by the index.
• The number of index entries (this might not be the same as the number of records in
the index), and the number of unique main headings.

If you are viewing a fully formatted index (but not if you are viewing a draft
index) Cindex will also show:
• The number of page references.
• The number of cross-references.
Controlling the Scope of
the Examination

Normally, Cindex examines all records that are accessible in the current view.
Cindex can confine the examination to certain parts of the index.
NOTE: Your settings of Hide by Attribute… (View menu) determine whether labeled
records are accessible in the formatted view.

To examine records that would fall on specified pages (for your current page
setup) click Pages, and set at from and to the range of pages you want to examine.
Cindex will examine only entries that would fall on the specified pages, were
they being printed.
To examine records you have selected, click Selection (this is dimmed if no
records are selected).
To examine a range of records in the view, click Records and specify the starting
and ending records in from and to. You can specify a range of headings by enter-
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ing leading text, e.g., Abr through Doc. You can also specify a range of record
numbers (e.g., 55 through 79) within which Cindex should confine the search.
To look among specified headings, you need only provide as much of the beginning text as will identify a record uniquely. You can specify leading text from a
subheading by appending a semicolon to the heading text then adding subheading text. To specify a heading that begins with digits, place a \ before the first
numeral; Cindex will otherwise interpret leading digits as a record number.
If you omit the first part of the range Cindex will start at the first record in the
view and stop at the record at the end of the range. If you omit the second part of
the range, Cindex will start at the specified record and continue until it reaches
the last record.
NOTE: Before beginning the examination Cindex checks that the last record in the
range appears after the first. If the last record appears before the first, Cindex will display a warning message.

Counting Records
To learn about the distribution of records under particular letters of the alphabet
or under different headings, and about the numbers of fields and characters they
contain, choose Count Records… from the Tools menu. Cindex will display the
dialog box shown in Figure 65.
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FIGURE 65.

Counting index records

Click Count to obtain a count of the number of main headings that begin with
each letter of the alphabet (more properly, the first character on which records
are sorted). Cindex will display:
• The number of records examined.
• The numbers of modified, deleted, marked, generated and labeled records (a single
record might fall in more than one category). Records carrying different labels are
distinguished in the count.
• The number of heading levels in the deepest record.
• The number of characters in the longest record.
• A table showing the numbers of records sorted under each leading character.
Specifying Records to
be Counted

Normally, Cindex counts all records that are accessible in the current view. To
confine the count to selected records or to a specified range of headings make the
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appropriate setting under Scope. The scope options are the same as those available
when you use Find or Replace, and are described fully in “Scope of Operations” on
page 255.
NOTE: Your settings of Hide by Attribute… (View menu) determine whether labeled
records are accessible in the formatted view.

To confine the count to records that contain references falling within a certain
range, define the range in the box Containing Locators. The locators can be simple
page references (e.g., 55 and 66) or compound references (e.g., 1997:5a:xv and
1997:7b:xiv). You must supply both starting and ending locators (or none at all).
If your locators are simple page numbers, Cindex will display the average number
of records per indexed page when it makes the count.
To confine the examination to records with certain attributes (and within the
range defined by Scope), check the appropriate attributes (Modified, Deleted,
Marked, Generated or Labeled).

EXPANDING INDEX ENTRIES
A Cindex record often contains several page references or cross-references. This
usually makes it easier to work with entries, and helps keep down the size of
index documents. Sometimes you might need to work with groups of records
that refer to different sets of pages (for example, if chapters are moved or repaginated after you have prepared an index), and then it is often easier to deal with
records that each contain only a single page reference or cross-reference.
Cindex can unpack references from records that contain more than one, and
generate new records as necessary, so that none in your index contain more than
one page reference or cross-reference. To expand an index in this way, choose
Expand from the Tools menu. Before you can do this the main view must show
All Records; you cannot expand an index when viewing new records, or a group.
NOTES: When Cindex expands references, it normally recognizes successive page references separated with a comma, and successive cross-references separated with a semicolon. If you have used different characters to separate these two kinds of references, you
should ensure that Cindex knows what they are. “Specifying the Structure of Page Ref-
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erences” on page 128 explains how to specify the page reference separator; “Specifying
the Structure of Cross-References” on page 110 explains how to specify the cross-reference separator.
When Cindex expands an index it invalidates any record groups that belong to the
index. “Rebuilding Groups” on page 229 explains how you can restore invalid groups.

COMPRESSING INDEX ENTRIES
While working on an index you might create records that are exact duplicates of
others, and you might create some empty records. You will also probably have
deleted some records. Cindex never displays or prints any of the above kinds of
records in a fully formatted view, so you can safely leave them in the index, but if
you want to reduce the size of your index you can remove them permanently.
To remove records permanently, choose Compress… from the Tools menu. Cindex will display the dialog box shown in Figure 66. Compress… is available only
when the view is set to show All Records. It is dimmed if you are viewing new
records, or a group.

FIGURE 66.

Compressing an index

Removing Unnecessary Records from the Index
To remove records that contain no text check Remove Empty Records.
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To remove deleted records check Remove Deleted Records.
To remove exact duplicates check Remove Duplicated Records. Cindex cannot
remove duplicated records if the index is sorted in page number order, in which
case this item is dimmed.
Click OK to remove the chosen records.
NOTE: When Cindex removes records from an index it renumbers those that remain.
You should not rely on a record having the same number before and after you compress
an index.
Cindex uses a record’s number to keep track of its membership in any group. Because
record numbers often change when you compress an index, Cindex invalidates all the
groups. For information on reconstructing invalid groups, see “Managing Groups” on
page 227.

Removing Generated Records
Cindex can automatically generate cross-references for an index (see “Generating
Cross-References Automatically” on page 117 for more information about
these), and can automatically convert cross-references to fully-qualified entries
(see “Converting Cross-References to Fully-Qualified Entries” on page 116).
When Cindex does either of these things, it creates new records, and keeps track
of them.
To remove records that were automatically-generated check Remove Generated
Records.
NOTE: If you edit a record that contains automatically generated text, Cindex no longer considers it to be a generated record.

Consolidating References from Multiple Records
As you build an index you might create several records that are identical except
for their page references or cross-references. This is of no real consequence,
because Cindex always aggregates references when it displays or prints a fullyformatted index, but the index document might be larger than it needs to be. To
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simplify the organization of records, Cindex can merge the identical entries, putting all their page references and cross-references into as few records as possible,
and deleting any unnecessary records that result.
To consolidate references from records that have identical headings, and to
remove records that are no longer needed, check Consolidate References. Cindex
will not normally consolidate references from records that carry different labels.
To consolidate regardless of record labels, check Ignore different Labels. When
Cindex consolidates across records with different labels, the resulting record carries the label (if any) of the first of the set.
NOTES: Cindex cannot consolidate references and remove duplicated records if the
index is sorted in page number order. If the index is sorted by page number, Consolidate
References is dimmed.
When Cindex consolidates references, it normally separates successive page references
with a comma, and successive cross-references with a semicolon. If you have used other
characters to separate these two kinds of references, you should ensure that Cindex
knows what they are. See “Specifying the Structure of Page References” on page 128,
and “Specifying the Structure of Cross-References” on page 110.

When you click OK, Cindex will accumulate references where it can. If there are
more references than can be placed in a single record, Cindex will retain as many
records as it needs.

MANAGING GROUPS
Cindex provides several tools for managing groups of records you have defined.
You can get information about how and when they were formed, you can delete
them, or you can rebuild them by applying the search criteria used in their formation.
You may need to rebuild groups after using either of the tools Expand… or Compress… Both of these operations invalidate existing groups in an index.
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To manage groups, choose Groups… from the Tools menu. Cindex will display
the dialog box shown in Figure 67.

FIGURE 67.

Managing Groups

Getting Information About Groups
When Cindex makes a group, it saves information about the group, including:
• The number of records in the group.
• The time the group was created.
• How the group was made (from a selection or from search results). If the group was
made from search results, Cindex saves information about the search.
• Whether the group has been changed since it was created.
• How the group is sorted.

To view a digest of this information, click Info…. Cindex will display a dialog box
containing information about the group.
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Rebuilding Groups
Cindex knows how a group was made originally (e.g., from a search, or from a
selection of records). If a group was made from a search, Cindex can rebuild it
using the original search criteria.
To rebuild one or all groups that belong to an index choose from the Group dropdown list the name of the group you want to rebuild, (or click All Groups to
rebuild all of them), then click Rebuild.
NOTE: Although Cindex applies the correct search criteria when rebuilding a group, it
does not keep information about the records it should examine. For example, it does not
know if a group to rebuild was formed by a search of the whole index, or a search of
another group.

Removing Groups
To remove a group choose the group you want to delete from the Group dropdown list (or click All Groups if you want to remove all of them), then click Delete.
When Cindex removes a group it deletes only the information it has stored
about which records belong to the group; Cindex does nothing to the records
themselves.

Linking Cross-References
Cindex can find and add to a group all the records that make cross-references to
records already in the group. You might want this when a work you have indexed
is broken into multiple volumes, and you want to find all the records that belong
to each volume. (For more information on breaking indexes see “Breaking an
Index into Parts” on page 231).
To add to an existing group all the records containing cross-references to records
already in it, choose the group from the Group drop-down list (or click All Groups
to link cross-references for all of them), then click Link Cross-References (this is
dimmed if the index is not sorted alphabetically). When you click OK Cindex
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will examine all records in the index, and will add to the group any record that
contains a cross-reference to a record already in the group.

CUMULATING AND COMBINING INDEXES
Indexes to serial publications are often cumulated at intervals, and indexes to
individual volumes in a multi-part series are often combined into a single master
index. Cindex copes efficiently with these kinds of tasks, relieving you of most of
the work. The following sections explain how to proceed.

Managing Locators in Cumulations
Locators in cumulated indexes will often need to be adapted from their forms in
the component indexes. Usually you will need to do one of two things:
• If only the indexes to volumes are being cumulated, you will probably need to attach
some kind of volume identifier to page references from each component volume.
• If the contents of volumes are being combined to make an integrated volume, pages
will probably be renumbered, and you will need to adjust the page references in the
index entries.

Cindex provides different means for modifying locators, depending on the kind
of change you need to make. It is easiest to change locators before adding records
to the combined index.
Adding Volume
Numbers

If you are combining several indexes and need to add volume numbers to the
page references in the component indexes, follow the directions given in “Adding
Volume Numbers to Page References” on page 244.

Adjusting Page
Numbers

If a publisher combines the contents of several volumes into a single one with a
uniform run of page numbers, the page references for entries in the indexes to
component volumes will need to be adjusted. You can use Alter References… from
the Tools menu to adjust page references in the component indexes before adding records to the combined index. For information on how to do this see
“Adjusting References” on page 90.
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Building the Master Index
After having made any necessary adjustments to page numbers, follow these
steps to build a master index:
1.

Create a new index that will contain the cumulated or combined components. Do
not be concerned about the record size; Cindex will re-size the index if necessary
when it adds records to it.

2.

Open a component index that you want to include in the master index.

3.

Select the records you want to include in the master index (choose Select All from the
Edit menu if you want to include all records).

4.

Drag the records to the main window of the master index.
Alternatively, copy the records (choose Copy from the Edit menu), activate the master
index (click its main window, or choose it by name from the Window menu), then
paste the records (choose Paste from the Edit menu).

5.

Repeat steps 2 through 4 for each component index.

BREAKING AN INDEX INTO PARTS
Single volume works are sometimes broken into multiple (spinoff ) volumes,
each with its own index. In such cases one wants to extract from the index to the
single volume the entries that will belong to the separate volumes (adjusting page
references if the text pages have been renumbered).
Follow these steps to break out the appropriate records into separate indexes.
1.

Ensure that each record contains a single locator. If any records contain more than
one page reference, choose Expand from the Tools menu. For more information see
“Expanding Index Entries” on page 224.

2.

Find page references that belong to each spinoff volume. With the view set to show
all records, choose Find from the Edit menu. In the Find window set the drop-down
list under the search text to confine the search to the locator field (usually named
Page field), and check Evaluate References. Enter as search text the range of page numbers that are to be included in the spinoff volume. (For more information see
“Searching for Locators” on page 75.) Click Find All to locate all records that refer to
these pages. Cindex will make a temporary group that holds the results of the search.
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3.

Choose Save Group… from the File menu to create a permanent group from the
results of the search. Use a name that helps you identify the spinoff volume.

4.

Choose Groups… from the Tools menu, then in the dialog box Cindex displays click
Link Cross-References (ensure that the list shows the name of the group you have just
made). When you click OK Cindex will examine all records in the index, and will add
to the group any record that contains a cross-reference to a record already in the
group.

5.

Repeat steps 2 through 4 for each set of pages that will constitute a different spinoff
volume.

Working with Spinoff Indexes
The pages in a spinoff volume are usually numbered differently from their counterparts in the original volume (each spinoff volume is likely to have its first page
numbered 1). You will therefore probably need to adjust the page references in
the group of records that represent each component index.
If you are confident that no records in the parent index appear in more than one
of the groups (a record might appear in more than one group if the spinoff volumes have some content in common), you can make the required page number
adjustments on each group of records separately. However, it is generally advisable to make a completely new index for the records in each group. To do this:

Adjusting Page
References
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1.

Activate the main view window for the parent index.

2.

Set the view to show the group for a spinoff index (choose the group from the View
menu).

3.

Select the records in the group (choose Select All from the Edit menu).

4.

Copy the records (choose Copy from the Edit menu).

5.

Create a new index for the group. Do not be concerned about setting the right record
size—Cindex will re-size the index if necessary when it adds records to it.

6.

Paste the records (choose Paste from the Edit menu).

7.

Repeat steps 1 through 6 for each group that contains records for a spinoff index.

For each new spinoff index, adjust the page references to take account of the
changed page numbers. “Adjusting References” on page 90 explains how to do
this.
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You might sometimes need to search for (or replace) a set of characters that
meets some general specification, such as “any numeral at the beginning of a line
followed by the letter X,” or “any word beginning with an uppercase letter and
ending in ‘ing’,” or “any four-digit number beginning with 19 and enclosed in
parentheses.” When you use Find… and Replace… you can specify a pattern that
describes a class of characters, words or phrases that Cindex should look for (or
replace) in the index.
You can also use patterns with Alter References… to specify a class of page references (for example, those in a particular volume) to which you want to restrict
page reference adjustments.
You can also use patterns to define templates to which headings in records must
conform when you enter them.
Patterns are sometimes called regular expressions. They provide an extraordinarily powerful tool for inspecting and modifying entries in your index. This
chapter explains how to form and use them.

FORMING PATTERNS
For the most part patterns consist of ordinary characters for which Cindex
searches. For example, if you use Find to search for the following sequence of
characters as a pattern (to make Cindex treat the characters as a pattern you must
check Pattern in the Find window):
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Cindex will display the first record that contains the sequence of letters
“abcdefg.” The power of patterns derives from their use of special characters. The
following sections introduce these special characters and explain how to use
them.

. (period)
The . stands for any character. If you use . in a pattern Cindex will find a match to
any character. For example, to find records that contain sequences of three letters
that begin with ‘c’ and end with ‘t’ you would use the pattern
c.t

You can use . as often as you like and in combination with other special characters described below.

[: :] (character set)
Within [: :] you specify a character that is a member of a set. For example, [:letter:] identifies the set of letters. If you specified the pattern
[:letter:]

Cindex would find a match to any letter (in any script). To specify a character
that is not a member of the set, place a ^ immediately after the opening square
bracket, e.g.
[^:letter:]

Cindex recognizes many kinds of character sets, such as currency symbols, diacritical marks, and classes of punctuation. Table 3 identifies some of those.
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TABLE 3.

Character Sets Recognized in Patterns

Name

Short
Name

Character Set

[:ascii:]

[:ascii:]

ASCII character

[:letter:]

[:l:]

Any letter (in any script)

[:lowercase letter:]

[:ll:]

Lowercase letter

[:uppercase letter:]

[:lu:]

Uppercase letter

[:mark:]

[:m:]

Diacritical mark or character combined with a letter

[:separator:]

[:z:]

Any space or invisible separator

[:symbol:]

[:s:]

Any symbol, including, math, currency, dingbats, etc.

[:math symbol:]

[:sm:]

Math symbol

[:currency symbol:]

[:sc:]

Currency symbol

[:other symbol:]

[:so:]

Other symbol (none of the above)

[:number:]

[:n:]

Numeric character in any script

[:decimal digit number:]

[:nd:]

Decimal digit (0 through 9)

[:punctuation:]

[:p:]

Punctuation

[:dash punctuation:]

[:pd:]

Any kind of hyphen or dash

[:open punctuation:]

[:ps:]

Any kind of opening bracket

[:close punctuation:]

[:pe:]

Any kind of closing bracket

[:initial punctuation:]

[:pi:]

Any kind of opening quote

[:final punctuation:]

[:pf:]

Any kind of closing quote

[:connector punctuation:]

[:pc:]

Any character that connects words

You can use the full name or the short name when specifying a set. The collection of character sets that Cindex recognizes corresponds to the Unicode Character Categories (see http://en.wikipedia.org/wiki/
Character_property_(Unicode)#General_Category).
Cindex provides a set of ready-made patterns to help you search for character
classes. See “Using Patterns with Find” on page 243.
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Cindex also recognizes many script sets, such as [:arabic:], [:devanagari:], [:cyrillic:], [:greek:], [:han:], [:hangul:], [:hebrew:], [:katakana:], [:latin:]. For a complete list see http://www.unicode.org/charts/#scripts.
You can form new character sets by combining existing ones.
• To make a set that is the union of other sets, just concatenate them:
[:letter:][:symbol:] (or [:l:][:s:]) is the set of all letters and all symbols.
• To make a set that is the difference of two sets, connect them with [:letter:]-[:latin:] is the set of all letters from scripts other than latin.
• To make a set that is the intersection of two sets (the set of characters common to
both), connect them with & :
[:letter:]&[^:han:] is the set of all letters that are not Han.

[ ] (square brackets)
If you enclose a set of characters in square brackets, Cindex will find a match to
any one of the characters in the brackets. The pattern below will find records
that contain any of the following sequences: 1985, 1986 or 1987.
198[567]

You may include character sets as elements within square brackets, e.g.
[[:digit:]abc]

will find any digit followed by the letter ‘a’ or ‘b’ or ‘c’.
When you use [ ] to search for any of a contiguous range of characters, you need
not specify every character explicitly: you can specify just the first and the last,
separating them with a hyphen. Thus [a–z] will match any lowercase letter, and
[0–9] will match any single numeral. When you use the – (hyphen) to specify an
inclusive range of characters, Cindex understands the range to include all characters having Unicode values between the lowest and the highest. When you want
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any character from a set it is generally better to use a named set (e.g., [:lowercase
letter:] than to enumerate the characters.
You can search for a character that is not in the set by placing a ^ (caret or circumflex) immediately after the opening square bracket. To find any number that is
not followed by a space, you could use the following pattern:
[0-9]+[^0-9 ]

(See below for an explanation of + .) The caret is special only if it appears as the
first character inside the brackets. The . and some other special characters
described below lose their significance (and are treated as ordinary characters)
when they are included in a set enclosed by [ ]. To search for one of a set of characters that includes ] (the closing square bracket), you must place that bracket
first in the sequence, immediately after the opening square bracket or after any
initial ^. The – (hyphen) loses its special significance when it occurs as the first
character (or after any initial ^) or the last character inside square brackets.

( ) (parentheses)
When you form a pattern you can group elements of it by enclosing them in
parentheses ( ). Such a group is called a subpattern. When finding a match to the
whole pattern Cindex keeps track of the text matched by any subpattern, and
allows you to use that text as part of what must be matched later in the pattern.
Suppose you wanted to find all records in which you had typed a word twice in
succession. The solution is to match the first occurrence of the word with a subpattern and check whether the text matched by this subpattern appears a second
time after an intervening space. You can do this by using the following pattern:
(\b[:l:]+) \1

CHAPTER 13 Patterns

237

Forming Patterns

The pattern can be read as “any sequence of one or more letters starting on a
word boundary, followed by a space, then by a second occurrence of the same
sequence of letters.” It can be dissected as follows:
\b specifies that the following element occurs at the start of a word (see later discussion of \).
[:l:] specifies any continuous sequence of letters.
+ specifies one or more occurrences of the preceding element (see later discussion of
+).
( ) enclosing [[:l:]]+ marks it as a subpattern.
\1 denotes whatever text was matched by the first defined subpattern.
Properties of
Subpatterns

You can define up to nine subpatterns in a single pattern, so to refer to text
matched by a particular subpattern you must identify the one you want. Cindex
provides a simple convention for this. It numbers subpatterns implicitly from left
to right, by their order of appearance in the pattern. To refer to a subpattern, use
\ followed by a numeral in the range 1-9. For example, \1 denotes the text
matched by the first subpattern, \7 the text matched by the seventh.
You can nest subpatterns, i.e., you can include one subpattern inside another.
When you do this the outer patterns have lower numbers.
If you use \N where N refers to a subpattern that has not yet been defined, Cindex will display a warning message.
Parentheses have no special significance if they appear within [ ].
A later section, “Including Parts of Matched Text in the Replacement” on
page 246, explains how you can use subpatterns with Replace to rearrange text in
records.

* (asterisk)
The * stands for any number of occurrences (including none) of the preceding
element. This can be a character matched by a set enclosed in [ ], e.g., [0-9]*, or a
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character from a set, e.g., [:l:]*, or a subpattern, e.g. cat(s)*. You can refer to a previously defined subpattern with an expression of the form \N*, where N is a digit
in the range 1–9. This means “any number of occurrences (including none) of
what was matched by subpattern N." To find anything between opening and
closing parentheses, search for.
\(.*\)

The * finds the maximum possible number of matching occurrences of the preceding element.
The * has no special significance if it is the first character in a pattern or if it
appears in a set of characters contained within [ ].

+ (plus)
The + stands for one or more occurrences of the preceding matched element.
This element can be a character matched by a set enclosed in [ ], or one from a
character set, such as [:l:], or a subpattern.
The + finds the maximum possible number of matching occurrences of the preceding element.
The + has no special significance if it is the first character in a pattern or if it
appears in a set of characters contained within [ ].

? (question mark)
The ? stands for zero or one occurrence the preceding matched element. This
element can be a character matched by a set enclosed in [ ], or one from a character set, such as [:l:], or a subpattern.
The ? finds the maximum possible number of matching occurrences of the preceding element.
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The ? has an additional special role when it follows * or +. or ? It is used to ensure
that the matched text is the least that satisfies the pattern. For example, to find
single parenthetical phrase in a record field that might contain multiple phrases
in parentheses, use this pattern:
\(.*?\)

The ? has no special significance if it is the first character in a pattern or if it
appears in a set of characters contained within [ ].

{N,N} (number or numbers in braces)
A number N in braces specifies how many occurrences of the preceding element
are to be matched. This can be a character matched by a set enclosed in [ ], or one
from a character set., such as [:l:], or a subpattern For example, to find any 5digit number search for.
[0-9]{5}

The braces may contain two numbers separated by a comma, where the first
specifies the minimum number of matches required, and the second specifies the
maximum number of matches. Thus
[0-9]{3,5}

finds any number that has 3, 4 or 5 digits. If the second number is omitted, e.g.,
{3,} the match must satisfy at least the minimum. Cindex normally seeks the
greatest number of matches that satisfy the pattern. If ? follows the braces, as in
{3,5}? or {3,}? Cindex will seek the smallest number of matches that satisfy the
pattern.
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| (vertical bar)
The | separates alternative patterns to match. To find a match to "cat" or "dog,"
search for
cat|dog

You can specify multiple alternative matches (e.g., cat|dog|canary|snake). The |
causes everything to its left (as far as a preceding |) to be treated as one pattern to
match, and everything to its right (as far as a succeeding |) as an alternative pattern to match. You can limit the leftward and rightward scope of the | within a
larger pattern by enclosing it and its operands in (), thus: (cat|dog).
The | has no special significance if it is the first character in a pattern or if it
appears in a set of characters contained within [ ].

^ (caret)
If the caret (circumflex) is the first character in a pattern, Cindex will find a
match to the remainder of the pattern only if the match can be made at the start
of a field. The pattern
^between

will make Cindex find records that contain the word “between” at the beginning
of a field; it will ignore occurrences of “between” elsewhere in a record. Similarly
^[:pi:].[:pi:]

will find records in which any field begins with any single character enclosed in
any kind of quotation marks.
The ^ is not interpreted literally as a character; it merely indicates that any match
to the remainder of the pattern must appear at the beginning of a field. This use
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of the caret is distinct from its special function as the first character in a series
enclosed in [ ]. The caret has no special significance (and is interpreted as an
ordinary character) if it occurs elsewhere in a pattern.

$ (dollar sign)
If $ is the last character in a pattern, Cindex will find a match to the rest of the
pattern only if the match can be made at the end of a field. The pattern
and$

will find only the records in which “and” (or some word ending in “and”) appears
at the end of a field. $ has this special meaning only if it is the last character in a
pattern; it has no special significance (and is interpreted as an ordinary character) if it appears elsewhere.

\ (backslash)
The backslash has three different functions:
1.

When placed before certain letters, \ introduces a special operation. A notable one is
\b to indicate that the pattern element that follows must match on a word boundary.
For example
\banti

would find a match to “anti” only at the start of a word. For a full list of special operations introduced by \, see www.regular-expressions.info/reference.html.
2.

When placed immediately before any of the characters with special functions:
*?+[(){}^$|\.
\ causes the following character to lose any significance it would otherwise have in a
pattern. For example, to search for any sequence of characters enclosed in square
brackets (that is, square brackets are a literal part of the sequence) use
\[.*\]

242

CHAPTER 13 Patterns

Using Patterns with Find

To use a backslash as a literal character in a pattern, place another backslash immediately before it.
3.

The \ functions quite differently in a pattern when it is placed immediately before a
digit in the range 1 through 9. Here it refers to the text that matches an earlier component in a pattern (a subpattern).

The \ has no special significance when it appears as part of a set of characters
contained within [ ].

USING PATTERNS WITH FIND
To simplify your use of patterns, Cindex provides a set of ready-made ones that
you can use alone or in combination when searching with Find... To deploy a
ready-made pattern, right click or CONTROL click in the box where you enter
search text. Cindex will display a contextual menu that offers different kinds of
patterns, grouped under General Patterns, Character Properties, and Scripts. When
you choose a pattern Cindex enters it in the search box. You can edit the pattern,
or combine it with others chosen from the menu.
Remember these points when searching with patterns:
• Cindex searches for text that matches a pattern only when you have checked the Pattern box.
• Any match to a pattern will lie wholly within a single field of a record. Cindex will
not find a match that straddles two fields.
• Cindex will always find the longest sequence of characters that matches a pattern,
unless you have used ? to specify that the match be the shortest that satisfies the pattern. See “? (question mark)” on page 239.

USING PATTERNS WHEN REPLACING TEXT
To search for and replace sequences of characters that match a pattern use
Replace… from the Edit menu, and construct the pattern exactly as you would
using Find…, as described in the previous section.
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A special advantage of patterns in search-and-replace operations is that Cindex
can include the characters that match the pattern in the replacement text. That
is, the text you are looking for can be put back in the record, augmented by other
text, or transformed in one of several ways. The following sections provide examples.

Adding Volume Numbers to Page References
Suppose that you have indexed a work in a single volume and have used simple
page references, and now need to incorporate the index into a larger one in
which references have to be tagged with the number of the volume in which they
appear. Consider a series of references such as:
45, 66, 89-91, 200

that you want to convert to
2:45, 2:66, 2:89-91, 2:200

You can easily add a volume number to each reference with the following pattern:

The pattern tells Cindex to find (in the locator field) the longest sequence that
contains one or more digits and possibly a hyphen. In other words the pattern
describes a simple page reference or a range of references.
The characters \& (backslash, ampersand) in the replacement sequence denote
the text that matched the pattern. When Cindex makes the substitution it incorporates this text in the replacement sequence. Thus Cindex replaces each reference by itself, preceded by the characters 2:.
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NOTE: To include the \ (backslash) as a literal character in replacement text, it must be
preceded by itself (\\). This restriction applies only when you use a pattern. In making
ordinary replacements, \ is treated as a literal character.

Case Conversion
You can use \& together with the + and – signs to convert words and phrases
from lowercase to uppercase and vice-versa. Suppose you have an index in which
the first character of every main heading is a lowercase letter and you want to
convert it to uppercase. You can do this quite simply with the following replacement:
Find:

^[:ll:]

Change to: \&+

This causes Cindex to replace every lowercase letter that occurs at the beginning
of a main heading with its uppercase counterpart.
NOTE: You need never actually make a change of the kind just shown. Cindex can
automatically capitalize the leading letters of headings when it displays or prints a formatted copy of the index. “Typography and Punctuation of Headings” on page 184
explains how.

You could capitalize all of the first word of each main heading with
Find:

^[:ll:]+

Change to: \&+

This causes Cindex to find the longest continuous sequence of letters from the
beginning of the main heading, then convert it to uppercase.
You can convert a whole field (for example the main heading field) to uppercase
letters with
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Find:

^.*$

Change to: \&+
NOTE: You need never actually make a change of the kind just shown. Cindex can
automatically capitalize headings when it displays or prints a formatted copy of the
index. “Typography and Punctuation of Headings” on page 184 explains how to do this.

If you include \&– in the replacement text, Cindex will convert to lowercase any
letters in the sequence of characters that matches the pattern.
A later section explains how to capitalize the initial letters of every word in a
heading.
NOTES: The & in the replacement sequence is interpreted specially only if preceded
by \. The + or – has its special effect only if it appears immediately after \&. You can disable the special effect of + or – by placing \ immediately before either character (e.g., \+
or \–).
If the segment of text matched by a pattern is very long, there might not be sufficient
space in the record to accommodate it in a replacement phrase. If this happens, Cindex
marks the record and displays a warning message when it has finished making replacements.

Including Parts of Matched Text in the Replacement
When you replace text matched by a pattern you can incorporate selected parts
of the matched text in the replacement sequence. The following examples
exploit this capability.
Changing the Format of
References

Suppose that your index contains references to pages in several volumes and that
each reference has the form vol: ppp, as in
3:55, 3:66, 4:72, 5:60-63

and you want to change the references so that the volume number appears in
parentheses, as in
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(3)55, (3)66, (4)72, (5)60-63

You need to find one or more digits followed by a colon, then replace what is
matched by that pattern with the same digits enclosed in parentheses. You can do
this by exploiting a feature that allows you to include in the replacement text
only a part of the sequence of characters that matched the pattern. In this
instance you will include just the digits that represent the volume number.
The following operation replaces each volume number and its terminating colon
with the same number enclosed in parentheses:
Find:

([1-9][0-9]*):

Change to: \(\1\)

The ( ) (parentheses) enclose a part of the pattern (a subpattern) that matches
the volume number. The character pair \1 in the replacement sequence tells Cindex that the replacement text should include the characters that matched the
first subpattern. Thus the above replacement text can be read as “whatever was
matched by the first subpattern, enclosed in parentheses.” The colon is discarded
during the replacement.
You can define and use up to nine subpatterns. For more information on subpatterns see “Properties of Subpatterns” on page 238.
Capitalizing Initial
Letters of Words

To capitalize the initial letter of every word in the main heading you could use

Find:

([:ll:])([:l:]*)

Change to: \1+\2
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This causes Cindex to find every continuous sequence of letters that start with a
lowercase letter, by matching the first letter with subpattern 1 and any remaining
letters with subpattern 2. Cindex then replaces the first letter with its uppercase
version and replaces all the others by themselves.
The above operation does not guarantee that all letters after the first in each
word will be lowercase—were these uppercase to begin with, Cindex will have
left them alone. To ensure that all letters after the first are made lowercase, use
the following replacement sequence:
Find:

([:ll:])([:l:]*)

Change to: \1+\2Rearranging the Format
of Dates

The following example illustrates how you can use several subpatterns to rearrange the forms of references. Suppose your entries had dates in the form
year:month day (e.g., 1992:Jun 15) and wanted them to read day month year
(e.g., 15 Jun 1992). You can define a pattern to recognize a date, identifying each
component as subpattern, then rearranging the components by forming a
replacement sequence built from text matched by the subpatterns.
Here the three components of the date are matched by three subpatterns connected by the appropriate punctuation:

Find:

([12][90][0-9][0-9]):([ADFJMNOS][a-z][a-z]) ([1-9][0-9]*)

Change to: \3 \2 \1
{[12][90][0-9][0-9} identifies a year in the 20th or 21st century.
{[ADFJMNOS][a-z][a-z]} identifies a three letter sequence beginning with the initial capital letter from the name of a month. (A more elaborate subpattern would be
necessary to identify months uniquely, but in the context of the overall pattern the
form shown here would almost certainly be sufficient.)
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{[1-9][0-9]*} identifies a day. (This subpattern does not uniquely identify a legitimate date, because it permits a match to more than 2 digits, but in the context of the
overall pattern it is sufficient.)

By forming the replacement sequence from the text elements matched by the
subpatterns, but in the reverse order of their appearance in the original record,
you have rearranged the dates:

USING PATTERNS WHEN ALTERING
REFERENCES
When you use Alter References… (from the Tools menu) to adjust page references, Cindex normally changes the first number (or range) that falls within the
range you specify. If records contain multi-part page references you will probably
want to restrict the alterations to a particular segment. You can do this by using
patterns, as shown in the following examples.

Changing Page Numbers in Selected Volumes
Suppose you have an index with page references like these:
MED: 45-47, ART: 325, ART: 4, ENG: 257-261, HIST: 3

and you want to change all references in the “ART” volume, but not in any others. You can confine alterations to the correct references by specifying a Matching
Pattern in the panel (shown in full in Figure 26 on page 91):

Cindex will disregard references that do not contain the characters “ART:”. After
alteration the references will look like:
MED: 45-47, ART: 326, ART: 4, ENG: 257-261, HIST: 3
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When you specify a pattern Cindex examines each reference for characters that
match the pattern. If part of the reference matches the pattern, Cindex examines
the remainder of the reference (i.e., the part that lies to the right of the section
matched) and makes the required adjustment if it is in the correct range.
No special pattern-matching characters (e.g., ^ * $) were used in the above illustration, but you may use them as required. For example, to adjust every page
number (the last element) in compound references such as
1988(3)55, 1988(4)66, 1988(5)72, 1988(4)60-63

you could use the following pattern to exclude all components of the reference
up to and including the closing parenthesis:

Removing References to Entries in Selected Volumes
You might on occasion need to remove references to selected volumes from the
index to a multi-volume work. You can do this very easily with Alter References…
by defining a pattern that identifies the volume for which you want to remove
references, and then subtracting a very large number from each reference in that
volume. Cindex will automatically remove any reference to a page number that
would be less than 1. If removing such a reference leaves a locator field empty,
Cindex marks the record for deletion. Consider an index in which references
had the following form:
1987: Jun 555; 1988: Oct 1032; 1989: Jan 22

To remove from records all references to 1988 set up this adjustment:
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The pattern identifies any reference beginning with 1988 and includes all of it
up to the page number. For every reference that satisfies this pattern, Cindex will
subtract 10000 from the page number. This would make the page numbers less
than 0, so Cindex will remove all references to pages in the 1988 volume. Cindex
deletes records from which it removes all references.

Indexing with Temporary Page Numbers
Sometimes you will have to index a book before final pagination is known. In
such a case you can assign temporary references while you make entries and when
you later learn the initial page numbers of chapters you can use Alter References…
to make the conversion automatically.
When you index with temporary page numbers you should include with each
reference some distinctive means to identify the chapter to which it belongs. For
example, if you were indexing chapter 6 you might identify a reference to page
32 with 06%32, where the 06% provides a distinctive identifier. You can use an
equivalent notation to identify references to other chapters (e.g., 14%). (You can
use other forms of tag to identify a chapter, but you should choose a character or
sequence of characters that would not otherwise appear in a reference.) You
should identify the chapter with as many digits as there are in the highest numbered chapter, e.g., if the highest-numbered chapter were 23, you would use two
digits, placing a leading 0 before any chapter numbered between 1 and 9. Each
reference should have its chapter tag placed immediately in front of it.
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NOTES: When making a reference to a range of pages (e.g., 54-57) place a temporary
marker before the first member of the range only (e.g., 06%54–57).
Be sure that Cindex knows what character you use to separate page references. “Specifying the Structure of Page References” on page 128 explains how to specify this.

When you know the correct first page for chapter 6 (e.g., 189), choose Alter References… from the Tools menu, and set up an adjustment of this sort (see
“Adjusting References” on page 90):

This will add 188 to all references that have 06% immediately before them. (We
add 1 less than the number of the starting page of the chapter, because temporary
page numbers began with 1). Use the same method for other chapters, substituting the appropriate chapter identifier and starting page.
When you have made all your alterations you can remove your temporary chapter markers. If you have used a consistent scheme to mark chapters (e.g., the
chapter number always ends with %) you can remove all of them in a single operation. Use Replace… (from the Edit menu) to search for the following pattern
(confined to the locator field), and replace each match with nothing:
[0-9]+%

Find:
Change to:
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This finds in the locator field a number followed by %; it then removes both the
number and the % (leaving behind the unadorned page reference).
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This chapter begins with a discussion of certain principles common to a broad
range of operations that Cindex undertakes, then briefly summarizes the function of menu items, in their order of appearance in menus.
Where a topic is discussed fully elsewhere in the Guide, a page reference appears
in square brackets in the left margin, thus: [155].

SCOPE OF OPERATIONS
When you choose a menu item that initiates some global action on records (for
example replacing text, or checking spelling) Cindex confines that action to
records accessible in the current view. For example, if the view is set to show only
a group of records, the action is confined to that group. Certain actions can be
undertaken only when the view shows all records.
Confining Action to
Parts of the Index

Cindex allows you to restrict the scope of many actions to a subset of the records
accessible in the current view. For example, when using Find…, or Replace…, or
Count…, or certain options of Save As…, Cindex will provide you with options of
the following sort:

• To permit the operation on all records accessible in the current view, click All Records
in View.
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NOTE: When you work with a fully formatted view, deleted records are never accessible, and labeled records are accessible according to your settings of Hide by Attribute…
(View menu). For more information see “Displaying Labeled Records” on page 57.

• To confine the operation to records you have selected, click Selected Records (this is
dimmed if no records are selected).
• To confine the operation to a range of records in the view, specify the starting and
ending records in From and to. You can specify a range of headings by entering leading
text, e.g., Abr through Doc. You can also specify a range of record numbers (e.g., 55
through 79) within which Cindex should confine the operation. To look among
specified headings, you need only provide as much of the beginning text as will identify a record uniquely. You can specify leading text from a subheading by appending a
semicolon to the heading text then adding subheading text. To specify a heading that
begins with digits, place a \ before the first digit; Cindex will otherwise interpret
leading digits as a record number.
If you omit the first part of the range Cindex will start at the first record in the view
and stop at the record at the end of the range. If you omit the second part of the
range, Cindex will start at the specified record and continue until it reaches the last
record in the view.
NOTE: When Cindex operates on a specified range of records, it proceeds in whatever
order the records are displayed on the screen. Before beginning the operation it checks
that the last record in the range appears after the first. If the last record appears before
the first, Cindex will display a warning message.
Confining Action by
Record Modification
Date

When searching for text with Find… or Replace…, Cindex offers a further option
to control the scope of the search: you can confine the search to records made or
modified between certain dates:

To confine the operation to records last modified on a particular date or between
specified dates, type the starting and ending dates in the boxes labeled From and
To. Cindex interprets dates in whatever form is standard in the country you are
working in (e.g., month, day, year or day, month, year) and can accept dates in a
wide variety of forms (e.g., Jan 1 96, 1/1/96, 1 January 96, January 1 1996). If
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you omit the year Cindex assumes the current year. If you omit the month, Cindex assumes the current month. If you omit a starting date, Cindex assumes January 1, 1970; if you omit an ending date, Cindex assumes a date in the next
century.
Confining Action to
Records with Specified
Attributes

In many operations (such as searching for text, or counting records), you can
confine action to records that possess (or lack) specified attributes. Several of the
dialog boxes Cindex displays offer one or more check boxes for the following
attributes.
• New Records. Records added to the index in your current session with Cindex.
• Modified Records. Records changed during your current session with Cindex.
• Deleted Records. Records that are deleted.
• Marked Records. Records that have been marked because some operation could not be
completed (usually because there was insufficient space in the record). The mark
remains on the record until you edit it.
• Generated Records. Records that contain automatically-generated cross-references.
• Labeled Records. Records that you have labeled. When you use Find or Replace you
can also specify a particular label.

TOOLBARS
Font drop-down list [33]

This list shows the fonts available on your computer.
When the main index window is active any font you choose becomes the one in
which all entries are displayed (except where a font has been explicitly specified
in a record, or in a format setting).
When the record window is active any font chosen is applied to the currently
selected text (the list is dimmed if no text is selected).

Size list

[33]

The box shows the character size (in points) used by the active index. When the
main index window is active you can change the size either by typing directly
into the box, or choosing from the drop-down list.
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Toolbar buttons execute the actions of often-used menu items or, in the case of
the two buttons at the right-hand end of the toolbar, switch between commonly
used formats that can be chosen via Style & Layout in the Document menu.

Buttons

To learn the function of a button place the mouse pointer over it.

FILE MENU
New…
[9]

This creates a new index, or a new set of abbreviations. Cindex displays a standard dialog box. Choose from the File of type list whether to create an index or a
new set of abbreviations.
Options… (new index only). This displays a dialog box through which you can
specify the structure of records (for more information see “Record Structure…”
on page 292). You have complete freedom to change record structure before you
add records to the index. After the index contains records, you cannot change
the minimum number of fields in a record, or the minimum number of characters in a field.

Open…
[10]

This opens one of several kinds of document that Cindex works with. Cindex
displays a standard dialog box through which you can choose the document and
the folder that will contain it.
Files of type. This list allows you to choose the kinds of documents Cindex will

show.

Read Only. Check this to open an index as a read-only document (this is dimmed
if you select another kind of document). When you open an index as a read only
document, you cannot make changes to it.

Close
[9]
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This closes the active window. Close has the same effect as clicking the close box
at the right corner of the title bar of a window.
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Save
[9]

This saves to disk the document displayed in the active window.

Save As…
This saves the document in the active window under another name and/or
another format. Depending on the contents of the active window, Cindex will
offer options via the Save as type drop-down list.
Saving Contents of Text
Windows

Cindex can save the contents of text windows as plain text or in Rich Text Format (RTF).

Saving Abbreviations

Cindex saves and closes the old set, leaving a copy as the active one.

[47]

NOTE: When you save a set of abbreviations under a new name, the saved set becomes
the active one. Cindex remembers where this set of abbreviations was saved, and opens
it when you begin your next session. To save a copy of abbreviations without that copy
becoming the active set, see “Save Backup Copy…” on page 262.

Cindex can save indexes in several formats. These are summarized below. In
some cases Cindex provides options that allow you to specify more precisely
what should be saved or how it should be saved.

Saving Indexes

[9]

Cindex Index. Cindex saves and closes the old index document, leaving a copy as the

active index.

[219]

Template. Cindex saves a description of the index (information about record struc-

ture, how records are sorted, and the layout of entries in the finished index) but
no records, in a document that you can use as a template for creating another
index.
[204]

XML Records. Cindex saves index records in a plain format from which you can rec-

reate an index when necessary. This format is useful for backup storage. (For
Options see “Options for Saving Unformatted Documents” on page 260).
[204]

Cindex Archive. Cindex saves index records in a compact format that you can use for
interchange with earlier versions of Cindex. (For Options see “Options for Saving
Unformatted Documents” on page 260).

[204]

Delimited Records. Cindex saves the text of index records as a plain text document

that can be read by database programs. The text of each record is contained on a
CHAPTER 14 Reference

259

File Menu

single line, with each field separated from the next by a ‘tab’ character. (For
Options see “Options for Saving Unformatted Documents” on page 260).
[191]

Plain Text. Cindex saves the text of the index as it would appear in the fully for-

matted view, but without any style or font information, and without breaking
long lines to form runover lines. (For Options see “Options for Saving Formatted
Documents” on page 261).
[190]

Rich Text Format (RTF). Cindex saves the fully formatted index along with informa-

tion about fonts, styles and layout of headings. The RTF document contains the
information a word-processor or desktop publishing program would need to display a fully formatted index. (For Options see “Options for Saving Formatted
Documents” on page 261).
[191]

QuarkXPress. Cindex saves the index as a tagged document for use by QuarkX-

[191]

InDesign Tagged Text. Cindex saves the index as a tagged document for use by

Press. (For Options see “Options for Saving Formatted Documents” on page 261).
Adobe InDesign.

Options for Saving
Unformatted
Documents
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[196]

XML Tagged Text. Cindex saves the fully formatted index as an XML document,
marked-up with tags you have specified. (For Options see “Options for Saving
Formatted Documents” on page 261).

[199]

SGML Tagged Text. Cindex saves the fully formatted index with embedded tags for
typesetting or display by a publishing system. Cindex uses tags you have specified. (For Options see “Options for Saving Formatted Documents” on page 261).

Cindex will display a dialog box that contains some or all of the following elements, depending on the type of document:
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FIGURE 68.

Options for saving unformatted documents

Items under Scope define the collection of records to be saved. For more information on this see “Scope of Operations” on page 255.
[206]

Include Deleted Records. Cindex does not normally save deleted records. Check this
item to include deleted records in the saved document.

[206]

Write in Record Number Order. Check this item to make Cindex put records in the

document in order of record number. Otherwise Cindex uses the order in which
records appear in the current view.

[206]

UTF-8 Encoding/ANSI Encoding. Specifies whether character values are encoded using

UTF-8 (Unicode) or the Windows ANSI character set.

[206]

Minimum Number of Fields. Plain text records can be written with a minimum num-

ber of fields (blank fields are inserted before the locator field if a record contains
fewer than the specified minimum).
Options for Saving
Formatted Documents

For saving formatted documents, Cindex will display a dialog box that contains
the following elements:
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FIGURE 69.

[193]

Options for saving formatted documents

Range to Save. Items define the collection of records to be saved. For more infor-

mation on this see “Scope of Operations” on page 255.
[194]

Save Backup Copy…
[9] [47]

Revert to Saved
[10]

Save Style Sheet…
[187]
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Subhead Indent. Click the appropriate button to specify how Cindex will define
leading indents to subheadings in the saved document.

This saves a copy of the document in the active window under another name.
You can save either an index or an abbreviation set. The active document does
not change.
This restores the index to its last-saved state (its state when you last saved it with
Save… or when Cindex last saved it automatically).
This saves a style sheet that contains all the settings that govern the layout of
entries in the formatted index. Cindex saves these settings: Margins & Columns,
Headers & Footers, Grouping Entries, Style & Layout, Headings, Cross-References, Page
References and Styled Strings.
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To apply a style sheet to the active index choose Open… from the File menu.

Import…
[207]

This imports index records from a text document into an index. Cindex can read
several document formats, and can usually recognize the format by examining
the document’s filename extension and contents. The Files of type drop-down list
in the dialog box offers these options:

[207]

XML Records. Records are encoded using the XML format recommended for inter-

change with other indexing software.
[207]

Cindex Archive. Records are in the backup format used by earlier versions of Cin-

dex.
[208]

Delimited Records. Each record is contained in a single line of plain text, with head-

ing levels separated by ‘tab’ characters.
[209]

Sky Text. Records are in the tab-delimited format used by Sky Index 7.

[210]

DOS Cindex Data. Records are in the tab- or quote-delimited format produced by
the legacy program Cindex for DOS.

[209]

Macrex. Records are in the backup format produced by Macrex indexing software.

New Group
[65]

This makes a temporary group from the records selected in the main index window. This item is dimmed if no records are selected.

[66]

This converts to a permanent group the temporary group displayed in the main
index window. Cindex displays a dialog box in which you type the name you
want to give the group. This item is dimmed unless the view shows a temporary
group.

[80]

This displays the standard Windows dialog box through which you specify
paper settings for your printer.

Save Group…

Page Setup…
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Print…
[80]

This displays, with some additional items that are special to Cindex, the standard Windows dialog box through which you specify how you want the document printed.

[10]

These items identify the most recently used indexes. To open a recently-used
index choose it by name from the menu. Via Preferences… you can set the maximum number of filenames displayed.

Recent Files

Exit
[9]

This saves and closes all open documents, then shuts down Cindex.

EDIT MENU
Undo

In any window containing editable text this undoes your last action (Cut, Paste,
etc.) Actions on other windows cannot be undone. This item is dimmed if the
last action cannot be undone.

Redo
In a window in which you are editing text this redoes the last action that you
undid.

Cut
[38]

This cuts selected text in a window that contains editable text. The text can be
viewed in the Clipboard window (from the Window menu). This item is dimmed
if nothing can be cut.

Copy
This copies to the Clipboard the selected items in the active window. The copied
selection can be viewed in the Clipboard window (from the Window menu).
[50]
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If the main index window is active, Cindex copies selected records.

CHAPTER 14 Reference

Edit Menu

[38]

If a text-editing window is active, Cindex copies selected text.

Paste
This pastes items from the Clipboard to the active window. This item is dimmed
if the clipboard contains no object of a kind that can be pasted into the active
window.
[50]

If the main index window is active, Cindex pastes records.

[38]

If an editable text window is active, Cindex pastes the text at the insertion point
(or replaces any selected text).

Clear
If the active window contains editable text, this removes any selected text.

Select All
This selects all items in the active window.

New Record
[20]

This opens a window (below) that contains a new, empty record.

FIGURE 70.

Edit Record
[35]

Window for adding or editing records

If a main index window is active, Cindex opens a window that contains the text
of the first selected record.
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Duplicate
[49]

If the main index window is active, this duplicates the selected record(s). If you
duplicate a single record, Cindex immediately opens it for editing; if you duplicate several records, Cindex puts them in a temporary group and displays that
group in the main window. This item is dimmed if nothing is selected.

[49]

If the record window is active and contains an existing record (not a new one),
this saves the record and displays a copy of it.

[51]

When the main index window is active, this deletes or undeletes selected
records. Deleted records are invisible in a formatted view, but remain in the
index until you compress it with Compress… from the Tools menu. In any draft
view of the index, a deleted record is identified by a x beside it.

Deleted

When the record window is active, this deletes or undeletes the record (the status line at the bottom of the window will show ‘Deleted’ if the record is deleted).

Labeled
[52]

When the main index window is active, this applies the specified label to selected
records if the first record in the selection does not already carry that label; otherwise it removes the specified label from all selected records that carry it.
When the record window is active, this applies the specified label or removes a
label from the active record (the status line at the bottom of the window will
show ‘Labeled’ if the record is labeled).

Find…
When the main index window is active, this displays a window (Figure 71)
through which you can search for text in records.
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Enter
search text
here

FIGURE 71.

Find window

Scope

Items in the Scope box control the scope of the search. For more information on
them see “Scope of Operations” on page 255.

Confining the Search to
Records with Specified
Attributes

Items in the Only Among box specify the attributes records must have to be
included in or excluded from the search. For more information see “Using
Record Attributes” on page 73. If any attributes are checked, you can find
records that have (or lack) these attributes simply by specifying no search text.

[70]

Find/Find Again/Resume. Click this to find the first/next occurrence of the search
text (or the first record with the checked attributes, if no search text is specified).

[71]

Find All. Click this to find the all records that contain the search text (or have the

checked attributes, if no search text is specified). Cindex makes a temporary
group for the records.

[70]
Specifying the Search
Target

Reset. Click to clear the current settings and set up for a new search.

Enter the search text in the box marked in Figure 71. The following items govern
how Cindex treats this text.
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[76]

Not. When this is checked Cindex finds records that do not contain the specified

text or the specified text attributes.

[72]

Attributes. Click this to display a dialog box through which you can specify the

attributes of the text for which you are searching. When an attribute has been
specified, Cindex identifies it in the sunken box beside the button.

[74]

Field. This list identifies the fields in records that Cindex will examine when

searching for text.

[75]

Evaluate References. When this is checked, Cindex treats the search text as specify-

ing a locator (or range of locators) and will find any record that contains a reference falling within the range. This item is dimmed unless the search is confined
to the locator field.
[76]

Match Whole Word. When this is checked, Cindex matches only a whole word (a

continuous sequence of letters or numbers). This item is dimmed if the search
text contains anything other than letters or numbers.
[76]

Match Case. When this is checked Cindex finds text in which the case of letters

matches the target text.
[76]

Match Pattern. When this is checked Cindex treats the text as a pattern to be

matched.
[76]

Only/And/Or. Items in this drop-down list determine whether Cindex searches for

the specified text alone or in conjunction with some other text. Choose And or
Or to extend the window to accommodate the specification of a second segment
of text. You can specify up to four segments altogether.

Find Again
[70]

Finds the next occurrence of the search target previously specified with Find.

Replace…
When the main index window is active, this brings up a window (Figure 72)
through which you can search for and replace text in records.
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FIGURE 72.

Replace window

Scope

Items in the Scope box control the scope of the search. For more information on
them see “Scope of Operations” on page 255.

Confining the Search to
Records with Specified
Attributes

Items in the Only Among box specify the attributes records must have to be
included in the search. For more information on them see “Using Record Attributes” on page 73.

[85]

Find. This contains text for which Cindex searches. The drop-down list contains

a history of recent searches.

[84]

Find/Find Again/Resume. Click this to find the first/next occurrence of the search

text.
[84]

Replace. Click this to replace the search text in the highlighted record. Cindex

automatically looks for the next occurrence after replacing the text.

[84]

Replace All. Click this to replace every occurrence of the search text in records.

[84]

Reset. Click to clear the current settings and set up for a new search and replace.
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Specifying the Search
Target and
Replacement
[87]

Enter the search text in the Find box in Figure 72. Type the replacement text at
Change to. The following items govern how Cindex treats the search text.
Attributes (search). Click this to display a dialog box through which you can spec-

ify the attributes of the text for which you are searching. When an attribute has
been specified, Cindex identifies it in the sunken box beside the button.
[89]

Field. Use this list to choose which fields in records Cindex examines when

searching for text.

[90]

Match Whole Word. When this is checked, Cindex matches only a whole word (a

continuous sequence of letters or numbers). This item is dimmed if the search
text contains anything other than letters or numbers.
[90]
[90]

Match Case. When this is checked Cindex finds text in which the case of letters
matches the target text.
Match Pattern. When this is checked Cindex treats the text as a pattern to be

matched.
[87]

Attributes (replacement). Click this to display a dialog box through which you can
specify the attributes to be added or replaced.

Spelling…
When the main index window is active, this opens a window (Figure 73)
through which you can check the spelling of text in records.
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FIGURE 73.

Items under Scope control the scope of the examination. For more information
on most of these see “Scope of Operations” on page 255.

Scope

Dictionaries

Spelling dialog box

[104]

Field. The chosen item determines which field or fields Cindex will check.

[104]

Check Page References. If this is checked Cindex will check the spelling of text in the
locator field, whether or not the text is a cross-reference. If this item is
unchecked, Cindex checks only cross-references.

[99]

Language. The chosen item identifies the main language dictionary Cindex will

use for checking spelling.

[101]

Dictionary. The chosen item identifies the personal dictionary (if any) that Cindex

will use in addition to the main language dictionary.

Buttons

[106]

Suggest. Clicking this causes Cindex to suggest alternative spellings for an unrec-

ognized word. The button is dimmed if Cindex is set to suggest alternatives
whenever it encounters an unknown word (see “Setting Options [105]” on
page 272).
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[99]

Start/Resume/Ignore/Delete. Clicking this starts spell-checking, or (if spell-checking
is already under way) causes Cindex to ignore a word it has not recognized, or
delete a repeated word.

[100]

Change. Clicking this causes Cindex to change the misspelled word to the word

[103]

Reset. Clicking this causes Cindex to stop checking spelling, and restores the
Spelling window to its initial state.

[101]

Ignore All. Clicking this causes Cindex to ignore all further occurrences of the

displayed at Change To.

unknown word in your current session.

Setting Options

[101]

Add. Clicking this adds the unknown word to the active personal dictionary.

[105]

Clicking Options… displays the dialog box shown in Figure 74.

FIGURE 74.

[105]

Spelling Options dialog box

Use Additional Dictionaries. This shows any additional specialized dictionaries that

can be used with the chosen language.

[102]

272

Personal Dictionary. This contains a list of available personal dictionaries. For the
dictionary chosen, Edit… displays a dialog box that shows all words in it. You can
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edit the words in the list. New… displays a dialog box through which you name
and create a new personal dictionary.
[106]

Always Suggest Alternatives. When this is checked Cindex will always try to suggest

alternative spellings for unknown words.
[106]

Ignore Words in CAPITALS. When this is checked Cindex will not check any word

that consists entirely of capital letters.
[106]

Ignore Alphanumeric Strings. When this is checked Cindex will not check any word

that contains both letters and numerals.
[107]

New Abbreviation…
[46]

Clear Ignore List. Clicking this causes Cindex to forget any words it has been told to

ignore (via Ignore All in the Spelling window).

When the Abbreviation window is active, this starts the definition of a new
abbreviation. When the record-editing window is active, this displays a dialog
box through which you can define an abbreviation for selected text.

Preferences…
This displays a dialog box through which you make settings that govern the general behavior of Cindex.
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FIGURE 75.

General Tab

Preferences dialog box

[10]

No Action/Open Last Index/Show Open Panel. This determines whether Cindex will
open the last index you worked on when it starts up (unless you started Cindex
by double-clicking an index), displays the Open… panel, or does nothing.

[13]

Maximize Cindex. This specifies whether or not Cindex occupies your whole screen

when it starts.

[12]

Prompt for User ID. This specifies whether or not Cindex will prompt you for a user

identifier each time you begin a session.
[13]

Maximize on Opening. This specifies whether or not Cindex will maximize each

index as it is opened.
[9]
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Save Open Indexes Every… This specifies the interval (in minutes) at which Cindex
automatically saves indexes to disk. To disable automatic saving set this to 0.
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[10]

Maximum Number of Recent Indexes. This specifies how many names of recently-used

[12]

User ID. Enter up to four identifying characters that Cindex will attach to each

indexes are displayed in the File… menu.

record that you make or modify. Cindex displays these characters on the status
line in the record window. You can use User ID as a search criterion with Find.

[5]

Automatically check for updates. Check this to make Cindex check automatically and
notify you when an update is available.

[13]

Default Folder. Click this to display a dialog box through which you can specify the

folder that Cindex will use by default when it saves or opens indexes.

Items here control how Cindex behaves when you add or edit records through
the record window.

Editing Tab
[20]

Use Separate Window. When this is checked the record-entry window is detached
from the bottom of the main window and displayed separately.

[58]

Switch to Draft View. When this is checked, and the main window shows fully for-

matted entries, Cindex will temporarily switch the view to show records in draft
format when it opens the record window.
[38]

Remove Extra Spaces. When this is checked, Cindex will reduce multiple spaces

between words to a single space, whenever multiple spaces are entered in records.

[41]

Smart Flip. When this is checked, Cindex will intelligently adjust the case of lead-

ing letters and the positions of prepositions and articles when it swaps the contents of two record fields.
[39]

Complete Page Ranges. hen this is checked, Cindex will automatically complete a
page range when you type the connecting character that follows the first part of
the range.

[28]

Track New Entries. When this is checked, Cindex immediately displays each new
entry in its sorted position in the main index window.

[39]

Carry Locators Forward. When this item is checked, the locator field of each new

record you make is automatically loaded with the contents of the locator field
from the record most recently added to the index.
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[36]

Auto-Complete Entries. When this is checked, Cindex will attempt to complete any

record field when what you have typed matches an entry already in the index.

[36]

Ignore Style & Case. When this is checked, Cindex will auto-complete entries if
what you have typed matches and existing entry, regardless of letter style and
case.

[36]

Track Source. When this is checked, will display in the main view window the entry

that provides the source of the text used in auto-completion.

[42]

Propagate Changes. When this item is checked, Cindex will propagate editing

changes to any following records in which fields originally matched those that
were changed.

[36]

Return to Entry Point. When this item is checked, after editing a series of records
Cindex restores the main index display to show the entries it contained when
you started editing.

[26]

On Closing Window. The active button determines how Cindex behaves when you

[216]

Mismatch to Template. The active button determines what Cindex does when you

close the record-editing window by clicking its close box, or by choosing Close
from the File menu.

attempt to save a record in which the contents of a field do not match a template
specified for it.

[43]

Bad Locator. The active button determines what Cindex does when you attempt to

save a record that has an empty locator field, or a badly-formed locator.

View Tab

[44]

Bad Cross-Ref. The active button determines what Cindex does when you attempt
to save a record containing a cross-reference that has no target.

[33]

Default Font. The list specifies the font Cindex will use initially as the standard

font for a new index it creates.

[33]

Main View. This specifies the size of the characters Cindex will use initially to dis-

play entries in a new index it creates.
[33]
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Entry View. This specifies the type size Cindex will use when it displays entries for
editing in the record window. Set 0 to make Cindex use whatever type size is set
for the main window.
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[52]

Label Colors. Double-click any colored cell to display a dialog box through which

you can specify the color in which records carrying the label will be displayed.

[52]

Display in Formatted View. Check this to make Cindex display unique parts of

labeled records in their distinctive color when using a formatted view. In a draft
view records are always displayed in their distinctive colors.

Formatted Export Tab
[194]

Plain Text/RTF/Quark/InDesign. The item chosen here determines how Cindex will
form the leading indents to subheadings when it saves formatted indexes in Rich
Text Format, as plain text, or in the tagged text formats used by QuarkXPress or
Adobe InDesign.

[202]

Include Sorting Information when Embedding Entries. Check this to make Cindex include
with embedded entries information about how they should be sorted.

[191]

Encode Plain Text Documents. Specifies the character representation (UTF-8 Unicode

or Mac Roman) Cindex will use when saving plain documents.

VIEW MENU
Go To…
[68]

When the main index window is active this brings up a dialog box (Figure 76)
through which you can specify an entry, or a page of entries, you want to bring
into view.

FIGURE 76.

Go To dialog box
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To display a particular record, click Record and specify it by the contents of its
headings or by its number (see the discussion under “Scope of Operations” on
page 255). To display entries that would fall on a particular printed page of the
index, click Formatted Page and enter the page number.

All Records
[64]

This sets the view to show all records in the index.

[64]

This sets the view to show only new records. This item is dimmed if there are no
new records.

[66]

This submenu identifies groups that belong to the index, and sets the view to
show records in the chosen group. This item is dimmed if the index has no
groups.

New Records

Group

Temporary Group
[65][71]

Full Format
[55]

This sets the view to show fully-formatted index entries.

[58]

This sets the view to show index entries in draft format.

[60]

This sets the view to show entries in summary format (a draft format showing
headings and cross–references only). Cindex scans the index before displaying
entries in this format.

Draft Format
Summary
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This sets the view to show records in any temporary group that Cindex has
formed. Temporary groups can be formed from selected records, or by using
Find…, from the Edit menu. This item is dimmed if the index has no temporary
group.
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Unformatted
[61]

Hide by Attribute…

This sets the view to show unformatted records.

[57]

Displays a dialog box through which you can specify the visibility of records carrying particular labels. This item is available only when Cindex displays fully formatted entries.

[59]

This hides (when unchecked) or shows (when checked) record numbers in any
view except the fully formatted one. This item is dimmed when Cindex displays
fully formatted entries.

[59]

The checked item in this submenu identifies the lowest heading level that Cindex will display, in any view but the fully formatted one. This item is dimmed
when Cindex displays fully formatted entries.

[62]

This item determines whether Cindex clips, or wraps to the next line, record text
that would extend beyond the right margin of the page. This item is available in
the unformatted view only; it is dimmed otherwise.

[62]

This item determines whether index entries are displayed in sorted or unsorted
order. It is available only when the view is set to show all records, and is dimmed
otherwise.

Show Numbers

View Depth

Wrap Lines

Sorted

CHARACTER MENU
Default Font
[33]

When the record editing window is open this sets selected text in the default
font for the index.
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Plain
[34]

Bold … Superscript

When the record editing window is open this clears all styles from the selected
text.

[34]

The styles Bold, Italic, Underline, Small Caps and Subscript or Superscript can
be applied concurrently to any selection. A check mark indicates when a style is
applied to the whole of the selected text.

[24]

Opens a window that displays the full character set available in any font. From
this window you can enter special characters directly in records, or in specifying
search text with Find or Replace.

Character Map…

DOCUMENT MENU
Items in this menu control aspects of the structure or formatting of indexes. If an
item is chosen when the main window for an index is active, the settings apply to
that index only. If an item is chosen when no index is open, Cindex applies the
settings to new indexes when it creates them.

Margins & Columns…
This displays the dialog box shown in Figure 77.
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FIGURE 77.

Setting Margins

Margins & Columns dialog box

[169]

Top. This specifies the size of the top margin, in the unit displayed in the Unit
drop-down list.

[169]

Bottom. This specifies the size of the bottom margin, in the unit displayed in the

[169]

Left/Inside. This specifies the size of the left or inside margin, in the unit displayed

[169]

Right/Outside. This specifies the size of the right or outside margin, in the unit dis-

[169]

Facing Pages. When this item is checked Cindex formats pages with inside (near

Unit drop-down list.

in the Unit drop-down list.

played in the Unit drop-down list.

binding) and outside (far from binding) margins. When this item is unchecked,
all pages are printed with the same left and right margins.
Setting Columns

[169]

Columns. This drop-down list specifies the number of columns that will appear on

the printed page. The screen display always shows a single column, but of the
correct width.
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[169]

Gutter. This specifies the space between columns, in the unit displayed in the Unit
drop-down list.

Repeating Broken
Headings
[171]

Never/At New Page/At New Column. These buttons specify the conditions under
which Cindex should repeat, at the start of a new column or page, the heading(s)
from any entry broken at the foot of the preceding column or page.

[171]

To Level. The chosen item in this list specifies the lowest-level heading that Cindex
will repeat if it breaks an entry.

[171]

Append. Cindex appends this text to each level of heading it repeats after breaking

an entry.
[171]

Style… This brings up a dialog box through which you can set the style of any

text Cindex will append to a repeated heading.

Headers & Footers…
This displays the dialog box shown in Figure 78.

FIGURE 78.

282

Headers & Footers dialog box
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[172]

Header/Footer [Left Header/Left Footer, etc.]. Click the tab to make settings for the

appropriate header or footer.
[172]

Left/Center/Right. Each of these segments contains text the will appear left-justified,

centered, or right- justified in the header or footer line on the left or right page.
When building the header or footer Cindex does not check if the segments of
text will overlap.

Unless preceded by \ (backslash), the following characters have special meanings
when used in a segment:
• @ denotes the current date/time.
• # denotes the current page number.
• % denotes the name of the index.
[173]

Font. This specifies the font in which the header or footer line will be printed.

The item at the top of the list (<Default>) represents the standard font in which
the index is currently displayed.
[173]

Size. This specifies the size of text used in the header or footer. 0 means the size
used for index entries.

[173]

Style. This displays a dialog box through which you can set the style to be applied

to text in the header or footer line.
[172]

Copy. When the index is formatted for facing pages, clicking this copies the set-

tings for the currently selected page (left or right) to the other page. The button
is dimmed if the pages have identical headers and footers.

Date Format

[174]

First Page Number. This specifies the number (if any) printed on the first page.

[174]

Number Format. This specifies the format of numerals (Arabic or Roman).

[174]

Long/Short. This determines the format in which Cindex will print a date in the
header or footer. Define these formats through the Date tab of your computer’s
Regional Settings Control Panel.

[174]

Add Time. If this is checked, Cindex appends the time to any date it prints in a
header or footer.
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Grouping Entries…
The dialog box shown in Figure 79 contains settings that govern how Cindex
groups entries for display in the formatted index. Settings take effect only when
the index is displayed in fully formatted view.

FIGURE 79.

[174]

Grouping Entries dialog box

Title Text. Text entered here appears as the title to each group. The character % is

understood to represent the character that begins the group. This character is the
first under which Cindex sorts an entry.

[174]

Font. This specifies the font in which Cindex will print any group title. The item

at the top of the list (<Default>) represents the standard font in which the index
is currently displayed
[174]

Style. This displays a dialog box through which you can set the style in which

Cindex will print any group title.
[174]
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Grouping Method. The item chosen in the drop-down list determines how Cindex
groups entries that begin with numbers and symbols (each letter of the alphabet
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occupies its own group). Elements within a single pair of square brackets are
grouped together.
[175]

Numbers/Symbols Titles. Specify here any titles to be used for groups that aggregate

all numbers, all symbols or all numbers and symbols.

Style & Layout…
The dialog box shown in Figure 80 contains settings that govern the style and
layout of entries in the formatted index.

FIGURE 80.

Style

[177]

Style & Layout dialog box

Indented/Run-In. This determines the basic index style, indented or run-in. In run-

in style, the drop-down list specifies the heading level below which entries are
run-in (they are indented until that level).

[178]

Variant. The item chosen from the drop-down list specifies any variant on the

basic indented or run-in style.

CHAPTER 14 Reference

285

Document Menu

[180]

Collapse Headings below. This determines the level below which headings will be

suppressed, and their page references and cross-references displayed as though
belonging to the last visible heading level.

Indentation

[181]

Type. The drop-down list determines how Cindex will calculate the indentation
of different levels of heading and runover lines.

[182]

Unit. This determines the unit in which Cindex will calculate the indentation of

formatted entries. (An Em space is the width of M in the standard font in which
the index is displayed.)

[182]

Lead. This specifies the size of the indent (in the chosen unit) that Cindex will
use before a new level of heading.

[182]

Runover. This specifies the size of the indent (in the chosen unit) that Cindex will

use before a runover (continuation) line.
Line Spacing

[183]

The item chosen in the drop-down list determines how Cindex spaces lines (single, one-and-one-half lines, double).

[183]

Auto. When this is checked, Cindex calculates the line spacing automatically for
the font and size in which entries are displayed. This item is dimmed if the spacing is set to some other value.

[183]

The text box shows the separation of lines, in the unit chosen from the dropdown list to its right. The text box is dimmed if Auto is checked.

[183]

Extra at Main Headings. Cindex inserts this number of extra lines between main

headings.

[183]

Extra at Alphabetic Groups. Cindex inserts this number of extra lines between each

group of entries. (Groups are identified through settings in “Grouping Entries…”
on page 284.)
Adjusting
Punctuation

[184]

Around Quotation Marks. If this is checked Cindex will move a trailing period or

comma inside any closing quotation mark when it displays formatted entries.
[184]

Around Styled Text. If this is checked Cindex will move a trailing punctuation mark

inside any closing style (italics, boldface, etc.) when it displays formatted entries.
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Headings…
The dialog box shown in Figure 81 contains settings that govern the punctuation, font and style in which Cindex displays headings at different levels. The
settings take effect only when the index is displayed in fully formatted view.

FIGURE 81.

Heading Format dialog box

[184]

Main … Click the tab corresponding to the heading level to which settings will be
applied.

[184]

Font. This specifies the font in which the heading will be displayed. The first item

(<Default>) represents the standard font assigned to the index from the font
drop-down list in the toolbar.
[184]

Style. This brings up a dialog box through which you can specify the style in
which the heading will be displayed.

[184]

Leading Text. This contains text that Cindex will insert immediately before the text

of the heading.
[184]

Trailing Punctuation. This contains any punctuation that Cindex will place after a
heading that has no immediately following page reference or cross-reference.

[184]

Suppress. When this is checked, headings at the specified level, and any associated

page references or cross-references, are suppressed.
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Cross–References…
The dialog box shown in Figure 82 contains settings that govern how Cindex
displays cross-references. Most settings take effect only when the index is displayed in fully formatted view.

FIGURE 82.

[120] [123]

Cross–References dialog box

From Main Heading/From Subheading. Click the tab to make settings for cross–refer-

ences from the main heading, or cross-references from subheadings.
[120] [123]

Prefix. Cindex displays the this text (including spaces) before the first cross–refer-

ence of the appropriate kind (See, or See also).
[120] [123]

Suffix. Cindex displays this text (including spaces) immediately after the last

cross-reference of the appropriate kind (See, or See also).
[120]

Position. This determines where Cindex places cross-references: immediately fol-

lowing the heading (after any page references), immediately following the heading (only if there are no page references); as the first subheadings, or as the last
subheadings. The setting affects both draft and full-formatted views.
[123]

Alphabetize Multiple References. If this is checked Cindex will arrange cross–refer-

ences alphabetically when more than one is made from a single heading or subheading. If this item is unchecked, cross–references appear in the order in which
they were entered in records.
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[124]

Suppress All References. If this is checked Cindex will suppress the display of all

cross-references (fully formatted view only).

[125]

Don’t Apply Style Prefix if it Matches Existing Body Style. If this is checked Cindex will
not apply a prefix style if that style is already applied to the cross-reference body.

[124]

Prefix Style. This brings up a dialog box through which you can specify the style in

which Cindex will display the phrase that introduces a cross–reference.

[124]

Body Style. This brings up a dialog box through which you can specify the style in

which Cindex will display the body of a cross–reference.

Page References…
These settings govern how Cindex displays page references, and take effect only
when the index is displayed in fully formatted view. Cindex displays the dialog
box shown in Figure 83.

FIGURE 83.

Page References dialog box
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Ranges

Punctuation

[141]

Connecting Text. This contains the set of characters that Cindex will display in fullyformatted entries instead of the single character (usually –) used to connect a
range in a record.

[142]

Conflate Beyond. The chosen item identifies the number of separate references to
consecutive pages Cindex must encounter before it conflates them into a range
(e.g., 55, 56, 57 becomes 55–57).

[143]

Abbreviation Rule. The item chosen determines the rule (if any) Cindex will use to
abbreviate the higher number in a connected range (e.g., 325–327 becomes
325–27).

[145]

Before Single. This contains the characters (including spaces) that Cindex will

place between a heading and an immediately following single page reference.

[145]

Before Multiple. This contains the characters (including spaces) that Cindex will

place between a heading and immediately following multiple page references.

[145]

After. This contains the characters (if any) that Cindex will place after the last

page reference to a heading.
[145]

Right Justify. When this is checked Cindex will right-justify page references

(within the width of a column). This setting applies only to indexes formatted in
indented style.

Multi-Part
References

[145]

Dot Leader. When this is checked, Cindex formats right-justified references with a
dotted leader.

[144]

Suppress Repeated Parts. When this is checked Cindex will suppress leading seg-

ments of multi-part references beyond the first in a series (e.g., displaying XIV
55:10; XIV 55:62; XIV 55:79 as XIV 55:10, 62, 79).
[144]

Suppress to. This specifies a (possibly disconnected) sequence of characters that

determine how much of the beginning of a multi-part reference Cindex will suppress. Cindex suppresses everything that lies before the last character in the
sequence.
[144]

Concatenate with. Cindex replaces any suppressed leading segments of multi-part

references with the characters entered here.
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Other Settings

[147]

Arrange in Sorted Order. If this is checked Cindex will display multiple page refer-

ences from the same heading in sorted order. If this item is unchecked, references
appear in their order of entry in records.
[148]

Suppress All References. If this is checked Cindex will suppress the display of all page

references (fully-formatted view only).

Locator Style

[146]

Style. This brings up the dialog box shown in Figure 84. Through this you specify

the style in which Cindex will display the different components of page references.

FIGURE 84.

[146]

Locator Style dialog box

First … N. Click the tab to identify the segment of a multi-part reference to which

styles will be applied (a simple page reference has only one segment).

[146]

Locator Element. Checked styles are applied to the reference element proper.

[146]

Lead Punctuation. Checked styles are applied to any punctuation that precedes the
reference element.

Styled Strings…
The dialog box shown in Figure 85 contains a list of words and phrases to which
Cindex will apply a style or styles automatically when it displays a formatted
index. Settings take effect only when the index is displayed in fully formatted
view.
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FIGURE 85.

Styled Strings dialog box

[186]

The list shows words or phrases to which Cindex will automatically apply a style.
Click a word or phrase in the list to see, below it, the styles that Cindex will apply
to it.

[186]

Add. This adds to the list a new word or phrase typed in the text box, with the
specified attributes. This item is dimmed if the displayed word or phrase is
already in the list.

[186]

Delete. This removes from the list the selected word or phrase.

Record Structure…
The dialog box shown in Figure 86 contains settings that control the structure of
index records.
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FIGURE 86.

[214]

Record Structure dialog box

Maximum Characters in a Record. This specifies the maximum number of characters a

record can hold. If the index contains records, this number cannot be less than
the number of characters contained in the longest record. That number will be
shown to the right.

[214]

Number of Fields. The Min and Max list settings specify the minimum and maxi-

mum number of fields index records can hold. The minimum can be set only if
the index contains no.
[215]

Subhead Preceding Locator is Required. When this is checked each record will contain a

last subheading field (attached to the locator field) that cannot be split or joined
to another field. This is dimmed unless the minimum number of fields is at least
3.

Properties of Fields [216]

First… Each tab contains settings for its corresponding record field. Tab names

identify fields by their order of appearance in records (the locator field is always
represented by the last tab).
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[216]

Field Name. This specifies the name Cindex will use to identify the field in the
record window and in various drop-down lists.

[216]

Maximum/Minimum Characters. These set the maximum and minimum numbers of

characters that the field may contain (a setting of 0 implies no limitation).

[216]

Match. This contains any pattern to which the contents of the field must con-

form.

Reference Syntax…
The dialog box shown in Figure 87 contains settings that specify the structure of
cross-references and page references.

FIGURE 87.

Page References

[128]

Reference Syntax dialog box

Separator. This (single) character separates one page-reference from the next when

two or more are contained in a record.
[128]

Connector. This character separates the parts of an inclusive range of page refer-

ences, in records. It need not be the character Cindex displays in formatted
entries.
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[43]

Maximum Value. This specifies the maximum value a locator can take. Cindex can

check that locators you enter in records do not exceed this value.

[43]

Greatest Range. This number specifies the maximum span of pages than can be rep-

resented in a consecutive range. Cindex can check that the spans of ranges you
enter in records do not exceed this value.
Cross–References [110]

Lead. This contains the words that can form the introductory phrase of a crossreference.

[110]

Separator. This specifies the character that is used to identify the end of a cross–

reference when two or more appear sequentially in a record.
[110]

General. This contains the individual words that may begin a general cross-refer-

ence that refers to no particular entry (e.g., See specific diseases).
[110]

Recognize Cross-References in Locator Field Only. Check this to prevent Cindex identify-

ing text in a heading as a cross-reference.

Smart Flip Words…
[41]

The panel contains the words that Cindex may move within and between record
fields when it executes a ‘Smart Flip’.

TOOLS MENU
Check References…
This checks that cross-references refer correctly to entries somewhere in the
index, and/or that entries do not contain too many unqualified page references
Cindex displays the dialog box shown in Figure 88.
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FIGURE 88.

[114]

Checking References

Require Exact Matches. If this is checked Cindex requires an exact match between

the body of a cross-reference and the entry to which it refers. If this item is
unchecked, Cindex accepts shortened or modified matches.

[115]

Minimum number of entries to match. This specifies the minimum number of target

entries that Cindex must find under each heading to which a cross-reference is
made. The value must be at least 1.
[132]

Maximum locators in single entry. Specifies the maximum acceptable number of loca-

tors that can be attached to a single entry.

Reconcile Headings…
This finds orphaned subheadings, or reconciles heading levels in records by
adjusting fields so that no record contains more levels of heading than it needs.
Cindex displays the dialog box shown in Figure 89.
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FIGURE 89.

[95]

Reconcile Headings dialog box

Check Headings Below. The chosen item specifies the level below which Cindex may

split or join headings.

[96]

Find Orphaned Subheadings/Reconcile headings. Choose whether Cindex will provide a
list of orphaned subheadings or will reconcile heading levels.

[97]

Modifying Phrases Follow. This specifies the character (usually a comma) that sepa-

rates a heading from any immediately following modifying phrase.
[97]

Preserve Modified Headings. If this is checked, Cindex will not break modified head-

ings before joining fields to remove redundant heading levels.
[97]

Protect Names. When this is checked Cindex will never break a field if the text fol-

lowing the potential break point begins with a capital letter.
[97]

Convert Orphans to Modifying Phrases/Remove Orphans. Choose how Cindex will deal

with orphaned subheadings.
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Manage Cross-References…
This displays the dialog box shown in Figure 90, through which you choose to
whether to generate cross-references automatically for specified target entries, or
convert existing cross-references to fully-qualified entries.

FIGURE 90.

[117]

Manage Cross-References dialog box

Generate from File. This displays an Open dialog box through which you choose the

source of cross-references that Cindex will add to the active index if it contains
appropriate target entries. Check “See” References Only to make Cindex generate
only See references, vs. both See and See also references

[116]

Convert to Fully Qualified Entries. Choose this to make Cindex convert any see refer-

ences with fewer than a specified number of target entries into fully qualified
entries.
[116]

For Fewer Targets Than. Specify the number of target entries below which Cindex

will convert a see reference to a fully qualified entry.

Alter References…
This adjusts references to page numbers contained in the locator fields of
records. Cindex displays the dialog box shown in Figure 91.
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FIGURE 91.

[91] [92]

[249]

Alter References dialog box

All References/Range. This specifies whether Cindex adjusts all references, or only
references falling within a range identified by the beginning and ending page
numbers in the boxes.
Matching Pattern. This can contain a pattern that specifies any initial parts of a

multi-part reference Cindex must skip before the part that it will adjust.

[93]

Adjust Only/Remove References. This determines whether Cindex adjusts or removes

[91]

Adjustment. This specifies the amount (positive or negative) by which references

references that match the specification in Scope. If Remove References is specified,
Cindex adjusts references to higher numbered pages to take account of those
removed, unless Hold Higher Values is checked.
will be adjusted.

Sort…
This sorts entries by rules specified via the dialog box shown in Figure 92.
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FIGURE 92.

Text

Sort dialog box

[149]

Language. This specifies the type of alphabetizing rule Cindex will use.

[156]

Alphabetizing Rule. This specifies the type of alphabetizing rule Cindex will use.

[160]

Ignore -/. If this is checked Cindex will ignore - and / in word-by-word alphabetiz-

ing. If this is unchecked Cindex treats - and / as spaces.
[160]

Ignore .,:; If this is checked, Cindex will ignore these characters, in letter-by-letter

or word-by-word alphabetizing only. If this is unchecked, Cindex treats these
characters as having higher precedence than spaces.
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[161]

Evaluate Numbers. If this is checked, Cindex evaluates a series of digits as a number,

in letter-by-letter or word-by-word alphabetizing only. If this is unchecked, Cindex ignores digits while alphabetizing entries.
[161]

Ignore Parenthetical Phrases. When this item is checked, Cindex ignores parentheti-

cal phrases, in letter-by-letter or word-by-word alphabetizing only. When this
item is unchecked, Cindex attends to text in parentheses.
[161]

Ignore Parenthetical Endings. When this item is checked, Cindex ignores parentheti-

cal endings to words, in letter-by-letter or word-by-word alphabetizing only.
[159]

Character Priority. The position of a character class in this list determines the prece-

dence of that class of characters. (Items in the list can be dragged to new positions.)
[159]

Ignore Subheading Prefixes. This list contains words that Cindex will ignore if they

appear at the beginnings of subheadings, in letter-by-letter or word-by-word
alphabetizing only.
Fields

[149]

Order. The order in which checked items appear in the list determines the order
in which Cindex evaluates the corresponding fields in records. Double-clicking
an item checks or unchecks it. (Items can be dragged to new positions.)

[152]

Ignore Lowest Subheading. When this is checked Cindex ignores the contents of the

lowest-level text field in a record.

Locators

[135]

Segment Order. This specifies whether, and in what order, Cindex will evaluate a

particular segment of a multi-part reference. Cindex evaluates segments appearing at the positions identified by check marks. Double-clicking an item checks or
unchecks it. The order in which Cindex evaluates a checked item is determined
by the item’s position in the list. (Items can be dragged to new positions.)
[133]

Type Precedence. This specifies whether or not Cindex will recognize reference

components of different classes, and the precedence of the classes Cindex does
recognize. Cindex recognizes components of classes that are checked. Doubleclicking an item checks or unchecks it. The precedence of a checked item is
determined by its position in the list. (Items can be dragged to new positions.)

[135]

Style Precedence. This specifies the precedence of otherwise identical locator com-

ponents that differ in text style.

CHAPTER 14 Reference

301

Tools Menu

[138]

Ascending Order. When this is checked, low-valued references precede higher val-

ued ones. When this is unchecked, higher valued references precede lower-valued ones.
[138]

Examine All. When this is checked Cindex sorts by the lowest (or highest) valued

reference (per Ascending Order, above). When this item is unchecked, Cindex uses
the value of the first reference in a record.

Compress…
This removes records of specified kinds from the index. Cindex displays the dialog box shown in Figure 93.

FIGURE 93.

[225]

Compress dialog box

Remove Deleted Records. When this is checked Cindex removes deleted records and

renumbers records that remain.
[225]

Remove Empty Records. When this is checked Cindex removes records that contain

no text.
[225]

Remove Duplicated Records. When this is checked Cindex removes any record that is

an exact duplicate of another.
[226]

Remove Generated Records. When this is checked Cindex removes records that con-

tain automatically generated cross-references.
[226]

Consolidate References. When this is checked Cindex finds records that are identi-

cal, except for their page references or cross-references, and consolidates page ref-
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erences or cross-references into as few records as possible. Cindex removes
unnecessary records.
[226]

Ignore Different Labels. Check this to make Cindex consolidate references from
identical records, regardless of whether they carry the same label.

[224]

This generates new records as needed so that no record in the index contains
more than one page reference or one cross-reference.

[222]

This counts records of specified kinds. Cindex displays the dialog box shown in
Figure 94.

Expand

Count Records…

FIGURE 94.

Count dialog box
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Cindex counts records within the scope specified under Scope, and containing
the attributes checked in Only Among. For more information on setting the scope
and attributes see “Scope of Operations” on page 255.
[223]

Containing Locators. This specifies the range of locators for which Cindex will count

records. If no range is specified, Cindex counts records regardless of locator
value.

Index Statistics…
[220]

This provides various statistics about the active index. Cindex displays the dialog
box shown in Figure 95.

FIGURE 95.

Index Statistics dialog box

Cindex displays information about the formatted entries within the scope specified in Range to Examine. For more information on setting the scope see “Scope of
Operations” on page 255.
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Abbreviations
[46]

Fonts…

Commands in this submenu manage abbreviation files.
This displays a dialog box (Figure 96) through which you can make font substitutions and cleanup unused fonts.

FIGURE 96.

Font Management dialog box

[217]

Each row in the list displays information about a font used (or previously used)
in the index. From left to right the row displays the Cindex identifier for the
font, the preferred font’s name, then the alternate font’s name.

[218]

Check Use. Click this to check that all fonts in the list are currently being used. You

can remove unused fonts. (This button is hidden if only the default font and
Symbol font are in the list.)
[218]

Preferred. Type or use the drop-down list to change the preferred font for the
selected row in the list.

[218]

Alternate. Use this drop-down list to change the alternate font for the selected row
in the list.
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Hot Keys…
[44]

This displays a window that shows hot key definitions and the text attached to
each key. You can change the keys or keystroke combinations that are ‘hot’ and
you can change the text assigned to them.

Markup Tags…
This displays a dialog box (Figure 97) through which you can inspect and edit
tag sets for marking-up different elements of a formatted index.

FIGURE 97.

Tag Set Selection dialog box

[194]

XML Tags/SGML Tags. Determines which kind of markup tags to manage.

[194]

Active Set. This list shows all tag sets that Cindex possesses. The chosen item spec-

ifies the set on which various operations will be undertaken.
[194]

Duplicate. This duplicates the selected tag set. Cindex asks you to provide a name

for the new set.

[194]

New. Cindex creates and opens a new tag set. Cindex asks you to provide a name

for the new set. All new tags except Character Tags are empty.
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[194]

View/Edit. Opens a tag set for inspection or editing.

[194]

Delete. This deletes the selected tag set.
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When you create a new or duplicate set of tags, or click View/Edit, Cindex opens
the dialog box shown in Figure 98.

XML Tags

FIGURE 98.

[197]

XML Tag Set dialog box

Structure Elements. This tab contains tags that identify major structural elements of
the index (beginning, end, levels of heading, etc.), together with settings that
specify how tags are used.
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[198]

SGML Tags

Other Elements. This tab contains tags that identify type styles (italics, boldface,
etc.) and fonts used in entries.

When you view or edit an SGML tag set Cindex opens the dialog box shown in
Figure 99.

FIGURE 99.
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SGML Tag Set dialog box

CHAPTER 14 Reference

Tools Menu

[200]

Structure Tags. This tab contains tags that identify major elements of the index
(beginning, end, levels of heading, references, etc.).

[200]

Style Tags. This tab contains tags that identify type styles (italics, boldface, etc.).

[200]

Font Tags. This tab contains tags that identify different fonts.

[201]

Special. This tab contains special tags, such as those that represent characters used

to form tags.

Record Events
[83]

Choosing an item from this submenu starts recording of a sequence of keystrokes and mouse clicks that you can later play back. To stop recording hit CONTROL BREAK .

[83]

Choosing an item from this submenu replays a previously recorded sequence of
keystrokes and mouse clicks.

Play Events

Groups…
This displays a dialog box (Figure 100) through which you can manage the
groups that belong to the active index. This item is dimmed if the index has no
groups.

FIGURE 100.

Manage Groups dialog box
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[227]

All Groups/Group. The chosen item defines the scope of the action—on all groups or

the one chosen in the drop-down list.

[228]

Info… Click this to obtain information about a particular group.

[229]

Rebuild. Cindex will rebuild the specified group(s) if it can, using information
stored within the group(s) about how they were originally formed.

[229]

Delete. Cindex will delete the specified group(s).

[229]

Link Cross-References. Cindex will examine the whole index to find records that

contain cross-references to records in the specified group or groups. Records that
contain qualifying cross-references are added to the group.

WINDOW MENU
Clipboard
Displays the contents of the clipboard.

Cascade
Arranges all open windows in a staggered array.

Tile
Arranges all open windows in a rectangular grid on the screen.

Close All
Closes all open windows

HELP MENU
Help Topics
Opens the Cindex help window. This provides access to all Cindex on-line help.

About Cindex…
Displays information about the version of Cindex, and about your registration.
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Check for Updates…
[5]

Checks whether a Cindex update is available.
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Index
The following typographical conventions are used in the index: Tempo typeface denotes a menu item or an item in a window or dialog box; SMALL CAPS identify a key or keystroke combination; f and t identify figures and tables, respectively.
The index was typeset from a file produced by Cindex.

- See Hyphen/Minus (-)
; See Semicolon (;)
: See Colon (:)
? See Question mark (?)
. See Period (.)
@, in header/footer template, 173
* See Asterisk (*)
/ See Slash (/)
\ See Backslash (\)
&, in replacement patterns, 244–246
# See Pound sign (#)
% See Percent symbol (%)
•, indicating modified record, 28
+ See Plus (+) key; Plus (+) symbol
×, indicating deleted record, 51
, denoting unknown character, 211
$, in patterns, 242
[ ] See Square brackets ([ ])
| See Vertical bar (|)
^, in patterns, 237, 241–242
← key, 22t
→ key, 22t
key, 22t, 67t
key, 22t, 67t
[ key, in editing shortcuts, 22t
] key, in editing shortcuts, 22t
< > See Angle brackets (< >)
{ } See Braces ({ })
~ See Tilde (~)

A

AAP markup standard, 191

Abbreviation(s)
page references, 131, 143–144
month names in, 130
in spelling check, 106
spelling out, in sorting, 164–165, 166f
as text entry shortcuts, 45–49. See also Abbreviation sets
Abbreviation Rule drop down list, 290
Abbreviation sets
icon, 6
working with, 46–49
Abbreviations Tools menu item, 305
About Cindex... Help menu item, 310
Accented letters, 24
entering in records, 24
sorting, 154
Acronyms
conflict with abbreviations, 49
exchange text, 40
in spelling check, 106
Activating inactive index, 11
Active Set drop-down list, 306
Add button
Spelling window, 272
Styled Strings dialog box, 292
Add Time check box, 283
Adding records, 20–35. See also New records
Adjust Only button, 299
Adjusting punctuation, 184
Adjusting references, 90–95
adding volume numbers, 249–250
breaking an index into parts, 232
compound locators, 92, 249–251
connecting and separating characters, 91
cumulating and combining indexes, 230
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Adjusting references (Continued)
group of records, 92, 93–95
movement of chapters or sections, 93–95
rearranging parts, 246–247
removing, 93, 250–251
temporary page numbers, 251–253
using patterns, 249–253
Adjustment text box, 299
Adobe InDesign document format, 191
After text box, 290
Alignment. See Justification
All Groups/Group buttons, 310
All Numbers Title text box, 285
All records, viewing, 65
All Records View menu item, 278
All References/Range buttons, 299
All Symbols Title text box, 285
Alphabetical groups of records
formatting, 174–176, 175f
SGML markup tag for, 200
XML markup tag for, 197
Alphabetize Multiple References check box, 288
Alphabetizing, 153–161. See also Sorting
abbreviations
expanding, 166f
sorting as expanded, 165–166
spelling out, 164–165, 166f
ignoring text while
characters or words, 162–164, 163f, 164f
leading words in subheadings, 159–160
language conventions, 149
letter-by-letter. See Letter-by-letter alphabetizing
modifying basic rules, 159–162
page references, 130
principles, 154–157
punctuation, 160
shortcut, 153
simple. See Simple alphabetizing
symbols and numbers, 166–167, 166f
as spelled-out, 164–165, 165f
unusual spellings, 165–166, 166f
word-by-word. See Word-by-word alphabetizing
Alphabetizing Rule drop down list, 300
Alphabets, foreign. See Accented letters
Alphanumeric sequences, spelling check, 107
Alter References... Tools menu item, 298–299, 299f
Altering references. See Adjusting references
Alternate drop-down list, 305
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Alternate font, 217–218
Alternative spellings, 100–101, 106
Always Suggest Alternatives check box, 273
Ampersand (&), in replacement patterns, 244–246
“and,” conditional searches, 77–79, 78f
And drop-down list, 268
Angle brackets (< >)
checking entries with, 28
in exported tab-delimited records, 204
in exported XML records, 204
in imported Macrex records, 210
in imported SKY Index records, 209
in imported tab-delimited records, 209
as literal characters, 25, 201
sorting, 167
and page reference separator, 129
in SGML markup tags, 201
sorting entries with, 162–164, 163f, 164f, 167
sorting page references, 140, 140f
in XML tag name, 198
ANSI character set. See Windows® character set
Append text box, 282
Arabic numerals. See Numerals; Page references
Archive. See Cindex Archive
Archive documents, 9
Around Quotation Marks check box, 286
Around Styled Text check box, 286
Arrange in Sorted Order check box, 291
Articles
flipping record fields, 41–42
ignoring in subheading, 159–160
Ascending order, page references, 138
Ascending Order check box, 302
ASCII characters, SGML markup tags for, 201
Association of American Publishers (AAP) markup standard,
191
Asterisk (*)
denoting special subheading field, 215
indicating unsaved changes, 9
in patterns, 238–239
At (@) symbol, in header/footer template, 173
Attributes
of records
deleted. See Deleted records
generated. See Generated records
labeled. See Labeled records
marked. See Marked records
modified. See Modified records

new. See New records
of text. See Font(s); Text style
Attributes button
Find window, 268
Replace window, 270
Auto check box, 286
Auto-Complete Entries check box, 276
Auto-entry, 36–38
Automatic operations
Cindex update notification, 5, 13
complete page range, 39
completion of entries, 36–38
generation of cross-references. See Generated cross-references
line spacing, 183
propagation of editing changes, 42–43
removing empty fields, 40
removing leading/trailing spaces in fields, 23, 38, 40
saving of entries, 9
switching to draft formatted view, 58–59
text style application. See Text style, automatically applied
Automatically check for updates check box, 275

B

Backing up, 9
Backslash (\)
in header/footer template, 173
identifying headings beginning with numerals, 256
exporting formatted entries, 194
exporting records, 206
finding, 68, 73
index statistics, 222
printing, 81
replacing text, 88
as literal character, 25, 173
sorting, 167
locating records in page order sort, 152
with page reference separator, 129
in patterns, 237–240, 242–246
BACKSPACE key, editing text, 22t, 23, 40, 41
Backup format
index copy as, 9
Macrex, importing records from, 209–210
Bad Cross-Ref buttons, 275
Bad Locator buttons, 276
Badly-formed records
import warnings, 211
repair index, 10

INDEX

Bar (|)
in custom run-in headings, 180
in patterns, 241
Beep. See Warnings
Before Multiple text box, 290
Before Single text box, 290
Beginning an index, 8–10. See also New document
Beginning of entry
ignoring when sorting entries, 163–164, 164f
locating record by, 68–69
Blank fields. See Empty record fields
Blank records. See Empty records
Blinking text, during macro recording, 84
Blocks of entries, selecting, 63–64, 64f
Body Style button, 289
Bold... Character menu item, 280
Boldface italic style
SGML markup tag for, 200
XML markup tag for, 198
Boldface style. See also Text style
applying to text, 34–35
Book pages. See Page proofs
Bookmarks, in embedded index entries, 203
Boolean operators. See Conditional searches
Bottom text box, 281
Braces ({ })
checking entries with, 28
in exported tab-delimited records, 204
in exported XML records, 204
in imported Macrex records, 210
in imported SKY Index records, 208
in imported tab-delimited records, 209
as literal characters, 25
sorting, 167
in patterns, 240
sorting entries with
expanding abbreviations and unusual spellings, 165–166,
166f
page references, 139–140, 139f
spelling out numbers, symbols and abbreviations, 164–165
Brackets. See Angle brackets (< >); Braces ({ })
Breaking an index into parts, 231–232
Breaking fields
editing records, 23, 40
reconciling heading levels, 40, 96–98
Bullet (•), in draft index view, 28
Buttons. See named dialog box buttons; Toolbar buttons
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C

Capitalizing. See Case conversion
Caret (^), in patterns, 237, 241–242
Carry Locators Forward check box, 275
Cascade Window menu item, 310
Case conversion, 35. See also Initial Capital letter; Lowercase letters; Uppercase letters
automatic
in formatted cross-references, 124–125
in formatted headings, 185
flipping record fields, 41
using patterns, 245–248
Case-sensitivity
replacing text, 90
searching with, 76
Change To text box
in Replace window, 270
in Spelling window, 272
Changing records. See Editing records
Chapters, rearranged, adjusting references for, 93–95
Character(s). See also Keystrokes; Letters of alphabet; Special
characters
count, in longest record, 223–224
filing order, 159
fixed number on line, 171
forbidden in abbreviations, 48
for inclusive page number range, 31, 129
for lead indents to subheadings, 193f, 194
permissible
in records, 24
maximum number, 20
restricting, 216
total number, 214
in SGML markup tags, 200
in XML markup tags, 198
reserved, 25
separating multiple cross-references, 110
separating multiple page references, 128–129
sorting. See Sorting
space available for, in record, 21
unknown, 211
Character classes, in patterns, 234–236
Character encoding. See also Unicode characters; Windows®
character set
importing tab-delimited records, 208, 209
saving plain text documents, 192
saving tab-delimited records, 206
Character Map... Character menu item, 280
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Character menu, 35, 279–280
Default Font, 279
Plain, 279
Bold, 280
Character Map..., 280
Character Priority drag list, 300
Character set, in patterns, 234–236
Check for Updates... Help menu item, 311
Check Headings Below drop-down list, 297
Check Page References check box, 271
Check References... Tools menu item, 295–296, 296f
Check Use button, 305
Checking
cross-references. See Verifying cross-references
page references. See under Checking records
records. See Checking records
Checking for updates to Cindex, 5, 13
Checking index integrity, 10
Checking records
cross-references, 44. See also Verifying cross-references
importing records, 210–211
match to template, 28–29
orphaned subheadings, 95–96
in page order sort, 152
page references, 43–44
missing or badly-formed, 75–76
for undifferentiated strings, 132
permissible characters, 216
spelling. See Spelling check
typographical errors while adding/editing, 28–29
Chicago Manual of Style
abbreviating page references, rules for, 143–144
alphabetizing principles, 157
Chronological order, sorting subheadings by page reference
number, 151–152, 164–165
Cindex Archive
icon, 6
importing records, 207
saving records, 204
Cindex Archive (*.arc), drop-down list item, Import dialog box,
263
Cindex Archive, drop-down list item, Save As dialog box, 259
Cindex for DOS, importing records from, 210
Cindex for Macintosh, exchanging indexes with, 204
Cindex Index, drop-down list item, Save As dialog box, 259
Cindex updates, checking for, 5, 13
Circular cross-references, detecting, 112–114
Circumflex (^), in patterns, 237, 241–242

Clear Edit menu item, 265
Clear Ignore List button, 273
Clicking. See also Double-clicking
opening contextual menu, 36
selecting entries, 63–64, 64f
selecting text, 23t
Clipboard Window menu item, 310
Close All Window menu item, 310
Close File menu item, 258
Closing indexes, 9
Closing punctuation. See Trailing punctuation
CMS. See Chicago Manual of Style
Codes. See Markup
Collapse Headings below drop-down list, 286
Collapsing headings, 180–181
Collation. See Alphabetizing
Colon (:)
in pattern character set specification, 234–236
sorting, 154–155
ignoring in letter-by-letter sorting, 160
Colors, for labeled records, 51–52
Columns. See Margins and columns
Columns drop-down list, 281
Combining fields
adding/editing record, 23
reconciling heading levels, 40, 41, 96–98
Combining indexes, 230–231
Combining page references, 142–143
Comma (,)
identifying modified headings, 96–97, 114–115
separating page references, 128–129
sorting, 154–155
ignoring in letter-by-letter alphabetizing, 160
Commands, summarized, 258–310
Comments, in records, 32, 215
Compatibility, Mac and Windows documents, 6, 204
Complete Page Ranges check box, 275
Completion, of record fields, automatic, 36–38
Complex locators. See Multi-part references
Components, page references, 129–130
Compound references. See Multi-part references
Compress Tools menu item, 302–303, 302f
Compressing index entries, 225–227
invalidating groups of records, 226
restrictions, 65, 66
Concatenate with text box, 290
Conditional searches, 76–79
“and,” 77–79, 78f
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evaluation order, 79
grouping elements, 78–79
“not,” 77, 77f
“or,” 77–79, 77f
Configuration. See Default settings; Preferences
Confining actions. See Scope of operations
Conflate Beyond drop-down list, 290
Conflation of page references, 142–143
with suppressed leading parts, 145
Conjunctions
flipping record fields with, 41–42
ignoring in subheading, 159–160
Connecting character, for inclusive range of page numbers, 31,
141–142
Connecting Text text box, 290
Connector text box, 294
Consecutive pages, conflating references, 142–143
Consolidate References check box, 302
Consolidating references from multiple records, 226–227
Containing Locators text boxes, 304
Context-sensitive menus, 36
Continuation lines
indentation, 181–183
in records, 26
in saved formatted indexes, 190, 192
"Continued" headings, 171–172
CONTROL key
dragging and dropping text, 39
in editing shortcuts
with RETURN key, 26, 29, 35
for text retrieval from previous record, 38–39
editing text, 22t, 23t
flipping record fields, 41–42
Control panels
Keyboard, 68
Region and Language Settings, 174
Conversion
case of letters. See Case conversion
cross-references to fully-qualified entries, 116–117
orphaned subheadings to modifying phrases, 97
Convert Orphans to Modifying Phrases button, 297
Convert to Fully Qualified Entries button, 298
Copy
button, 283
Edit menu item, 264–265
Copying. See also Duplicating
documents, 9
embedding index entries, 202

317

Copying (Continued)
formatted entries, 202
records, 50–51
text, 38
Correcting entries. See Editing records
Correcting spelling. See Spelling check
Count Records... Tools menu item, 303–304, 303f
Counting records, 222–224
Creating
abbreviations, 45–47, 46f
dictionary, spelling check, 101–103
groups of records, 65
indexes. See New document
markup tag sets, 195f, 196
records. See New records
Cross-references, 109–124
adding to groups, 229–230
automatically generated, 116f, 117–119
checking. See Verifying cross-references
from collapsed headings, 180
converting to fully-qualified entries, 116–117
counting, 221
in draft view, 120, 123
in embedded index entries, 203
entering in records, 30–32, 110
as subheadings, 112
flipping record fields, 41
formatting, 119–125
saved settings, 188
in fully-formatted view, 120
general (nonspecific) forms, 111–113
automatic styles not applied, 125
controlling sorted position, 123
identifying, 109–111
introductory phrase, 31, 109, 111, 124
from main heading, 120–122
position in formatted entries
from collapsed headings, 180
from main heading, 120–122
from subheading, 123
as subheadings, 121–122
prefixes, 31, 111, 123
punctuation
between, 110, 111, 224–225, 227
before and after, 120, 123
in marked-up documents, 198, 200
in records imported from Macrex, 210
“see” used other than in cross-reference, 112
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SGML markup tag for, 200
sorting, 123–124
in draft view, 120
general cross references, 112
with page order sort, 151–152
spelling check, 105
structure, specifying, 110–112
from subheadings, 123
in summary view, 60–61
suppressing, 124
text styles, 32, 124–125, 124f
verifying. See Verifying cross-references
XML markup tag for, 197
Cross-References... Document menu item, 288–289, 288f
Cumulating and combining indexes, 230–231
Curly brackets. See Braces ({ })
Current view, scope of operations. See Scope of operations
Custom tags, document markup, 194–202
Customizing Cindex. See Preferences; Toolbars
Cut Edit menu item, 264
Cutting and pasting text, 38

D

Damaged index, repairing, 10
Dangling subheadings. See Orphaned subheadings
.dat filename extension, import document, 210
Database management programs, saving records for, 204–205
Date
in headers and footers, 173, 174
index creation/modification, 221
month names in references, 130, 133–135
rearranging format, with patterns, 248–249
record creation/modification, 21f, 29
finding entries by, 73, 256–257
replacing entries by, 88
Decrement page reference, 39
Deepest heading level, 222–224
Default folder, 13
Default Folder button, 275
Default font, 33
in headers and footers, 173
in headings, 185
restoring selected text to, 34
in search and replace, 87
setting, 14
SGML markup tag for, 200–201
in style sheets, 188

in titles to entry groups, 176
XML markup tag for, 198
Default Font Character menu item, 279
Default Font drop-down list, View preferences, 276
Default settings, 8–9, 219. See also Preferences
abbreviation set used, 47–48
index format, 188
restoring original, 219
from template, 219–220
Delay. See Time
Delete button
Manage Groups dialog box, 310
Markup Tags dialog box, 306
Spelling window, 272
Styled Strings dialog box, 292
DELETE key, editing text, 22t
Deleted Edit menu item, 266
Deleted records
confining actions to, 257
confining search to, 73–74
replacing text, 89
count of, 223
in draft view, 51
excluding from search, 73–74
replacing text, 89
in exported document, 206
finding, 74
in fully formatted view, 51, 56
record window, 51
indicator, 21f
removing, 225–226
restoring, 51
verifying cross-references and, 113
Deleting
abbreviations, 47
duplicate words, spelling check, 101
markup tag sets, 196
page references, 93, 250–251
record groups, 228f, 229
records, 51. See also Deleted records
after adjustment of page references, 251
text, with replacement, 86
Delimited format, exporting records in, 204–205
Delimited Records, drop-down list item, Save As dialog box,
259–260
Delimited Records (*.txt), drop-down list item, Import dialog
box, 263
Depth of headings, controlling display of, 59–60, 60f
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Descending order, page references, 138
Designing markup tags, 194–202
Desktop publishing. See Saving documents
Diacritical marks. See Accented letters
Dictionaries, spelling check, 99
installing additional, 105–106
personal, 101–103
Dictionary drop-down list, 271
Digits. See Numerals
Discarding
changes to index, 10, 50, 86, 92, 98
changes to record, 35
new record
duplicate, 49
empty, 26
Display in Formatted View check box, 277
Displaying. See Views and viewing
Document formats, saving indexes, 190–192
Document menu, 280–295
Margins & Columns..., 280–282, 281f
Headers & Footers..., 282–283, 282f
Grouping Entries..., 284, 284f
Style & Layout..., 285–286, 285f
Headings..., 287, 287f
Cross-References..., 288–289, 288f
Page References..., 289–291, 289f
Styled Strings..., 291–292, 292f
Record Structure..., 292–294, 293f
Reference Syntax..., 294–295, 294f
Smart Flip Words…, 295
Documents
creating. See New document
Mac and Windows compatibility, 6
opening. See Opening documents
printing, 80–81
saving. See Saving documents
Dollar ($) sign, in patterns, 242
Don't Apply Prefix Style if it Matches Existing Body Style check box,
289
DOS, importing records from Cindex for DOS, 210
DOS Cindex Data (*.dat), drop-down list item, Import dialog
box, 263
Dot Leader check box, 290
Double spacing, 183
Double-clicking
opening entry for editing, 29, 35
selecting text, 23t
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Double-posting, 116–117
converting cross-references to fully-qualified entries, 116–
117
Draft Format View menu item, 278
Draft formatted view, 58–60, 58f
automatic switch to, 58–59
cross-reference display in, 120
deleted records in, 51
embedding index entries, 202
labeled records in, 52
marked records in, 86–87
modified records in, 28
page reference display in, 141, 148
record numbers in, showing or hiding, 59f
toolbar button for, 58
Drag-and-drop
embedding index entries, 202
formatted entries, 202
records, 50–51
text, 38–39
discarding fonts and styles, 39
Dragging, to select entries, 63
Duplicate
button, Markup Tags dialog box, 306
Edit menu item, 266
Duplicate records
consolidating references, 226–227
removing, 226
sorting, 156
Duplicate words, spelling check, 101
Duplicating. See also Copying
markup tag sets, 196
records, 49–50

E

Edit button, 273
Edit menu, 264–277
Undo, 264
Redo, 264
Cut, 264
Copy, 264–265
Paste, 265
Clear, 265
Select All, 265
New Record, 265
Edit Record, 265
Duplicate, 266
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Deleted, 266
Labeled, 266
Find..., 266–268, 267f
Find Again, 268
Replace..., 268–270, 269f
Spelling..., 270–273, 271f
New Abbreviation..., 273
Preferences..., 273–277, 274f
Edit Record Edit menu item, 265
Editing abbreviations, 45–47
Editing markup tags, 196–202, 197f
Editing records, 35–36
balancing headings. See Reconciling headings
breaking fields, 23, 40
carrying locators, 39
copying records, 50–51
correcting typographical errors. See Spelling check
cutting and pasting text, 38
deleting records, 51
draft view for, 58–59
dragging-and-dropping text, 38–39
duplicating records, 49–50
empty fields, 28, 40
exchanging (flipping) fields, 41–42
finding and. See Finding entries
fonts, 33–34
generated cross-references, 119. See also Generated cross-references
hot keys, 44–45
increment/decrement locator, 39
inserting fields, 23, 40
joining fields, 40–41
keystrokes, 21–23, 22t–23t, 29–30, 35–36, 39
labeling records, 51–52
page references, 39–40
changing globally. See Adjusting References
propagating changes, 42–43
removing deleted records. See Compressing index entries
restoring deleted records, 51
restoring view after, 36
retrieving a field from last-edited record, 39
saving changes, 35–36
searching and. See Finding entries
shortcuts, 22t–23t
spaces, leading and trailing, 23, 28, 40
structure, 213–217
warnings, 43
window. See Record window

Elements
of an index, 7
of a record, 21f
Elements of an index
SGML markup tags for, 199–202
XML markup tags for, 196–198
Embedding index entries, 202–203
Empty record fields, 40
automatic removal, 40
checking entries for, 28
finding, 75
imported, 208
locator field
following reference adjustment, 251
sorting entries in page reference order, 151
warning for, 43
new entries, 23
replacing text with, 86
Empty records
as new entries, 26
removing from index, 225–226
Em-space unit for indentation, 182
Encode Plain Text Documents buttons, 277
Encoding. See Character encoding; Unicode characters
END key, 22t, 67t
En-dash, connecting character for inclusive ranges, 142
Ending punctuation. See Trailing punctuation
Enlarging record size, 214
while importing records, 211
ENTER key, 22t. See also RETURN key
completing entry, 26
Entering new records, 20–35
Entity tags. See Markup tags, for formatted indexes
Entries. See also Cross-references; Page references; Record(s)
automatic completion, 36–38
changing. See Editing records
counting, 221
from cross-references, making automatically, 116–117
defined, 7
embedding in other documents, 202–203
filing. See Sorting
making. See New records
printing, 80–81
Entry View drop-down list, View preferences, 276
Erasing. See Deleting
Errors. See also Warnings
damaged index, 10
entering records, 28–29, 43–44
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importing records, 211
typographical. See Spelling check
verifying cross-references, 112–115
ESC key, 23t, 67t
discarding changes to record, 26, 35
removing highlighting in main view, 63
European alphabets. See Accented letters
Evaluate Numbers check box, 301
Evaluate References check box, 268
Evaluation order, conditional searches, 79
Even numbered pages, in index printed by Cindex
headers and footers, 173
margins, 170
Examine All check box, 302
Exchanging documents with other applications, 189–205
exporting formatted entries, 189–200
exporting records, 203–206
importing records, 207–211
Exchanging (flipping) fields, 41–42
Exit, from Cindex, 9
Exit File menu item, 264
Expand Tools menu item, 303
Expanding abbreviations and unusual spellings, for sorting,
165–166, 166f
Expanding entries, 224–225
restrictions, 65, 66
Explorer. See Windows® Explorer
Exporting, 189–205
formatted indexes, 189–200
records, 203–206
copying between indexes, 50–51
Expressions
abbreviations for. See Abbreviation(s)
regular. See Patterns
Extensible Markup Language. See XML
Extra at Alphabetic Groups text box, 286
Extra at Main Headings text box, 286

F

Facing pages, in indexes printed by Cindex
headers and footers, 173
margin settings, 170
Facing Pages check box, 281
Field drop-down list
Find window, 268
Replace window, 270
Spelling window, 271
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Field Name text box, 294
Fields. See Empty record fields; Locator field; Record Fields
File menu, 258–263
New..., 258
Open..., 258
Close, 258
Save, 258
Save As..., 259–262
Save Backup Copy..., 262
Revert to Saved, 262
Save Style Sheet..., 262
Import..., 263
New Group, 263
Save Group..., 263
Page Setup..., 263
Print..., 264
Recent Files, 264
Exit, 264
Filename extensions
importing records, 208, 209
saving formatted indexes as tagged text, 202
Files. See New document; Opening documents; Saving documents
Files of type drop-down list, 258
Filing order. See Sorting
Filter, showing/hiding records, 57
Find, drop-down list, 269
Find Again button
Find window, 267
Replace window, 269
Find Again Edit menu item, 268
Find All button, 267
Find button
Find window, 267
Replace window, 269
Find..., Edit menu item, 266–268, 267f
Find Orphaned Subheadings button, 297
Finding entries, 67–79, 70f. See also Replace
among generated records, 119
among range of records
beginning with numerals, 73
by modification date, 73
by record number, 73
among records with specified attributes, 73–74
backward search, 76
by beginning text in headings and subheadings, 68–69, 158
Boolean searches. See Conditional searches
case sensitive search, 76
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conditional search. See Conditional searches
containing specified text, 70f
continuing previous search, 71
cross-references, automatically generated, 119
editing found records, 71
excluding records with specified attributes, 73–74
field-specific, 74–75
by font, 72
forming groups of records. See Groups of records
keyboard shortcuts for, 67
by locators, 75
missing, 75
multi-part, 75, 136–138
misspellings. See Spelling check
navigation shortcuts, 67t
with page order sort, 152
by printed index page number, 69–70
by record number, 69
shortcuts, 67t
with text styles, 72
with too many page references, 132
toolbar button, 70
by user ID, 73
using patterns, 76, 233–243. See also Patterns
whole words only, 76
First (printed) page number, formatting, 174
First Page Number text box, 283
First... tabs
Locator Style dialog box, 291
Record Structure dialog box, 293
Fixed indentation, 181
Flashing text, during macro recording, 84
Flipping fields, 41–42
“Flush right” page references, 146
SGML markup tag for, 201–202
Folios, temporary, indexing with, 251–253
Font(s)
adjusting punctuation around, 184
alternate, 217–218
changing, 33–34
in cross-reference verification, 115
default. See Default font
discarding
in drag-and-drop, 39
in paste, 38
in drag-and-drop, 39
drop-down list, 34
in exported records, 204

finding entries by, 72
for formatted headings, 185
for headers and footers, 173
in hot key text, 45
markup tags for. See Font markup tags
missing, 217–218
preferences, 33
preferred, 217–218
replacing, 87–88
SGML markup tags for, 200–201
size, 33
substitution, 218
imported records from SKY Index, 209
importing records, 207
substitutions, 218
for titles to groups of entries, 176
used in index, 218
Font change, adjusting punctuation around, 184
Font drop-down list
Grouping Entries dialog box, 284
Headers & Footers dialog box, 283
Headings dialog box, 287
main toolbar, 257
Font markup tags, 195
SGML, 200–201
XML, 198
Font Tags tab, 309
Font-based unit for indentation, 182
Fonts... Tools menu item, 305, 305f
Footers. See Headers and footers
For Fewer Targets Than text box, 298
Forcing sort order
page references, 139–140, 139f, 140f
special characters for. See Angle brackets (< >); Backslash (\);
Braces ({ }); Tilde (~)
Foreign letters. See Accented letters
Format
of displayed or printed entries. See Formatting
document, saving formatted indexes, 190–192
imported records, 207–210
Formatting, 169–188. See also Draft formatted view; Fully formatted view; Saving documents
alphabetical groups, 174–176. See also Grouping formatted
entries
columns. See Margins and columns
cross-references, 119–125, 180
even numbered pages. See Even numbered pages, in index
printed by Cindex
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facing pages. See Facing pages, in indexes printed by Cindex
fonts. See Font(s)
footers. See Headers and footers
grouping entries, 174–176. See also Grouping formatted
entries
headers. See Headers and footers
headings
collapsing, 180–181
continuing across column and page breaks, in index
printed by Cindex, 171–172
font for, 185
indentation, 181–183
punctuating, 186
run-back, 179
style for, 185
suppressing, 186
indented style, 177–180
left-hand pages. See Even numbered pages, in index printed
by Cindex
line length, 171
line spacing, 183, 183f
margins. See Margins and columns
odd numbered pages. See Odd numbered pages, in index
printed by Cindex
page breaks, in index printed by Cindex, 171–172
page numbering, in index printed by Cindex, 174
page references, 140–148. See also Page references
punctuation
automatic adjustments, 184
cross-references, 120, 123
headings, 186
page references, 145–146
quotation marks, 184
right-hand pages. See Odd numbered pages, in index printed
by Cindex
run-in style, 177–180
saving settings, 187–188
default, 219
spacing, 183. See also Margins and columns
style of index, 177–180
style sheets, 187–188
text style. See Text style
units. See Units of measurement
From Main Heading tab, 288
From Subheading tab, 288
Full Format View menu item, 278
Full point. See Period (.)
“Full record” warning, 21
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Fully formatted view, 55–57, 56f. See also Formatting
continuing headings across column and page breaks when
printing, 171–172
cross-references, 120
deleted records, 51, 56
entry statistics, 221
hiding records, 57
highlighting found entries, 71
labeled records, 52
page references, 140–148
printing, 80
saving formatted indexes, 189–200
suppressing reserved characters, 167
toolbar button for, 55
Fully-qualified entries, converting cross-references to, 116–117
Function keys, 5, 44–45

G

General (nonspecific) cross-references. See Cross-references,
general
General text box, 295
Generate from File button, 298
Generated cross-references, 116f, 117–119
Generated records
confining actions to, 257
confining search to, 73–74
replacing text, 89
from conversion of cross-references, 116–117
counting, 223
excluding from search, 73–74
replacing text, 89
finding, 74, 119
removing, 226
Generic document formats, saving indexes, 190–192
Global actions, 255–257. See also Scope of operations
Go To... View menu item, 277, 277f
Greatest Range text box, 295
Greek letters. See Symbols
Group Method drop-down list, 284
Group View menu item, 278
Grouping elements of conditional search, 78–79
Grouping Entries... Document menu item, 284, 284f
Grouping formatted entries, 174–176
line spacing, 183
saved settings, 188
SGML markup tag for, 200
titles for, 174
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XML markup tag for, 197
Groups of records, 65–67
adding cross-references to, 229–230
adjusting references in, 93–95
creating
by duplicating records, 50
from search results, 71–72
from selected records, 65
deleting, 228f, 229
icon, 6
information on, 227–228
invalid, 225, 226
limitations, 66
permanent, 66, 72
rebuilding, 225, 229
sorting, 66
temporary, 65, 66, 72
verifying cross-references and, 113
viewing, 65
Groups... Tools menu item, 309–310, 309f
Gutter, between columns, 170, 171
Gutter text box, 282

H

Half flip, 41–42
Hard (non-breaking) space, 142
Hart's Rules, 143–144
Hash (#) mark. See Pound sign
Header (alphabetic group), 174–176
Header/Footer tabs, 283
Headers and footers
in index printed by Cindex, 172–174
omitting in saved documents, 190
saved settings for, 188
Headers & Footers... Document menu item, 282–283, 282f
Headings, 7. See also Main heading(s); Modified headings; Subheading(s)
confining actions to, 256
replacing text, 89–90
search, 74–75
spelling check, 104–105
"continued," 171–172
entering in records, 21–23
finding entries by, 68–69
in letter-by-letter or word-by-word sort, 158
formatting. See Formatting, headings
level of deepest, 222–224

reconciling levels, 96–98
record structure, 18, 20
SGML markup tags for, 200
suppressing, 186
XML markup tags for, 197
Headings... Document menu item, 287, 287f
Help, online, 5
Help menu
Help Topics, 310
About Cindex..., 310
Check for Updates, 311
Help Topics Help menu item, 310
Hidden records, 57, 256
Hidden text
controlling alphabetizing, 164–165
embedded index entries as, 203
Hide by Attribute... View menu item, 279
Hiding. See also Suppressing
characters or words, sorting entries, 162–164, 163f, 164f
deleted records, 51, 56
record numbers, in draft formatted view, 59, 59f
records, 57, 256
Highlighting, selecting entries, 63–64, 64f
Hold Higher Values check box, 299
HOME key, 22t, 67t
Hot keys, 44–45
Hot Keys... Tools menu item, 306
HyperText Markup Language (HTML) markup standard, 191
Hyphen/Minus (-)
in chapter-page numbering, 129
denoting inclusive range of pages, 129, 142
in patterns
changing case of text, 245–246
inside square brackets ([ ]), 237
in replacement patterns, changing case of text, 245–246
sorting entries with, 155
ignoring in word-by-word sort, 160

I

Icons, document types, 6
ID. See User identifier
Identical records. See Duplicate records
Identifying the indexer. See User identifier
Ignore All button, 272
Ignore Alphanumeric Strings check box, 273
Ignore button, 272
Ignore -/ check box, 300
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Ignore.,:; check box, 300
Ignore Different Labels check box, 303
Ignore Lowest Subheading check box, 301
Ignore Parenthetical Endings check box, 301
Ignore Parenthetical Phrases check box, 300
Ignore Style & Case check box, 276
Ignore Subheading Prefixes text box, 301
Ignore Words in CAPITALS check box, 273
Ignoring text
during sorting
characters or words, 162–164, 163f, 164f
leading words in subheadings, 159–160
lowest subheading, 152–153
segments of page references, 134
specified fields, 150–153
during spelling check, 106–107
specified fields, 104–105
Import... File menu item, 263
Importing records, 207–211
Inactive indexes, 11
Inches. See Units of measurement
Include Deleted Records check box, 261
Include Sorting Information when Embedding Entries check box, 277
Inclusive page ranges. See Range of page references
Increment page reference, 39
Incremental indentation, 181, 182–183
Indentation, formatted entries, 181–183, 181f
in exported documents, 190
tab characters for, 194
Indented button, 285
Indented index style, 56f, 177–180
cross-references, location and style, 121
draft view, 58, 58f
overriding, 179–180
“runback” style, 179
InDesign document tags, 191
InDesign Tagged Text, drop-down list item, Save As dialog box,
260
Index, icon, 6
Index entries. See Entries
Index pages, printed by Cindex, 80–81
numbering, in headers and footers, 173, 174
ranges
finding entries on, 69
saving formatted entries on, 193
Index Statistics... Tools menu item, 304, 304f
Index title, asterisk (*) beside, 9
Indicators, record window, 21f
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Information
about index, 220–224
about record groups, 228
Initial capital letter, 35
cross-references, 124–125
headings, 185
pattern for conversion, 247–248
Initial page number, in index printed by Cindex, 174
Initial settings. See Default settings
Insert, keyboard mode indicator, 21f
Inserting
abbreviations, 48–49
fields, 23, 40
text, hot keys for, 44–45
Inside margins, 170
Insufficient record space
adjusting references, 92
entering text, 21
reconciling heading levels, 98
replacing text, 86–87
Intelligent flip, 41–42
International Standards Organization (ISO), alphabetizing
principles, 157
Invalid record groups, 225, 226
ISO alphabetizing principles, 157
Italic style. See also Text style
applying to text, 34–35

J

Joining fields, reconciling heading levels, 40–41, 96–98
Justification
headers and footers, in index printed by Cindex, 173
page references, 146

K

Keyboard control panel, 68
Keystrokes. See also Accented Letters; Symbols
adjusting time delay between, 68
for editing, 21–23, 22t–23t
for finding entries, 67
hot keys, 44–45
recording and replaying, 83–84
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L

Label Colors buttons, 277
Labeled Edit menu item, 266
Labeled records
colors for, 51–52
confining search to, 73–74
replacing text, 89
consolidating references, 227
counting, 223
excluding from search, 73–74
replacing text, 89
finding, 74
formatted display, 57
hiding, 57, 257
indicator, 21f
Laid-out index style. See Indented index style
Language
collation convention for sorting, 149
lowercase vs. uppercase collation order, 154
for spelling check
choosing, 99, 105
installing dictionary, 105–106
Language drop-down list, 271, 300
Last-saved index, reverting to, 10, 50, 86, 92, 98
Last-used index, automatically opening, 10
Layout. See Formatting; Headers and footers; Indented index
style; Margins and columns; Run-in index style; Views and
viewing
Lead Punctuation check boxes, 291
Lead text box
Reference Syntax dialog box, 295
Style & Layout dialog box, 286
Leading characters
finding records by, 68–69
ignoring while sorting entries, 163–164, 164f
Leading punctuation, headings, 186
Leading Text text box, 287
Left/Center/Right text boxes, 283
Left-hand pages. See Even numbered pages, in index printed by
Cindex
Left/Inside text box, 281
Length
of index, 220–222
of index record, 214
of lines, formatted entries, 171
of text, new entries, 26
Letter-by-letter alphabetizing, 154, 156–158
overriding rules for, 162–164

Letters of alphabet. See also Character(s)
accented. See Accented letters
counting records falling under, 222–224
grouping entries under, 174–176
sorting, 154
Levels. See Headings; Record fields
Limits. See also Maximum number
abbreviations, 47
record size and structure, 213–217
Line(s)
length, in formatted index, 170–171
number, 221
spacing, 183
Line-breaks
formatting page references, 142
run-over lines, omitting in saved documents, 190
in text-only documents, saving formatted indexes, 192
Link Cross-References button, 310
Linking cross-references, 229–230
Locating records. See Finding entries
Locator Element check boxes, 291
Locator field, 19, 30
confining search to, 75
while replacing text, 90
cross-references in, 30, 110, 123
empty, 43
ignoring while sorting entries, 164
imported records, 208, 209–210
page references in, 30, 127–128, 131
sorting on, 151–152
spelling check, 105
Locators. See Cross-references; Page references; Multi-part references
Longest record, 222–224
limiting, 214
Long/Short buttons, 283
Lowercase letters. See also Case-sensitivity
collation order, 154
conversion to and from uppercase. See Case conversion
in page references, 130
sorting, 154

M

Macintosh, exchanging indexes with, 204
Macrex, importing records from, 209–210
Macrex (*.mbk), drop-down list item, Import dialog box, 263
Macros, 83–84. See also Abbreviation(s); Hot keys
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Main heading(s)
cross-references from, 120–122
finding records by, 68–69, 158
SGML markup tags for, 200
in summary view, 60–61
unique, 221
XML markup tags for, 197
Main... tabs, Headings dialog box, 287
Main View drop-down list, View preferences, 276
Main window. See also Views and viewing
duplicating records from, 50
navigation shortcuts for, 67t
Malformed locators, 43
finding, 75
Manage Cross-References... Tools menu item, 298
Managing index documents, 213–232
Manuscript pages. See Page proofs
Margins and columns, 169–172
headings repeated at column breaks, in index printed by Cindex, 171–172
omitting column breaks, saving formatted indexes, 190
saved settings, 188
Margins and Columns... Document menu item, 280–282, 281f
Marked records
after adjusting references, 92
after importing records, 211
after reconciling heading levels, 98
after repairing index, 10
after replacing text, 86–87
confining actions to, 257
confining search to, 73–74
replacing text, 89
counting, 223
excluding from search, 73–74
replacing text, 89
finding, 74
Markup tags, for formatted indexes, 190, 191
built-in, 195
creating sets, 196
examining and modifying, 196–202
invoking, 194
removing, 196
Markup Tags... Tools menu item, 306–309, 306f
Master index, cumulating and combining indexes as, 230–231
Match Case check box
Find window, 268
Replace window, 270
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Match Pattern check box
Find window, 268
Replace window, 270
Match text box, 294
Match Whole Word check box
Find window, 268
Replace window, 270
Matching Pattern text box, 299
Maximize Cindex check box, 274
Maximize on Opening check box, 274
Maximizing windows, 13
Maximum Characters in a Record text box, 293
Maximum Characters text box, 294
Maximum number. See also Limits
characters in a field, 216
characters in record, 214
fields in record, 214–215
of macros, 84
in page reference, 43–44
undifferentiated page references, 132
Maximum Number of Recent Indexes drop down list, 275
Maximum Value text box, 295
.mbk filename extension, import document, 209
Measurement, units. See Units of measurement
Medical dictionary, 105
Menu(s). See also individually named menus
context-sensitive, 36
items (summarized), 258–310
Microsoft Word
accented letters, 24
embedding index entries in, 202–203
Millimeters. See Units of measurement
Minimum Characters text box, 294
Minimum locators in single entry text box, 296
Minimum number
characters in a field, 216
fields in records, 214–215
export documents, 206
target entries, for verifying cross-references, 115–116
Minimum number of entries to match text box, 296
Minimum Number of Fields text box, 261
Minus (-) key, 41. See also Hyphen/Minus (-)
Mismatch
angle brackets or braces, 28
parentheses or square brackets, 28
quotation marks, 28
Mismatch to Template buttons, 276
Missing font, 217–218
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Missing locators
finding, 75
warning, 43
Misspellings, finding. See Spelling check
Modification date. See also Modified records
confining actions by, 256–257
finding entries by, 73
index, 221
replacing text by, 89
Modified headings
reconciling heading levels, 97
verifying cross-references to, 114–115
Modified records. See also Editing records; Modification date
confining actions to, 257
confining search to, 73–74
replacing text, 89
counting, 223
excluding from search, 73–74
replacing text, 89
finding, 74
identifying in draft view, 28
new entries and, 28
spelling check, 104
Modifying Phrases Follow text box, 297
Month names, in locators, 130, 133–135
rearranging format of, 248–249
Mouse. See Clicking; Double-clicking
Mouse pointer, 63
Moving chapters or sections, adjusting references following, 93–
95
Moving through index. See Navigation
Multi-part references, 127f, 129–130
adjusting parts, 92, 249–251
evaluation order for sorting, 135–136
finding entries, 75, 137–138
formatting, 144–145
abbreviating, 143–144
conflating, 142–143
suppressing repeated parts, 144–145
patterns, 249–251
text styles, 146–147
Multiple columns. See Margins and Columns
Multiple indexes
concurrent work on, 11
displaying, 310
Multiple references
consolidating in single record, 226–227
entering in records, 30–31

single record for each, 224–225
sorting cross-references, 123
sorting page references, 138
Multiple spaces, in records, 38

N

Names
index name in headers and footers, 173
months, in page references, 130
proper, when reconciling headings, 97
Naming
dictionary, for spelling check, 103
documents, saving formatted indexes, 193
markup tag sets, 196
new indexes, 8, 220
permanent groups, 66
record fields, 216
Navigation, 29–30, 67t, 68–69
searching backward through index, 76
shortcuts for finding entries, 67t, 68–69
Never/At New Page/At New Column buttons, 282
New Abbreviation... Edit menu item, 273
New button
Markup tags dialog box, 306
Spelling options, 273
New document. See also Saving documents
abbreviation set, 48
index, 8
initial settings, 219
from template, 219–220
personal dictionary, for spelling check, 101–103
New... File menu item, 258
New Group File menu item, 263
New Record Edit menu item, 265
New records
adding to index, 20–35. See also Editing records
display options, 28
confining actions to, 257
excluding from search, 73–74
identifying in draft view, 28
replacing text in, 89
searching among, 73–74
spelling check among, 104
viewing, 64
New Records View menu item, 278
No Action button, 274
Non-breaking hyphen, 142
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Non-breaking space, 142
“not,” conditional searches, 77, 77f, 78–79
Not check box, 268
Notational conventions, User's Guide, 5
Notes, 32, 215
Number(s). See also Numerals
characters in fields, 216
characters in record, 20, 214
available, 21
longest, 222–224
used, 21
fields in records, 19–20
exporting records, 206
importing records, 208, 210
limits, 214–215
pasting records, 51
formatted entries, 220–221
index statistics, 220–224
page references and cross-references, 220–221
in patterns, 240
records, 222–224
Roman. See Roman numerals
Number Format drop-down list, 283
Number of Fields drop-down lists, 293
Numbering
printed index pages, 173, 174
records, 18
Numbers & Symbols Title text box, 285
Numerals. See also Page references; Roman numerals
in alphabetizing, 155–156
evaluating, 161–162
filing order vs. letters and symbols, 159
filing under, 166–167, 166f
spelling out, 164–165, 165f
grouping formatted entries under, 175
headings beginning with
finding by, 68, 73, 88
printing, 81
spelling check, 104
identifying subpatterns, 240
ignoring in spelling check, 107

O

Obligatory field, for special text, 32, 215
Odd numbered pages, in index printed by Cindex
headers and footers, 173
margins, 170
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On Closing Window buttons, 276
Only drop-down list, 268
On-screen help, 5
Open... File menu item, 258
Open Last Index button, 274
Opening documents. See also New document
abbreviation, 48
archive, 207
index, 10
automatically on startup, 11
index template, 219–220
style sheet, 188
Opening records. See Editing records; New records
Options button
New dialog box, 258
Save As dialog box, 260–261, 261f, 262f
Spelling window, 272, 272f
“or,” conditional searches, 77–79, 77f
Or drop-down list, 268
Order drag list, 301
Ordering entries. See Sorting
Orphaned subheadings
converting to modified heading, 97
finding, 95–96
removing, 97
Other Elements tab, 308
Outside margins, 170
Overflow, text in record, 21
Overriding
expansion of abbreviations, 49
sorting rules. See Sorting
suppression of redundant headings, 179–180
Overwrite, keyboard mode indicator, 21f

P

Page breaks
“continued,” headings, in index printed by Cindex, 171–172
omitting, when saving formatted indexes, 190
PAGE DOWN key, 22t, 29–30, 67t
Page field. See Locator field
Page layout
for exported formatted index, 189–190
for indexes printed by Cindex. See Headers and footers; Margins and columns
Page locators. See Multi-part references; Page references
Page numbers
on index pages printed by Cindex, 173, 174
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temporary folios, compiling index from, 251–253
Page order sort, 151–152
shortcut, 153
Page proofs
adjusting references to rearranged sections and chapters, 93–
95
average entry count per page, 224
temporary folios, using to compile index, 251–253
Page references, 127–148. See also Multi-part references
abbreviating, 31, 129, 131, 143–144
changing. See Adjusting references
checking, 43, 132
conflating, 142–143, 145
counting, 221
in cumulative indexes, 230–231
deleting. See Adjusting references
in embedded index entries, 202–203
entering in records, 23, 30–31
finding, 75–76
multi-part, 137–138
formatting, 140–148
saved settings, 188
forms, 127–130
ignoring
sorting entries, 164
in spelling check, 105
inclusive range. See Range of page references
increment/decrement shortcut, 39
letters in, 130
malformed, 43
finding, 75
maximum value, 43–44
missing, 43
after altering references, 251
month names in, 130, 133–135
multiple, individual records for, 224–225
multiple in entry, display order, 147–148
punctuation
denoting inclusive range, 129
preceding, 145–146
separating successive, 31, 128–129, 224–225, 227
in SGML marked-up documents, 200
in XML marked-up documents, 198
range. See Range of page references
recognizing, 129–130
reorganizing via patterns, 246–247
Roman numerals, 130
SGML markup tag for, 200

sorting, 132–140
suppressing, 148
temporary, 251–253
text styles, 131–132, 146–147
too many undifferentiated, 132
warnings, 43
XML markup tag for, 197
Page References... Document menu item, 289–291, 289f
Page setup, for printing, 80
Page Setup... File menu item, 263
Page size, 80
PAGE UP key, 23t, 29–30, 36, 67t
Pagination. See Page numbers
Paragraph style. See Run-in index style
Paragraphs
end of, SGML markup tag for, 201
imported records prepared on word processor, 208
styles, for markup, 190
Parentheses
exchange text content with acronym, 40
ignoring contents, in sort, 160–161
mismatched, in records, 28
Parentheses (( )), defining subpatterns, 237–238
Parenthetical endings, ignoring, in spelling check, 99
Paste Edit menu item, 265
Pasting
records, 50–51
text, 38
Patterns, 233–251
adjusting references, 92, 249–253
character sets, 234–236
finding entries, 76
minimum match, 240
pre-formed elements, 243
ready-made, 243
replacing text, 90, 243–249
sample, 243
special characters in
finding text, 234–243
replacing text, 244–249
specifying record structure, 216
subpatterns, 237–238
Percent symbol (%)
in header/footer template, 173
representing alpha group header, 174
Period (.)
in patterns, 234
with asterisk (*), 236
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within square brackets ([ ]), 235
sorting, 154–155
in letter-by-letter alphabetizing, 160
Personal dictionaries, in spelling check, 101–103
Phrases
abbreviations representing. See Abbreviation(s)
attaching to hot keys, 44–45
finding, 70–79, 70f
replacing. See Replace
type style automatically applied to, 186–187
Picas. See Units of measurement
Plain Character menu item, 280
Plain text
in exported records, 204
in imported records, 208
page references, 130
removing styles, 35
saving formatted indexes, 191–192
Plain Text, drop-down list item, Save As dialog box, 260
Plain Text/RTF/Quark/InDesign buttons, 277
Play Events Tools menu item, 309
Plus (+) character, in patterns, 239
replacing text, 245–246
Plus (+) key, 22t, 41
Plus (+) symbol, in drag list, 134, 150
Pointer, mouse, 63
Points. See Units of measurement
Position drop-down list, 288
Pound sign (#)
in draft index view, 86–87, 92
in header/footer template, 173, 174
Preferences. See also Default settings
adding records, 26–27
automatic saving interval, 9
editing records, 27, 27f, 39, 42, 43, 59
embedding entries, 203
font, 33, 34f
general, 11–14, 12f
labeled records, 51–52
new indexes, 219
new record display, 28
restoring original, 219
toolbars, 14–15
view, 14, 34f
Preferences... Edit menu item, 273–277, 274f
Preferred drop-down list, 305
Preferred font, 217–218
Prefix Style button, 289
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Prefix text
for cross-references, choosing style for, 124–125
for headings, 186
Prefix text box, 288
Prepositions
flipping record fields with, 41–42
ignoring in subheading, 159–160
Preserve Modified Headings check box, 297
Print File menu item, 264
Printed pages. See Index pages
Printing, 80–81
page setup, 80
specified entries, 80–81
Prompt for User ID check box, 274
Proofs. See Page proofs
Propagate Changes check box, 276
Propagating changes, 42–43
Protect Names check box, 297
Protecting names, when reconciling heading levels, 97
Punctuation
adjusting automatically, 184
cross-references, 110, 111, 120
expanding abbreviations, 48
headings, 186
page references, 128–129, 145–146
patterns for, 235
in sorting, 154–155, 160
spelling check, 100

Q

QuarkXPress, drop-down list item, Save As dialog box, 260
QuarkXPress document format, 191
Question mark (?)
in dialog boxes, 5
in patterns, 239–240
finding minimum match, 243
Quitting, 9
Quotation marks
closing punctuation around, 184
expanding abbreviations, 48
mismatched, 28

R

Range of page references, 129
abbreviating, 131, 143–144
adjusting, 92–93
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automatically completing, 39
character denoting, 31
checking, 43–44
conflating, 142–143, 145
in embedded index entries, 203
entering, 31
formatting, 141–142
limiting span, 43–44
searching among multi-part references, 137–138
Range of records
checking spelling in, 103–104
confining actions to, 255–257
counting among, 223–224
exporting, 205–206
printing, 80–81
replacing text in, 88
saving formatted indexes, 193–194
searching in, 72–73
Range to Save buttons, 262
Read only, opening an index as, 10
Read Only check box, 258
Reading records (importing), 210–211
Rebuild button, 310
Rebuilding groups of records, 72, 225, 229
Recent documents, opening, 10
Reconcile Headings button, 297
Reconcile Headings... Tools menu item, 296–297, 297f
Reconciling headings, 41, 96–98
proper names, protecting, 97
restrictions on, 65, 66, 152
Record(s), 7, 17–20, 19f
average number per indexed page, 224
comments in, 32, 215
counting, 222–224
damaged, 10
deleted. See Deleted records
editing. See Editing records
empty. See Empty records
exporting, 203–206
fields. See Record fields
finding. See Finding entries
hidden, 57, 256
new. See New records
obligatory field, 32, 215
range. See Range of records
removing permanently, 225–227
saving. See Saving
selecting, 63–64, 64f

size. See Record size
sorting. See Sorting
special text fields in, 32, 215
structure, 18–20, 213–217, 214f
from template, 219
viewing. See Views and viewing
web address in, 32, 215
Record Events Tools menu item, 309
Record fields, 18–19
confining actions to
replacing, 89–90
searching, 74–75
spelling check, 104–105
content restriction, 20
empty. See Empty record fields
evaluation order, in sorting entries, 149–153
exchanging/flipping, 41–42
inserting, 23, 40
joining, 40–41, 96–98
length, 20, 216
naming, 19, 216
number, 19–20
in exported records, 206
limits, 214–215
obligatory, 32, 215
retrieving from last-edited record, 38
splitting, 40, 96–98
Record number, 18
change after compressing entries, 226
with deepest heading level, 223
exporting records by, 205
finding entries by, 69
longest record, 223
showing or hiding, in draft view, 59, 59f
specifying records to find, 256
viewing records by, 62–63
Record size, 20
changing, 214
consolidating references from multiple records and, 227
importing records and, 211
longest record, 223
transferring records between indexes and, 51
Record Structure... Document menu item, 292–294, 293f
Record window, 19f, 20–24, 21f. See also Editing records; New
records
buttons in, 29–30, 35–36, 41
closing, 26–27
duplicating records, 49
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keyboard shortcuts in, 22
moving through entries, 29–30
status line, 22, 51
verifying cross-references in, 114
Recording keystrokes, 83–84
Recto pages. See Odd numbered pages, in index printed by Cindex
Redo Edit menu item, 264
Redundant subheadings. See Orphaned subheadings
Reference Syntax... Document menu item, 294–295, 294f
References. See Cross-references; Multi-part references; Page
References
Refreshing groups, 72
Regional and Language Settings Control Panel, 174
Regular expressions. See Patterns
Remove Deleted Records check box, 302
Remove Duplicated Records check box, 302
Remove Empty Records check box, 302
Remove Extra Spaces check box, 275
Remove Generated Records check box, 302
Remove Orphans button, 297
Remove References button, 299
Removing
abbreviations, 47
orphaned subheadings, 96–98
record groups, 228f, 229
records, 225–227, 225f
generated, 119, 226
redundant subheadings, 95–98
references to entries in selected volumes, 250–251
references to specified page numbers, 93
spaces, automatically, 38
text, by replacing, 86
Renumbering. See also Adjusting references
indexed (proof ) pages, 251–253
records, following index compression, 226
Repagination of text, changing entries following, 251–253
Repair index, 10
Repeating headings
after page or column break, in index printed by Cindex, 171–
172
in formatted display, 179–180
Replace, 85–90. See also Finding entries
clear current settings, 86
fonts, 87–88
removing text, 86
repeating search, 86
styles, 87–88
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Replace (Continued)
temporary page numbers, 251–253
undoing changes, 86
using patterns with, 90, 243–249
Replace All button, 269
Replace... Edit menu item, 268–270, 269f
Require Exact Matches check box, 296
Reserved characters. See Angle brackets (< >); Backslash (\);
Braces ({ }); Tilde (~)
Reset button
Find window, 267
Replace window, 269
Spelling window, 272
Restoring. See also Revert
deleted records, 51
index to last-saved, 10
original Cindex settings, 219
RETURN key, 23
breaking fields, 40
completing entry, 26
completing record field, 23
inserting fields, 40
opening entry for editing, 67t
Return to Entry Point check box, 276
Revert to Saved File menu item, 262
Reverting
edited record, 35
to last-saved index, 10, 50, 86, 92, 98
Rich Text Format (RTF), 190–191
for embedding index entries, 202–203
Rich Text Format (RTF), drop-down list item, Save As dialog
box, 260
Right justified page references, 146
SGML markup tag for, 201–202
Right Justify check box, 290
Right-click, 36
Right-hand pages. See Odd numbered pages
Right/Outside text box, 281
Roman numerals
in headers and footers, 174
in locators, 130, 133–135
RTF. See Rich Text Format (RTF)
Run-in button, 285
Run-in index style
cross-references, 121–122
formatting, 177–180
for specified entries, 180
Running head
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in index printed by Cindex, 171–172
omitted in saved formatted index, 190
Runover lines. See Continuation lines
Runover text box, 286

S

Sample patterns, 243
Save As... File menu item, 259–262
Save Backup Copy... File menu item, 262
Save File menu item, 259
Save Group... File menu item, 263
Save Open Indexes Every... text box, 274
Save Style Sheet... File menu item, 262–263
Saved index, reverting to, 10, 50, 86, 92, 98
Saving documents
abbreviations, 47
archives, 204
for Cindex for Macintosh, 204
exporting records, 203–206
formatted indexes, 189–200
Adobe InDesign, 191
part of index, 193–194
plain text documents, 191–192
Rich Text Format, 190–191
tagged text. See Markup tags, for formatted indexes
XPress tagged, 191
style sheets, 188
Saving index entries, 26–27
automatically, at regular intervals, 9
changes to, 35–36
SBL (Society of Biblical Literature), alphabetizing principles,
157
Scope of operations, 255–257
counting records, 223–224
entry statistics, 221–222
exporting records, 205–206
finding entries, 72–73
replacing text, 88
saving formatted indexes, 193–194
spelling check, 103–104
Scripts, in pattern search, 236
Search. See Finding entries; Replace
Sections of book rearranged, adjusting references to, 93–95
“See,” other than in cross-reference, 112
See also references. See Cross-references
See references. See Cross-references
Segment Order drag list, 301

Segments, page references, 129–130, 135–136. See also Multipart references
Select All Edit menu item, 265
Selecting entries, 63–64, 64f
Selecting text of entry, shortcuts for, 22t
Semicolon (;)
finding entries by beginning text in subheadings, 68–69, 256
separating cross-references, 111
sorting, 154–155, 160
Separating punctuation
cross-references, 110, 111
page references, 128–129
Separator text box
Cross-References, 295
Page References, 294
Serial publications, cumulating, 230–231
Set-out style. See Indented index style
Sets of records. See Groups of records
SGML. See Markup tags, for formatted indexes
SGML Tagged Text, drop-down list item, Save As dialog box,
260
SGML Tags tab, 306
SHIFT key
dragging and dropping text, 39
modifying PAGE DOWN, 30, 49
pasting text, 38
to restore original settings, while starting Cindex, 219
reversing flip mode, 42
selecting entries, 63, 64
selecting text, 22t
Shortcuts
abbreviations as, 45–49
adding and editing entries, 22t
automatic completion of record fields, 36–38
customizing toolbars, 14–15
finding records, 67t
hot keys, 44–45
increment/decrement locator, 39
Show Numbers View menu item, 279
Show Open Panel button, 274
Simple alphabetizing, 153
restrictions, 160, 161, 162
Single spacing, 183
Size. See also Record size
indentation units, 182–183
index statistics, 220–224
limits, abbreviations, 47
paper, for printing, 80
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text. See Text size
Size drop-down list, Headers & Footers dialog box, 283
Sky Index, importing records from, 209
Sky Text (*.sky7), drop-down list item, Import dialog box, 263
.sky7 filename extension, 209
Slash (/), sorting, 155
ignoring in word-by-word sort, 160
Small caps. See also Text style
applying to text, 35
display in record-entry window, 35
in User's Guide, 5
'Smart' flip, 41–42
Smart Flip Words Document menu item, 295
Society of Biblical Literature (SBL), alphabetizing principles, 157
Solidus (/). See Slash (/)
Sort... Tools menu item, 299–302, 300f
Sorted view, 62–63
status indicator, 56f
Sorted View menu item, 279
Sorting, 149–167
alphabetically. See also Alphabetizing
toolbar button, 62
cross-references. See Cross-references
embedded index entries, 203
field evaluation order, 149–153
identical records, 156
ignoring fields, 150–153, 164
letter-by-letter. See Letter-by-letter alphabetizing
letters, 154
in page references, 133–135
precedence, 159
numbers, 155–156, 161–162
as literal characters, 166–167, 166f
precedence, 159
spelling out, 164–165, 165f
overriding sorting rules, 162–164
in page reference order, 151–152
toolbar button for, 62, 153
page references. See Sorting page references
punctuation, 160
saving preferred settings for, 219
shortcuts, 153
simple. See Simple alphabetizing
symbols
as literal characters, 166–167, 166f
precedence, 159
spelling out, 164–165
word-by-word. See Word-by-word alphabetizing
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Sorting page references, 133–140
ascending/descending, 138
in formatted view, 147–148
ignoring, 164
letters in, 133–135
multi-part
precedence of segment types, 135–136
segments evaluation order, 135–136
multiple in entry, display order, 147–148
forcing, 139–140, 139f, 140f
overriding standard rules, 139–140, 139f, 140f
text styles, 135
Space character
in alphabetizing, 155
leading and trailing, 23, 28, 40
non-breaking, 142
omitting between references, 23
superfluous, removing, 38
Spacing
alphabetical groups, 183
columns, 170–171, 170f
lines, 183
main headings, 183
Special characters
angle brackets (< >). See Angle brackets (< >)
backslash (\). See Backslash (\)
bar (|), to override format, 180
braces ({ }). See Braces ({ })
in headers and footers, 173
in patterns, 234–243
in replacement patterns, 244–249
tilde (~). See Tilde (~)
in titles to groups of entries, 175
Special tab, 308, 309
Special tags, for document markup, 195
Special text field, for comment or URL, 32, 215
Spelling check, 99–107
alphanumeric sequences, 107
among specified records, 103–104
capital letters, 106
clearing list of words to be ignored, 107
cross-references, 105
dictionaries, 99, 101–103
medical terms, 105
personal, 101–103
duplicate words, 101
languages, 99, 105
numerals, 105, 107
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page references, 105
in specified record fields, 104–105
suggesting alternatives, 100–101
enabling/disabling, 106
Spelling... Edit menu item, 270–273, 271f
Spelling out numbers, symbols, and abbreviations, 164–165,
165f
Spin-off indexes, 231–232
Splitting index into parts, 231–232
Splitting record fields, 40, 96–98
Spreads of page references. See Range of page references
Square brackets ([ ])
mismatched, in records, 28
in patterns, 236–237
in User's Guide, 5
Stamping records
date and time, 29
user identifier, 29
Standard dictionary, spelling check, 99
Standard font. See Default font
Standard settings. See Default settings; Preferences
Start button, 272
Starting an index, 8–16
Startup, opening an index on, 11
Statistics, 220–224, 220f
record groups, 222–223, 223f, 228
Status line, 56f
macro recording, 84
record window, 21, 21f, 51
Storing text
on hot keys, 44–45
for recall via abbreviation. See Abbreviation(s)
Strings. See Text strings
Structure
cross-references, 110–112
page references, 128–129
records, 18–20, 213–217
Structure Elements tab, 307
Structure markup tags
SGML, 200
XML, 196, 197–198
Structure tags, for document markup, 195
Structure Tags tab, 309
Style
index, 176–184, 177f. See also Indented index style; Run-in
index style
saved settings, 187–188
text. See Text style

Style and Layout... Document menu item, 285–286, 285f
Style button
Grouping Entries dialog box, 284
Headers & Footers dialog box, 283
Headings dialog box, 287
Margins & Columns dialog box, 282
Page References dialog box, 291
Style Precedence drag list, 301
Style sheet, 187–188
icon, 6
Style tags
SGML document markup, 200
XML document markup, 198
Style Tags tab, 309
Styled Strings... Document menu item, 291–292, 292f
Subhead Indent buttons, 262
Subhead Preceding Locator is Required check box, 293
Subheading(s), 7. See also Sub-subheadings
creating, from modified headings, 96–97
cross-references as, 112
displaying in formatted view, 121–122
cross-references from, formatting, 123
display in draft view, 59–60
entering in records, 23
finding entries by, 68–69, 256
formatting
draft view, 59–60
indentation, 181–183
styles, 177–180
limiting text replacement to, 89
obligatory, 32, 215
orphaned (redundant), 95–96
searching among, 74–75
SGML markup tags for, 200
sorting, 150–153
ignoring, 150–153
ignoring leading words, 159–160
special last, 32, 215
verifying cross-references to, 114–115
XML markup tags for, 197
Subpatterns, 237–238
Subscript characters, 34–35. See also Text style
Subsets of records. See Groups of records
Substitute
font. See Font(s), substitution
text. See Replace
Sub-subheadings
modified indented style, 180
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modified run-in style, 179
orphaned (redundant), 96–98
Suffix text box, 288
Suggest button, 271
Suggested alternatives, spelling check, 100–101, 106
Summary view, 60–61, 61f
Summary View menu item, 278
Superscript characters, 34–35. See also Text style
Suppress all References check box
Cross-References dialog box, 289
Page References dialog box, 291
Suppress check box, 287
Suppress Repeated Parts check box, 290
Suppress to text box, 290
Suppressing. See also Hiding
components of multi-part references
leading parts, display, 144–145
in sorting, 136
cross-references, 124
deleted entries, 51
headings and subheadings, 186. See also Collapsing headings
leading/trailing punctuation in references, 198, 200
page references, 148
repeated headings, overriding, 179–180
Suspect cross-references, 113
Switch to Draft View check box, 275
Symbol font, imported records, 209
Symbols
entering in records, 24, 25f
grouping formatted entries, 175
patterns for, 235
sorting, 155
filing order for, 159
as literal characters, 166–167, 166f
spelling out, 164–165, 165f

T

Tab character
as lead indent to subheading, 194
markup tag for, 201–202
TAB key, 23
editing text, 22t
expanding abbreviation, 48
selecting record, 64
showing selected record, 67t
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Tab-delimited text
exported records, 204
imported records, 208–209
.tag, filename extension, 202
Tags. See Markup tags, for formatted indexes
Template
icon, 6
index format. See Formatting
for new index, 219–220
for patterns. See Patterns
record fields, 216
suppressing parts of multi-part references, 144–145
Template, drop-down list item, Save As dialog box, 259
Temporary group of records, 50, 65–66, 72
Temporary Group View menu item, 278
Temporary page numbers, indexing with, 251–253
Text editor, importing records from, 208–209
Text fields. See Record fields
Text size
default settings, 14, 33
in headers and footers, 174
in style sheets, 188
Text strings
finding in entries, 70–79, 70f
replacing in entries, 85–90
style automatically applied to, 186–187, 187f
Text style, 34–35
adjusting punctuation around, 184
automatically applied
cross-references, 32, 124–125
headings, 185
page references, 146–147
specified words and phrases, 186–187, 187f
in automatically completed entries, 37
boldface italic
SGML markup tag for, 200
XML markup tag for, 198
cross-references, 32, 124–125. See also Cross-references
in imported records, 210
discarding
in drag-and-drop, 39
in paste, 38
in drag-and-drop, 38
in embedded index entries, 203
in exported records, 204
finding entries using, 72
headers and footers, 174
headings, 185. See also Headings
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hidden, 203
page references, 131–132, 146–147
sorting, 135
preferences, 188
removing, 35
replacing, 87–88
SGML markup tags for, 200
for titles to groups of entries, 176
in verification of cross-references, 115
XML markup tags for, 198
Text-only documents, saving formatted indexes, 192
Tilde (~)
as literal character, 25
sorting, 167
in records imported from Macrex, 210
with smart flip prefix/suffix, 42
in sorting entries
overriding ignored subheading prefixes, 160
reserved characters as literal characters, 167
symbols and numbers as literal characters, 166–167, 166f
suppressing cross-reference recognition, 112
Tile Window menu item, 310
Time
in headers and footers, in index printed by Cindex, 174
between keystrokes, 68
record creation/modification, 29
replacing entries by, 88
work on index, 221
Time delay
between keystrokes, 68
summary view, 61
Title. See also Headers and footers
to group of entries, in index printed by Cindex, 175
Title bar, asterisk (*) in, 9
Title Text text box, 284
To Level drop-down list, 282
Toolbar buttons, 258
copying/pasting records, 50
deleting/restoring records, 51
draft formatted view, 58
entering/editing records, 21, 29–30
default font, 34
flipping fields, 41
propagating changes, 42
restoring record text, 49
text styles, 35
finding entries, 70
fully formatted view, 55, 56

hiding text from sorting, 163
including text for sorting, 165
labeling/unlabeling records, 51
new record, 20
record window, 29–30
sorting entries, 153
view all records, 50, 65
Toolbars
buttons. See Toolbar buttons
customizing, 14–15
drop-down list
font, 257
font size, 257
Tools menu, 295–310
Check References..., 295–296, 296f
Reconcile Headings..., 296–297, 297f
Manage Cross-References..., 298, 298f
Alter References..., 298–299, 299f
Sort..., 299–302, 300f
Compress..., 302–303, 302f
Expand, 303
Count Records..., 303–304, 303f
Index Statistics..., 304, 304f
Abbreviations, 305
Fonts..., 305, 305f
Hot Keys..., 306
Markup Tags..., 306–309, 306f, 307f
Record Events, 309
Play Events, 309
Groups..., 309–310, 309f
Top text box, 281
Track New Entries check box, 275
Track Source check box, 276
Trailing punctuation
cross-references, 120, 123
headings, 186
page references, 146
Trailing Punctuation text box, 287
Trailing spaces, 23, 28, 40
Translating characters
connecting inclusive page ranges, 142
importing records, 210, 211
Triple-clicking, selecting field, 23t
Type drop down list, 286
Type Precedence drag list, 301
Type size. See Text size
Type style. See Text style
Typeface
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in index entries. See Font(s); Text style
in User's Guide, 5
Typesetting. See Saving documents
Typographical errors
correcting. See Spelling check
warnings, 28–29
Typography. See Font(s); Text style

U

UCP markup standard, 191
Underlining. See also Text style
applying to text, 34–35
Undifferentiated page references, 132
Undo. See also Reverting
discarding changes to records, 35
drag or paste records, 50
Undo Edit menu item, 264
Unformatted view, 61–62, 62f
Unformatted View menu item, 279
Unicode characters
character categories, 235
entering in records, 24
in exported formatted index, 192
in exported index records, 204
in imported index records, 208
ordering, 154, 159
script sets, 236
in SGML tagged text, 201
sorting accented letters, 154
translation, 211
in XML tagged text, 196
Unique main headings, 221
Unit drop-down list
Margins & Columns dialog box, 281, 282
Style and Layout dialog box
indentation, 286
line spacing, 286
Units of measurement
indentation, 181f, 183
line spacing, 183, 183f
margins and columns, 170, 170f
University of Chicago Press. See also Chicago Manual of Style
markup standard, 191
Unknown character (), 211
Unnecessary records, compressing index entries, 225–227
“Unpacking” references, 224–225
Unsorted view, 62–63
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Unusual spellings, sorting, 165–166, 166f
Update Cindex, automatic check for, 5, 13
Uppercase letters. See also Case-sensitivity
collation order, 154
conversion. See Case conversion
ignoring, spelling check, 106
in page references, 130
reconciling heading levels and, 97
sorting, 154
URLs, in records, 32, 215
Use Separate Window check box, 275
User dictionary, 101–103
User ID text box, 275
User identifier, 12, 21f
finding records by, 73
stamping records with, 29
User preferences. See Preferences
UTF-8. See Unicode characters
UTF-8 Encoding/ANSI Encoding radio buttons, 261

V

Variant drop-down list, 285
Verifying cross-references, 112–115
error report, 113–114
while entering in record, 44
Verso pages. See Even numbered pages, in index printed by Cindex
versus and vs., automatically italicized, 186
Vertical bar (|)
custom run-in headings, 180
in patterns, 241
View Depth submenu, 279
View menu, 277–279
Go To..., 277–278, 277f
All Records, 278
New Records, 278
Group, 278
Temporary Group, 278
Full Format, 278
Draft Format, 278
Summary, 278
Unformatted, 279
Hide by Attribute..., 279
Show Numbers, 279
View Depth, 279
Wrap Lines, 279
Sorted, 279
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Viewing, markup tag sets, 196–202
Views and viewing, 55–63. See also Draft formatted view; Fully
formatted view
abbreviations, 46
adding/editing records, 58–59
defining scope of operation, 255–257
deleted records, 51, 56
groups of records, 65
hidden records, 57, 256
labeled records, 57
multiple columns, displaying, 170–171
multiple indexes, displaying, 310
printing, 80–81
in record number order, 62–63
restoring after editing, 36
sorted entries, 62–63
summary of entries, 60–61, 61f
unformatted view, 61–62, 62f
unsorted entries, 62–63
Visibility, of records, 57
Volume identifiers. See also Page references
adding to page references, using patterns, 244–245
altering references, 249–250
cumulating and combining indexes, 230
removing references, 250–251
repeated, suppressing in formatted display, 144–145
vs. and versus, automatically italicized, 186

W

Warnings
badly-specified range of records, 256
impermissible text in record field, 28–29, 216
insufficient text space in record
dropping text, 38
expanding abbreviation, 48
hot keys, 45
pasting text, 38
mismatched parentheses or square brackets, 28
mismatched quotation marks, 28
missing/malformed page references, 43
Web addresses, in records, 32, 215
Whole words, searching for, 76, 86, 90
Width, margins and columns, 170–171
Window menu
Clipboard, 310
Cascade, 310
Tile, 310

Close All, 310
Windows. See also Main window; Record Window
abbreviations, 46
default size, 13
hot key text, 44–45
Windows® character set, 192, 204, 206, 208
Windows® Explorer
copying an index, 9
opening a template, 220
opening an archive, 207
opening an index, 10
Word boundary, in pattern, 242
Word processor
exporting indexes to. See Microsoft Word; Saving documents
importing records prepared on, 208–209
Word-by-word alphabetizing, 154, 156–158
angle brackets, spaces and hyphens within, 163
hyphen and slash, treatment of, 155, 160
overriding rules for, 162–164
Work time, 221
Wrap Lines View menu item, 279
Wrapping long entries, unformatted view, 62
Write in Record Number Order check box, 261
Writing order, exported records, 206

X

XML document markup, 190
tags, 196–198
XML Records, 9
exporting, 204
icon, 6
importing, 207
XML Records, drop-down list item, Save As dialog box, 259
XML Records (*.ixml), drop-down list item, Import dialog box,
263
XML Tagged Text, drop-down list item, Save As dialog box, 260
XML Tags tab, 306
XPress document tags, 191

Y

Years, rearranging in dates, via patterns, 248–249
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